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Notice
The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental 
or consequential damages in connection with the furnishing, performance, or use of this 
material.

LIMITED WARRANTY
The material contained in this document is provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the maximum extent permitted by applicable 
law, Agilent disclaims all warranties, either express or implied with regard to this manual 
and any information contained herein, including but not limited to the implied warranties of 
merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or 
for incidental or consequential damages in connection with the furnishing, use, or 
performance of this document or any information contained herein. Should Agilent and the 
user have a separate written agreement with warranty terms covering the material in this 
document that conflict with these terms, the warranty terms in the separate agreement will 
control.

Assistance
Product maintenance agreements and other customer assistance agreements are available for 
Agilent Technologies products. For any assistance, refer to “Contacting Agilent” on page 552.
ii



Software Licensing
The Physical Layer Test System has two licensing options. The options are:

Node-Locked allows use of PLTS software only on a single personal computer. The license 
resides on and is tied to the local PC via a hardware address.

Network-Server
Floating allows the sharing of a licences (or multiple licences) across a network. The 

PLTS software may be installed on an unlimited number of personal 
computers. The license(s) reside on a networked drive/folder and are 
checked out on a first-come, first-served basis.

Refer to Chapter 3, Installing the Physical Layer Test System Software, for the licensing 
procedure.

Software Compatibility
This user’s guide is compatible with Physical Layer Test System software revisions 2.000 and 

above. 

Document Conventions
This document uses a few conventions to make reading easier.

• Menu and dialog box items are shown in bold face type. When described in text, menus and 
sub-menus are separated by right arrows, as in File > Open > Data…

• Window and dialog box names are shown in italic font.

• Keyboard entries are shown in mono-spaced typeface.

• Network analyzer keys are displayed in condensed, bold font.
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Embedded Operating System Risk
The Agilent PNA-family of network analyzers make use of Embedded Operating Systems 
(EOS) technology. The EOS is Windows1 2000, a standard personal computer-based operating 
system. The PNA is essentially a network analyzer with a personal computer behind the front 
panel.

EOS devices, including the PNA may be connected to computer networks. When connected, 
these devices are open to numerous security exploits, worms, and viruses. In addition, they 
can become a threat to other EOS devices, servers, end-user PCs, and to the network itself.

Precautions are taken to ensure that the PNA has no security issues, such as worms or 
viruses, prior to shipping. To maintain the health of the PNA, it is recommended that you 
install anti-virus software and the latest service packs on the PNA before connecting the PNA 
to a computer network.

1. Windows and MS Windows are U.S. registered trademarks of Microsoft Corporation.
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Part I guides you through the initial steps of installing the physical layer test system.

Chapter 1, “Installing the VNA-Based Physical Layer Test System Hardware”

Provides you a step-by-step installation procedure for the VNA-based PLTS 
hardware.

Chapter 2, “Installing the TDR-Based Physical Layer Test System Hardware”

Provides you a step-by-step installation procedure for the TDR-based PLTS 
hardware.

Chapter 3, “Installing the Physical Layer Test System Software”

Provides you a step-by-step installation procedure for the PLTS software. This 
chapter also explains the various areas of the main software screen.
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Installing the VNA-Based Physical Layer Test System Hardware
The Physical Layer Test System (PLTS) consists of the following items:

• Personal computer (PC)

• VNA-based system (Network analyzer and S-parameter test set)

• PLTS software

The installation procedure in this chapter will lead you through setting up the hardware (the 
PC and the VNA-based system). After that is complete, you will refer to Chapter 3, Installing 
the Physical Layer Test System Software, to install the software. 

NOTE If you have the TDR-based PLTS system, refer to Chapter 2, “Installing the 
TDR-Based Physical Layer Test System Hardware,” on page 43 for instructions 
on setting up that system.

This installation procedure will lead you through a series of steps to set up your PLTS 
hardware. The following is a list of the installation steps:

• Step 1. Set Up the Personal Computer

• Step 2. Verify your System Shipment

• Step 3. Set Up the Network Analyzer

• Step 4. Attach the Test Set to the Network Analyzer (N4420B or N4464A/B Test Set Only)

• Step 5. Install the S-Parameter Test Set on a Bench Top or in an Equipment Rack

• Step 6. Make the Interconnections between the S-Parameter Test Set and the Network 
Analyzer

• Step 7. Set Up the General Purpose Interface Bus (GPIB)

• Step 8. Power up the Physical Layer Test System

NOTE These installation instructions were written specifically for customers who 
have just received their PLTS. If you have already been using our S-parameter 
test set and its corresponding network analyzer, you have probably completed 
most of these installation steps. Review these installation steps to ensure that 
your system is currently set up as recommended. Then, begin the software 
installation process by starting at Chapter 3, “Installing the Physical Layer 
Test System Software,” on page 51.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 1. Set Up the Personal Computer
Step 1. Set Up the Personal Computer

1. Make sure that your PC meets the following minimum system controller requirements:

2. Using the PC documentation, make sure that the PC is operating properly.

3. Make sure the GPIB card is installed in the PC and that it is operating properly.

4. Make sure the PC is located near where you will position the Physical Layer Test System 
(PLTS). Later in this process, you will connect the GPIB card to the PLTS using a GPIB 
cable.

Table 1-1 Minimum PC Requirements by PLTS Modes of Operation

PC Requirement

Measurement Controller Mode Off-Line Analysis Mode

In the lab, controlling test 
equipment and making quick 
analysis of the results

In your office, performing “What if...” 
analysis, characterization, 
cross-domain analysis, filtering, 
waveform math, and eye diagram 
simulation

CPU 400 MHz Pentiuma II or greater

a. Pentium is a U.S. registered trademark of Intel Corporation.

1 GHz Pentium III compatible PC

Main Memory 256 MBb

b. 512 MB of Main Memory is recommended for the Measurement Controller Mode when the 
measurement is measuring 16,000 points with the PNA B-model network analyzer.

512 MB

Virtual Memoryc

c. As a general rule for optimum PC performance when using PLTS, virtual memory should be 
1.5 to 2 times the size of the main memory.

512 MB 768 MB

GPIB Interface Agilent 82357A USB/GPIB Interface 
for Windows or supported GPIB card 
(any National Instruments or Agilent 
82340/41 or 82350 GPIB card)

No GPIB connection is required to 
utilize PLTS in the off-line mode. 
Saved (stored) measurement files can 
be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPd

d. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
Step 2. Verify your System Shipment

1. Unpack your system from the containers in which it was shipped.

WARNING The test system hardware is heavy. Use proper lifting techniques. 
The network analyzer can weigh between 53 lb. (24 kg) and 64 lb. 
(29 kg). The test set can weigh as much as 20 lb. (9 kg). 

2. Carefully inspect the system hardware to make sure that it was not damaged during 
shipment.

NOTE If your test system was damaged during shipment, contact Agilent 
Technologies. Refer to “Contacting Agilent” on page 552.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
3. Use Table 1-2 to verify that your test set is compatible with your network analyzer and its 
installed options. “Step 3. Set Up the Network Analyzer” on page 10 has additional 
network analyzer option information if you have a question. If the installed options are not 
compatible, contact us before proceeding. Refer to “Contacting Agilent” on page 552.

Table 1-2 Physical Layer Test System Configurations

Test Set
Model 

Number

System
Frequency

Range

Supported Network Analyzer

Model 
Number

Optionsa

a. This table lists only the most specifically relevant options. For compatibility with options not 
listed here, contact the factory.

Required Compatible Incompatible

N4415A 30 kHz to 
6.0 GHz

8753ES 006b, 014

b. Option 006 required only for operation above 3 GHz.

002, 004, 010, 
1D5

011, 075, H16

N4416A 300 kHz to 
6.0 GHz

E8356Ac/7A/8A

c. Using this network analyzer, the maximum operating frequency is limited to 3 GHz.

015 010, 1D5

N4417Ad

d. E8356A family requires N4417A Option 103; E8801A family requires N4417A Option 104.

300 kHz to 
9.0 GHz

E8356Ac/7Ae/8A

e. Using this network analyzer, the maximum operating frequency is limited to 6 GHz.

015 010

E8801Ac/2Ae/3A 014 010, 1E1, 1E5

N4418A 50 MHz to 
20 GHz

8720ES H32 or H42 010, 012, 400 007, 085, 089

8722ESf

f. When an 8722ES is used with an N4418A, the N4418A requires Option 302. The system’s 
maximum operating frequency is limited to 20.0 GHz.

H32 or H44 010, 012, 400 007, 085, 089

N4419Ag/B 10 MHz to 
20 GHz

E8362Ag/B

g. “A” models of this test set or network analyzer have a start frequency of 45 MHz.

014 010, 022, 711, 
UNL

N4420B 10 MHz to 
40 GHz

E8363Ag/B 014 010, 022, 711, 
UNL

N4421Ag/B 10 MHz to 
50 GHz

E8364Ag/B 014 010, 022, 711, 
UNL
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
4. Check the accessories that were shipped with your system. Your network analyzer 
accessories will be checked during the network analyzer setup. 

Item Nr Part Number Part Description

1 8120-3445 GPIB Cable (3 feet)

2 N/A “Port 3” Label

3 Varies by Test Set 
Model and Option

Semirigid interconnect cables (refer to Step 6. Make the 
Interconnections between the S-Parameter Test Set and the 
Network Analyzer for the appropriate number of cables)

4 Unique to country AC Power Cord (for the test set)

5 AD00658 Balanced Transmission Line PC Board Device (Sample DUT)

6 Left: Z5823-20239 
Right: Z5823-20240

2 Rear Locking Feet (N4420B, N4421A/B only) (With 4 Screws - 
2 each - longer: 0515-0686 and shorter: HW00235)

7 1600-1423 4 Lock Links (N4420B, N4421A/B only) with 8 screws 
(0515-1499)
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
5. If you ordered any of the following options, check the parts. Option 1CP is shipped in a 
separate container.

Option 
Number

Item 
Number

Part Description

1CP 1A
1B

Rack mount flange kit (For use with handles)
Handles (set of 2)

B20 2 Precision 50-ohm cables (4)

060 3 4-Port Electronic Calibration Module/Kit (Not available as an 
option for the N1951A/53A/53B/55B/57A/57B PLTS)

Other Calibration Kits

N/A Not Shown 85033E 3.5mm Calibration Kit (0 Hz (dc) − 9 GHz) 1

85052D 3.5mm Economy Calibration Kit (0 Hz (dc) − 26.5 GHz) 1

85056A 2.4mm Precision Calibration Kit (0 Hz (dc) − 50 GHz) 1

85050C 7 mm Precision Calibration Kit (0 Hz (dc) − 18 GHz) 2

1 Kit for SOLT Calibration; 2 Kit for TRL Calibration
Chapter 1 9



Installing the VNA-Based Physical Layer Test System Hardware
Step 3. Set Up the Network Analyzer
Step 3. Set Up the Network Analyzer

1. Using Table 1-3, verify that your network analyzer options are compatible with the 
physical layer test system. Incompatible options are shaded.

Table 1-3 Common Hardware Option Number Descriptions for Network Analyzers

8753ES Network Analyzer Options

002 Harmonic-Measurement Upgrade 004 Step Attenuator Upgrade

006 6 GHz Upgrade for Standard Units 010 Time Domain Capability

011 Receiver Configuration 014 Configurable Test Set

075 75 Ohm Impedance 1D5 High Stability Frequency Reference

H16 Low Noise Floor

8720ES and 8722ES Network Analyzer Options

007 Mechanical Transfer Switch 010 Time Domain Capability

012 Direct Sampler Access 085 High-Power Test System

089 Frequency Offset Mode 1D5 High Stability Frequency Reference

400 Four-Sampler Test Set H32 Front panel access to A and B samplers 
and Port 1 and Port 2 switch and 
coupler

H42 8719/8720 only: Front panel access to all 
samplers and Port 1 and Port 2 switch 
and coupler (installs options 400 & 012) 

H44 8722 only: Front panel access to R1, R2, 
A, and B samplers, and Port 1 and Port 
2 switch and coupler ports (installs 
options 400 & 012) 

E8356A, E8357A, and E8358A Network Analyzer Optionsa

010 Time Domain Capability 015 Configurable Test Set

E8801A, E8802A, and E8803A Network Analyzer Optionsa

010 Time Domain Capability 014 Configurable Test Set

1E1 Extended Power Range 1E5 High Stability Timebase

E8362A/B, E8363A/B, and E8364A/B Network Analyzer Optionsa

010 Time Domain Capability 014 Configurable Test Set

016b Add Receiver Attenuators 022 Extended Memory
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Installing the VNA-Based Physical Layer Test System Hardware
Step 3. Set Up the Network Analyzer
2. Using the network analyzer’s Installation and Quick Start Guide, set up the network 
analyzer. 

3. If you are installing your network analyzer in an equipment rack, be sure to leave at least 
2 rack units of space below the analyzer to install the test set.

NOTE For the N4420B or N4421A/B test set, connect the E8363A/B or E8364A/B 
network analyzer to the test set before placing in the rack as a single unit on 
one set of rails. Refer to“Step 4. Attach the Network Analyzer to the Test Set” 
on page 12 for instructions.

080b Frequency Offset 081b External Reference Switch

083b Frequency Converter Measurement 
Application

711 Standard Power Range

UNL Extended Power Range with Bias Tees

a. PNA network analyzers should have firmware revision A.03.53 or later. Contact the 
factory for information regarding PLTS support of earlier firmware revisions.

b. This option has not been tested and is not specified with the Physical Layer Test System.

Table 1-3 Common Hardware Option Number Descriptions for Network Analyzers
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Step 4. Attach the Network Analyzer to the Test Set 
(N4420B or N4421A/B Test Set Only)

If your test set is not an N4420B, an N4421A, or an N4421B, continue with “Step 5. Install the 
Test System on a Bench Top or in an Equipment Rack” on page 15.

The E8363A/B and E8364A/B network analyzers are attached to theN4420B and N4421A/B 
test sets using lock links at the front and locking feet at the rear. This hardware is supplied 
with the test set. Other network analyzers are not attached to test sets (N4415A, N4416A, 
N4417A, N4418A, and N4419A/B) using this hardware.

Preparing the Network Analyzer

1. Remove the four feet from the bottom of the network analyzer.

2. Remove the screws from the two lower rear panel standoffs.

3. Install the two rear locking feet where the standoffs were removed. Use part number 
Z5823-20239 on the left side of the analyzer and part number Z5823-20240 on the right 
side. Use the two longer screws to secure the feet to the analyzer.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Preparing the Test Set

4. Remove the trim strip from the top of the front frame.

5. Install the four lock links to the top of the front frame using eight screws.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Attaching the Network Analyzer to the Test Set 

6. Place the network analyzer on top of the test set ensuring that the front frame of the 
network analyzer is positioned slightly forward of the lock links that are attached to the 
the test set. Then slide the network analyzer back so the lock links engage the front frame 
of the analyzer.

7. Secure the network analyzer’s lower locking feet to the test set’s upper locking feet by 
inserting the shorter two screws between the two pairs of locking feet, one on each side of 
the instrument as shown below. 

If the screw holes between the network analyzer’s lower locking feet are not aligned with 
the screw holes in the test set’s upper locking feet, loosen the screws securing the feet to 
the instruments slightly to align. 

8. Tighten all screws.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
Step 5. Install the Test System on a Bench Top or in an 
Equipment Rack
The test system can be installed on a bench top or in an equipment rack. 

In all installations, consider the following ventilation requirements when deciding where to 
set up your test system.

CAUTION Ventilation Requirements: 
When installing the product in a cabinet, the convection into and out of the 
product must not be restricted. The ambient temperature (outside the cabinet) 
must be less than the maximum operating temperature of the instrument by 
4 °C for every 100 watts dissipated in the cabinet. If the total power dissipated 
in the cabinet is greater than 800 watts, then forced convection must be used.

Refer to the section that applies to your installation.

• For bench top installation, continue on page 16.

• For equipment rack installation, continue on page 17.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install on a Bench Top

1. Place the test set and the network analyzer on a bench top. In the example illustration 
shown below, the system is placed on a riser as an alternative to the bench top. Make sure 
that there is at least four inches of clearance on the sides and back of the system for 
adequate ventilation.

The front panel test cables are shown only as a reminder to make sure they can easily 
reach the test surface of the bench.

CAUTION Consider the ventilation requirement described on page 15 when selecting the 
location of your system.

2. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 21.
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Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install in an Equipment Rack

You may install the PLTS in an equipment rack in one of following two ways:

When you install the test set in an equipment rack, you will install rails in the rack to support 
the weight of the test set, attach the handles and the rack mount flanges to the test set, and 
secure the test set to the equipment rack.

1. Ensure that the front handle kit, the rack mount flange kit, and the rack mount rail set 
are complete.

NOTE If any items are damaged or missing from a kit, contact us (refer to “Contacting 
Agilent” on page 552) to order a replacement kit. Items within these kits are 
not individually available.

Removing Feet from VNA Leaving Feet attached to VNA

1. Install one set of rails into the 
equipment rack

2. Remove feet from Test Set and VNA
3. Attach mount flanges and the handles to 

Test Set
4. Attach mount flanges and the handles to 

VNA
5. Insert test set on rails in equipment rack 

and screw to rack
6. Place VNA on top of test set and screw 

VNA into rack
7. Bend Semi rigid interconnect cables to 

fit between the test set connector and the 
VNA connector

8. Connect semirigid between test set and 
VNA

1. Install one set of rails into the 
equipment rack

2. Remove feet from Test Set only
3. Attach mount flanges and the handles to 

Test Set
4. Attach mount flanges and the handles to 

VNA
5. Insert test set on rails in equipment rack 

and screw to rack
6. Place VNA on top of test set
7. Connect semirigid between test set and 

VNA

Handle Kit Contents Flange Kit Contents

• 4 Screws
• 2 Side Trim Strip
• 2 Handles
• Installation Instructions

• 4 Screws (Long)
• 4 Screws with Washers
• 4 Nuts with Metal Clips
• 2 Flanges
• Installation Instructions
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
2. Install the rails into the equipment rack using the instructions provided. Consider that the 
test set is two rack units high (3.5 inches). Mount the test set immediately below the 
network analyzer.

NOTE For the N4420B, N4421A, or N4421B test set, connect the network analyzer to 
the test set before placing in the rack as a single unit on one set of rails.

3. Attach the cabinet mount flanges and the handles to the sides of the front panel, using two 
long screws per side. (Attach the flanges to the outside of the handles.)

WARNING If an instrument handle is damaged, you should replace it 
immediately. Damaged handles can break while you are moving or 
lifting the instrument and cause personal injury or damage to the 
instrument.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
4. Remove the feet before cabinet mounting the analyzer using the directions imprinted on 
the feet.

5. Ensure there is adequate clearance between the system cabinet and the sides and back of 
the test system for adequate ventilation.

CAUTION Consider the ventilation requirements described in “Step 5. Install the Test 
System on a Bench Top or in an Equipment Rack” on page 15 when selecting 
the location of your system.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
6. Lift the test set and slide it onto the rails that you installed earlier from the front of the 
equipment rack. Secure the test set to the equipment rack using the screws with washers 
and metal-clipped nuts provided in the flange kit.

7. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 21.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Step 6. Make the Interconnections between the 
S-Parameter Test Set and the Network Analyzer

1. Locate your system or test set and network analyzer listed below. Refer to the page 
indicated for information describing the interconnections between the test set and the 
network analyzer.

2. Using the illustration and table located on the page referenced above in step 1, connect the 
interconnect cables between the test set and the network analyzer. Torque the semirigid 
cable connectors to 8 inch-pounds.

Test System 
Model Number

Test Set 
Model Number

Network Analyzer 
Model Number

Refer
to:

N1957A/B
N1955B

N1953A/B
N1951A
N1948A
N1947A

N/A
N/A

N4421A/B
N4420B

N4419A/B
N4418A
N4417A
N4417A
N4416A
N4415A

E8364A/B
E8363A/B
E8362A/B
8720ES, 8722ES
E8356A, E8357A, E8358A
E8801A, E8802A, E8803A
E8356A, E8357A, E8358A
8753ES

page 23
page 25
page 27
page 29
page 31
page 33
page 35
page 37
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
CAUTION When connecting the interconnect cables described in the remaining pages of 
this section, be careful to install the interconnect cables correctly. The longer 
end of the interconnect cable connects to the network analyzer front panel 
connector. Refer to Figure 1-1 for the correct orientation. 

Figure 1-1 Interconnect Cable Orientation

Damage to the interconnect cable can result from improper connection of the 
cable.

TIP If the test set and the network analyzer are rack mounted, the screws securing 
the rack mount flanges to the instrument rack may be loosened slightly to allow 
for minor repositioning of the instruments. Don't forget to retighten the screws 
when you are done.

3. Continue with “Step 7. Set Up the General Purpose Interface Bus (GPIB)” on page 39.
Chapter 122



Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1957A/B Test System Interconnections 

(or N4421A/B Test Set with E8364A/B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Call Out
Sequence

Cable Part 
Number

From
E8364A/B

To
N4421A/B

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1955B Test System Interconnections 

(or N4420B Test Set with E8363A/B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Call Out
Sequence

Cable Part 
Number

From
E8363A/B

To
N4420B

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1953A/B Test System Interconnections 

(or N4419A/B Test Set with E8362A/B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Call Out
Sequence

Cable Part 
Number

From
E8362A/B

To
N4418A

1 AD00756-1 REF 1 SOURCE OUT REF 1 SOURCE OUT
2 AD00756-1 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 AD00756-1 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 AD00756-1 REF 2 SOURCE OUT REF 2 SOURCE OUT
5 AD00756-2 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 AD00756-2 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 AD00756-2 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 AD00756-2 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 AD00756-3 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 AD00756-3 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 AD00756-3 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 AD00756-3 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 AD00756-4 REF 1 on rear panel of the test set
14 AD00756-4 REF 2 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1951A Test System Interconnections 

(or N4418A Test Set with 8720ES or 8722ES Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Call Out
Sequence

Cable Part 
Number

From
8720ES/8722ES

To
N4418A

1 AD00599-2 PORT 1 SWITCH PORT 1 SWITCH
2 AD00599-1 A IN A IN
3 AD00599-2 PORT 1 BIAS TEE PORT 1 COUPLER
4 AD00599-1 A OUT A OUT
5 AD00599-2 PORT 2 BIAS TEE PORT 2 COUPLER
6 AD00599-1 B OUT B OUT
7 AD00599-4 R CHANNEL OUT R OUT
8 AD00599-3 R CHANNEL IN R IN
9 AD00599-2 PORT 2 SWITCH PORT 2 SWITCH
10 AD00599-1 B IN B IN
11 AD00599-5 REF 1 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1948A Test System Interconnections 

(or N4417A Option 104 Test Set with E8356A, E8357A, or E8358A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Installation
Sequence

Cable
Part Number

From
E8356/E8357/E8358

To
N4417A

1 AD00747-1-2 R1 IN R1 IN
2 AD00747-1-2 A IN A IN
3 AD00747-1-2 COUPLER IN COUPLER IN
4 AD00747-1-2 COUPLER IN COUPLER IN
5 AD00747-1-2 B IN B IN
6 AD00747-1-2 R2 IN R2 IN
7 AD00747-1-1 R1 OUT R1 OUT
8 AD00747-1-1 A OUT A OUT
9 AD00747-1-1 SOURCE OUT SOURCE OUT
10 AD00747-1-1 SOURCE OUT SOURCE OUT
11 AD00747-1-1 B OUT B OUT
12 AD00747-1-1 R2 OUT R2 OUT
13 AD00747-1-3 REF 1 on rear panel of the test set
14 AD00747-1-3 REF 2 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1947A Test System Interconnections 

(or N4417A Option 103 Test Set with E8801A, E8802A, or E8803A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Installation
Sequence

Cable
Part Number

From
E8801/E8802/E8803

To
N4417A

1 AD00747-2-2 R1 IN R1 IN
2 AD00747-2-2 A IN A IN
3 AD00747-2-2 COUPLER IN COUPLER IN
4 AD00747-2-2 COUPLER IN COUPLER IN
5 AD00747-2-2 B IN B IN
6 AD00747-2-1 R1 OUT R1 OUT
7 AD00747-2-1 A OUT A OUT
8 AD00747-2-1 SOURCE OUT SOURCE OUT
9 AD00747-2-1 SOURCE OUT SOURCE OUT
10 AD00747-2-1 B OUT B OUT
11 AD00747-2-3 REF 1 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N4416A Test Set with the E8356A, E8357A, or E8358A Network Analyzer 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Installation
Sequence

Cable
Part Number

From
E8356/E8357/E8358

To
N4416A

1 AD00653-2 R1 IN R1 IN
2 AD00653-2 A IN A IN
3 AD00653-2 COUPLER IN COUPLER IN
4 AD00653-2 COUPLER IN COUPLER IN
5 AD00653-2 B IN B IN
6 AD00653-2 R2 IN R2 IN
7 AD00653-1 R1 OUT R1 OUT
8 AD00653-1 A OUT A OUT
9 AD00653-1 SOURCE OUT SOURCE OUT
10 AD00653-1 SOURCE OUT SOURCE OUT
11 AD00653-1 B OUT B OUT
12 AD00653-1 R2 OUT R2 OUT
13 AD00653-3 REF 1 on rear panel of the test set
14 AD00653-3 REF 2 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N4415A Test Set with the 8753ES Network Analyzer

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Installation
Sequence

Cable
Part Number

From
8753ES

To
N4415A

1 AD00632-2 Port 1 Switch Switch
2 AD00632-1 A OUT A OUT
3 AD00632-2 Port 1 Coupler Coupler
4 AD00632-1 A IN A IN
5 AD00632-2 Port 2 Coupler Coupler
6 AD00632-1 B IN B IN
7 AD00632-2 Port 2 Switch Switch
8 AD00632-1 B OUT B OUT
9 AD00632-3 R Channel In R IN
10 AD00632-3 R Channel Out R OUT
11 AD00632-4 REF 1 on rear panel of the test set
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Installing the VNA-Based Physical Layer Test System Hardware
Step 7. Set Up the General Purpose Interface Bus (GPIB)
Step 7. Set Up the General Purpose Interface Bus (GPIB)
The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. The PLTS software will locate and identify your test system equipment 
automatically. Each test system device must have a unique GPIB address. 

NOTE There are 32 GPIB addresses, numbered 0 to 31. However, there may be the 
occasion that you need to change the GPIB address for test equipment. GPIB 
addresses are set either using rear panel switches or using the equipment 
firmware. Refer to “Setting Up the General Purpose Interface Bus Manually” 
on page 597 for more information.

1. Connect a GPIB cable from the rear panel GPIB connector on the network analyzer to the 
rear panel GPIB connector on the test set.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 7. Set Up the General Purpose Interface Bus (GPIB)
2. Connect a second GPIB cable from the PC GPIB card's connector to the GPIB connector on 
either end of the first cable that was connected.
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Step 8. Power up the S-Parameter Test Set
Step 8. Power up the S-Parameter Test Set

1. Ensure the available ac power supply meets the Power Source Requirements and the 
operating environment meets the Operating Environment Requirements listed below.

Refer to Chapter 15, “Specifications and Characteristics,” for the complete specifications.

2. Verify that the ac power cable is not damaged, and that the power-source outlet provides a 
protective earth contact.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage.

3. Turn off the PC and the network analyzer.

4. Connect the ac power cable from the power-source outlet to the ac input on the rear panel 
of the test set.

5. Turn on the PC, the network analyzer, and the test set by pressing the ON/OFF button on 
the front panel of each device.

Power Source Requirements
Input Voltage Range 100 − 120 Vac - or - 220 − 250 Vac
Frequency Range 47 − 62 Hz / 400 Hz
Power 40 VA maximum.

Operating Environment Requirements
Operating Environment Indoor use
Altitude Operating:

Storage: 
0 to 2.0 km (6,560 ft.)
0 to 15.24 km (50,000 ft.)

Temperature 0 °C to 40 °C
Maximum Relative Humidity 80% for temperatures up to 31 °C; decreasing 

linearly to 50% for a temperature of 40 °C
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Installing the VNA-Based Physical Layer Test System Hardware
Step 8. Power up the S-Parameter Test Set
6. If your network analyzer is an N8362A/B, N8363A/B, or N8364A/B, you will need to 
perform the Phase-Lock IF Gain Adjustment after it has been connected to the test set. 
This routine adjusts the R Channel receivers ALC gain to ensure phase lock over the 
entire frequency range. Refer to Phase-Lock IF Gain Adjustment in the network 
analyzer’s online help system for details. Use the following steps to perform this 
adjustment:

a. On the PNA, from the System menu, click Service, then Adjustments, then IF Gain 
Adjustment.

If you are unable to find these selections on your N836XA PNA, your analyzer firmware 
is a revision prior to 3.0. Follow the instructions in “IF Gain Adjustment” on page 602 
to complete this adjustment.

b. Select any special test set options installed.

c. No connections to the test ports are required.

d. Click Begin Adj. The adjustment takes about a minute to complete.

The advanced screen is for factory personnel only.

NOTE This adjustment must be performed before using the network analyzer each 
time the system is assembled or disassembled.

7. The PLTS hardware installation is complete. Continue with the PLTS software installation 
by referring to Chapter 3, “Installing the Physical Layer Test System Software,” on 
page 51.
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Installing the TDR-Based Physical Layer Test System Hardware
To make time domain measurements using the Physical Layer Test System (PLTS) software 
and a TDR system, you need the following equipment:

• Personal computer (PC)

• PLTS software

• TDR-based PLTS hardware (one of the following systems)

— Agilent 86100A/B Infiniium DCA Wide-Bandwidth Oscilloscope equipped with two 
54754A Differential 18 GHz TDR/TDT Plug-in Modules using Firmware Revision 03.06 
or greater

— Tektronix CSA8000 Communications Signal Analyzer equipped with two 80E04 Dual 
Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or greater

— Tektronix TDS8000 Digital Sampling Oscilloscope equipped with two 80E04 Dual 
Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or greater

Figure 2-1 TDR-based Physical Layer Test System Hardware: 
Tektronix CSA8000 (left) and Agilent 86100A/B DCA (right)

This installation procedure leads you through setting up the hardware (the PC and the 
TDR-based Physical Layer Test System). After you complete this installation, you will refer to 
Chapter 3, Installing the Physical Layer Test System Software, to install the software. 
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Installing the TDR-Based Physical Layer Test System Hardware
NOTE If you have the VNA-based Physical Layer Test System, refer to Chapter 1, 
“Installing the VNA-Based Physical Layer Test System Hardware,” on page 3 
for instructions on setting up that system.

The following is a list of the installation steps to set up your TDR system hardware:

• Step 1. Set Up the Personal Computer

• Step 2. Set Up the TDR System

• Step 3. Set Up the GPIB

• Step 4. Power up the TDR System

NOTE These installation instructions were written specifically for customers who 
have just received their TDR system with their PLTS software. If you have 
already been using your TDR system, you have probably completed most of 
these installation steps. Briefly review installation these steps to ensure that 
your system is currently set up as recommended. Then, begin the software 
installation process by starting at Chapter 3, “Installing the Physical Layer 
Test System Software,” on page 51.
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Step 1. Set Up the Personal Computer
Step 1. Set Up the Personal Computer

1. Make sure that your PC meets the following minimum system controller requirements:

NOTE Memory, both main and virtual, is critical to using PLTS effectively. There is no 
substitution for not having enough memory. As more applications are added to 
the PC, more memory is used. If your PC needs more memory, we suggest you 
take the time to remove unused programs. 

2. Using the PC documentation, make sure that the PC is operating properly.

3. Make sure the GPIB card is installed in the PC and that it is operating properly.

4. Make sure the PC is located near where you will position the oscilloscope-based TDR 
system. Later in this process, you will connect the GPIB card to the TDR system using a 
GPIB cable.

Table 2-1 Minimum PC Requirements by PLTS Modes of Operation

PC Requirement

Measurement Controller Mode Off-Line Analysis Mode

In the lab, controlling test 
equipment and making quick 
analysis of the results

In your office, performing “What if...” 
analysis, characterization, cross- 
domain analysis, filtering, waveform 
math, and eye diagram simulation

CPU 400 MHz Pentium II or greater 1 GHz Pentium III compatible PC

Main Memory 256 MBa

a. 512 MB of Main Memory is recommended for the Measurement Controller Mode when the 
measurement is measuring 16,000 points with the PNA B-model network analyzer.

512 MB

Virtual Memoryb

b. As a general rule for optimum PC performance when using PLTS, virtual memory should be 
1.5 to 2 times the size of the main memory.

512 MB 768 MB

GPIB Interface Agilent 82357A USB/GPIB Interface 
for Windows or supported GPIB card 
(any National Instruments or Agilent 
82340/41 or 82350 GPIB card)

No GPIB connection is required to 
utilize PLTS in the off-line mode. 
Saved (stored) measurement files can 
be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPc

c. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768
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Step 2. Set up the TDR System
Step 2. Set up the TDR System

1. Unpack your system from the containers in which it was shipped.

WARNING The TDR system hardware can be heavy. Use proper lifting techniques. 
Refer to the TDR system’s documentation for information regarding 
the equipment weight.

2. Carefully inspect the system to make sure that it was not damaged during shipment.

NOTE If your TDR system was damaged during shipment, refer to the system’s 
documentation to contact the manufacturer. If the manufacturer is Agilent, 
refer to “Contacting Agilent” on page 552.

3. Using the TDR system’s documentation, set up the system as instructed, ensuring that the 
system’s permanent location is near the PC that was set up in Step 1 on page 46. 

CAUTION Both the Agilent and Tektronix TDR systems, although not required, may be 
connected to a computer network. Connecting to a computer network may 
present security risks to your TDR system. For the Agilent TDR system, refer 
to “Embedded Operating System Risk” on page iv for additional information. 
For the Tektronix TDR systems, refer to your system documentation for 
additional information.
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Step 2. Set up the TDR System
4. Ensure that your TDR system is one of the following: 

• Agilent 86100A/B Infiniium Digital Communications Analysis Wide-Bandwidth 
Oscilloscope with:

— Firmware revision 03.06 (or later)
— 1 or 2 Agilent 54754A 18 GHz Differential TDR/TDT Plug-In Modules installed

• Tektronix CSA8000 Communications Signal Analyzer Oscilloscope with:

— Firmware revision 1.3.3 (check with your Tektronix representative for firmware)
— 1 or 2 Tektronix 80E04 Dual Channel, 20 GHz TDR Sampling Modules installed in 

slot 1/2 and/or slot 3/4 only (no support for channels 5, 6, 7, or 8)

• Tektronix TDS8000 Digital Sampling Oscilloscope with:

— Firmware revision 1.3.3 (check with your Tektronix representative for firmware)
— 1 or 2 Tektronix 80E04 Dual Channel, 20 GHz TDR Sampling Modules installed in 

slot 1/2 and/or slot 3/4 only (no support for channels 5, 6, 7, or 8)

CAUTION Avoiding ESD Damage to TDR Plug-In Modules

The input connectors are very sensitive to electrostatic discharge (ESD). When 
you connect a device or cable that is not fully discharged to the input connector, 
you risk damage to the module and expensive instrument repairs. Refer to your 
TDR documentation for detailed information regarding ESD susceptibility.
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Step 3. Set Up the General Purpose Interface Bus (GPIB)
Step 3. Set Up the General Purpose Interface Bus (GPIB)
The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. The PLTS software will locate and identify your test system equipment 
automatically. Each test system device must have a unique GPIB address. 

Check the GPIB address of your Agilent TDR system by selecting Remote Interface from 
the Utilities menu on the TDR display. To check the GPIB address of your Tektronix TDR 
system, refer to the programming manual for information.

NOTE There are 32 GPIB addresses, numbered 0 to 31. However, there may be the 
occasion that you need to change the GPIB address for test equipment. GPIB 
addresses are set using the equipment firmware. Refer to “Setting Up the 
General Purpose Interface Bus Manually” on page 597 for more information.

1. Connect a GPIB cable from the PC GPIB card's connector to the rear-panel GPIB 
connector on the TDR system.
Chapter 2 49



Installing the TDR-Based Physical Layer Test System Hardware
Step 4. Power up the TDR System
Step 4. Power up the TDR System
If you have not previously powered on your TDR system, start with step 1. If you have already 
powered on your TDR system, just review steps 1, 2, and 3 before continuing with step 4.

1. Ensure the available ac power supply meets the power source requirements and the 
operating environment meets the operating environment requirements for the TDR 
system. Refer to the TDR system documentation for the environmental specifications.

2. Verify that the ac power cable is not damaged, and that the power-source outlet provides a 
protective earth contact.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage.

3. Connect the ac power cable from the power-source outlet to the ac input on the rear panel 
of the test set.

4. Turn on the PC and the TDR system.

5. The TDR system hardware installation is complete. Continue with the PLTS software 
installation by referring to Chapter 3, “Installing the Physical Layer Test System 
Software,” on page 51.
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Installing the Physical Layer Test System Software
This chapter guides you through installing the Physical Layer Test System (PLTS) software. 
The software can be used 1) in the lab to control test equipment making measurements and 
make a quick analysis of the results, and it can be used 2) in your office to perform “What if...” 
analysis, characterization, cross-domain analysis, filtering, waveform math, and eye diagram 
simulation. 

• If you are making measurements in the lab, you should have already installed one of the 
following hardware systems:

— VNA-based system (Network analyzer and S-parameter test set) described in 
Chapter 1, “Installing the VNA-Based Physical Layer Test System Hardware”

— TDR-based system (Agilent TDR or Tektronix TDR) described in Chapter 2, “Installing 
the TDR-Based Physical Layer Test System Hardware”

NOTE Steps 1 and 2 of this chapter were performed during the hardware installation 
procedures described in Chapter 1 and Chapter 2. You may skip these steps if 
you already performed them.

• If you are performing analysis in your office, you will only need a PC to use the software.

This software installation chapter will lead you through a series of steps to install the PLTS 
software. The following is a list of the installation steps:

• Step 1. Set Up the Personal Computer 
(Skip this step if you already performed it during hardware installation.)

• Step 2. Verify your System Shipment 
(Skip this step if you already performed it during hardware installation.)

• Step 3. Install the Physical Layer Test System Software 

• Step 4. License the Physical Layer Test System Software

• Step 5. Start the Physical Layer Test System Software

• Step 6. Familiarize Yourself with the PLTS Software Screen
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Step 1. Set Up the Personal Computer
This procedure describes the steps that need to be performed if you plan to use PLTS in your 
office, performing “What if...” analysis, characterization, cross-domain analysis, filtering, waveform 
math, and eye diagram simulation and you do not plan to use this software to control test 
equipment and make measurements.

NOTE If you plan to control test equipment with the software, refer to “Set Up the 
Personal Computer” step in the appropriate chapter, either Chapter 1, 
“Installing the VNA-Based Physical Layer Test System Hardware,” or 
Chapter 2, “Installing the TDR-Based Physical Layer Test System Hardware.”

1. Make sure that your PC meets the following minimum system controller requirements:

2. Using the PC documentation, make sure that the PC is operating properly.

Table 3-1 Minimum PC Requirements for Off-Line Analysis Mode of Operation

CPU 1 GHz Pentium III compatible PC

Main Memory 512 MB

Virtual Memorya

a. As a general rule for optimum PC performance when using PLTS, virtual memory should be 1.5 to 2 
times the size of the main memory.

768 MB

GPIB Interface No GPIB connection is required to utilize PLTS in the off-line mode. Saved 
(stored) measurement files can be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPb

b. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768
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Step 2. Verify your System Shipment

NOTE This procedure describes the steps that need to be performed if you only 
purchased the N1930A PLTS Software.

If you purchased a PLTS with the software, refer to “Verify your System 
Shipment” step in the appropriate chapter, either Chapter 1, “Installing the 
VNA-Based Physical Layer Test System Hardware.”

1. Unpack and carefully inspect the package to make sure that it was not damaged during 
shipment.

NOTE If the contents of your package were damaged during shipment, contact Agilent 
Technologies. Refer to “Contacting Agilent” on page 552.

Item Nr Part Nr Part Description

1 N1930-90003 User’s Guide (this document)

2 N1930A Physical Layer Test System Software CD-ROM (in envelope with 
Agilent Software License Terms printed on exterior)

3 N/A Software Entitlement Certificate (in envelope)

Not Shown N/A Agilent 86100 firmware upgrade on LM-120 and CD-ROM
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Step 3. Install the Physical Layer Test System Software 
If you are upgrading your computer with a new version of PLTS, refer to “Installation of PLTS 
as a Software Upgrade” on page 66.

In addition to loading PLTS files, PLTS installs three other software packages that it requires. 
As part of the installation, PLTS also installs:

• Microsoft .NET Framework
• Agilent T&M Programmers Toolkit Redistributable Package
• Agilent IO Libraries

NOTE If you already have of these software packages installed on your PC, you will be 
asked if you want to upgrade to this version. If this version is newer than your 
version, please upgrade your software.

However, if your version is newer than the version PLTS wants to install, 
please decline to load the PLTS version.

1. Insert the PLTS software CD-ROM in your PC. The software should begin the installation 
process automatically. 

If the software does not start the automatic installation process, select Start > Run… in 
Windows as shown below. With the Run dialog box displayed, enter your CD-ROM drive 
letter followed by “\:setup.exe”. For example: D\:setup.exe. Then click OK and follow 
the onscreen instructions
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2. After the InstallShield Wizard extracts the PLTS files, the InstallShield Wizard welcome 
screen is displayed.

3. Before installing PLTS, a license agreement is displayed, read the agreement. You will be 
asked if you accept the terms of the license agreement. If you click No, the PLTS setup will 
close. To install PLTS, you must accept this agreement by clicking Yes. 

4. When asked to select the Setup Type, select Typical.

After checking the settings, the installation procedure begins installing PLTS program 
files.
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5. When the Agilent Test and Measurement Programmers Toolkit Redistributable Package 
Welcome screen is displayed, click Next > to be guided through the installation process.

6. You will be asked to enter your name and your company’s name. We recommend that you 
select to install this application for anyone who uses the computer.
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7. When asked to choose a destination location for Agilent T&M Programmers Toolkit 
Redistributable Package, use the default directory. Click Next > to continue.

8. The installation wizard asks you to review the settings. Use the default settings. Click 
Next > to continue.
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9. The installation process guides you through the T&M Programmers Toolkit 
Redistributable Package installation process until the installation has finished.

When you click Finish, the InstallShield Wizard extracts the files needed to load the 
Agilent IO Libraries.

10.You will be asked if you want to upgrade Agilent IO Libraries to this version. If this 
version is newer than your version, please upgrade your software.However, if your version 
is newer than the version PLTS wants to install, please decline to load the PLTS version by 
selecting Cancel.
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11.If the following Agilent IO Libraries screen is displayed, leave the selections unchanged 
and select the Next > button.

12.When the InstallShield Wizard notifies you that the Agilent IO Libraries has been 
installed, select the Run IO Config check box and click Finish to configure the IO.
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13.The Agilent IO Libraries Configuration - IO Config screen is displayed. Select the Auto 
Config button.
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14.When the Auto Config process is run, the Configured Interfaces list is displayed. Check 
the GPIB entry. For GPIB entry, the SICL Name must match the VISA Name exactly 
including the case of the letters.

Since the “gpib0” SICL name does not match the “GPIB0” VISA name, select the GPIB 
entry and click the Edit… button.
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15.With the GPIB Card Configuration dialog box for your GPIB card displayed, change the 
SICL Interface Name to match the VISA Interface Name exactly. Then click OK to 
return to the Agilent IO Libraries Configuration - IO Config screen.

16.In the Agilent IO Libraries Configuration - IO Config screen, verify that the SICL name 
matches the VISA name for the GPIB card. Then click OK.
Chapter 3 63



Installing the Physical Layer Test System Software
Step 3. Install the Physical Layer Test System Software
17.When the InstallShield Wizard is complete, click the Finish button. The PLTS software 
installation is complete.

18.PLTS communicates with instruments using a Microsoft Service, the PLTS Connection 
Manager. The log on for this service needs to be changed to from a local system account to 
a specific account. 

To make this change, select Start > Settings > Control Panel. From the Control Panel, 
select Administrative Tools and then Services. Double-click the Agilent PLTS 
Connection Manager selection. 
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19.In the Agilent PLTS Connection Manager Properties dialog box window under the Log On 
tab, select the This account selection. Enter your user name with administrative 
privileges. Enter and confirm the password. Then click OK to save the change.

20.Continue with “Step 4. License the Physical Layer Test System Software” on page 77.
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Installation of PLTS as a Software Upgrade

Use this procedure to upgrade your PLTS software. This procedure will first guide you 
through removing the older PLTS version and then guide you through installing the new 
PLTS software.

In addition to loading PLTS files, PLTS installs three other software packages that it requires. 
As part of the installation, PLTS also installs:

• Microsoft .NET Framework
• Agilent T&M Programmers Toolkit Redistributable Package
• Agilent IO Libraries

NOTE If you already have of these software packages installed on your PC, you will be 
asked if you want to upgrade to this version. If this version is newer than your 
version, please upgrade your software.

However, if your version is newer than the version PLTS wants to install, 
please decline to load the PLTS version.

1. Insert the PLTS software CD-ROM in your PC. The software should begin the installation 
process automatically. 

If the software does not start the automatic installation process, select Start > Run… in 
Windows as shown below. With the Run dialog box displayed, enter your CD-ROM drive 
letter followed by “\:setup.exe”. For example: D\:setup.exe. Then click OK and follow 
the onscreen instructions
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2. When asked select the Remove selection and click the Next > button.

3. When asked to confirm the removal, click OK to completely remove the PLTS application 
and its components.

4. During the PLTS software removal process, several read-only files are detected. Click the 
Yes button each time this is encountered or select the Don’t display this message again 
check box and then click the Yes button.
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5. During the PLTS software removal process, several locked files are detected. Click the 
Ignore button each time this is encountered or select the Don’t display this message 
again check box and then click the Ignore button.

6. The PLTS software removal process will finish. Click the Finish button to complete the 
process.

7. Repeat step 1 to start the installation of the new PLTS software.
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8. After the InstallShield Wizard extracts the PLTS files, the InstallShield Wizard welcome 
screen is displayed. Click the Next > button to start the installation.

9. Before installing PLTS, a license agreement is displayed, read the agreement. You will be 
asked if you accept the terms of the license agreement. If you click No, the PLTS setup will 
close. To install PLTS, you must accept this agreement by clicking Yes. 

10.When asked to select the Setup Type, select Typical.

After checking the settings, the installation procedure begins installing PLTS program 
files.
Chapter 3 69



Installing the Physical Layer Test System Software
Step 3. Install the Physical Layer Test System Software
11.Review the settings and then click the Next > button.

12.When asked to modify the Agilent IO Libraries installation, leave the selection set to 
Modify and click the Next > button.
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13.If the following Agilent IO Libraries screen is displayed, leave the selections unchanged 
and select the Next > button.

14.When the InstallShield Wizard notifies you that the Agilent IO Libraries has been 
installed, select the Run IO Config check box and click Finish to configure the IO.
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15.The Agilent IO Libraries Configuration - IO Config screen is displayed. Select the Auto 
Config button.
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16.When the Auto Config process is run, the Configured Interfaces list is displayed. Check 
the GPIB entry. For GPIB entry, the SICL Name must match the VISA Name exactly 
including the case of the letters.

Since the “gpib0” SICL name does not match the “GPIB0” VISA name, select the GPIB 
entry and click the Edit… button.
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17.With the GPIB Card Configuration dialog box for your GPIB card displayed, change the 
SICL Interface Name to match the VISA Interface Name exactly. Then click OK to 
return to the Agilent IO Libraries Configuration - IO Config screen.

18.In the Agilent IO Libraries Configuration - IO Config screen, verify that the SICL name 
matches the VISA name for the GPIB card. Then click OK.
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19.When the InstallShield Wizard is complete, click the Finish button. The PLTS software 
installation is complete.

20.PLTS communicates with instruments using a Microsoft Service, the PLTS Connection 
Manager. The log on for this service needs to be changed to from a local system account to 
a specific account. 

To make this change, select Start > Settings > Control Panel. From the Control Panel, 
select Administrative Tools and then Services. Double-click the Agilent PLTS 
Connection Manager selection. 
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21.In the Agilent PLTS Connection Manager Properties dialog box window under the Log On 
tab, select the This account selection. Enter your user name with administrative 
privileges. Enter and confirm the password. Then click OK to save the change.

22.Continue with “Step 4. License the Physical Layer Test System Software” on page 77.
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Step 4. License the Physical Layer Test System Software 
PLTS is sold with one of two type of licenses, either node-locked or network-server floating. 
The type of license that you have was decided when the software was purchased. 

A node-locked license entitles you to use the software on only one personal computer and 
the software enforces that restriction.

A network-server floating license entitles you to install the software license on only one 
server and check the license out to any personal computer on the server network that has 
PLTS installed. The software enforces the restriction that a license can checked out to one 
user at a time unless multiple PLTS network-server floating licenses are owned.

Stop! Determine the type of license that you own. Do not proceed until you have determined 
the type of license you own.

• If you own a node-locked license, continue with “Setting Up the Node-locked License” on 
page 77.

• If you own a network-server floating license, continue with “Setting Up the 
Network-Server Floating License” on page 79.

Setting Up the Node-locked License

This procedure instructs you how to license your Physical Layer Test System Software which 
is required before it can be used. The software is node-locked which means that license 
entitles you to use the software on only one personal computer (PC) and the software enforces 
that restriction. 

CAUTION The software is node-locked which means that license entitles you to use the 
software on only one personal computer and the software enforces that 
restriction. Make sure that you license the software to the correct PC.

During this procedure, you will identify the Host ID of that PC. The host ID is a unique 
identifier for that computer. Then, you will use the host ID to license the software to that 
unique identifier of your PC. Therefore, it is very important to affirm that you have loaded 
and are licensing the software to the correct PC.

1. In Windows, select Start > Programs and locate the Command Prompt selection on 
your PC. Open the Command Prompt window by clicking the Command Prompt 
selection. 
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2. In the Command Prompt window, change the directory to the License subdirectory in the 
PLTS subdirectory using the following command: 

The default directory that the software is loaded on is: C:\Program Files\Agilent. 
Therefore, enter the following command to change to the default directory:

 cd c:\Program Files\Agilent\PLTS\License 

Refer to the illustration in step 4 on page 78.

3. Run the lmhostid executable file that will display the host ID for the PC that you have 
installed the software on by entering the following command as shown in the following 
figure:

lmhostid

4. The host ID of the computer is displayed in window opened by the lmhostid.exe file. 
Write the host ID for your computer in the space provided below. You will need the host ID 
to license the software. 

5. Locate the Software Entitlement Certificate that was shipped with your software.

The certificate lists the Order Number and the Certificate Number for your software. 
These two numbers will also be used to license your software. 

cd x:\dddd\ssss\PLTS\License
where, x is the letter of the drive the software was installed on.

dddd is the directory name the software was installed on.
ssss is any subdirectories the software was installed on.

Record the host ID for your computer here:
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The certificate also lists the web site where you must register your software.

6. Go to the Agilent web site listed on the Software Entitlement Certificate. Follow the 
instructions at the web site to receive your license file for the software. You will need to 
provide the following information:

• Order Number 
• Certificate Number
• Host ID for your computer that will run the PLTS Software

The web site will also ask you provide your e-mail address. The license file will be e-mailed 
to you promptly. 

7. Once you receive the E-mail with the attached licence file, save the file to the “License” 
directory (the same directory that you used earlier to identify the host ID).

8. Make a back up of the license file and store in a safe location.

This back up file is very important! You may need this back up file if you encounter 
problems with your computer or if the licence file is lost or erased.

9. Continue with “Step 5. Start the Physical Layer Test System Software” on page 85.

Setting Up the Network-Server Floating License 

This procedure instructs you how to set up PLTS with a Network License Server/Floating type 
of license. This type of license allows you use PLTS on one of many PCs (or clients), utilizing a 
single license on a common server. The server issues the license to any of the clients that 
attempt to run PLTS. If the license is already being used by another client, notification is 
provided that the license is in use. If you have multiple licenses of this type, multiple clients 
can be issued a license at the same time, up to the number of licenses installed.

CAUTION During this procedure, you will identify the Host ID of the server. The host ID is 
a unique identifier for a computer. Then, you will use the host ID to obtain a 
software license for that unique identifier of your server. Therefore, it is very 
important to affirm that you have loaded and are licensing the software to the 
correct server.

To use PLTS, the client PC must be on the same network as the license server.

NOTE With this type of license, a PC can be both a server and a client. This allows the 
PC to use the PLTS software or issue the license for other PCs on the network 
to use PLTS.
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PLTS supports servers operating the Windows 2000 or Windows XP operating system.

Preparing the License Server

To install Network License Server/Floating type of license after you have installed PLTS on 
your PC (one of the client machines): 

1. Copy the following files from your PC that has PLTS installed to the server: 

You will find these files in the license directory of the PLTS software. If you used the 
default path to set up PLTS on your PC, that path is:.

C:/Program Files/Agilent/PLTS/License

While you could save these files to any directory on your server, we recommend that you 
create a similar directory structure on your server.

Obtaining the License

2. On your license server, in Windows, select Start > Programs and locate the Command 
Prompt selection. Open the Command Prompt window by clicking the Command 
Prompt selection. 

3. In the Command Prompt window, change the directory to the License directory that you 
created to save the five files (the servers PLTS License directory): 

4. In the Command Prompt window, run the lmhostid executable file to display the host ID 
for the license server by typing:

lmhostid

5. The host ID of the server is displayed in the Command Prompt window. Write the host ID 
for your computer in the space provided below. You will need the host ID to license the 
software. 

agilent.exe lmgrd.exe lmhostid.exe lmtools.exe lmgrd.dl

cd x:\dddd\License
where, x is the letter of the drive where you created a directory for the 5 files.

dddd is all directory names between the drive letter and the License 
directory you created.

Record the host ID for your server here:
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CAUTION This software license is locked to a specific server that you provide information 
for when obtaining the license. Make sure that you obtain and provide the Host 
ID for the correct server when obtaining your license.

6. You also need the network computer name of the server to redeem license. To locate the 
network name of your server: From Windows Control Panel, double-click the System icon 
to open the System Properties dialog box. On the Network Identification tab, locate the 
Full Computer Name entry. The network computer name of the server is the first 
portion of the Full Computer Name. For example:

7. Locate the Software Entitlement Certificate that was shipped with your software.

The certificate lists the Order Number and the Certificate Number for your software. 
These two numbers will also be needed to license your software. 

The certificate also lists the web site where you must register your software.

8. Go to the Agilent web site listed on the Software Entitlement Certificate. Follow the 
instructions at the web site to receive your license file for the software. You will need to 
provide the following information:

• Order Number 
• Certificate Number
• Host ID for your PLTS license server
• Network Computer Name for your PLTS license server 

The web site will also ask you provide your e-mail address. The license file will be e-mailed 
to you promptly. 

Record the network computer name of your server here:
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Setting Up the License Server

9. Once you receive the E-mail with the attached licence file, save the license file to the 
server’s PLTS License directory (the same directory that you created on your server to save 
the five files to earlier).

10.Make a back up of the license file and store in a safe location.

This back up file is very important! You may need this back up file if you encounter 
problems with your computer or if the licence file is lost or erased.

11.In the server’s PLTS License directory, double click the lmtools.exe file to open the 
LMTools dialog box. Select the Config Services tab. On this tab:

a. In the Service Name list, select or enter AGILENT License Manager.
b. In the Path to the LMgrd.exe file text box, enter the path to the server’s PLTS 

license directory followed by the lmgrd.exe file name.
c. In the Path to the license file text box, enter the path to the server’s PLTS license 

directory followed by the file name of the license that you copied to the directory.
d. In the Path to the debug log file text box, enter the path to the server’s PLTS license 

directory followed by the lmgrd.dl file name.
e. Click the Use Services check box and then click the Start Server at Power Up check 

box to make the PLTS license available for PLTS on restart of the server.
f. Click the Save Service button to save the changes.
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12.In the LMTools dialog box, select the Service/License File tab. On this tab, highlight 
AGILENT License Manager and click the Configuration using Services selection.
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13.In the LMTools dialog box, select the Start/Stop/Reread tab. On this tab, highlight 
AGILENT License Manager and click the Start Server button.

This step must be repeated each time the server is powered up if you did not click the 
Start Server at Power Up check box earlier in this procedure.

14.Continue with “Step 5. Start the Physical Layer Test System Software” on page 85.
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Step 5. Start the Physical Layer Test System Software 

1. Start the PLTS software by double-clicking the Physical Layer Test System icon on the 
PC desktop.

You may also run the program by selecting Start, Programs, Agilent Technologies, 
Physical Layer Test System, Physical Layer Test System.

2. The first time you start the software, you will be asked to identify the license type of the 
software. 
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When the dialog box is displayed:

• If you own a node-locked license:
Select Specify the License File and then click the Next > button. 

• If you own a network-server floating license:
Select Specify the License Server and then click the Next > button.

3. Based on the type of license you own:

• If you own a node-locked license: 

When this FLEXlm License Finder dialog box is displayed asking you to choose 
the license filename, click the Browse button and select the license file in the 
License directory. 

Once the directory and the license file is identified, the directory path is 
displayed in the FLEXlm License Finder dialog box. Select the Next> button.

• If you own a network-server floating license:

The client PC needs to be configured to look for the PLTS license on the Server. 
Enter the server’s network computer name that you recorded earlier.
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4. When the license is found and identified, select the Finish button to continue starting the 
software.

NOTE Make a back-up copy of the license file if you have not already done so.

5. After the licensing is completed, the software scans the GPIB bus to find the PLTS systems 
that are available to use.

The PLTS software looks for the following VNA-based and TDR-based PLTS systems:

• If the software recognizes one of the systems, it sets your software to make a 
measurement using the measurement wizard. You should review “Step 6. Familiarize 
Yourself with the PLTS Software Screen” on page 91.

Then, based on your PLTS system hardware, continue with either:

— Chapter 4, “Setting Up and Making Measurements using the VNA-Based PLTS,” on 
page 105

— Chapter 6, “Setting Up, Calibrating, and Making Measurements using the 
TDR-Based PLTS,” on page 183

• If the software does not recognize one of the systems, it notifies you: “No instruments 
were detected. PLTS will operate in analysis-only mode.” This may be because:

VNA-Based Systems: TDR-Based Systems:

N1957B (E8364B & N4421B) Agilent 86100A/B
N1955B (E8363B & N4420B) Tektronix CSA8000
N1953B (E8362B & N4419B) Tektronix TDS8000
N1951A (8720ES & N4418A)
N1948A (E8358A & N4417A)
N1947A (E8803A & N4417A)
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You want to perform analysis only and do not have any PLTS system hardware 
connected to the GPIB. In this case, select the virtual instrument that be matches 
your PLTS system or if known, the system that was used to measure the data. 
Continue at “Step 6. Familiarize Yourself with the PLTS Software Screen” on 
page 91.

— PLTS does not recognize your system hardware or PLTS finds more than one system 
connected to your GPIB. Continue with the next step.

6. If the PLTS software does not recognize your system hardware or if it finds more than one 
system on the GPIB, it displays the Build Logical Measurement System dialog box. This 
dialog box allows you to identify your PLTS system hardware for the PLTS software.

• To identify your VNA-based system (VNA with a test set) for the software:

a. In the Instruments Found list, click the model number of your network analyzer 
to highlight it. Then click the Primary Inst >> button which moves the model 
number to the text box at the right of the button. 
Chapter 388



Installing the Physical Layer Test System Software
Step 5. Start the Physical Layer Test System Software
b. In the Instruments Found list, click the model number of your test set to highlight 
it. Then click the Secondary Inst >> button which moves the model number to the 
text box at the right of that button.

c. Click the Create System button which moves the combination of the devices to the 
Logical Measurement System box.

d. Click the OK button to save the system so the software identifies the PLTS system.

• To identify your TDR-based (or single-instrument) system for the software:

a. In the Instruments Found list, click the model number of your network analyzer 
to highlight it. Then click the Primary Inst >> button which moves the model 
number to the text box at the right of the button. 

b. Click the Create System button which moves the device to the Logical 
Measurement System box. (Note that this step may be omitted for 
single-instrument systems, such as the TDR systems.)

c. Click the OK button to save the system so the software identifies the PLTS system.
Chapter 3 89



Installing the Physical Layer Test System Software
Step 5. Start the Physical Layer Test System Software
NOTE If you can not get your system identifies, you can manually configure your 
system by selecting the Manual Configuration button to display the 
Hardware Configuration dialog box.

Select the primary instrument (typically at VNA or a TDR) from the Primary 
Instrument list. If necessary, select a secondary instrument (typically at test 
set) from the Secondary Instrument list. 

Enter the address for the primary instrument in the Analyzer Address text 
box and the secondary instrument in the Test Set Address text box. Also, 
enter the VISA Interface Name.
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Step 6. Familiarize Yourself with the PLTS Software Screen
This section describes the features of the Physical Layer Test System software. Refer to 
Figure 3-1, Main Window, for the locations of each of the software’s main features.

Figure 3-1 Main Window

Each of these areas are described in the remainder of this section. 

The software was designed with an informal flow down the left edge of the window in mind. It 
is an informal flow because with the flexibility of the software, this is an easy way, not the 

1. Title Bar 5. Parameter Bar 9. Marker Bar

2. Menu Bar 6. Format Bar 10. Plots Area

3. Toolbar 7. Scaling Bar 11. Measure Bar

4. Browser 8. Status Bar 
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only way to setup many of the features. For example, you may open a device file from areas 2 
and 3. Then you will select a data analysis that shows the open file in area 4. You will need to 
select parameters to display from area 5. If you need to change the format of the display, you 
change the format in area 6. Then you can adjust the scaling of the plots in area 7. 

1. Title Bar

The title bar (Figure 3-2) displays the title of the software. In the brackets, it also displays the 
file name of the data in the active plot window if the data has been saved. The data analysis 
type of the active plot window is also displayed. At the right side of the title bar, buttons are 
also provided quickly perform tasks at the program level. 

Figure 3-2 Title Bar

Clicking: Performs:
Minimizes the program window to the Windows task bar.

Toggles the program window to full screen mode.

Toggles the program window to partial screen mode.

Closes the program.
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2. Menu Bar

The menu bar (shown in Figure 3-3) lists each of the drop down menu names currently 
available. When you click a menu name, the menu is displayed. The menu names and menus 
change to reflect appropriate choices for the data analysis type of the active plot window. 
Refer to Chapter 14, “Menu Reference,” for detailed information about each of the menu bar 
selections. 

When the active plot window is maximized, completely filling the plot area, the menu bar also 
displays three buttons to control the plot window.

Figure 3-3 Menu Bar

Clicking: Performs:

Minimizes the plot window within the plot windows display area.

Toggles the plot window to partially fill the plot windows display area.

Closes the plot window.
Chapter 3 93



Installing the Physical Layer Test System Software
Step 6. Familiarize Yourself with the PLTS Software Screen
3. Toolbar

The toolbar (Figure 3-4) provides buttons for beginning a new measurement, opening existing 
files, saving current data, copying current data, exporting data, removing plots, and printing.

Figure 3-4 Toolbar

Clicking: Performs:

New Starts the setup wizard so that a new measurement may be 
made.

Open Opens the Open dialog box so that an existing file may be 
opened.

Save Opens the Save As dialog box so that a file may be saved.

Copy Copies the active plot to the clipboard.

Export Bitmap Saves the active plot as a bitmap file (bmp).

Remove Plot Deletes the active plots.

Print Prints the active plots.

About Opens the About PLTS information.
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4. Browser

The browser (Figure 3-5) provides access to each measurement and data analysis type. 
Selecting a new Data Analysis type from the browser opens up a corresponding plot window. 
Each Data Analysis type may view multiple sets of data. 

• Clicking a bold label opens a new window in the plots area with that data analysis type.
• Clicking a non-bold label displays that plot and makes it the active plot in the plots area.
• Clicking the minus sign (−)hides the data selections for a given data analysis type.
• Clicking the plus sign (+) shows the data selections.

Figure 3-5 Browser
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5. Parameter Bar

The parameter bar (Figure 3-6) allows you to open a new plot, or add a new trace to an 
existing plot. Figure 3-6 shows the parameter bar for the balanced time domain plots. Each 
analysis type has a unique parameter bar specific to that type of analysis. Refer to Figure 
14-24, “Parameter Bars for Each Data Analysis Type” on page 435 to see all parameter bars.

Select New Plot and then click a parameter to display a new plot.

- or - 

Select New Trace and then click a parameter to overlay a new trace to an existing plot. 
Clicking the parameter a second time removes the added trace from the plot.

Figure 3-6 Parameter Bar for Balanced Time Domain Plots
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6. Format Bar

The format bar (Figure 3-7) is only available when the active plot window is a time domain or 
frequency domain selection. The format bars allow you to format the parameters for the active 
time domain or frequency domain plot window. To display the format bar, select Format Bar 
from the View menu. It is hidden with the same selection.

The time domain format bar differs from the frequency domain format bar. It has different 
format selections and it is divided into three areas. Therefore, the time domain format bar has 
three selections while the frequency domain format bar has one selection. Each format bar 
matches its corresponding Format menu (selected in the Menu bar.) The format bar and the 
title of each button for both time and frequency domain are shown below. 

Figure 3-7 Format Bars

For detailed information about each of the 
selections, refer to “Selecting Time Domain 
Display Formats” on page 272.

For detailed information about each of the 
selections, refer to “Selecting Frequency 
Domain Display Formats” on page 233.

Impulse Log Mag (default selection)

Step (default selection) Linear Mag

Volts (default selection) Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart

ns (default selection) Real

cm Imaginary
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7. Scaling Bar

The scaling bar (see Figure 3-8) allows you to change the scale on both the horizontal and 
vertical axis.

Figure 3-8 Scaling Bars

For time domain, the horizontal axis entries are units/division and delay. The vertical axis 
units are units/division and reference level.

For frequency domain and RLCG, the horizontal axis entries are the start frequency and the 
stop frequency. The vertical axis units are the units/division and the reference level.

NOTE When the time domain horizontal units per division is changed, the Delay 
value is reset to zero.
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8. Status Bar

The status bar (Figure 3-9) provides a visual indication of when conditions are happening 
within the software and the impedance associated with each system channel.

When any of the conditions listed below are active, an indicator adjacent to the condition title 
is displayed in a bright color. If the condition is not active, the color of the indicator is gray. 
The conditions are:

Figure 3-9 Status Bar

9. Marker Bar

The marker bar (Figure 3-10) allows you to add and display up to two markers to the active 
plot. The X-Y values of each cursor and the delta (the value of their difference) is displayed at 
the right edge of the plot. The eye diagram marker bar and the frequency domain polar and 
Smith chart marker bars differ slightly. Refer to “Markers” on page 365 for complete marker 
bar information.

Figure 3-10 Marker Bar

Measurement is bright when a measurement is being performed by the software.

Continuous sweep is bright when the measurement is being continuously swept.

De-Embedding is bright when the active plot has de-embedding data applied.

Ref-Z is bright when the active plot has reference impedance applied.

Hardware is bright when the hardware has been identified by the software.
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10. Plots Area

The plot windows (Figure 3-11) display the measurement results in the data analysis type 
selected. You select the data analysis type when you make a measurement, open existing data 
files, or make a selection in the browser. The Parameter Bar or the Data menu on the Menu 
bar allows you to display plots for all of the parameters or just the parameters you want to 
view. Multiple plot windows can be displayed in the plot window display area at the same time 
as shown in the figure.

Figure 3-11 Plot Windows in the Plots Area
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11. Measure Bar

The measure bar allows you to make measurements on your DUT without using the wizard. 
With a valid calibration file loaded, you may measure a single sweep or measure continuous 
sweeps.

Figure 3-12 Measure Bar
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Part II provides detailed information about making measurements using both the VNA-based 
and TDR-based physical layer test systems. Part II also provides information about error 
correcting each system for optimum accuracy.

Chapter 4, “Setting Up and Making Measurements using the VNA-Based PLTS”

Provides information about making a measurement using the VNA-based PLTS.

Chapter 5, “Performing Error Correction on the VNA-Based PLTS”

Provides information about performing error correction on the VNA-based 
PLTS.

Chapter 6, “Setting Up, Calibrating, and Making Measurements using the 
TDR-Based PLTS”

Provides information about performing error correction and making a 
measurement using the TDR-based PLTS.
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Setting Up and Making Measurements using the VNA-Based PLTS
This chapter guides you through setting up the initial measurement definitions, performing 
the system calibration, making a measurement, and analyzing the measurement results. It 
uses a simple balanced transmission line that was supplied with the system as a sample 
device-under-test (DUT). See Figure 4-1.

Figure 4-1 Balanced Transmission Line Sample DUT

The Startup Wizard steps you through the initial setup, the calibration, and the 
measurement. 

1. Initial setup includes:

• System Hardware Verification
• Calibration Level Selection
• Calibration and Measurement Parameter Selection

2. Calibration includes:

• Calibration Type Selection and Calibration Kit Selection
• Calibration (SOLT Mechanical, SOLT Electronic, TRL, or LRM)
• Adapter Characterization

3. Measurement includes:

• Device Under Test Connection
• Analysis Type Selection
• Stimulus Verification
• Running a Measurement

After the measurement is made, the main Physical Layer Test System (PLTS) window gives 
you the flexibility to perform analysis on the measured data in a variety of ways.

• Frequency Domain. Allows for analysis in Balanced and Single-Ended mode.

• Time Domain. Allows for analysis in Differential and Single-Ended mode. 

• Eye Diagram. Allows for analysis in Differential and Single-Ended mode.

• Transmission Line (RLCG). Allows for analysis in Differential, Common, W-Element, 
and Self/Mutual modes.
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Navigating the Startup Wizard
When PLTS is first started, the Startup Wizard is displayed. The Startup Wizard Welcome 
Screen is displayed in Figure 4-2. It is also displayed anytime a new measurement is initiated, 
such as after selecting New from the File menu, or clicking on the new file icon on the toolbar. 

Figure 4-2 Startup Wizard Welcome Screen

The Startup Wizard Welcome Screen gives you two choices, New Measurement or Load 
Measurement. The selected choice has a green check mark to the right of the label. New 
Measurement leads you through the process of calibrating and making a measurement. 
Load Measurement loads measurement data from an existing file that you must select. 

When you select New Measurement, the Startup Wizard will guide you through:

• Initial Setup
• Calibration
• Measurement 

For this exercise, select New Measurement and then select the Next > button.
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How to Perform the Initial Setup

The Initial Setup process consists of:

1. Verifying that the software recognizes your PLTS system hardware.

This step uses the left portion of the Hardware Auto-Detection Summary dialog box to 
verify that the software recognizes the correct system hardware. This portion of the dialog 
box displays the model number, GPIB address, and serial number of the hardware. You 
may re-scan to look for hardware changes automatically. You may select another 
recognized PLTS measurement system.

2. Selecting the appropriate level of calibration for the upcoming measurement.

This step uses the right portion of the Hardware Auto-Detection Summary dialog box to 
select the appropriate level of calibration to be performed. You may perform a new 
calibration, reuse existing calibration data, or perform measurements without calibration.

3. Setting up the VNA Calibration and Measurement Settings.

This step uses the Setup TDR dialog box to display the default TDR calibration and 
measurement settings, based on the PLTS hardware recognized by the software. You may 
modify these default TDR calibration and measurement settings as required.
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When you selected New Measurement and then clicked the Next > button described on 
page 107, the Hardware Auto-Detection Summary dialog box is displayed. See Figure 4-3.

Figure 4-3 Hardware Auto-Detection Summary Dialog Box

Verifying the Software Recognizes the PLTS Hardware

On the left portion of the Hardware Auto-Detection Summary dialog box, the VNA’s model 
number, the GPIB address, the serial number, and the firmware revision is displayed. In 
addition, the test set’s model number, the GPIB address, and the serial number are displayed. 
This is the test equipment that the software finds connected to the GPIB bus. 

If this information is incorrect, check your hardware connections and power status, then 
select the Re-Scan button. The software re-checks for the presence of hardware on the GPIB.
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NOTE If you have multiple PLTS systems on the GPIB and you want to select the 
other equipment, click the Select New Device button. The Select 
Measurement System dialog box is displayed. See Figure 4-4. To choose another 
PLTS system, you may select from the available PLTS systems and then click 
the OK button. The software makes the change and returns to the Startup 
Wizard Welcome Screen of Figure 4-2.

Figure 4-4 Select Measurement System Dialog Box

The Cancel button exits without saving a change and returns to the Startup 
Wizard Welcome Screen.

Selecting the Appropriate Level of Calibration

On the right portion of the Hardware Auto-Detection Summary dialog box (Figure 4-3), select 
your calibration strategy:

• Perform a new calibration continues with the Startup Wizard performing a new 
calibration before making a measurement.

• Load existing calibration data allows you to select a previously saved calibration 
(*.cal) file to be used for the new measurement. See Chapter 5, “Performing Error Correc-
tion on the VNA-Based PLTS,” for guidance on calibration intervals, etc.

• None. Collect measurement data uncalibrated allows you skip the calibration, select 
measurement parameters (see Figure 4-5 on page 111), and then proceed directly to the 
measurement screen. This option is not recommended for qualitative data collection.

Select the Perform a new calibration choice for this example exercise and then click the 
Next > button.
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Setting Up the Calibration and Measurement Parameters

After you select Perform a new calibration and Next >, the first of three Calibrate 
Hardware for Measurement dialog boxes is displayed as shown in Figure 4-5. Use 
this Calibrate Hardware for Measurement dialog box to change the parameters for your 
calibration and measurement to meet your measurement requirements. This dialog box 
displays the default measurement parameters which are based on the specifications of your 
PLTS hardware.

1. Since the default parameters are based on the specifications of your PLTS hardware, leave 
the parameters unchanged and click the Next > button for this exercise.

Figure 4-5 Measurement Parameter Dialog Box 

Modifying these values also modifies other associated values interactively. For example, when 
you change the # of Points entry, the Time Base and the Frequency Start entries change 
appropriately. To modify a parameter, enter the value in associated value box and then click 
the Recalculate Parameters button to update the value each parameter. Refer to Table 4-1 
for a description of each parameter.

You can return to the default values at any time by selecting the Reset Values button.

The Advanced button shown in Figure 4-5 toggles between Advanced and Basic. When in 
Advanced, the entire dialog box is displayed. When in Basic, just the upper portion of Figure 
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4-5 (the top six entries of Table 4-1) is displayed.

Table 4-1 Measurement and Calibration Parameter Entry Descriptions

Parameter Description

Time Base
Sets the maximum time base (in ns). Time base calculated as  where Fmin 

is the start frequency.

Rise Time sets the transition time (in picoseconds) of the stimulus signal rising from 10 to 
90% of the maximum signal amplitude.

# of Points sets the number of measured points per sweep.

Frequency 
Start

sets the start frequency of the sweep.

Frequency 
Step

sets the step size between points. This value is locked to (is the same as) the 
Frequency Start value.

Frequency 
Stop

sets the stop frequency of the sweep.

Spatial 
Resolution

describes how close in time two responses can be distinguished; depends on the 
width of the impulse response, which is inversely related to the measurement 
bandwidth.

Velocity 
Factor

is the numerical value related to the speed of energy through transmission lines 
with different dielectrics.

Dielectric 
Constant

is not used directly. It is used to calculate the velocity factor, which affects the way 
the data is displayed on the plots.

IF Bandwidth allows you to change the IF bandwidth. Narrow IF bandwidths allow you to view 
low-level signal, however, require more data samples per point and thus slow the 
measurement time. 

Power sets the signal level at the source appropriate for measurement of the device. You 
can measure the signal level available at the test port directly using a power 
meter.

Averaging averages each point of the traces of consecutive sweeps until the total number of 
sweeps is equal to the averaging factor, for a fully averaged trace for better noise 
reduction. A high averaging factor gives the best signal-to-noise ratio, but slows 
the measurement time. 

Analyzer 
Sweep Type

Stepped takes data while sweeping through defined frequency points. 

Swept takes data while sweeping linearly and continuously across the frequency 
range.

1
2 Fmin×--------------------
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How to Perform a Calibration

After you review and change the calibration and measurement parameters as needed and 
click Next >, the second of three Calibrate Hardware for Measurement dialog boxes is 
displayed as shown in Figure 4-6. This Calibrate Hardware for Measurement dialog box is 
used to select your calibration kit. However, the calibration procedure is described in 
Chapter 5, “Performing Error Correction on the VNA-Based PLTS.” 

To perform the calibration, continue with “Selecting a Calibration Type” on page 127. The 
calibration procedure includes:

• Selecting a calibration type and identifying your calibration kit
• Performing one of the following calibration types: SOLT (either mechanical or electronic), 

TRL, or LRM
• Characterizing any adapters that are used, if you do not already have the characterization 

data file

This procedure guides you through the calibration steps and then, when you have finished, it 
refers you back to “How to Make a Measurement” on page 114.

Figure 4-6 Select Calibration Type Dialog Box
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How to Make a Measurement

1. After saving the calibration data and selecting the Next > button, the Device connection 
scheme window for your calibration type is displayed. See Figure 4-7. This window shows 
you how the DUT must be connected to the PLTS for the type of calibration data that you 
are using. Connect the DUT to the PLTS hardware as shown and click the Next > button.

Figure 4-7 Device Connection Scheme Window

SOLT calibration data requires a different connection scheme than either TRL or LRM 
calibration data. See Figure 4-8.
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NOTE Figure 4-8 shows the difference in the DUT connection between SOLT 
calibrations and TRL/LRM calibrations. 

Figure 4-8Device Connection Differences by Calibration Type

Notice the difference in the ports 2 and 3 connections for the calibration 
methods.

2. The Hardware and Calibration Setup Wizard Complete window is displayed. See Figure 
4-9. 

This window is the software location to select the one of ten analysis formats that the 
measurement will be displayed as initially. The analysis formats are:

For the purpose of this example, the Time Domain (Differential) format icon is selected.

• Time Domain (Differential)

• Frequency Domain (Balanced)

• Eye Diagram (Differential)

• RLCG (Differential)

• RLCG (W-Element)

• Time Domain (Single-Ended)

• Frequency Domain (Single-Ended)

• Eye Diagram (Single-Ended)

• RLCG (Common)

• RLCG (Self/Mutual)
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Figure 4-9 Hardware and Calibration Setup Wizard Complete Window

The Modify Measurement Stimulus button opens the Measurement Stimulus dialog 
box. See Figure 4-10. This dialog box allows you to change the many of the measurement 
stimulus settings that you set up previously.

Settings that would require a recalibration are not active and may not be changed in this 
dialog box. To change the stimulus settings that are inactive, you must click the < Back 
button until you get back to the window described in “Setting Up the Calibration and 
Measurement Parameters” on page 111.

For the purpose of this example, leave the settings unchanged and click the OK button.

The Reset Values button resets any active values (any values that can be changed 
without requiring a recalibration) to their original default values prior to being changed in 
“Setting Up the Calibration and Measurement Parameters”. 

The Cancel button resets any changes that were made after opening this dialog box.

NOTE After the measurement has been made, you may verify these changes were 
made by printing a characterization report. See “Characterization Report 
Generator” on page 389 for help.
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Figure 4-10 Stimulus Dialog Box

3. Once you exit the Measurement Stimulus dialog box, the Hardware and Calibration Setup 
Wizard Complete window is displayed again (see Figure 4-9), select the Next > button to 
start the measurement.

4. The software displays the wizard’s Measurement & Post-Processing Status window and 
starts the measurement and the measurement post-processing. See Figure 4-11. The 
software makes each of the measurements. The status of the measurements and the 
post-processing is displayed in the status text area. The status is may also be observed by 
watching the status bar at the right edge of the text area. As the measurements and the 
post-processing proceed, the color of the bar gradually changes to blue.

Once the post-processing is complete, click the Next > button to display the Measurement 
and Calibration Setup Wizard Complete window.
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Figure 4-11 Measurement & Post-Processing Status Window

5. After selecting the Next > button, the Measurement and Calibration Setup Wizard 
Complete window is displayed. See Figure 4-11. Click the Finish button to display the 
measurement results in the main PLTS window.

Figure 4-12 Measurement & Calibration Setup Wizard Complete Window
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Analyzing the Measurement Results

Now that you have measured the device under test, its measurement results are displayed the 
main PLTS window as shown in Figure 4-13. This shows the results in the Time Domain 
(Differential) format, the analysis format selected earlier.

Figure 4-13 Displayed Measurement in Time Domain (Differential) Format

Now that the measurement has been made, the main Physical Layer Test System (PLTS) 
window gives you the flexibility to perform analysis on the measured data in a variety of 
ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.Refer to Chapter 7, “Analyzing Data in the Frequency Domain,” on 
page 221 for information.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 8, “Analyzing Data in the Time Domain,” on 
page 241 for information.
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• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 9, “Analyzing Data using Eye Diagrams,” on 
page 279 for information.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes. Refer to Chapter 10, “Analyzing 
Transmission Line Parameters,” on page 297 for information.

However, to ensure the measurement data is not lost, you may want to first save the 
measurement data by selecting Save from the File menu. See “Save” on page 419.
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What Is Measurement Calibration?
Measurement calibration is an accuracy enhancement procedure that effectively removes the 
systematic errors (repeatable measurement variations) that cause uncertainty in measuring a 
device under test (DUT). During measurement calibration, the physical layer test system 
measures actual, well-defined standards and mathematically compares the results with ideal 
“models” of these standards. Calibration measurements, which characterize the test system, 
are made with all cables and connections in place but without the DUT.

Systematic Errors are related to signal leakage, signal reflections, and frequency response 
of the test system. There are six types of systematic errors.

• Directivity and crosstalk related to signal leakage

• Source and load impedance mismatches related to signals being reflected

• Frequency response error caused by reflection and transmission tracking with the test 
receivers

Other factors that can impact the measurement accuracy of any measurement system are 
drift errors and random errors.

• Drift Errors are due to the instrument or test-system performance changing after a 
calibration has been done. Drift is primarily caused by temperature variation and it can be 
removed by recalibration. The timeframe over which a calibration remains accurate is 
dependent on the rate of drift that the test system undergoes in the test environment. A 
stable ambient temperature usually minimizes the rate of drift significantly. Allowing 
equipment to warm up and stabilize prior to calibration and properly ventilating 
equipment helps reduce drift errors.

• Random Errors are unpredictable since they vary with time in a random fashion. 
Therefore, they cannot be removed by calibration. The main contributors to random error 
are instrument noise such as, source phase noise, sampler noise, and IF noise. The 
accurate source and phase-locked receiver of the network analyzer greatly minimizes these 
random errors. There are also external contributors to random errors such as switching 
power supplies, EMI, etc.
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Why Is Calibration Needed?
Components of the measurement setup such as imperfect connectors, cabling, and even the 
response of the test instruments can introduce errors into measurements. For both 
transmission and reflection measurements, impedance mismatches within the test setup 
cause measurement uncertainties that appear as ripples superimposed on the measured data. 
These errors can distort the signal and make it difficult to determine which reflections are 
from the DUT and which are from other sources. 

Calibration is required for accurate measurements. Even though calibration does take a few 
minutes to complete, it saves time and money compared to costs associated with erroneous 
measurement data. Even mechanical (non-electronic) calibration is reasonably quick once you 
become familiar with the process.

TIP Understanding How Changes Affect Measurements

No two measurements and environmental conditions are exactly the same. The 
best way to understand your conditions is to experiment and see how your test 
equipment behaves over a period of time. A good way of doing this is to measure 
the same device (i.e., a known standard) hourly throughout the day. Save or 
print the measurement results of each measurement. Compare these results to 
gain an understanding of how the ambient environment and drift affect the 
measurements. Watch for trends with regard to the device meeting 
specifications or measuring within guard band limits. 
Chapter 5 123



Performing Error Correction on the VNA-Based PLTS
When Is Calibration Needed?
When Is Calibration Needed?
We recommend that you perform a calibration on your physical layer test system when the 
following conditions occur:

• When connectors are cleaned, repaired, or replaced.

• If test cables have any changes, such as:
— When a test cable is replaced

— When any connection is changed except the connections to the DUT

— When test cables are flexed excessively (kinked or unkinked)

• If the frequency range is changed beyond the limits of the previous calibration

• If the number of measurement points is increased to more than the number of points of the 
previous calibration

• When ambient temperature changes more than ±3 °C

• Any other ambient environmental changes of significance

• If none of the previous conditions apply, calibrate according to the intervals shown below 
due to drift:

— Check the calibration daily at a minimum (twice daily is recommended). Refer to “How 
to Verify a Calibration” on page 125.

— Calibrate weekly (daily calibration recommended).
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How to Verify a Calibration
A good method of checking calibration is to establish a Golden Device, which is a device that 
meets all specifications and is saved for comparison of the measured results in the future. 

Establishing a Golden Device

Follow these steps to establish a golden device:

1. Calibrate the system. 

2. Perform the complete set of measurements on the golden device. 

3. Save and print all of the test results from these initial measurements.

Now you can measure the golden device when you suspect that your system may need to be 
calibrated. Compare the results of these measurements against the results that you saved 
and printed from the initial measurements.
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How to Perform a Calibration
You will first select a calibration kit and then you will perform a calibration (either 
mechanical or electronic, depending on your calibration kit). After you finish the calibration, 
you will be ready to make a measurement.

Use the following procedure to calibrate the Physical Layer Test System. 

1. If you are referring to this chapter from the example measurement in Chapter 4, skip to 
“Selecting a Calibration Type” on page 127.

2. Open the Physical Layer Test System Startup Wizard by doing any of the following:

• Start the Physical Layer Test System software. 
(The startup wizard will open at start up unless the “Do not show this wizard again 
at start up” option has been selected.)

• Select New from the File menu.

• Select Calibration from the Utilities menu. Then select Calibrate.

3. Press the Next > button until you reach the startup wizard’s Calibrate Hardware for 
Measurement dialog box displaying the default parameters, such as the maximum time 
base, minimum rise time, and number of point settings. See Figure 4-5 on page 111.

Use this dialog box to check these calibration parameter settings. These default settings 
are based on the equipment limitations of your Physical Layer Test System.

Selecting the Advanced… button to display all of the calibration parameters in the 
Modify Time and Frequency Parameter dialog box.

You can change any of the time domain or frequency domain parameters, and then by 
selecting the Recalibrate Parameters button, the remaining parameters are 
recalibrated and displayed. Once all of the parameters are set to your satisfaction, select 
OK to return to the Calibrate Hardware for Measurement dialog box.

If you decide you want to reset all changed values to their default settings, select the 
Reset Values button.

4. Once the parameters are set, select the Next > button to display the calibration type 
selection dialog box shown in Figure 5-2.
Chapter 5126



Performing Error Correction on the VNA-Based PLTS
How to Perform a Calibration
Selecting a Calibration Type

The dialog box shown in Figure 5-2 is the window that is used to select the calibration type 
and the calibration kit. It opens in the default SOLT (Short-Open-Load-Thru) calibration 
type, showing the 4-Channel SOLT calibration type along with the SOLT calibration kits that 
have been determined by the auto-detection to be appropriate for the system hardware. Some 
calibration kits listed here may not be displayed.

Figure 5-1 Select Calibration Type Dialog Box

The Select Calibration Type list allows you to choose the calibration type. 4-Channel 
SOLT is the default calibration type. Opening the list displays that the 4-Channel TRL 
(Thru- Reflect-Line) and the 4-Channel LRM (Line-Reflect-Match) calibration types are also 
available. 

NOTE TRL and LRM calibration types are not supported for physical layer test 
systems that use the 8753ES or the 872XES network analyzers.

The usage of the PLTS ports 2 and 3 varies by the calibration type that is chosen. Refer to 
Table 5-1, PLTS Port Configurations for a Balanced Line by Calibration Type, for the 
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configuration of each port measuring a balanced line.

NOTE If you select either 4-Channel TRL or 4-Channel LRM, no calibration kit 
choices are initially available. You will first need to define a calibration kit that 
covers your measurement parameter start and stop frequency range. The 
calibration kit definition procedures are described later in this chapter. 
Continue as directed in the following list.

Select the calibration type from the list and refer to the appropriate section listed below.

• If you selected 4-Channel SOLT calibration, refer to “Performing an SOLT Calibration” 
on page 129.

• If you selected 4-Channel TRL calibration, refer to “Performing a TRL Calibration” on 
page 148.

• If you selected 4-Channel LRM calibration, refer to “Performing an LRM Calibration” on 
page 162.

Table 5-1 PLTS Port Configurations for a Balanced Line by Calibration Type

PLTS
Ports

Calibration Type

SOLT TRL LRM

Port 1 In + In + In +

Port 2 Out + In − In −

Port 3 In − Out + Out +

Port 4 Out − Out − Out −
Chapter 5128



Performing Error Correction on the VNA-Based PLTS
How to Perform a Calibration
Performing an SOLT Calibration

You have selected the 4-Channel SOLT calibration type. You will first select a calibration kit 
and then you will perform a calibration (either mechanical or electronic, depending on your 
calibration kit). After you finish the calibration, you will be ready to make a measurement.

Selecting a SOLT Calibration Kit

The dialog box shown in Figure 5-2 lists the calibration kits that have been pre-defined for use 
with the VNA-based PLTS hardware. 

Additional calibration kits, including user-defined kits, may be added by selecting 
Calibration then Edit Cal Kit from the Utilities menu. See “Defining a SOLT Calibration 
Kit” on page 132 for details.

Figure 5-2 Select Calibration Kit Dialog Box

NOTE The frequency range of the pre-defined calibration kits are limited to the 
frequency of the characterized thru adapter. The thru adapters have been 
characterized at frequencies used most by customers. Refer to Table 5-2 for the 
defined PLTS frequency boundaries of the default calibration kits.

If you set the frequency requirements beyond the defined PLTS frequency 
boundaries of your calibration kit, the calibration kit is not displayed. You will 
need to either:
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• Select as pre-characterized thru file that meets or exceeds the frequency 
requirements to create a new Thru Standards definition of the calibration 
kit. (Refer to “Defining a SOLT Calibration Kit” on page 132.)

• Characterize your own thru adapters to meet or exceed your frequency 
requirements (refer to “Characterizing Adapters” on page 176) and select 
that newly-created thru (adapter) file to create a new Thru Standards 
definition (refer to “Defining a SOLT Calibration Kit” on page 132).

1. Select your calibration kit. Refer to Table 5-2 for the appropriate calibration kit. 

The Nominal Frequency Range columns display the minimum and maximum frequencies 
that the calibration kit will operate. These frequencies are limited by the physical 
calibration kit. They can not be changed. 

The Defined PLTS Frequency Boundaries columns are the frequencies that the calibration 
kit are defined in the PLTS software when you first receive it. These frequencies are 
limited by the PLTS software. They may be changed as explained in the note above.

2. Select the More >> button to display the thru calibration configuration, the nominal 
minimum and maximum frequencies of the kit, and the connector type of the four ports. 

Table 5-2 Calibration Kit Frequency Parameters

Calibration Kit 
Model Number

Nominal Frequency Range of 
the Calibration Kita

a. Refer to the specific calibration kit documentation for actual specifications and 
characteristics of each product.

Defined PLTS Frequency 
Boundaries of the Calibration 

Kit 

Minimum 
Frequency

Maximum 
Frequency

Start 
Frequency

Stop 
Frequency

Mechanical Calibration Kits include:

85033E 0 MHz 9 GHz 6 MHz 9 GHz

85052D 0 MHz 26.5 GHz 10 MHz 20 GHz

85056A 0 MHz 50 GHz 10 MHz 50 GHz

Electronic Calibration Kits include:

N4430Ab

b. Also applies to the ATN-4801 Multiport Calibration Module.

30 kHz 6 GHz 30 kHz 6 GHz

N4430B 30 kHz 9 GHz 30 kHz 9 GHz
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See Figure 5-3.

Figure 5-3 Select Calibration Kit Dialog Box with More Button Selected

3. If the thru calibration configuration is not the configuration that you wish to use, click the 
Change thru configuration and adapter information box and then click the Next > 
button. The Thru Definition Wizard is displayed.

Figure 5-4 Thru Definition Wizard
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Refer to step 10 on page 134 (part of “Defining a SOLT Calibration Kit”) for information 
that will help you complete the Thru Definition Wizard.

After changing the Thru definition, click the Next > button to save the change and return 
to the Calibration Kit selection window of Figure 5-3. Clicking the Cancel > button will 
exit the start up wizard without making any changes to the calibration kit definition.

4. Once the calibration kit is selected, click the Next > button to display the calibration 
window.

• If you selected a mechanical calibration kit, refer to “Performing a Mechanical SOLT 
Calibration” on page 137 for additional information.

• If you selected an electronic calibration kit, refer to “Performing an Electronic 
Calibration” on page 144 for additional information.

Defining a SOLT Calibration Kit

A SOLT calibration kit may be defined if the calibration kits shown in Figure 5-2 do not match 
your measurement needs. You will need to exit the startup wizard to define your calibration 
kit. Use the following procedure. You may also refer to “Edit Cal Kit” on page 441 for 
additional details.

1. Exit the startup wizard by clicking the close button in the upper right corner of the wizard: 

2. From the Utilities menu, select Calibration, Edit CalKit as shown in Figure 5-5.

Figure 5-5 Selecting Edit CalKit

3. In the Select Cal Kit dialog box, select 4-Channel SOLT from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the process. See 
Figure 5-6.
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Figure 5-6 Select Cal Kit Dialog Box

4. The calibration kit definition is performed in the Edit SOLT Calibration Kit dialog box 
shown in Figure 5-7.

Figure 5-7 Blank Edit SOLT Calibration Kit Dialog Box
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5. Enter Cal Kit ID and Name into the appropriate entry boxes in the header.

Referring to Figure 5-6, Cal Kit ID is listed in the Cal Kit column and Name is listed in 
the Description column of the calibration kit selection window shown in Figure 5-2.

6. Also enter Connector Type along with the minimum (Min. Freq. MHz) and the 
maximum (Max. Freq. MHz) frequencies in megahertz. 

The software compares the minimum and maximum frequency entries against the 
measurement setup frequencies when determining which calibration kits to make 
available for selection for the calibration as in Figure 5-2.

7. Complete the Open Coefficients area by entering the coefficient and delay values 
displayed. If you are using a standard from a calibration kit, the coefficient and delay 
values may be found in the calibration kit documentation. The four coefficient values for 
the open are the capacitance in farads (F). Enter the capacitance value followed by the 
exponent. For example, if C0 is equal to 49.433×10−15, the value would be entered as: 
49.433E-15

Enter the Delay in picoseconds. This value may also be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

8. Complete the Short Coefficients area by entering the coefficient and delay values 
displayed. If you are using a standard from a calibration kit, the coefficient and delay 
values may be found in the calibration kit documentation. The four coefficient values for 
the short are the inductance in henries (H). Enter the inductance value followed by the 
exponent. For example, if H0 is equal to −2.0765×10−12, the value would be entered as: 
-2.0765E-12

Enter the Delay in picoseconds. This value may also be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

9. Complete the Load Coefficients area by entering the characteristic impedance (Z0) in 
ohms and Delay in picoseconds. If you are using a standard from a calibration kit, the 
coefficient and delay values may be found in the calibration kit documentation.

10.Complete the Thru Standards area. Figure 5-9 shows the data that is used in this 
example.

First, from the Choose a thru configuration for this Cal Kit: selection, select either 4 
Cross, 4 Box, or 6 Cross. Figure 5-8 shows the paths that will be calibrated using a thru 
for each selection.
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Figure 5-8 Thru Configuration Selections

Next, select either Choose Adapter File in the Characterization Data area or Delay 
(ps) in the Thru Delay area. 

• Choose Adapter File allows you to use a characterized file to eliminate the effects of 
the thru adapter when calibrating. 

If you select Choose Adapter File, select the characterization file for the thru adapter 
from the list of files.

If you don’t have a characterization file for the thru that you will use to calibrate, you 
can create one by selecting the Characterize Adapter selection in the 
Characterization Data area and then select the Create Custom… button. This will 
open the Custom Adapter Characterization Wizard. Refer to “Characterizing 
Adapters” on page 176 for information on the Custom Adapter Characterization 
Wizard.

• Delay (ps) allows you to insert just the delay (in picoseconds) of the thru adapter, 
based on the electronic length of the device. If you select Delay (ps), enter the time 
delay of the thru in the text area. If your thru is part of an Agilent (or Hewlett-Packard) 
calibration kit, this delay value is listed in the Standard Definitions section of the 
calibration kit documentation.

Finally, in the list of Thrus at the bottom of this dialog box, select the box at the left of the 
thru and click the Add button to associate the thru to either the selected adapter file or to 
the entered delay value. The color of the box at the left of the thru changes from red to 
green as the thru path is completed.

Enter a selected adapter file or a delay value for each thru path. All or the thru paths may 
use the same characterization file or delay value or each may have a different 
characterization file or delay value depending on your calibration requirements.

After the Edit SOLT Calibration Kit dialog box is complete, click the OK button to save the 
calibration kit with the new information and return to the Select Cal Kit dialog box. 
Cancel deletes the information entered and returns to the Select Cal Kit dialog box.
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Figure 5-9 Completed Edit SOLT Calibration Kit Dialog Box

11.Once the SOLT calibration kit data has been entered into the dialog box, select OK to save 
the calibration kit data and exit the Edit SOLT Calibration Kit dialog box. 

The Cancel button closes the Edit SOLT Calibration Kit dialog box without saving the 
calibration kit data.

12.Once the SOLT calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 5-10.

Figure 5-10 Close the Select Cal Kit Dialog Box
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Return to the startup wizard to complete the SOLT calibration procedure. You can select 
New from the File menu to restart the wizard. If you need help completing the startup 
wizard, return to Chapter 4 on page 105. If you do not need assistance, return to “Selecting 
a SOLT Calibration Kit” on page 129.

Performing a Mechanical SOLT Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

The 4-port (channel) Short/Open/Load/Thru (SOLT) calibration type is one of the most 
comprehensive calibrations. This calibration effectively removes the directivity error, 
crosstalk, source match error, load match error, frequency response reflection tracking error, 
and frequency response transmission tracking error from the test setup in a transmission or 
reflection test using these ports. 

It has two unique components: the Thru component and the Short/Open/Load (SOL) 
component. 

• The Thru component consists of connecting a through (Thru) adapter between the ends of 
the test cables connected to the system ports. The Thru adapter is also part of the 
calibration kit.

• The SOL component consists of connecting a short standard, an open standard, and a 
50-ohm load standard to the end of the test cable connected to each system port. Each of 
these standards is part of the calibration kit.

Figure 5-11 is the mechanical calibration interface that steps you through the SOLT 
calibration. It displays calibration configuration information—such as the calibration kit 
selection, the test port connector types, the selected thru adapter, and the thru 
configuration—as well as a graphical representation of the test ports. This graphical 
representation includes a set of icons for each port, corresponding to a short, open, and load 
(see “The Short/Open/Load (SOL) Component” on page 141). In the center of the screen, the 
selected thru configuration is displayed (see “The Thru Component” on page 138).
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Figure 5-11 The SOLT Calibration Interface

Note that all of the icons and the thru configuration paths are displayed in red at the start of 
the calibration. As each calibration standard is connected and measured, the color of its 
corresponding icon will change to blue. Once the measurement is complete, the color of the 
corresponding icon will change from blue to green. This change of color from red to blue to 
green also occurs for the thru configuration.

The Thru Component  In addition to the SOL component of the calibration, a series of 
through (thru) measurements are required. For a 4-port calibration, it can be assumed that 
six thru-path calibrations are required (1-2, 1-3, 1-4, 2-3, 2-4, 3-4). However, some test setups, 
particularly probing setups, may make thru connections for all six paths physically 
impossible.

PLTS provides an alternative, and only requires four thru-paths measurements to perform an 
accurate four-port calibration. These alternatives can be selected in calibration kit definition 
process. See “Defining a SOLT Calibration Kit” on page 132.
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Figure 5-12 “Thru Config” Options

The selection in the Thru Config area of the Calibrate Hardware for Measurement window 
(shown in Figure 5-11 on page 138) dictates the calibration pattern of the thru calibration. 
Figure 5-12 shows the Thru calibration pattern for each Thru Config selection. 

There are minor trade-offs to consider when deciding between a four or six thru-path 
calibration. With a four thru-path calibration, the un-measured thru-paths are accounted for 
as the PLTS software calculates the missing transmission tracking error terms (ETF and 
ETR). Although this calculation has been proven to be extremely accurate, the simulated 
paths have a fractional amount of ripple across the band that would not be present if the full 
six thru-path calibration were performed. This ripple is insignificant in all but extremely 
low-loss DUT specifications (< 0.1 dB for example). 

TIP Comparing Thru Path Calibrations

For the sake of convenience, the four thru-path calibrations are recommended 
in most situations. If you are concerned about the difference, you may choose to 
Chapter 5 139



Performing Error Correction on the VNA-Based PLTS
How to Perform a Calibration
perform two calibrations, one four thru-path and one six thru-path, and 
compare the results with your particular DUT specifications in mind.

Note that when a Thru Config calibration path is complete, the path color has changed from 
red (before the measurement) to blue (during the measurement) to green (after the 
measurement is complete).

To Perform the Thru Calibration Component  Use the following steps to perform the 
Thru calibration:

1. Connect the test cables and any adapters that you will use for your measurements to the 
Physical Layer Test System test ports. 

The calibration is made with all cables and connectors in place but without the DUT.

2. With the Calibrate Hardware for Measurement window displayed, select one of the Thru 
path icons on the window.

Figure 5-13 Thru Path Icons

3. Once a Thru path icon is selected, a prompt is displayed telling you which connections 
must be made for the Thru calibration. An example is shown in Figure 5-14.

Figure 5-14 Example Prompt for Thru

4. Continue to select the Thru icon following the instructions as each prompt is displayed. 
The Thru component of the calibration is complete once the color of all of the Thru paths 
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have changed to green.

5. Continue with “The Short/Open/Load (SOL) Component” to complete the calibration.

The Short/Open/Load (SOL) Component  Performing the SOL portion of the calibration 
consists of connecting each of the standards to each of the ports for a reference measurement. 
Any sequence may be used, and multiple connections may be made simultaneously for 
convenience (for example: connect the short to port 1, load to port 2, and open to port 3, then 
continue). The icons change color from red (before the measurement) to blue (during the 
measurement) to green (after the measurement is complete).

Each of the four ports on the window has an associated set of icons as shown: 

Each of the three icons in the set represents a different part of the SOL calibration 
component.

 represents the short standard from the calibration kit

 represents the open standard from the calibration kit

 represents the 50-ohm load standard from the calibration kit

As each standard is connected to each port and characterized during the calibration, the color 
of the associated icon changes from red to blue to green.

To Perform the Short/Open/Load (SOL) Calibration Component  Use the following 
steps to perform the SOL calibration:

1. With the Calibrate Hardware for Measurement window (see Figure 5-11 on page 138) 
displayed, ensure that the Show Prompts check box is checked.

TIP To perform the SOL calibration without using prompts:

Prompts are used to guide you through the steps for this calibration. It is not 
required that this calibration be performed using prompts, such as the one 
shown in Figure 5-15. These prompts may be disabled by clearing the Show 
Prompts checkbox. Until you become familiar with the calibration procedure, 
it is recommended that you use the prompts.

1. Ensure that the Show Prompts check box is cleared.
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2. Select a short, open, or load standard from the calibration kit and connect it 
to one of the test ports. Note: You may save time by connecting more than one 
standard (for example: connect the short to port 1, load to port 2, and open to 
port 3, then continue).

3. Click the corresponding icon to perform the appropriate measurement.

4. The system will perform a reference measurement, and the color of the icon 
will change to green, indicating completion.

5. Repeat for the remaining standards and ports until all of the icons have 
changed to green.

After you have finished the SOL calibration, select the Next > button to the 
save the calibration data. See “To Save the Calibration” on page 143.

2. Click on any one of the icons, at any one of the test ports.

3. A dialog box is displayed confirming the required standard and port. An example is shown 
in Figure 5-15.

Figure 5-15 Example Prompt for Shorts, Opens, and Loads

4. Make the requested connection and click OK.

5. The system will perform a reference measurement, and the color of the icon will change to 
green, indicating completion.

6. Repeat for the remaining standards and ports until all of the icons have changed to green.

7. After you have finished the SOL calibration, select the Next > button to the save the 
calibration data. See “To Save the Calibration” on page 143.
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To Save the Calibration  Once you have completed both components of the SOLT 
calibration, the Save Calibration Data dialog box is displayed as shown in Figure 5-16.

Figure 5-16 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is automatically saved with a “.cal” 
file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete.

3. If you started the calibration:

• As part of the example measurement of Chapter 4, return to “How to Make a 
Measurement” on page 114.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting Calibration from the Utilities menu and then selecting Calibrate, the 
software returns to the main software window.
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Performing an Electronic Calibration

You can perform a 4-port electronic calibration (ECal) using the Agilent N4430A 6 GHz 4-Port 
ECal Module1 or the N4430B 9 GHz 4-Port ECal Module.

With a one-time connection, the ECal procedure cycles through all of the impedance states 
and six thru paths required for a full, four-port, vector error-corrected SOLT calibration, and 
can transfer factory-calibration accuracy to the Physical Layer Test System. The software 
controls the electronic calibration. Refer to Figure 5-17 for a typical equipment setup.

Figure 5-17 Typical Equipment Setup for ECal

NOTE For maximum accuracy and repeatability, the system (network analyzer, test 
set, and ECal module) should be stabilized at room temperature for a minimum 
of 24 hours before calibration.

Using standard alignment precautions, the test set may have the ECal module connected and 
disconnected in any power state. After calibration, the ECal module may remain connected or 
may be disconnected from the test set Auxiliary connector with no effect on the calibration.

To perform the ECal with the physical layer test system:

1. Once you select an electronic calibration kit and then click the Next > button as instructed 
on the last step of the “Selecting a SOLT Calibration Kit” procedure on page 132, the 
Electronic Calibration is displayed. See Figure 5-18.

1. The ATN-4801 Multiport Calibration Module may also be used.
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Figure 5-18 Electronic Calibration Dialog Box

2. Connect the test cables and adapters that you will use for your measurements to the 
Physical Layer Test System test ports.

3. Connect the other end of the test cables and adapters to the ECal module so that the 
connections identified in Table 5-3 are made. If adapters are required to make the 
connections from the test cable/adapter setup to the ECal module, use the adapters in the 
ECal module kit.

Table 5-3 ECal Module Connections

ECal Module Connector PLTS Connector Cable Type Specified Torque

CONTROL AUXILIARY DB-15 N/A

PORT 1 PORT 1 Coax 8 in/lb

PORT 2 PORT 2 Coax 8 in/lb

PORT 3 PORT 3 Coax 8 in/lb

PORT 4 PORT 4 Coax 8 in/lb
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CAUTION Make sure that test port 2 of the system is connected to Port 2 of the ECal 
module and that test port 3 of the system is connected to Port 3 of the ECal 
module. Connecting to the wrong port will lead to incorrect calibration results. 
Refer to Figure 5-19 for test cable connections to the ECal module.

Figure 5-19 Connecting Test Cables to the ECal Module

4. Select the electronic calibration characterization file for your ECal module from the list. 
Refer to Figure 5-18. Verify that the file name matched the serial number of your ECal 
module.

If your characterization file was not located by the software, load the characterization file 
from the floppy disk provided with the ECal module. Load the file from the floppy disk by 
inserting the floppy disk in the PC, selecting the Have Disk … button, and locating the 
characterization file from the floppy disk directory using the Open dialog box. Each module 
characterization file is unique, so verify that the file name matches the ECal module serial 
number. The characterization file has an “.ecl” extension. The ECal module should be 
loaded into the C:\Program Files\Agilent\PLTS\ecal, where C is the hard drive where 
the PLTS is stored.
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NOTE Select the ECal Info… button to display the following ECal module 
information dialog box for the selected module. 

5. If your system’s test cable setup won’t connect directly to the ECal module, you may use an 
adapter that has already been characterized. To use the adapter, select the adapter’s 
characterization file from the Select Adapter Files list. Refer to “Characterizing 
Adapters” on page 176 for detailed information.

NOTE If you use one or more of the 3.5 mm male to male adapters in the ECal kit, you 
may select one of the 3.5m-m.txs files from the Select Adapter Files list.

• If you are connecting the adapter in the forward orientation (with the adapter’s 
characterized port 2 connected to the ECal module), just select the checkbox labeled A 
(representing Adapter) for the port to which it is being connected.

• If you are connecting the adapter in the reverse orientation (with the adapter’s 
characterized port 1 connected to the ECal module), select the checkbox labeled A 
(representing Adapter) and the checkbox labeled R (representing Reverse) for the port 
to which it is being connected. 

NOTE The Adapter (A) checkbox must be selected before the program accounts for the 
Reverse (R) checkbox being selected.

6. Once the system is connected to the ECal module, select Next > to start the electronic 
calibration. A small window showing the calibration progress is displayed.

Once the calibration is complete, it should be saved. See “To Save the Calibration” on 
page 143.
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Performing a TRL Calibration

You have selected the 4-Channel TRL (THRU - REFLECT - LINE) calibration type. TRL 
calibration is convenient in that calibration standards can be fabricated for a specific 
measurement environment, such as a transistor test fixture or microstrip. Microstrip devices 
cannot be connected directly to the coaxial ports of the analyzer. The device under test (DUT) 
must be physically connected to the PLTS by some kind of transition network or fixture. 
Calibration for a fixtured measurement in microstrip presents additional difficulties.

A calibration at the coaxial ports of the PLTS removes the effects of the network analyzer, test 
set, and any cables or adapters before the fixture; however, the effects of the fixture itself are 
not accounted for. An in-fixture calibration is preferable, but high-quality SHORT - OPEN - 
LOAD - THRU (SOLT) standards may not be readily available to allow a calibration of the 
system at the desired measurement plane of the device. In microstrip, a short circuit is 
inductive, an open circuit radiates energy, and a high-quality purely resistive load is difficult 
to produce over a broad frequency range. The 4-Channel TRL calibration is an alternative to 
the traditional SOLT calibration technique that utilizes simpler, more convenient standards 
for device measurements in the microstrip environment.

For coaxial, waveguide and other environments where high-quality impedance standards are 
readily available, the traditional SOLT method provides the most accurate results since all of 
the significant systematic errors are reduced. 

In all measurement environments, you must provide calibration standards for the desired 
calibration to be performed. The advantage of TRL is that only three standards need to be 
characterized as opposed to four standards in the traditional SOLT calibration. Further, the 
requirements for characterizing the T, R, and L standards are less stringent and the 
standards are more easily fabricated.

The TRL calibration kit contains the following:

• zero length THRU

• “flush” short for the REFLECT standard (0 second offset)

• 50-ohm terminations with known delay for the LINE 

NOTE TRL calibration is not supported for physical layer test systems that use the 
8753ES or the 8720ES-series network analyzers.

Start with “Selecting a TRL Calibration Kit”.
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Selecting a TRL Calibration Kit

The dialog box shown in Figure 5-20 lists the defined TRL calibration kits that have been 
determined by the auto-detection to be appropriate for the system hardware and the 
frequency range that was defined in the measurement parameters.

Figure 5-20 Select TRL Calibration Kit Dialog Box

NOTE No TRL calibration kits are defined in the software when you receive it. 

• If you have not defined your TRL calibration kit, select the Cancel button 
and define your TRL calibration kit using the procedure described in 
“Defining a TRL Calibration Kit” on page 150.

• If you have defined a TRL calibration kit but it is not displayed in the dialog 
box:

1. Make sure that you have selected 4-Channel TRL from the Select 
Calibration Type list. See “Selecting a Calibration Type” on page 127.

2. Make sure that the start and stop frequencies that were defined for the 
TRL calibration kit (“Defining a TRL Calibration Kit” on page 150) 
match or exceed the start and stop frequencies that were defined in the 
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measurement parameters (“Setting Up the Calibration and 
Measurement Parameters” on page 111).

1. Select your calibration kit in the Cal Kit column.

2. Select the More >> button to display the thru calibration configuration, the minimum and 
maximum frequencies of the kit, and the connector type of the four ports. See Figure 5-21.

Figure 5-21 Select Calibration Kit Dialog Box with More Button Selected

3. Once the calibration kit is selected, click the Next > button to display the calibration 
window and continue with “Performing a TRL Calibration” on page 154.

Defining a TRL Calibration Kit

The dialog box shown in Figure 5-23 shows only the USER_DEF selection. This indicates 
that a TRL calibration kit must be defined before a TRL calibration may be performed.

1. From the Utilities menu, select your PLTS system name and then select Edit Cal Kits… 
as shown in Figure 5-22.
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Figure 5-22 Selecting Edit Cal Kits…

2. In the Select Cal Kit dialog box, select 4-Channel TRL from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the definition 
process. See Figure 5-23.

Figure 5-23 Select Cal Kit Dialog Box

3. The TRL calibration kit is defined using the Edit TRL Calibration Kit dialog box. See 
Figure 5-24.
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Figure 5-24 Blank Edit TRL Calibration Kit Dialog Box

4. Enter Cal Kit ID, Name, and Connector Type into the appropriate entry boxes in the 
header.

Referring to Figure 5-25, Cal Kit ID is listed in the Cal Kit column and Name is listed in 
the Description column of the calibration kit selection window.

In this example, Cal Kit ID is defined as “85050C”, Name is defined as “Agilent Cal 
Kit Model # 85050C”, and Connector Type is defined as “7mm”. Refer to Figure 5-21.

5. Enter the delay value of the device you are using as the Reflect in either the Open 
Coefficients area or the Short Coefficients area. Enter the delay value in only one area 
for your Reflective device. If you are using a standard from a calibration kit, the delay 
value may be found in the calibration kit documentation.

• If the Reflect device is an open, enter the Delay (in picoseconds) in the Open 
Coefficients area.

• If the Reflect device is an short, enter the Delay (in picoseconds) in the Short 
Coefficients area.

Figure 5-25 shows the data that is used in this example.
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6. Complete the Load Coefficients area by entering the characteristic impedance (Z0) in 
ohms and Delay in picoseconds. If you are using a standard from a calibration kit, the 
coefficient and delay values may be found in the calibration kit documentation. Figure 
5-25 shows the data that is used in this example.

7. Complete of the Edit TRL Calibration Kit dialog box. For the Enter Cal Standard 
Characterization Data area, enter a name for each Line along with each line’s start and 
stop frequency (in MHz) and delay (in ps). Information for up to three lines can be entered 
into this area. If you are using a standard from a calibration kit, the coefficient and delay 
values may be found in the calibration kit documentation. If the delay of a line is entered 
as 0 ps, the line is assumed to be a load (50Ω termination). Also enter the name and delay 
of the Thru device, which is typically 0 ps. Figure 5-25 shows the data that is used in this 
example.

Figure 5-25 Completed Edit TRL Calibration Kit Dialog Box

8. Once the TRL calibration kit data has been entered into the dialog box, select the OK 
button to save the calibration kit data and exit the Edit TRL Calibration Kit dialog box. 

The Cancel button closes the Edit TRL Calibration Kit dialog box without saving the 
calibration kit data.
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9. Once the TRL calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 5-26.

Figure 5-26 Close the Select Cal Kit Dialog Box

10.Return to the startup wizard to complete the TRL calibration procedure. You can select 
New from the File menu to restart the wizard. 

• If you need help completing the startup wizard, return to Chapter 4 on page 105. 

• If you do not need assistance, continue with “Selecting a TRL Calibration Kit” on 
page 149.

Performing a TRL Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

As indicated by its name, the Thru-Reflection-Line (TRL) calibration consists of three 
portions. First, the reflection portion is performed by connecting a short to each system port. 
The Line portion is performed by connecting each line and a thru between system ports 1 and 
3 and then by connecting the same lines and thru between ports 2 and 4. Finally, the Thru 
portion is performed by connecting the thru between system ports 1 and 4 and then by 
repeating the connection between ports 2 and 3. 
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Figure 5-27 Initial TRL Calibration Display

The TRL calibration is performed in two parts. First the Reflect portion of the calibration is 
done. Then the Thru-Line portion of the calibration is done.

Reflect Portion of TRL Calibration  The following three steps are the Reflect portion of 
the TRL calibration.

1. Select the following icon to start the Reflection portion of the calibration: 

2. As described in the prompt shown in Figure 5-28, connect the reflective device (in this 
case, defined as a short) from your calibration kit to Port 1 and click OK.

Figure 5-28 Displaying the Port 1 Reflection Prompt
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As the portion of the calibration is complete, the Port 1 icon color changes from red to 
green. Actually, as the measurement is being made, the icon is blue, however, the 
measurement is so quick you may not even see the icon turn blue before turning to green.

3. Repeat steps 1 and 2 for each of the remaining ports.

The order that the ports are calibrated does not matter. 

Once all four of the ports are calibrated using the Reflect device, the color of each reflect 
icon has changed to green. See Figure 5-29.

Figure 5-29 Reflection Portion of Calibration Complete

Thru-Line Portion of TRL Calibration  The following steps are the Thru-Line portion of 
the TRL calibration.

1. Click the Thru-Line icon that extends from Port 1 to Port 3. When this icon is clicked, the 
color changes from red to blue. See Figure 5-30.
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Figure 5-30 Start Thru-Line Calibration Port 1 - Port 3

2. Click the top button on the right side of the display. In this case, the button is called 
Termination because the TRL calibration kit was defined with that label for Line 1 
Name. See Figure 5-25 on page 153. If you enter another name for Line 1, that label is 
used.

When you click the Termination button, the following prompt window is displayed:

Figure 5-31 Prompt for Line 1 (Termination) Calibration

3. Make the connections as described in the prompt window and click OK to start the 
calibration measurement.

Once this measurement is made, the color of the box at the right of the Termination 
button changes from red to green.

4. Repeat step 2 and 3 for Lines 2 (0.5 -- 3.0GHz), Line 3 (3.0 - 18GHz), and the Thru 
(ZeroDelay).

Once these measurements are taken, the calibration between ports 1 and 3 is complete. 
See Figure 5-32. On the display, the color of:

• Each box to the right of the buttons have changed from red to green.
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• The line between ports 1 and 3 changes from blue to green indicating that this path is 
complete.

Figure 5-32 Port 1 - Port 3 Line Portion of Calibration Complete

5. Repeat steps 1 through 4 for the Port 2 to Port 4 path.

Figure 5-33 Line Portion of Calibration Complete
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6. Select the Port 1 - Port 4 Thru icon.

Figure 5-34 Thru Icons for Port 1 - Port 4 and Port 2 - Port 3

The icon (both halves) turns blue and the box at the right of the Zero Delay Thru button 
turns red.

7. Click the Zero Delay thru button which displays the prompt window.

All of the line buttons are inactive.

8. After the thru is connected between ports 1 and 4 as indicated on the prompt and click the 
OK button. 

The calibration is performed and the color of the box to the right of the thru button and the 
thru icon are changed to green.

9. Repeat steps 6 through 8 to complete the Thru calibration between Port 2 and Port 3.
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10.Once the Port 2 to Port 3 Thru calibration is made, the TRL calibration measurements are 
complete. The color of all icons has changed to green. Refer to Figure 5-35. 

Figure 5-35 TRL Calibration Complete

11.Click the Next > button.

Continue at “To Save the TRL Calibration” on page 161.
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To Save the TRL Calibration  Once you have completed the TRL calibration, the Save 
Calibration Data dialog box is displayed as shown in Figure 5-36.

Figure 5-36 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is saved with a “.cal” file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete. A window is displayed 
showing how to make the connections to measure your DUT following the TRL calibration.

3. If you started the calibration:

• As part of the example measurement of Chapter 4, return to “How to Make a 
Measurement” on page 114.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting the system name from the Utilities menu and then selecting 
Calibrate…, the software returns to the main software window.
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Performing an LRM Calibration

You have selected the 4-Channel LRM (LINE - REFLECT - MATCH) calibration type. LRM 
calibration is convenient in that calibration standards can be fabricated for a specific 
measurement environment, such as a transistor test fixture or microstrip. Microstrip devices 
cannot be connected directly to the coaxial ports of the analyzer. The device under test (DUT) 
must be physically connected to the PLTS by some kind of transition network or fixture. 
Calibration for a fixtured measurement in microstrip presents additional difficulties.

A calibration at the coaxial ports of the PLTS removes the effects of the network analyzer, test 
set, and any cables or adapters before the fixture; however, the effects of the fixture itself are 
not accounted for. An in-fixture calibration is preferable, but high-quality SHORT - OPEN - 
LOAD - THRU (SOLT) standards may not be readily available to allow a calibration of the 
system at the desired measurement plane of the device. In microstrip, a short circuit is 
inductive, an open circuit radiates energy, and a high-quality purely resistive load is difficult 
to produce over a broad frequency range. The 4-Channel LRM calibration is an alternative to 
the traditional SOLT calibration technique that utilizes simpler, more convenient standards 
for device measurements in the microstrip environment.

For coaxial, waveguide and other environments where high-quality impedance standards are 
readily available, the traditional SOLT method provides the most accurate results since all of 
the significant systematic errors are reduced. 

In all measurement environments, you must provide calibration standards for the desired 
calibration to be performed. The advantage of LRM is that only three standards need to be 
characterized as opposed to four standards in the traditional SOLT calibration. Further, the 
requirements for characterizing the L, R, and M standards are less stringent and the 
standards are more easily fabricated.

Unless you have defined an LRM calibration kit previously, you will need to define an LRM 
calibration kit before proceeding. Refer to “Defining an LRM Calibration Kit”. Select Launch 
Startup Wizard from the Tools menu after you complete the definition to return to the 
calibration and measurement process.

The LRM calibration kit contains the following:

• zero length LINE

• “flush” short for the REFLECT standard (0 second offset)

• 50-ohm termination of the MATCH (infinite length line)

NOTE LRM with a zero length line is sometimes referred to as TRM (THRU - 
REFLECT - MATCH).
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NOTE LRM calibration is not supported for physical layer test systems that use the 
8753ES or the 872XES network analyzers.

Start with “Selecting an LRM Calibration Kit”.

Selecting an LRM Calibration Kit

The dialog box shown in Figure 5-37 lists the defined LRM calibration kits that have been 
determined by the auto-detection to be appropriate for the system hardware and the 
frequency range that was defined in the measurement parameters.

Figure 5-37 Select LRM Calibration Kit Dialog Box

NOTE No LRM calibration kits are defined in the software when you receive it. 

• If you have not defined your LRM calibration kit, select the Cancel button 
and define your LRM calibration kit using the procedure described in 
“Defining an LRM Calibration Kit” on page 165.

• If you have defined a LRM calibration kit but it is not displayed in the dialog 
box:
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1. Make sure that you have selected 4-Channel LRM from the Select 
Calibration Type list. See “Selecting a Calibration Type” on page 127.

2. Make sure that the start and stop frequencies that were defined for the 
LRM calibration kit (“Defining an LRM Calibration Kit” on page 165) 
match or exceed the start and stop frequencies that were defined in the 
measurement parameters (“Setting Up the Calibration and 
Measurement Parameters” on page 111).

1. Select your calibration kit in the Cal Kit column.

2. Select the More >> button to display the thru calibration configuration, the minimum and 
maximum frequencies of the kit, and the connector type of the four ports. See Figure 5-38.

Figure 5-38 Select Calibration Kit Dialog Box with More Button Selected

3. Once the calibration kit is selected in the Cal Kit column, click the Next > button to 
display the calibration window and continue with “Performing an LRM Calibration” on 
page 168.
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Defining an LRM Calibration Kit

The dialog box shown in Figure 5-40 shows only the USER_DEF selection. This indicates 
that a LRM calibration kit must be defined before a LRM calibration may be performed.

1. From the Utilities menu, select your PLTS system name and then select Edit Cal Kits… 
as shown in Figure 5-39.

Figure 5-39 Selecting Edit Cal Kits…

2. In the Select Cal Kit dialog box, select 4-Channel LRM from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the definition 
process. See Figure 5-40.

Figure 5-40 Select Cal Kit Dialog Box

3. The LRM calibration kit is defined using the Edit LRM Calibration Kit dialog box. See 
Figure 5-41.
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Figure 5-41 Blank Edit LRM Calibration Kit Dialog Box

4. Enter Cal Kit ID, Name, and Connector Type into the appropriate entry boxes in the 
header. Referring to Figure 5-42, Cal Kit ID is listed in the Cal Kit column and Name is 
listed in the Description column of the calibration kit selection window.

In this example, Cal Kit ID is defined as “LRM”, Name is defined as “GSG - 150 
micron”, and Connector Type is defined as “150 um”. Refer to Figure 5-38.

5. For the Reflect: Enter the delay value (in picoseconds) of the short that you are using in 
the Short Coefficients area. Figure 5-42 shows the data that is used in this example.

6. For the Match: Complete the Load Standards area by entering the characteristic 
impedance (Z0) in ohms and Delay in picoseconds. Also enter a Load Name for the Match 
as well as the start and stop frequencies in MHz of the load.

In this example, Z0 is defined as “500” ohms, Delay is defined as “-0.0034” ps, the Load 
Name is defined as “Termination”, Start Freq. is defined as “0.00” MHz, and Stop 
Freq. is defined as “50001” MHz. Figure 5-38 shows the data that is used in this example.

7. For the Line: In the Enter Cal Thru Characterization Data area, enter a name for the 
Thru along with its delay (in ps). In this example, the Thru Name is defined as “Line” 
and the Delay is defined as “1.0” ps. Figure 5-42 shows the data that is used in this 
example.
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Figure 5-42 Completed Edit LRM Calibration Kit Dialog Box

8. Once the LRM calibration kit data has been entered into the dialog box, select the OK 
button to save the calibration kit data and exit the Edit LRM Calibration Kit dialog box. 

The Cancel button closes the Edit LRM Calibration Kit dialog box without saving the 
calibration kit data.

9. Once the LRM calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 5-43.

Figure 5-43 Close the Select Cal Kit Dialog Box
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10.Return to the startup wizard to complete the LRM calibration procedure. You can select 
New from the File menu to restart the wizard. 

• If you need help completing the startup wizard, return to Chapter 4 on page 105. 

• If you do not need assistance, continue with “Selecting an LRM Calibration Kit” on 
page 163.

Performing an LRM Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

As indicated by its name, the LINE - REFLECT - MATCH (LRM) calibration consists of three 
portions. First, the Reflect portion is performed by connecting a short to each system port. The 
Line portion is performed by connecting a thru between system ports 1 and 3 and then 
between ports 2 and 4. Finally, the Match portion is performed by connecting a load between 
ports 1 and 3, ports 2 and 4, ports 1 and 4, and ports 2 and 3. 

Figure 5-44 Initial LRM Calibration Display
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The LRM calibration is performed in two parts. First the Reflect portion of the calibration is 
done. Then the Line-Match portion of the calibration is done.

Reflect Portion of LRM Calibration  The following three steps are the Reflect portion of 
the LRM calibration.

1. Select the following icon to start the Reflection portion of the calibration:

2. As described in the prompt shown in Figure 5-45, connect the reflective device (in this 
case, defined as a short) from your calibration kit to Port 1 and click OK.

Figure 5-45 Displaying the Port 1 Reflection Prompt

As the portion of the calibration is complete, the Port 1 icon color changes from red to 
green. Actually, as the measurement is being made, the icon is blue, however, the 
measurement is so quick you may not even see the icon turn blue before turning to green.

3. Repeat steps 1 and 2 for each of the remaining ports.

The order that the ports are calibrated does not matter. 

Once all four of the ports are calibrated using the Reflect device, the color of each reflect 
icon has changed to green. See Figure 5-46.
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Figure 5-46 Reflection Portion of Calibration Complete

Line-Match Portion of LRM Calibration  The following steps are the Line-Match portion 
of the LRM calibration.

1. Click the Line-Match icon that extends from Port 1 to Port 3. When this icon is clicked, the 
color changes from red to blue. See Figure 5-47.
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Figure 5-47 Start Thru - Line Calibration Port 1 - Port 3

2. Click the top button on the right side of the display. In this case, the button is called 
Termination because the LRM calibration kit was defined with that label for Load 
Name (this is the name of the match). See Figure 5-42 on page 167. If you would have 
entered another name for the load, that label would be used.

When you click the Termination button, the following prompt window is displayed:

Figure 5-48 Prompt for Load (Termination) Calibration

3. Make the connections as described in the prompt window and click OK to start the 
calibration measurement.

Once this measurement is made, the color of the box at the right of the Termination 
button changes from red to green.

4. Repeat step 2 and 3 for the thru (Line).

Once these measurements are taken, the calibration between ports 1 and 3 is complete. 
See Figure 5-49. On the display, the color of:
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• Each box to the right of the buttons have changed from red to green.
• The line between ports 1 and 3 changes from blue to green indicating that this path is 

complete.

Figure 5-49 Port 1 - Port 3 Line Portion of Calibration Complete

5. Repeat steps 1 through 4 for the Port 2 to Port 4 path.

Figure 5-50 Line Portion of Calibration Complete
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6. Select the Line icon that extends from Port 1 to Port 4.

Figure 5-51 Thru Icons for Port 1 - Port 4 and Port 2 - Port 3

The icon (both halves) turns blue and the box at the right of the Line button turns red.

7. Click the Line button which displays the prompt window. (The Termination button is 
inactive.)

8. After the Line (thru) is connected between ports 1 and 4 as indicated on the prompt and 
click the OK button. 

The calibration is performed and the color of the box to the right of the thru button and the 
thru icon are changed to green.

9. Repeat steps 6 through 8 to complete the Line calibration between Port 2 and Port 3.

10.Once the Port 2 to Port 3 Line calibration is made, the LRM calibration measurements are 
complete. Refer to Figure 5-52. 

The color of all icons has changed to green.
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Figure 5-52 LRM Calibration Complete

11.Click the Next > button.

Continue at “To Save the LRM Calibration” on page 175.
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To Save the LRM Calibration  Once you have completed the LRM calibration, the Save 
Calibration Data dialog box is displayed as shown in Figure 5-53.

Figure 5-53 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is saved with a “.cal” file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete. A window is displayed 
showing how to make the connections to measure your DUT following the LRM 
calibration.

3. If you started the calibration:

• As part of the example measurement of Chapter 4, return to “How to Make a 
Measurement” on page 114.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting your PLTS system name from the Utilities menu and then selecting 
Calibrate…, the software returns to the main software window.
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Characterizing Adapters

For non-insertable1 calibrations, the thru adapter to be used must be characterized by itself so 
that its effects can later be removed from the calibration measurement results. 

Several standard thru adapter characterization files have been provided with PLTS (see the 
..\PLTS\adapters directory) and are automatically selected based on the calibration kit to be 
used. These files may be used with very good results, but for the very highest accuracy, it is 
recommended that you characterize your own adapters using the following procedure.

To perform the characterization, first, a short/open/load calibration is performed directly at 
the front panel of the system. Either one or two test ports will be used depending on the 
adapter category selected during the process. Then the adapter is inserted and the 
short/open/load calibration is repeated. The resulting adapter S-parameters are saved in 
Citifile format, which can later be de-embedded from the device measurement. 

For adapters that will be used for broadband measurements, characterize the adapter over 
the entire frequency range of the instrument with as many points as possible. This allows for 
interpolation of adapter data if the frequency points used in a later DUT measurement are 
not exactly the same as the adapter frequency points.

Adapter characterization is performed directly at the instruments front panel (either Port 1 or 
Ports 1 and 4). If an additional adapter is needed between the front panel and the adapter to 
be characterized (for type or gender change), install the additional adapter first (metrology 
grade recommended), and perform all calibrations with it installed.

For purposes of characterization, your adapters must have an orientation. Mark the 
connectors on the adapter as ports 1 and 2, and treat them as such during the 
characterization procedure. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Follow these steps to characterize your adapters:

1. Select Characterize Adapter from the Utilities menu to start the Custom Adapter 
Characterization Wizard.

1. Non-insertable calibrations are those in which the test port connectors are of the 
same gender (male-to-male or female-to-female).
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Figure 5-54 Characterize Adapter Selection

2. In the Custom Adapter Characterization Wizard dialog box, select the appropriate adapter 
category and the calibration kit to be used. See Figure 5-55. Press Next > to continue to 
the next window.

The two adapter characterization categories are:

• “In-Series, Same-Sex” uses a single port (Port 1) and applies only to adapters having 
the same type and gender on both ends (3.5 mm male-to-male, for example). Select the 
calibration kit to be used on Port 1 from the pull-down menu.

• “All Others” uses two ports (Ports 1 and 2) and allows the adapter types to be specified 
independently. Select the calibration kits to be used on Port 1 and on Port 2 from the 
pull-down menus.

Figure 5-55 Custom Adapter Characterization Wizard
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3. Make the connections listed on the Custom Adapter Characterization Wizard Setup 
Instructions window (Figure 5-56) and then click the Setup Stimulus button. 

Figure 5-56 Custom Adapter Characterization Wizard Setup Instructions

4. Make any required changes to the stimulus to match your actual measurement conditions. 
When you make any change, click the Recalculate Parameters button to update all 
parameters. Refer to Figure 5-57. When you are satisfied with the parameters, click OK.

Figure 5-57 Stimulus Parameter Dialog Box

Refer to “Measurement and Calibration Parameter Entry Descriptions” on page 112 for 
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definitions of each parameter.

5. Following the order shown on your Forward Orientation Adapter Calibration dialog box, 
install the calibration standards as listed and click the Measure button. 

Depending on your previous selections, your window may differ slightly from the window 
shown in Figure 5-58.

Figure 5-58 Forward Orientation Adapter Calibration Window

NOTE The Next > button remains inactive until all data choices are measured.
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6. As you make each measurement, a check mark is displayed in the check box to the left of 
the measurement. See Figure 5-59. Once all measurements are made, click Next > to 
continue. 

Figure 5-59 Completed Forward Orientation Adapter Calibration Window
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7. Following the order shown on your Reverse Orientation Adapter Calibration window, 
install the calibration standards as listed and click the Measure button. Depending on 
your previous selections, your window may differ slightly from the window shown in 
Figure 5-60.

As you make each measurement, a check mark is displayed in the check box to the left of 
the measurement. Once all measurements are made, click Next > to continue. 

NOTE The Next > button remains inactive until all data choices are measured.

Figure 5-60 Reverse Orientation Adapter Calibration Window
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8. When the characterization is complete, save the adapter file using the dialog box shown in 
Figure 5-61. Enter a file name for the adapter data and click Finish. The file is 
automatically saved as a “.txs” file. The default directory for saving adapter 
characterization information is C:\Program Files\Agilent\PLTS\Adapters, where C is 
the hard drive where the PLTS is stored.

Figure 5-61 Save Adapter Characterization File Dialog Box

Since the characterization file is in Citifile format, you can import the data and make a 
visual check of the quality of the characterization. Select Import from the File menu and 
then select Citifile. You may open and inspect the adapter characterization file.
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This chapter guides you through setting up the initial measurement definitions, performing 
the system calibration, and making a measurement with the TDR-based PLTS hardware. 
PLTS supports the TDR-based PLTS hardware using coaxial test cables. 

NOTE PLTS does not support TDR-based measurements using probing techniques.

You will need four coaxial test cables for the TDR-based PLTS measurements.

• For the Agilent 86100A/B, we recommend you use:

— Four 3.5 mm (male-female) cables (such as the Agilent N4418A-B20)
-or-

— Four 3.5 mm (male-male) cables with a 3.5 mm (female-female) adapter used as a 
connector saver

• For the Tektronix CSA8000 and TDS8000, we recommend you use:

— Four 3.5 mm (male-male) cables
-or-

— Four 3.5 mm (male-female) cables (such as the Agilent N4418A-B20)

You also need the following calibration standards to perform the TDR calibration. As Table 
6-1 shows, different standards are required depending on the TDR-based PLTS hardware and 
the desired calibration type.

Table 6-1 Required Calibration Standards

TDR System Calibration For 
Single Ended 

Measurements

Calibration for Differential 
Measurements

Module
Calibration

Reference 
Plane Cal 

Only

Normalization 
plus Reference 
Plane Cal

Reference 
Plane Cal 

Only

Normalization 
plus Reference 

Plane Cal

Agilent 
86100A/B

1 50Ω Load 1 Thru 1 50Ω Load
1 Short
1 Thru

2 Thrus 2 50W Loads
2 Shorts
2 Thrus

Tektronix 
CSA8000/
TDS8000

2 50Ω Loads 1 Thru Not Applicable 2 Thrus Not Applicable
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The input connectors are very sensitive to electrostatic discharge (ESD). When 
you connect a device or cable that is not fully discharged to the input connector, 
you risk damage to the module and expensive instrument repairs. Refer to your 
TDR documentation for detailed information regarding ESD susceptibility.

The Startup Wizard steps you through the following steps to make a measurement. 

1. Initial setup includes:

• System Hardware Verification and Calibration Level Selection
• TDR Calibration and Measurement Parameter Setup
• Time Domain Calibration and Measurement Parameter Selection

2. Calibration includes:

• Calibration Kit Selection
• Calibration Kit Definition 

(if you need to use other than one of the predefined calibration kits)
• Calibration, which includes:

 Module Calibration (may be required or may be recommended)
 Reference Plane Calibration Only -or- Normalization and Reference Plane 
Calibration

3. Measurement includes:

• Device Under Test Connection
• Initial Analysis Type Selection
• Stimulus and Parameter Verification
• Running a Measurement

After the measurement is made, the main Physical Layer Test System (PLTS) window gives 
you the flexibility to perform analysis on the measured data in a variety of ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
Single-Ended mode.

• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes.
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Starting the Startup Wizard
When PLTS is first started, the Startup Wizard is displayed. The Startup Wizard Welcome 
screen is displayed in Figure 6-1. It is also displayed anytime a new measurement is initiated, 
such as after selecting New from the File menu, or clicking on the new file icon on the toolbar.

Figure 6-1 Startup Wizard Welcome Screen

The Startup Wizard Welcome Screen gives you two choices, New Measurement or Load 
Measurement. The selected choice has a green check mark to the right of the label. New 
Measurement leads you through the process of calibrating and making a measurement. 
Load Measurement loads measurement data from an existing file that you must select. 

When you select New Measurement, the Startup Wizard will guide you through:

• Initial Setup
• Calibration
• Measurement 

For this exercise, select New Measurement and then select the Next > button.
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Performing the Initial Setup
The Initial Setup process includes:

1. Verifying that the software recognizes your PLTS system hardware.

This step uses the left portion of the Hardware Auto-Detection Summary dialog box to 
verify that the software recognizes the correct system hardware. This portion of the dialog 
box displays the model number, GPIB address, and serial number of the hardware. You 
may re-scan to look for hardware changes automatically. You may select another 
recognized PLTS measurement system.

2. Selecting the appropriate level of calibration for the upcoming measurement.

This step uses the right portion of the Hardware Auto-Detection Summary dialog box to 
select the appropriate level of calibration to be performed. You may perform a new 
calibration, reuse existing calibration data, or perform measurements without calibration.

3. Setting up the TDR Calibration and Measurement Settings.

This step uses the Setup TDR dialog box to display the default TDR calibration and 
measurement settings, based on the PLTS hardware recognized by the software. You may 
modify these default TDR calibration and measurement settings as required.

4. Selecting the calibration and measurement parameters.

This step uses the Select Calibration and Measurement Parameters dialog box to allow you 
to select the parameters that will be measured. A calibration will be performed only where 
required for selected parameters.
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When you selected New Measurement and then clicked the Next > button described on 
page 186, the Hardware Auto-Detection Summary dialog box is displayed. See Figure 6-2.

Figure 6-2 Hardware Auto-Detection Summary Dialog Box

To Verify the Software Recognizes the PLTS Hardware

On the left portion of the Hardware Auto-Detection Summary dialog box, the model number, 
the GPIB address, the serial number, and the firmware revision for the TDR mainframe is 
displayed. In addition, the model numbers and serial numbers for the left side and right side 
modules are also displayed. This is the test equipment that the software finds connected to 
the GPIB bus. 

If this information is incorrect, check your hardware connections and power status, then 
select the Re-Scan button. The software re-checks for the presence of hardware on the GPIB.
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NOTE If you have multiple PLTS systems on the GPIB and you want to select the 
other equipment, click the Select New Device button. The Select 
Measurement System dialog box is displayed. See Figure 6-3. To choose another 
PLTS system, you may select from the available PLTS systems and then click 
the OK button. The software makes the change and returns to the Startup 
Wizard Welcome Screen of Figure 6-1.

Figure 6-3 Select Measurement System Dialog Box

The Cancel button exits without saving a change and returns to the Startup 
Wizard Welcome Screen.

To Select the Appropriate Level of Calibration

On the right portion of the Hardware Auto-Detection Summary dialog box (Figure 6-2), select 
your calibration strategy:

• Perform a new calibration continues with the Startup Wizard performing a new 
calibration before making a measurement.

• Load existing calibration data allows you to select a previously saved calibration 
(*.cal) file to be used for the new measurement. See Chapter 7, “Performing Error Correc-
tion on the TDR-Based PLTS,” for guidance on calibration intervals, etc.

• None. Collect measurement data uncalibrated allows you skip the calibration, select 
measurement parameters (see Figure 6-4 on page 190), and then proceed directly to the 
measurement screen. This option is not recommended for qualitative data collection.

Select the Perform a new calibration choice for this example exercise and then click the 
Next > button.
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To Set Up the TDR

The Setup TDR wizard screen is displayed. See Figure 6-4. This screen allows you to set the 
TDR parameters for the calibration and measurement. Each of these parameters is described 
in Table 6-2, “TDR Parameter Descriptions.”

Figure 6-4 Setup TDR Dialog Box

This wizard screen is initially displayed with default values for each entry. You may accept or 
modify these values. Modifying some of these values directly may also modify other associated 
values interactively. For example, when changing the Effective Dielectric Constant, the 
Relative Velocity Factor will change appropriately. 

The Reset Values button returns all selections and values to their default value.

When the Setup TDR dialog box values are correct, click the Next > button to continue.
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Table 6-2 TDR Parameter Descriptions

Parameter Description

Maximum Time 
Base

Sets the desired measurement range in nanoseconds.

Minimum Rise 
Time

Sets the rise time of normalized measurements in picoseconds. This is a 
function of normalization and is available to only the Agilent 86100-based 
TDR system.

Sampler 
Bandwidth

Sets the Agilent 86100-based TDR system receiver to either a 18.0 GHz 
bandwidth (which gives the highest fidelity and the fastest response time) or 
a 12.4 GHz bandwidth (which gives the best sensitivity by reducing the 
noise). This bandwidth is set at 20 GHz for other TDR systems.

Points/Waveform Sets the number of points for a waveform. Select Automatic or Manual. 
Automatic allows the TDR to select the record length for the input 
waveform. The TDR selects a record length that optimizes the amount of 
acquired data and the display update rate. This is available to only the 
Agilent 86100-based TDR system.
Manual allows you to define a record length from a list of points.
Record Length allows you to select the number of points from a list. 
Depending on the TDR system, the number of points are either: 
− 16, 32, 64, 128, 256, 512, 1024, 2048, and 4096 -or-
− 20, 50, 100, 250, 500, 1000, 2000, and 4000

Averaging Enable turn the trace averaging on and off. 
Number of Averages sets the number of sweeps to be averaged. 
Best Throughput allows you to view the waveform as it is acquired. The 
TDR displays any noise and feed through error on the signal. It has a faster 
measurement time. This is available to only the Agilent 86100-based TDR 
system.
Best Flatness turns on the feed through compensation circuit which reduces 
the amount of feed through error. It has a slower measurement time. This is 
available to only the Agilent 86100-based TDR system.

Effective 
Dielectric 
Constant

Specifies the dielectric constant for your transmission medium.

Relative Velocity 
Factor

Specifies the relative velocity for your transmission medium.
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To Select the Calibration and Measurement Parameters

The Select Calibration and Measurement Parameters dialog box is displayed. See Figure 6-5. 
The left side of the dialog box lists all 16 of the single-ended measurements that the TDR 
system can make. The right side of the dialog box lists all 16 of the differential measurements 
that the TDR system can make.

NOTE If you are using equipment other than the prescribed Agilent and Tektronix 
equipment, a subset of the these measurements may be displayed as active 
while other measurements may be inactive (grayed).

Figure 6-5 Select Calibration and Measurement Parameters Dialog Box

The default status for each of these measurements is selected. When a measurement is 
selected, it has a check in the check box for the corresponding measurement. However, you 
may not need or desire data for all 32 parameters (16 single-ended and 16 differential 
parameters). As a general rule, the more parameters that you select, the longer the 
calibration and the measurement takes to perform. 

Table 6-3, Approximate Calibration Times for Single Ended Parameters and Table 6-4, 
Approximate Calibration Times for Differential Parameters provide a guide for estimating 
Chapter 6192



Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
Performing the Initial Setup
calibration times for each selected parameter. Module calibration times are not listed.

Table 6-3 Approximate Calibration Times for Single Ended Parameters

Standards Thrus
Approximate Cal Time 
per column (in min:sec): 
Ref Plane Cal Only: 0:20
Norm + Ref Plane Cal: 1:00

Approximate Cal Timea 
per column (in min:sec): 
Ref Plane Cal Only: 0:40
Norm + Ref Plane Cal: 1:00

a. If the calibration for a parameter is performed, no additional calibration or time is required for any other 
parameters listed within that column. For example, if you performed the Port 1-2 Thru calibration for T12, 
selecting T21 does not require an additional calibration and the calibration time remains the same.

Port1 Port2 Port3 Port4 Port 
1−2

Port 
1−3

Port 
1−4

Port 
2−3

Port 
2−4

Port 
3−4

T11 X
T12 X

T13 X

T14 X
T21 X

T22 X

T23 X
T24 X

T31 X

T32 X
T33 X

T34 X

T41 X
T42 X

T43 X

T44 X
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Leave all of the parameters selected for this example exercise and then click the Next > 
button.

Table 6-4 Approximate Calibration Times for Differential Parameters

Standards Thrus

Approximate Cal Timea

per column (in min:sec): 
Ref Plane Cal Only: 0:20
Norm + Ref Plane Cal: 1:00

a. If the calibration for a parameter is performed, no additional calibration or time is required for any other 
parameters listed within that column. For example, if you performed the Port 1 standards calibration for 
TDD11, selecting TCD11 does not require an additional calibration and the calibration time remains the 
same.

Approximate Cal Timea 
per column (in min:sec): 
Ref Plane Cal Only: 0:40
Norm + Ref Plane Cal: 1:00

Left Module Right Module

Ports 1−3 & 2−4Differ
-ential

Mode Cal

Common 
Mode Cal

Differ
-ential

Mode Cal

Common 
Mode Cal

TDD11 X
TDD12 X

TDD21 X

TDD22 X
TDC11 X

TDC12 X

TDC21 X
TDC22 X

TCD11 X

TCD12 X
TCD21 X

TCD22 X

TCC11 X
TCC12 X

TCC21 X

TCC22 X
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Performing a Calibration
The PLTS software adds value and capability to both Agilent and Tektronix TDR systems by 
automating the calibration process which saves time, reduces the chance of calibration errors, 
eliminates tedious procedures, and improves the calibration results. The PLTS calibration 
process includes:

1. Selecting a calibration kit and defining the calibration file name.

This step uses the Select Calibration Kit and Filename dialog box to select the calibration 
standards and connectors that are used during the calibration process. The file name that 
the calibration information is saved to is also defined.

2. Defining a calibration kit.

This optional step allows you to define a calibration kit if none of the pre-defined 
calibration kits does not match your calibration needs.

3. Choosing the calibration type.

This step uses the Calibrate TDR and Modules wizard window to define the type of TDR 
calibration that will be performed, either a Reference Plane Calibration Only or a 
Normalization and Reference Plane Calibration.

4. Performing the module calibration.

This step uses the Calibrate TDR and Modules wizard window to perform the module 
calibration.

5. Connecting the calibration standards.

This step uses the Calibrate TDR and Modules wizard window to perform the standards 
calibrations, either the Reference Plane Calibration Only or the Normalization and 
Reference Plane Calibration.

Once the Next > button in the Select Calibration and Measurement Parameters dialog box is 
selected, the Select Calibration Kit and Filename wizard screen is displayed. See Figure 6-6.

Start the calibration:
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To Select a Calibration Kit and Define the Calibration File Name

The PLTS software has five default TDR calibration kits and their information stored in it. 

1. Select the calibration kit to use for the TDR calibration from the 1. Select the 
calibration kit to use: list of the Select Calibration Kit and Filename wizard screen.

PLTS is shipped with several calibration kits already defined for the TDR calibration. All 
of these calibration kits are listed in the 1. Select the calibration kit to use: list. PLTS 
is set to the Default 3.5mm selection.

Figure 6-6 Select Calibration Kit and Filename Wizard Screen

The 1. Select the calibration kit to use: list area displays each of the defined 

Table 6-5 Pre-Defined TDR Calibration Kits

Name Description

85052D-M 85052D male cal kit
85052D-F 85052D female cal kit
Default SMA TDR cal kit with female SMA thru
Default_3.5mm TDR cal kit with 3.5mm Connector Saver
N1020A-K05 N1020A TDR Probe cal kit
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calibration kits and its description. When the More >> button is selected, the list area also 
displays the thru configuration, the minimum frequency, the maximum frequency, and the 
calibration kit connector type as shown in Figure 6-7. The button label toggles between 
More >> and << Less.

Figure 6-7 Calibration Kit List with More >> Selected

If the calibration kits listed in the 1. Select the calibration kit to use: list area do not 
match your calibration kit, you may define a new calibration kit to meet your 
requirements. Refer to “To Define a Calibration Kit” on page 199.

2. In the 2. Specify calibration file to create/modify: text box of the Select Calibration 
Kit and Filename wizard screen, specify the file that you will use to save the calibration 
data.

The text box displays a default calibration file name based on the current date. It uses the 
string “TDRcal_” followed by the current date. In this example, “TDRcal_21Sep03” is 
displayed. 

You may enter another file name if you like. The calibration will be saved to the calibration 
directory. If you installed PLTS to the default C:/ directory, you may follow this path to the 
calibration directory: C:/Program Files/Agilent/PLTS/calibration

If you want to overwrite a previously saved calibration file, you may select the Load… 
button to display the TDR Calibration Files Found dialog box. This dialog box displays 
each TDR calibration file that has been saved in the Existing Calibration Files list. See 
Figure 6-8.
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Figure 6-8 TDR Calibration Files Found Dialog Box

You may review the calibration data that is saved in a calibration file by selecting a file in 
the Existing Calibration Files list. When a file is selected, its calibration information is 
displayed in the Selected Calibration File Information area as shown in Figure 6-9.

Figure 6-9 TDR Calibration Files Found Dialog Box with Calibration 
Information Displayed

Calibration files may be deleted by selecting the calibration kit in the Existing 
Calibration Files list and then selecting the Delete Cal File button.

NOTE Normalization files are stored on the Agilent 86100 DCA mainframe drive.
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Click the OK button to return to the Select Calibration Kit and Filename wizard screen. 

3. When the calibration kit is selected and the calibration file name is defined, click the 
Next > button to continue with the calibration.

For this example, we left the selected calibration kit set to the Default 3.5mm selection 
and the default calibration file name.

To Define a Calibration Kit 

If none of the previously defined calibration kits in the 1. Select the calibration kit to use: 
list meets your requirements, you can define your calibration kit. To define a calibration kit:

1. Exit the startup wizard by clicking the close button in the upper right corner of the wizard: 

2. From the Utilities menu, select the TDR System Model (in this case, 
86100A|54754A|54754A), the click Edit Cal Kits as shown in Figure 6-10.

Figure 6-10 Selecting Edit Cal Kits

3. In the Select Cal Kit dialog box, make sure 4-Channel TDR is selected in the Select 
Calibration Type list, then select the USER_DEF selection and click Edit to start the 
process. See Figure 6-11.

Figure 6-11 Select Cal Kit Dialog Box
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4. The calibration kit definition is performed in the Edit TDR Calibration Kit dialog box 
shown in Figure 6-12. Enter Cal Kit ID and Name into the appropriate entry boxes in the 
header.

The Cal Kit ID is listed in the Cal Kit column and Name is listed in the Description 
column of the calibration kit selection window shown in Figure 6-6.

Figure 6-12 Blank Edit TDR Calibration Kit Dialog Box

5. Also enter Connector Type along with the minimum (Min. Freq. MHz) and the 
maximum (Max. Freq. MHz) frequencies in megahertz. 

The software compares the minimum and maximum frequency entries against the 
measurement setup frequencies when determining which calibration kits to make 
available for selection for the calibration as in Figure 6-6.

6. Enter the delay values for the open and short standards Open Delay and Short Delay 
entry boxes.

Enter the delay values in picoseconds. The value may be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

Typically, if you are using an un-terminated connector or cable as the open, you may enter 
“0” (zero) ps as the value for the open.
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Figure 6-13 Completed Edit TDR Calibration Kit Dialog Box

7. Enter the delay value (in picoseconds) of the thru in the Thru Delay entry box. Then, in 
the list of thrus, select the box at the left of the thru and click the Add button to associate 
the thru to the entered delay value. Repeat this until all six thru paths are completed.

The color of the box at the left of the thru changes from red to green as the thru path is 
completed. Figure 6-13 shows the data that is used in this example. Be sure to enter a 
delay value for all six thru paths.

If your thru is part of an Agilent (or Hewlett-Packard) calibration kit, the delay value is 
listed in the Standard Definitions section of the calibration kit documentation.

The Remove button disassociates the delay value with the thru path allowing you to 
change the delay value for the path.

All or the thru paths may use the same delay value or you may have multiple thru delay 
values if you are using a thru having a different delay. One instance of using more than 
one delay value might be when you are creating a calibration kit definition for probing and 
not all of the thru paths would use the same thru.

8. After the Edit TDR Calibration Kit dialog box is complete, click the OK button to save the 
calibration kit with the new information and return to the Select Cal Kit dialog box shown 
in displaying the newly defined calibration kit in the list. Cancel deletes the information 
entered and returns to the Select Cal Kit dialog box.
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9. Then click the Close button to close the Select Calibration Kit dialog box.

Figure 6-14 Select Cal Kit Dialog Box with Newly Defined Cal Kit

Return to the Startup Wizard by selecting New from the File menu to make your 
measurement. Refer back to “Starting the Startup Wizard” on page 186.

To Choose the Calibration Type

After selecting the calibration kit, verifying the data file, and selecting the Next > button, the 
Calibrate TDR and Modules wizard window is displayed. See Figure 6-15. This wizard 
window is used for the entire calibration.

Figure 6-15 Calibrate TDR and Modules Wizard Screen: Initial Display
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However, to select the calibration type, you will only use the 1. Choose Cal. Type area which 
is labeled “1” in Figure 6-15. This area is shown in Figure 6-16. The 1. Choose Cal. Type 
area allows you to select between the two calibration types listed.

Figure 6-16 1. Choose Cal. Type Area

The Ref. Plane Calibration Only selection:
• Is available to all compatible TDR systems
• Sets the reference plane at the end of the cables
• Automatically de-skews the cables when differential measurements are selected
• Positions the trace on the display for easy viewing such that the step is one-half of a 

division from the left edge of the display and displays the complete maximum time base 
value to the right of the step

• Recommends the module calibration

The Normalization & Ref. Plane Calibration selection:
• Is the most complete and accurate calibration
• Removes errors, such as cable loss, mismatch, and reflections
• Has all of the features as the reference plane calibration, except the following:

— Is available only to the Agilent 86100-based TDR system using the 86100’s built-in 
normalization feature

— Requires the module calibration

Choose the Calibration Type

1. In the 1. Choose Cal. Type area (see Figure 6-16), select either Ref. Plane Calibration 
Only or Normalization & Ref. Plane Calibration.

To Perform a Module Calibration

The module calibration, also called the vertical channel calibration, calibrates the gains, 
offsets, and timing for each channel. This calibration is valid for all supported TDR systems.

The module calibration is not always a requirement. The 2. Module Cal. area (see Figure 
6-17) has a text box that indicates the status of the module calibration. It displays: 
REQUIRED, RECOMMENDED, or VALID
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Figure 6-17 2. Module Cal. Area

The module calibration is not required if you selected if you selected Ref. Plane Calibration 
Only in the 1. Choose Cal. Type area. However, it is recommended.

Once a module calibration is performed, it remains valid for ten hours, unless:
• the instrument power has been cycled
• the module has been removed and then reinserted.
• the ambient temperature changes more than 5°C since the last module calibration

There are two icons which represent the two modules, the icon labeled “L” representing the 
left module (channels 1 and 2) and the icon labeled “R” representing the right module 
(channels 3 and 4). The color of the module calibration icon shows the status of the module 
calibration. 

If an icon is:
• Red, the module calibration is required.
• Yellow, the module calibration is recommended.
• Green, the module calibration is valid.

The Resistance Value text box allows you to enter the resistance value of your load. The 
default value is 50 ohms.

Perform the Module Calibration

1. Enter the resistance value of your load in the Resistance Value text box if it varies from 
the current value.

2. Click the left module’s “L” icon to start the module calibration. 

3. Follow the PLTS software prompts to perform the module calibration for the left module. 
Figure 6-18 shows the first prompt that is displayed.
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Figure 6-18 First Module Calibration Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.

The module calibration gives you five prompts. The left module calibration prompts are:
i.  Disconnect everything from the left module
ii. Connect a 50 ohm load to Channel 1 at the reference plane
iii. Connect a 50 ohm load to Channel 2 at the reference plane 

(Note: You may use the load that was on channel 1 or you may use another load.)
iv. Disconnect everything from the left module
v. Done Re-connect test port Cables to Ports 1 and 2

When the module calibration is complete, the left module icon color changes to green.

4. Repeat steps 2 and 3 to perform the module calibration for the right module using the icon 
labeled “R”.

Once the right module calibration is complete, the color of both icons has changed to green. 
Also the text box which displayed either REQUIRED or RECOMMEDED, now has 
changed to VALID.

To Connect the Calibration Standards

Both calibration types (Ref. Plane Calibration Only and Normalization & Ref. Plane 
Calibration) require that the standards be connected to perform the calibration. After the 
calibration type is chosen and all required module calibrations are complete, the calibration 
icons are displayed in the 3. Connect Cal. Standards area of the Calibrate TDR and 
Modules wizard screen shown in Figure 6-19.

The calibration first calibrates the reference plane, setting the reference plane at the end of 
the cables. Then the calibration automatically de-skews the cables if differential 
measurements are selected. If the Normalization & Ref. Plane Calibration type is 
selected, then the normalization is performed which removes errors such as, cable loss, 
mismatch, and reflections.
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NOTE Automatic De-Skewing

Unmatched cables and differences in the path of the TDR module cause skew in 
differential and common signals. Skew must be removed to provide accurate 
differential measurements. De-skewing is required for TDR and TDT 
measurements. PLTS performs this tedious, error-prone task automatically and 
correctly. PLTS can remove skew of up to 780 ps in the Agilent TDR system and 
of up to 340 ps in the Tektronix TDR systems.

PLTS removes the TDR skew by measuring the amount of skew, and then 
adding 1/2 of the amount to the appropriate channel. PLTS then repeats the 
process, iteratively adjusting the channels until the rest of the skew is removed 
and the signals arrive at the input of the DUT at exactly the same time.

After TDR is de-skewed, Channel 1 is connected to channel 3 while channel 2 is 
connected to channel 4 using thrus. The time difference is measured in the two 
TDT signal paths and de-skewing is applied to the appropriate channel 
correcting the TDT response.

This section guides you through performing the calibrations for both calibration types. Both 
types are divided into two calibrations:

•  Single-Ended, Differential-Mode, and Common-Mode Calibration
•  Thru Path Calibration

Figure 6-19 Calibrate TDR and Modules Wizard Screen
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Figure 6-19 shows the Calibrate TDR and Modules wizard screen when all calibration and 
measurement parameters selected. The 3. Connect Cal Standards area displays several 
icons. All available icons are displayed in this illustration. 

Both modules in Figure 6-19 are shown with four icons. Two of these four icons are the same. 
There are only three unique icons: 

The icon labeled “1” is the single-ended icon. This icon is displayed twice in each module; once 
for each TDR channel. The icon labeled “2” is the differential-mode icon. It is displayed in each 
module. The icon labeled “3” is the common-mode icon. It is also displayed in each module.

Some of these icons may not be displayed when you are performing a calibration. The icons 
that are displayed depend on the calibration and measurement parameters that are selected 
during the initial setup in “To Select the Calibration and Measurement Parameters” on 
page 192. Table 6-6 shows when each of these icons are displayed and which calibrations are 
required based on the selected parameters. 

The color of the icons displayed in the 3. Connect Cal Standards area is red if the 
calibration has not performed. While the calibration is being performed, the icon color is blue. 
When the calibration is complete, the icon color turns to green.

The calibration also requires a calibration between the ends of the TDR channel cables. These 
calibrations are called Thru Path calibrations because a “thru” connector is used to connect 
the ends of the cables. Refer to Table 6-7 for an illustration showing each of the six thru path 
icons representing the each thru path between the four channels.

Some of these thru path icons may not be displayed when you are performing a calibration. As 
with the single-ended, differential-mode, and common-mode icons shown above, the icons that 
are displayed depend on the calibration and measurement parameters that are selected 

Table 6-6 Single Ended, Differential-Mode, and Common-Mode Calibration Parameters

Icon Definition Selected Parameters that Display Icon

Single-Ended T11, T22, T33, and T44: All single-ended TDR parameters 
(T11: icon on Channel 1, T22: icon on Channel 2, 
T33: icon on Channel 3, T44: icon on Channel 4)

Differential 
Mode

TDD11, TCD11, TDD22, TCD22: All differential TDR parameters 
having a differential stimulus (TDD11 and TCD11: icon on module 1, 
TDD22, TCD22: icon on module 2.

Common 
Mode

TDC11, TCC11, TDC22, TCC22: All differential TDR parameters 
having a common stimulus (TDC11 and TCC11: icon on module 1, 
TDC22, TCC22: icon on module 2.
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during the initial setup in “To Select the Calibration and Measurement Parameters” on 
page 192. Table 6-7 also shows when each of these icons are displayed and which calibrations 
are required based on the selected parameters. 

Perform the Single-Ended, Differential-Mode, and Common-Mode Calibrations

This section guides you through performing the Single-Ended, Differential-Mode, and 
Common-Mode Calibrations for both calibration type selections (Ref. Plane Calibration 
Only and Norm & Ref. Plane Calibration).

Selecting an icon in the 3. Connect Cal Standards area starts the calibration. The order 
that the calibration is performed is completely arbitrary. You may select the icons in any 
order.

In this example, we will be calibrating all of the icons. See Figure 6-19 for an illustration. The 
left module is calibrated first. The right module is calibrated next.

1. Select the single-ended icon  at Channel 1 to display the prompt box that reads: Leave 
open Channel 1 at the reference plane

The prompt box is displayed in Figure 6-20. These prompts are used throughout the TDR 
calibration.

Table 6-7 Thru Paths Required by the Parameters Selected

Thru Paths Icons 
Displayed on Wizard

Thru 
Paths

Single Ended 
Parameters

Differential Parameters

1 − 2 T12 and T21 N/A

1 − 3 T13 and T31 TXX12 or TXX21, where XX is DD, 
DC, CD, or CCa

a. When a differential parameter warrants the thru path calibration on either thru path 1 − 3 
or 2 − 4, the calibration of the other thru path is required and is performed at the same time.

1 − 4 T14 and T41 N/A

2 − 3 T23 and T32 N/A

2 − 4 T24 and T42 TXX12 or TXX21, where XX is DD, 

DC, CD, or CCa

3 − 4 T34 and T43 N/A
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Figure 6-20 Single-ended Calibration Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.

2. Make sure that nothing is connected to the end of the Channel 1 cable and click the OK 
button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are two additional calibration 
prompts to follow. These prompts are:

i. Connect a short to Channel 1 at the reference plane
ii. Connect a 50 ohm load to Channel 1 at the reference plane

The calibration is complete when the single-ended icon color changes to green.

3. Repeat steps 1 and 2 for the single-ended icon  at Channel 2.

4. Select the differential-mode icon  of the left module to display the prompt box that 
reads: Leave open Channels 1 and 2 at the reference plane

5. Make sure that nothing is connected to the end of the Channel 1 and Channel 2 cables and 
click the OK button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are four additional calibration 
prompts to follow. These prompts are:

i. Connect shorts to Channels 1 and 2 at the reference plane
ii. Remove short from Channel 1 at the reference plane
iii. Connect a 50 ohm load to Channel 1 at the reference plan
iv. Replace short on Channel 2 with a 50 ohm load

The calibration is complete when the differential-mode icon color changes to green.

6. Select the common-mode icon  of the left module to display the prompt box that reads: 
Leave open Channels 1 and 2 at the reference plane
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7. Make sure that nothing is connected to the end of the Channel 1 and Channel 2 cables and 
click the OK button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are four additional calibration 
prompts to follow. These prompts are:

i. Connect a short to Channel 1 at the reference plane
ii. Connect a 50 ohm load to Channel 1 at the reference plane
iii. Connect a short to Channel 2 at the reference plane
iv. Connect a 50 ohm load to Channel 2 at the reference plane

The calibration is complete when the common-mode icon color changes to green.

With all of the left module calibrations complete, the right module is calibrated next.

8. Repeat steps 1 through 7 for Channel 3 and Channel 4 on the right module.

With all of the right module calibrations complete, perform the thru path calibration next.

Perform the Thru Path Calibration

This section guides you through performing the thru path calibrations for both calibration 
type selections (Ref. Plane Calibration Only and Norm & Ref. Plane Calibration).

Selecting an icon in the 3. Connect Cal Standards area starts the calibration. The order 
that the calibration is performed is completely arbitrary. You may select the icons in any 
order. However, for this example, start with step 1.

1. Select the thru path icon between Channel 1 and Channel 2 (see Table 6-7, if necessary) 
and follow the PLTS software prompts to perform the thru path calibration between these 
channels. Figure 6-21 shows the prompt that is displayed.

Figure 6-21 Channel 1 - Channel 2 Thru Path Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.

The calibration is complete when the thru path icon color changes to green.
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2. Select the thru path icon between Channel 1 and Channel 3.

Depending on the selected parameters, the prompt box message can vary as shown in 
Figure 6-22 when the thru icon between channels 1 and 3 (or between channels 2 and 4) is 
selected. 

Figure 6-22 Channel 1 - Channel 3 Thru Path Prompts

3. Using thru connectors, make the cable connections indicated by the prompt and select the 
OK button to calibrate.

The calibration is complete when the thru path icon colors change to green.

4. Repeat step 1 for the remaining uncalibrated thru paths.

You may repeat any portion of this calibration by clicking the icon and following the 
prompt that is displayed.

5. When the calibration is complete and the color of all of the icons have changed to green, 
click the Calibrate TDR and Modules wizard screens Next > button to complete the 
calibration. Continue at “Making a Measurement” on page 212.
Chapter 6 211



Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
Making a Measurement
Making a Measurement
The Measurement process includes:

1. Connecting the DUT

This step shows you how to connect your DUT to the PLTS.

2. Selecting the initial displayed format of the measurement

This step guides you through selecting which of the ten analysis formats that the 
upcoming measurement will initially be displayed in. The measurement can be displayed 
in any of the 10 formats initially as well as later.

3. Modifying the measurement stimulus and measured parameters

This optional step allows you to make last minute changes to the measurement 
parameters and the list of parameters to be measured. The caveat is only changes that will 
not require a recalibration may be made.

4. Running the measurement

This step guides you through starting the measurement and displaying the data when the 
measurement is complete. It also directs you to save the measurement and points you to 
the chapters that will assist in your data analysis.

To Connect the DUT

1. After saving the calibration data and selecting the Next > button, the Device connection 
scheme for TDR calibrations window is displayed. See Figure 6-23. This wizard window 
shows how to connect your DUT to the TDR system to make the measurement. Connect 
the DUT to the TDR system as shown and then click the Next > button.
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Figure 6-23 Connecting the DUT to the TDR System

To Select the Initial Displayed Format of the Measurement

1. The Hardware and Calibration Setup Wizard Complete window is displayed. See Figure 
6-24. 

This window is the software location to select the one of ten analysis formats that the 
measurement will be displayed as initially. The analysis formats are:

For the purpose of this example, the Time Domain (Differential) format icon is selected.

• Time Domain (Differential)

• Frequency Domain (Balanced)

• Eye Diagram (Differential)

• RLCG (Differential)

• RLCG (W-Element)

• Time Domain (Single-Ended)

• Frequency Domain (Single-Ended)

• Eye Diagram (Single-Ended)

• RLCG (Common)

• RLCG (Self/Mutual)
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Figure 6-24 Hardware and Calibration Setup Wizard Complete

To Modify the Measurement Stimulus and Measured Parameters

1. The Modify Measurement Stimulus button opens the Measurement Stimulus dialog 
box. See Figure 6-25. This dialog box allows you to change the many of the measurement 
stimulus settings that you set up previously.

Settings that would require a recalibration are not active and may not be changed in this 
dialog box. To change the stimulus settings that are inactive, you must click the < Back 
button until you get back to the window described in “To Set Up the TDR” on page 190.

Figure 6-25 Measurement Stimulus Dialog Box

For the purpose of this example, leave the settings unchanged and click the OK button.
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The Reset Values button resets any active values (any values that can be changed 
without requiring a recalibration) to their original default values prior to being changed in 
“To Set Up the TDR”. 

The Cancel button resets any changes that were made after opening this dialog box.

NOTE After the measurement has been made, you may verify these changes were 
made by printing a characterization report. See “Characterization Report 
Generator” on page 389 for help.

2. Once you exit the Measurement Stimulus dialog box, the Select Measurement Parameters 
dialog box is displayed. See Figure 6-26. The left side of the dialog box lists all 16 of the 
TDR single-ended measurements. As with the dialog box described in “To Select the 
Calibration and Measurement Parameters” on page 192, the right side of the dialog box 
lists all 16 of the TDR differential measurements. Only the parameters for which the 
calibration is valid are active. You may select all of the active parameters or you may select 
a subset of these parameters. Selecting a subset of the parameters may save you some 
measurement time.

Figure 6-26 Select Measurement Parameters Dialog Box

To measure parameters that are inactive, you must click the < Back button until you get 
back to the window shown in To Select the Calibration and Measurement Parameters and 
reselect the parameters. However, note that if you change the parameters in this window, 
you may be required to perform additional portions of the calibration. 

For the purpose of this example, leave the parameters unchanged and click the OK button.

3. With the Hardware and Calibration Setup Wizard Complete window is displayed (see 
Figure 6-24), select the Next > button to start the measurement.
Chapter 6 215



Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
Making a Measurement
To Run the Measurement

1. The software displays the wizard’s Measurement & Post-Processing Status window and 
starts the measurement and the measurement post-processing. See Figure 6-27. The 
software makes each of the measurements. The status of the measurements and the 
post-processing is displayed in the status text area. The status is may also be observed by 
watching the status bar at the right edge of the text area. As the measurements and the 
post-processing proceed, the color of the bar gradually changes to blue.

Once the post-processing is complete, click the Next > button to display the measurement 
results in the main PLTS window.

Figure 6-27 Measurement & Post-Processing Status Window
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Analyzing the Measurement Results

Now that you have measured the device under test, its measurement results are displayed the 
main PLTS window as shown in Figure 6-28. This shows the results in the Time Domain 
(Differential) format, the analysis format selected earlier.

Figure 6-28 Displayed Measurement in Time Domain (Differential) Format

Now that the measurement has been made, the main Physical Layer Test System (PLTS) 
window gives you the flexibility to perform analysis on the measured data in a variety of 
ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.Refer to Chapter 7, “Analyzing Data in the Frequency Domain,” on 
page 221 for information.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 8, “Analyzing Data in the Time Domain,” on 
page 241 for information.
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• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 9, “Analyzing Data using Eye Diagrams,” on 
page 279 for information.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes. Refer to Chapter 10, “Analyzing 
Transmission Line Parameters,” on page 297 for information.

However, to ensure the measurement data is not lost, you may want to first save the 
measurement data by selecting Save from the File menu. See “Save” on page 419.
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Part III provides detailed information about optimizing and analyzing the measured data 
using the physical layer test system.

Chapter 7, “Analyzing Data in the Frequency Domain”

Provides information about analyzing measured data in the frequency domain.

Chapter 8, “Analyzing Data in the Time Domain”

Provides information about analyzing measured data in the time domain.

Chapter 9, “Analyzing Data using Eye Diagrams”

Provides information about analyzing measured data using the Eye diagram.

Chapter 10, “Analyzing Transmission Line Parameters”

Provides information about extracting transmission line R, L, C, G parameters 
from the measured data.

Chapter 11, “Importing and Exporting Data”

Provides information about importing data files into PLTS and exporting 
measured data for use with other software packages, such as TDA IConnecta 
MeasureXtractorb, Avanti HSPICE, or Agilent ADS.

a. IConnect is a registered trademark of TDA Systems, Inc.
b. MeasureXtractor is a trademark of TDA Systems, Inc.

Chapter 12, “Removing Unwanted Effects from the Measurement”

Provides information about using measurement enhancement features such as 
gating, phase skew, and de-embedding. 

Chapter 13, “Using Analysis Tools and Utilities”

Provides information about using the PLTS tools, such as markers, trace math, 
overlaying traces, zooming, and report generator and the file converter utility.
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Analyzing Data in the Frequency Domain
Physical layer test systems combine a vector network analyzer and a test set to make 
measurements by sweeping a signal in the frequency domain. The test system software can 
then mathematically transform these frequency domain measurements into other analysis 
types such as time domain, eye diagrams, and transmission line (RLCG). However, there is 
information to be gained from frequency domain measurements that these other analysis 
types do not provide.

Frequency measurements can help you verify and validate your modeling and simulation 
procedures by providing:

• vector error-corrected data which allows you to de-embed fixtures and signal launches.

• more accurate simulation for frequency dependent effects, such as bandwidth and 
impedance.

• insight into common analog problems, such as crosstalk, reflections, and loss.

• better information more efficiently when you are analyzing the effects of transmission 
lines, studying power/ground distribution, and investigating EMI effects as a function of 
frequency.

• S-parameter data which can be used over the widest range of applications and frequency 
bandwidths.
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About S-Parameters
At high frequencies, S-parameters (scattering parameters) are commonly used to describe the 
performance of microwave and RF devices. These parameters can be used to completely 
describe the electrical behavior of the device (or network). For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. While S-parameter data is formatted differently than TDR/TDT data, the 
underlying information is the same. 

S-parameters relate to familiar measurements such as reflection coefficient (input/output 
match), and transmission coefficient (gain or loss, and isolation). They are the shared 
language between simulation and measurement and are easily imported into 
electronic-design automation (EDA) tools like HSPICE, ADS, and other simulators.

Conventional single-ended parameters describe the performance of a single-ended device 
when it is stimulated on a single port, and the corresponding responses are observed on all of 
the ports. For a detailed explanation, refer to “Single-Ended (Unbalanced) S-Parameters” on 
page 224. Mixed-mode (or balanced) S-parameters describe the performance of devices with 
balanced ports. For a detailed explanation, refer to “Mixed Mode (Balanced) S-Parameters” on 
page 226.

Common Frequency Measurements with S-Parameters

Reflection Measurements Transmission Measurements

Return Loss Insertion loss

Standing Wave Ratio (SWR) Gain/loss

Reflection coefficient Transmission coefficient

Impedance Electrical delay

Sxx (x = stimulus port and response port) Syz (z = stimulus port, y = response port)
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How to Interpret S-Parameters
A multi-terminal device can be viewed in different ways, depending on how it is meant to be 
operated. For a device that is designed to be a single-ended four-port device, its conventional 
(single-ended) four-port S-parameters can be measured and displayed. In a balanced device, 
two terminals constitute a single balanced port. Each balanced port will support both a 
common-mode and a differential-mode signal. This performance is described using 
mixed-mode (balanced) S-parameters.

Single-Ended (Unbalanced) S-Parameters

Conventional single-ended S-parameters are defined as the ratio of two normalized power 
waves (response/stimulus), defined in terms of the voltages and current at each port of a 
device (see Figure 7-2).

S-parameter notation identifies these quantities using the following convention:

SAB

where:

The first number (represented by A) refers to the test-device port where the signal is 
received. This received signal is referred to as the response.
- and -
The second number (represented by B) refers to the test-device port where the signal is 
sourced. This signal is referred to as the stimulus.

Figure 7-1 S-Parameter Notation
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Figure 7-2 Single-Ended S-Parameter Review

Figure 7-3 shows the naming convention for a single-ended 4-port S-matrix, showing the ratio 
of all possible combinations of response/stimulus.

Figure 7-3 Single-Ended S-Matrix
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Mixed Mode (Balanced) S-Parameters

Mixed-mode S-parameters are used to describe the performance of balanced circuits by 
independently considering each mode of operation. The mixed-mode S-parameter concept is 
similar to conventional S-parameter definitions, except that instead of stimulating a single 
terminal of the DUT, we consider pairs of terminals to be stimulated in either a differential 
(anti-phase) or a common (in-phase) mode. 

For a balanced device, we are not necessarily interested in voltages and current referenced to 
ground. Instead, we can define differential and common mode voltages and currents on each 
balanced port. Likewise, we can also define differential-mode and common-mode impedances.

We can define normalized power waves on the ports of a balanced device having the exact 
same form as the single-ended case. Only the definitions of “voltage” and “current” are 
changed. Both are defined as ratios of normalized power waves.

Figure 7-4 Mixed Mode S-Parameter Basics
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The naming convention for mixed-mode S-parameters includes mode information as well as 
port information. Unlike the single-ended example, though, in the mixed-mode S-matrix, we 
are not only considering the port, but we are also considering the mode of the signal at each 
port. Therefore, the first two subscripts describe the mode of the response and stimulus, 
respectively, and the next two subscripts describe the ports of the response and stimulus.

Again we can take the ratio of all possible combinations of response over stimulus for the 
differential and common mode normalized power waves to calculate the mixed-mode 
S-parameters. The mixed-mode matrix fully describes the linear performance of a balanced 
two-port measurement. Figure 7-5 shows the naming convention for a mixed mode S-matrix, 
showing the ratio of all possible combinations of response/stimulus.

Figure 7-5 Mixed-Mode (Balanced) S-Matrix
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Viewing Data in the Frequency Domain
This section guides you with opening measured data in the frequency domain and viewing the 
data in the way that best suits your requirements. As discussed earlier, there are 16 4-port 
S-parameters for both single-ended and balanced devices. See Figure 7-3 and Figure 7-5. You 
may elect to view any number of these S-parameters.

Opening a Frequency Domain Plot Window

The frequency domain may be viewed in either balanced or single-ended mode. You may open 
the frequency domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 7-6

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 7-6

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 7-6

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Frequency Domain choices - see (B) of Figure 7-6

Figure 7-6 Opening the Frequency Domain Plot Window
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NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.

Viewing All 16 S-Parameters

Except when you open the plot window using the Browser, all 16 frequency domain 
parameter plots are displayed. The parameter plots are displayed in the same orientation as 
shown in Figure 7-3 and Figure 7-5. Each plot is labeled with its parameter at the top. See 
Figure 7-7.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.

Figure 7-7 All 16 Balanced Frequency Domain Plots
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Viewing a Single S-Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 7-8. 

Figure 7-8 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain up to four 
parameters. For example, you could show how SDD21 compares with SCC21. To do this 
double-click on the SDD21 plot so that is now displaying a single plot similar to Figure 7-8. 
With SDD21 displayed as a single plot, make sure New Trace is selected in the Parameter 
Bar (or the Data menu), then click any parameters you wish to add, SCC21 in this example. 

Figure 7-9 A Single Plot with Multiple Traces

It could contain as many as 4 of the parameters. All trace parameters are labeled at the right 
edge of the plot. The color of the trace labels are the same color as the traces they represent.
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Creating a Custom S-Parameter Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four SDDxx plots. To create a custom window, open the data 
file in any analysis type. Then, in the Browser, select the data type that you want to display 
the plots. In this example, select Frequency Domain (Balanced). A blank plot window is 
displayed. With New Plot selected in the Parameter Bar (or the Data menu), click the 
desired parameters (SCC11, SCC12, SCC21, and SCC22 in this example). As each parameter 
is selected, a new plot is added to the plots window. See Figure 7-10.

Figure 7-10 Custom S-Parameter Plots Window with Four Plots
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Selecting Frequency Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 7-11 Format Menu and Format Bar for Frequency Domain

Frequency Domain Format Bar

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. Typical 
measurements are return loss and gain. This is the default format.

Linear Mag displays positive values only. Typical measurements are 
transmission, reflection coefficients, time domain transfer.

Phase displays phase (no magnitude).

Group Delay displays signal transmission (propagation) time through a device. 
Chapter 7 233



Analyzing Data in the Frequency Domain
Selecting Frequency Domain Display Formats
Smith Chart displays an impedance plane that is mapped onto the polar plane. 
Every point on the Smith Chart represents a complex impedance made up of a real 
resistance (r) and an imaginary reactance (r + jX). The dotted circles represent 
constant resistance. The horizontal line through the middle is purely resistive (no 
reactive component).

• To the far right, the value is zero ohms (short). To the far left, the value is 
infinite ohms (open).

The dotted arcs represent constant reactance.

• The reactance arcs in the upper (positive) half of the circle represent inductive 
reactance (ZL = jωL).

• The reactance arcs in the lower (negative) half of the circle represent capacitive 
reactance (ZC = 1/jωC).

• Typical measurements: Impedance profile

When in this format, the cursor bar allows you to choose the cursor value in either 
Mag + Phase or Inductance style. Refer to “Frequency Domain Polar and Smith 
Chart Markers” on page 370 for additional information.

Polar Chart plots the measurement result in a vector representation. 

The magnitude at any point is determined by its displacement from the center (or 
zero value). Magnitude is scaled linearly, with the value of the outer circle set to a 
ratio value of 1.

The radial lines scale the phase angle from 0 degrees to +180 degrees 
(counterclockwise) or −180 degrees (clockwise).

When in this format, the cursor bar allows you to choose the cursor value in either 
Mag + Phase or Inductance style. Refer to “Frequency Domain Polar and Smith 
Chart Markers” on page 370 for additional information.

Real displays only the real (resistive) portion of the measured complex data. Can 
show both positive and negative values. Typical measurement: time domain

Imaginary displays only the imaginary (reactive) portion of the measured complex 
data. Typical measurements are impedance for designing matching circuits.

Frequency Domain Format Bar
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Table 7-1 Frequency Domain Formats

Log Mag Linear Mag

Phase Group Delay
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Smith Chart Polar Chart

Real Imaginary

Table 7-1 Frequency Domain Formats
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 7-12 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 7-13.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 7-13.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 7-13.

Figure 7-13 Entering a Scale Value
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The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. The horizontal scale may not be changed in Smith 
Chart and Polar formats.

The vertical scale units vary depending on the format. 

Quick Scale Features

PLTS has three features that make scaling changes quickly and easily. The three features are:

• Autoscale

• Reset Scale

• Copy Plot Format used with Paste Plot Format (see “Copying and Pasting Plot 
Formats” on page 394)

Autoscale

Autoscale changes the vertical scale of the active plot to allow the trace to occupy 
approximately 80% of the vertical axis of the display. It places the display such that the 
graticule values are numbers that are easy to work with.

Format Vertical Scale Units

Log Mag decibels (dB)

Linear Mag mU

Phase degrees

Group Delay nanoseconds (nS)

Smith Chart Not Applicable

Polar Not Applicable

Real mU

Imaginary mU
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Figure 7-14 Autoscale

To autoscale a plot, select the plot, then right click on the plot to display the quick menu 
displayed in Figure 7-16. Click Autoscale to change the vertical scale of the plot. Figure 7-15 
shows a frequency domain plot that has Autoscale applied to it.

Figure 7-15 A Plot that has been Autoscaled

Reset Scale

Reset Scale resets the vertical and horizontal scale of the active plot to the default settings. 
This is useful when you are adjusting the scale and the trace is moved off screen and can no 
longer be seen.

To reset the scale of a plot, select the plot, then right click on the plot to display the quick 
menu displayed in Figure 7-16. Click Reset Scale to reset the plot to the default settings.
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Figure 7-16 Reset Scale
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Analyzing Data in the Time Domain
The Agilent physical layer test system or (PLTS) combined with Agilent’s vector network 
analyzers and their companion multiport test sets perform measurements in the frequency 
domain by sweeping a RF signal and measuring the RF responses of a device under test or 
(DUT). The Agilent PLTS software can also mathematically transform these frequency 
domain data S parameters into their time domain counterparts and display them in either 
their step, impedance or their impulse/response modes.

In a linear network, the Fourier Transform describes the relationship between a frequency 
domain measurement and its corresponding time domain response in detail. Therefore, given 
the measured frequency domain response of a DUT, it is possible to determine its time domain 
response mathematically by performing an inverse Fourier Transform. And the PLTS 
software accomplishes it’s frequency domain transformation to time domain by utilizing this 
inverse chirp Z Fourier transform1.

The type of information that can be observed in time domain mode is quite different than the 
information that can be observed in frequency domain mode. If the network is thought of in 
terms of its equivalent circuit model, then the frequency domain response describes the 
composite behavior of all of the circuit elements at any given operating frequency. 

By contrast, the time-domain response shows the contribution of each individual circuit 
element. Since there is a direct relationship between time and distance, this mode allows each 
element to be separated spatially. With an understanding of the unique signature 
characteristics of different circuit elements, this view of the DUT can provide considerable 
insight into the device.

An alternative method of obtaining time-domain characterization of a device is to make the 
measurement directly in the time domain by synthesizing a step waveform, applying it to the 
device, and observing the response on an oscilloscope. The advantages of using the PLTS 
measurement approach for TDR data are listed below.

While the traditional TDR measurement technique provides fast measurement speed, the 
measurement technique used by the physical layer test system provides:

• Superior accuracy
• Significantly better dynamic range (important for crosstalk and mode-conversion terms)
• Ability to de-embed fixtures and signal launchers
• Access to both frequency and time domain information (as vector quantities)
• Single setup for forward and reverse transmission and reflection, single-ended, 

differential-, and common-mode, and mode-conversion terms
• No need for DUT to have DC return path
• No large voltage steps applied to DUT

1. The advantage of the chirp z-transform is that it enables calculation of the sample of the 
z-transform equally spaced over an arc or a spiral contour with an arbitrary starting point 
and arbitrary frequency range. In contrast, the frequency range of the discrete Fourier 
Transform is strictly related to the sampling frequency.
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TDR/TDT Mode
The time domain mode shows the contribution of each individual circuit element. Using time 
domain reflectance (TDR), you can measure the location, electrical length, nature of 
discontinuities (resistive, capacitive, inductive), and amount of reflection from discontinuities. 
Time domain transmission (TDT) response parameters typically measured are gain, 
propagation delay, and crosstalk between traces.

The physical layer test system can measure and display any of the single-ended (unbalanced) 
or mixed-mode S-parameters in the time domain and display the response of a device as if it 
were stimulated with either a step or an impulse waveform. For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. S-parameters are defined as the ratio of two normalized power waves 
(response/stimulus), defined in terms of the voltages and current at each port of a device. For 
more information, see “How to Interpret S-Parameters” on page 224.

• In TDR/TDT mode, the horizontal axis displays:

— Reflection parameters showing the characteristics of the DUT at a certain time delay 
into the device. 

— Transmission parameters showing the propagation delay through the device.

• The vertical axis displays:

— An impulse response that is a reflection or transmission coefficient on either a linear or 
logarithmic scale. This parameter can be displayed as an absolute number, or relative 
to a minimum or maximum value of the response. 

— A step response on either a linear or a logarithmic scale. Alternatively, a reflection 
parameter can be displayed as impedance versus time rather than as a reflection 
coefficient.

The following table shows the relationship between frequency domain parameters to their 
time domain equivalents.

Table 8-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter

Single-ended N/A TDR S11

Single-ended Reverse TDT S12

Single-ended Reverse TDT S13
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Single-ended Reverse TDT S14

Single-ended Forward TDT S21

Single-ended N/A TDR S22

Single-ended Reverse TDT S23

Single-ended Reverse TDT S24

Single-ended Forward TDT S31

Single-ended Forward TDT S32

Single-ended N/A TDR S33

Single-ended Reverse TDT S34

Single-ended Forward TDT S41

Single-ended Forward TDT S42

Single-ended Forward TDT S43

Single-ended N/A TDR S44

Differential Forward TDR SDD11

Differential Reverse TDT SDD12

Differential Forward TDT SDD21

Differential Reverse TDR SDD22

Common Forward TDR SCC11

Common Reverse TDT SCC12

Common Forward TDT SCC21

Common Reverse TDR SCC22

Differential-to-Common Forward TDR SCD11

Differential-to-Common Reverse TDT SCD12

Table 8-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Analyzing Time-Domain Signatures
The time-domain response of a device, its signature, provides specific circuit detail. The shape 
of the response indicates the element type and configuration (series or shunt). Its value and 
location can be determined from the size of the reflection and its time delay. In general, a 
wider measurement bandwidth will provide finer response resolution. Table 8-2 shows 
various circuit elements and associated time-domain signatures.

Differential-to-Common Forward TDT SCD21

Differential-to-Common Reverse TDR SCD22

Common-to-Differential Forward TDR SDC11

Common-to-Differential Reverse TDT SDC12

Common-to-Differential Forward TDT SDC21

Common-to-Differential Reverse TDR SDC22

Differential-to-Single-ended Reverse TDT SSD12

Differential-to-Single-ended Reverse TDT SSD13

Single-ended-to-Differential Forward TDT SDS21

Single-ended-to-Differential Forward TDT SDS31

Common-to-Single-ended Reverse TDT SSC12

Common-to-Single-ended Reverse TDT SSC13

Single-ended-to-Common Forward TDT SCS21

Single-ended-to-Common Forward TDT SCS31

Table 8-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Table 8-2 Time Domain Signatures

Transmission Line: ZC < Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Transmission Line: ZC > Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Series Inductor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Shunt Capacitor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Practical Considerations
In general, better accuracy of the measured frequency domain data will provide for better 
accuracy of the time domain data. Using the step mode rather than the sweep mode provides 
additional frequency stability of the source which can greatly improve the time domain data. 
The following are several other important considerations.

Masking

Time domain responses are most accurate closest to the location of the source. A discontinuity 
in the DUT will reflect some power back to the source, meaning less power is transmitted to 
the rest of the DUT. This loss of power going away from the source is referred to as masking, 
and allows the true impedance of the next discontinuity to be misrepresented.

Figure 8-1 Masking Effects

Masking effects can be seen in Figure 8-1. The plot on the left shows the differential-mode 
input reflection of a device (SDD11). The first large discontinuity is the input connector; the 
second is the output connector. Because these connectors are physically identical, the 
apparent impedance difference between the two can be attributed to masking. The power level 
at the output connector has been decreased (masked) by the input connector. The plot on the 
right, output reflection (SDD22), proves this. Looking backwards into the device, the output 
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connector now exhibits the greater apparent impedance. Were it not for masking, these two 
plots, and the measured impedance of the input and output connectors, would be identical.

The high dynamic range of the PLTS system extends the ability of the instrument to 
accurately characterize devices that have several discontinuities or high loss.

Time Domain Windowing

The PLTS software has a feature called Time Domain Windowing that is designed to enhance 
Time Domain measurements. The need for windowing is due to the abrupt transitions in the 
Frequency Domain measurement at the Start and Stop frequencies. This band limiting of the 
frequency domain response causes overshoot and ringing in the Time Domain response. It 
causes the un-Windowed Impulse stimulus to have a sin (kt)/kt shape (k=π/frequency span), 
which has two effects that limit the usefulness of the Time Domain measurement:

• Finite Impulse Width limits the ability to resolve between two closely-spaced responses. 
The effects of the finite impulse width cannot be improved with increasing the frequency 
span of the measurement.

• Impulse Sidelobes limit the dynamic range of the Time Domain measurement by hiding 
low level response within the sidelobes of the higher level responses. The effects of 
sidelobes can be improved by windowing.

Windowing improves the dynamic range of the Time Domain measurement by modifying 
(filtering) the Frequency Domain data prior to conversion to the Time Domain to produce an 
impulse stimulus with lower sidelobes. This greatly enhances the effectiveness in viewing 
Time Domain responses that are very different in magnitude. The sidelobe reduction is 
achieved, however, as the tradeoff with increased impulse width. The effect of Windowing on 
the STEP stimulus is a reduction of overshoot and ringing a the tradeoff with increased rise 
time.

Three windows are available: Minimum, Normal, and Maximum. The sidelobe levels of the 
Time Domain stimulus depend only on the Window that is selected. See Figure 8-3.

The purpose of windowing is to make the Time Domain response more useful in isolating and 
identifying individual responses. The window does not affect the displayed Frequency Domain 
response. It is turned on only when the Time Domain response is viewed. Figure 8-2 shows 
typical effects of windowing on the Time Domain response of the reflection measurement of a 
short circuit.

NOTE The windowing setting also has an effect on the transformation of eye 
diagrams.
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Figure 8-2 Windowing Effect on Time Domain Responses of a Short Circuit

The following formula can be used to determine the equivalent 10 percent to 90 percent 
system rise time for the step function transformation and the eye diagram simulation:

Table 8-3 shows the equivalent rise times for a maximum frequency of 20 GHz for each 
window setting.

By increasing or decreasing the filter value above or below the default, a trade-off can be 
made between rise time and side-lobe level (dynamic range). 

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed allowing a choice of the three Time Domain Window settings. 

 Tr = (1000 / Fmax) × MF

Where, Tr = Rise time of the step response form 10% to 90% (in picoseconds)

 1000 = Factor to convert frequency to picoseconds

 Fmax = Maximum stop frequency used in the measurement (in GHz)

 MF = Multiplication factor constant for the filter coefficient

As an example: System rise time = 27 ps = (1000/ 20 GHz) × 0.54 (see table below)

Table 8-3 Equivalent Rise Times for a Maximum Frequency of 20 GHz

Window Setting Maximum Frequency  Filter Coefficient Equivalent Rise Time

Minimum 20 GHz 0.54 27 ps

Normal 20 GHz 0.71 35.5 ps

Maximum 20 GHz 0.91 45.5 ps
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Figure 8-3 Time Domain Window Dialog Box

• Maximum gives the minimum sidelobes and this provides the greatest dynamic range. 
The filter coefficient value is 0.91. This is the default setting.

• Normal gives reduced sidelobes and is normally the most useful. The filter coefficient 
value is 0.71. 

• Minimum is essentially no window and therefore give the highest sidelobes. The filter 
coefficient value is 0.54. 

NOTE When you open measurement data in time domain format, the previously 
selected windowing is used. To change the windowing selection, select Time 
Domain Window… from the Tool menu which displays the Time Domain 
Window dialog box. Make your windowing selection from the dialog box and 
click OK. Then delete the current plot window and reopen a new plot window 
using the same data. The new windowing choice is then applied to the data.

Response Resolution

The response resolution describes how close in time two responses can be distinguished. This 
depends on the width of the impulse response, which is inversely related to the measurement 
bandwidth. The relationship between the three is approximately R = T = 1.25/BW; where R is 
the response resolution in picoseconds, T is the effective impulse width in picoseconds, and 
BW is the frequency span in GHz.
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Range Resolution

As described previously in “Analyzing Time-Domain Signatures” on page 245, the TDR 
signature provides specific circuit detail. Range resolution (TD span/Number of points, or 
Stop-Start/Number of points) will define how accurately the signature of a response can be 
identified. In general, a wider measurement bandwidth will provide finer spatial resolution.

To improve range resolution, zoom in on the section of interest and adjust the start- and 
stop-points to be as narrow as possible without compromising the agreement in the frequency 
domain.

Spatial Resolution

When measuring short electrical devices, matching the spatial resolution to the minimum 
discontinuity distance is critical. 

Impulse Response (IR) is the waveform that results at the output of a device when the input is 
excited by a unit impulse. As the maximum measurement frequency of a VNA increases, the 
pulse-width of the IR gets narrower. The pulse-width of the IR must be narrower than the two 
adjacent discontinuities in order to properly characterize the discontinuities in the time 
domain.

To illustrate this, assume we are measuring a device that has two discontinuities that are 
1 cm apart and the expected response in the time-domain is as pictured in Figure 8-4.

Figure 8-4 Expected Response for Two Discontinuities 1 cm Apart

If the IR has a spatial resolution is greater than 1 cm and is swept across the DUT as shown 
in Figure 8-5, the response in the time domain is dramtically different than what is expected. 
It looks like the picture on the right side of the illustration because the IR is larger than the 
two adjacent discontinuities, and the power levels from the multiple discontinuities are being 
added together. 
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Figure 8-5 Example 1: Displayed Response

Figure 8-6 shows the same device using an IR with a pulse-width that is less than 1 cm. The 
response you see in the time domain is much more like what is expected. It looks like the 
picture on the right side of the illustration. This is because the IR is narrower than the two 
adjacent discontinuities, and the IR is able to capture only the power level of the individual 
discontinuities. 

Figure 8-6 Example 2: Displayed Response

Understanding the spatial resolution requirements of a device is extremely important as 
devices become shorter in length.

An increased number of points can help provide some additional resolution to data, but will 
never make up for using a system with insufficient spatial resolution. Figure 8-7 shows the 
same device but measured with the number of points set at 900 and at 4500. While there is 
some improvement, the improvement is not significantly better.

Figure 8-7 Sampling Resolution: 900 Points Versus 4500 Points
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The idea to remember is that the spatial resolution of the PLTS system must be a narrower 
length than the expected minimum length of any adjacent discontinuities on the device.
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Automated Start and Stop Settings In Time Domain

For Measurements Made in the Frequency Domain Only

When a measurement is made in the frequency domain and is converted to the time domain, 
the time domain start and stop frequencies can be ambiguous. This describes the algorithm 
for displaying the start and stop frequencies using the PLTS automated process.

This algorithm is best described using a flow diagram (see Figure 8-8) and a few real life 
examples of this process. 

Example 9-1 Standard Transmission Measurement

Parameter = SDD21 (Transmission) 

Location of the SDD21 Peak Value in Time Domain = 2 ns

At Point 1, 

Tstart = 0 ns

Tstop = 8 ns

The result is:

Tstart = 0 ns

Tstop = 8 ns
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Figure 8-8 Automated Start and Stop Algorithm Flow Diagram
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Also using Figure 8-8, you can follow these examples:

Example 9-2 Standard Reflection Measurement

Parameter = SDD11 (Reflection) 

Location of the SDD21 Peak Value in Time Domain = 2 ns

At Point 1, 

Tstart = −1 ns

Tstop = 4 + 1 = 9 ns

The result is:

Tstart = −1 ns

Tstop = 4 + 1 = 9 ns

Example 9-3 Potential Limitation of the Algorithm

Parameter = SDD11 (Reflection) 

Location of the SDD21 Peak Value in Time Domain = 5 ns

At Point 1, 

Tstart = −2.5 ns

Tstop = 20 + 2.5 = 22.5 ns (greater than maximum time base of 10 ns)

At Point 2, 

Tstart = −2.5 ns

Tstop = 10 − 2.5 = 7.5 ns

The result is:

Tstart = −2.5 ns

Tstop = 7.5 ns

Comments: The results in the start and stop calculations are not suitable to 
resolve the SDD21 with a 5 ns measurement. This is because the stop 
time is 7.5 ns while the device needs 10 ns for the two-way travel of in 
reflection. The system is capable of resolving 10 ns, however, due to 
the current calculation of the -2.5 ns start time, an artificial 
limitation has been imposed. This can be worked around by manually 
changing the start and stop in the gating mode.
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Example 9-4 No Transmission Data

Parameter = SDD11 (Any parameter) 

Location of the SDD21 Peak Value in Time Domain = 0 ns

At Point 1, 

Tstart = 0 ns

Tstop = 0 ns

At Point 3, 

Tstart = −1 ns

Tstop = 1 ns

The result is:

Tstart = −1 ns

Tstop = 1 ns

Comments: Due to the absence of a strong signal in SDD21, the algorithm 
defaults to start of −1.0 ns and stop of 1.0 ns. This can be 
worked around by manually changing the start and stop in the 
gating mode.
Chapter 8260



Analyzing Data in the Time Domain
Checking the Validity of a Time-Domain Calculation
Checking the Validity of a Time-Domain Calculation
There are a number of practical considerations in examining time domain data, as described 
previously. Therefore, it is very important to have a method of validating the data. This can be 
accomplished by comparing the original frequency domain data to the data after it is inverse 
Fourier transformed into the time domain, and then Fourier transformed back into the 
frequency domain, as shown in Figure 8-9. Ideally, these data should be identical. Changing 
the time domain start- and stop-points, the filter value, and the value of the DC parameter 
may improve the agreement.

Figure 8-9 Time Domain Data Validation Model
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Viewing Data in the Time Domain
This section guides you with opening measured data in the time domain and viewing the data 
in the way that best suits your requirements. There are 16 parameter plots for both 
single-ended and balanced devices. You may elect to view any number of these plots.

Opening a Time Domain Plot Window

The time domain may be viewed in either balanced or single-ended mode. You may open the 
time domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 8-10

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 8-10

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 8-10

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Time Domain choices - see (B) of Figure 8-10

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.

Figure 8-10 Opening the Time Domain Plot Window
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Viewing All 16 Parameters

In all cases, except when you open the plot window using the Browser, all 16 time domain 
parameter plots are displayed. Each of the plots are labeled at the top with their parameter. 
See Figure 8-11.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.

Figure 8-11 All 16 Differential Time Domain Plots 
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Viewing a Single Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 8-12. 

Figure 8-12 Opening a Single Plot

Double-click on the single plot to return back to the original view with multiple plots.
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View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain up to four 
parameters. For example, you could show how TDD21 compares with TCC21. To do this 
double-click on the first plot so that is now displaying a single plot similar to Figure 8-12. For 
this example, TDD21 was double-clicked and is displayed as a single plot. With New Trace 
selected in the Parameter Bar (or the Data menu), click the remaining parameters (TCC21 
in this example). 

Figure 8-13 A Single Plot with Multiple Traces

It could contain as many as 4 of the parameters. All trace parameters are labeled at the right 
edge of the plot. The color of the trace labels are the same color as the traces they represent. 
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Creating a Custom Time Domain Plots Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four TDDxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Time Domain (Balanced). A blank plots 
window is displayed. With New Plot selected in the Parameter Bar (or the Data menu), 
click the desired parameters (TDD11, TDD12, TDD21, and TDD22 in this example). As each 
parameter is selected, the new plot is added to the plots window. See Figure 8-14.

Figure 8-14 Custom Time Domain Plots Window with Four Plots
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Optimizing the Time Domain Time Scale for Viewing
The Time Domain Start and Stop Time dialog box allows you to change and view the start 
times and stop times of time domain plots three ways.

NOTE The feature is used only for frequency domain S-parameter files that are 
calculated to show time domain. If your measurement was taken using a TDR, 
this feature does not apply. 

From the Tools menu, select Time Domain Start and Stop Time… to open the Time 
Domain Start and Stop Time dialog box. 

Figure 8-15 Opening the Time Domain Start and Stop Time Dialog Box
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NOTE While most dialog boxes will not allow you to work between them and the main 
PLTS window, the Time Domain Start and Stop Time dialog box will allow you 
to make changes and then go to the main PLTS window to see the change 
without closing the dialog box.

The Time Domain Start and Stop Time dialog box is displayed with either Auto Optimize 
Off or Auto Optimize On selected. The state depends on the Always optimize the Start 
and Stop Times when calculating the time domain data from frequency domain 
data selection in User Preferences dialog box dictates whether the Auto Optimize feature is 
turned on or off when the calculations are made from frequency domain to time domain. See 
Figure 8-16. Refer to “User Preferences” on page 464 for additional information.

Figure 8-16 User Preferences Dialog Box Determines if Auto Optimize is On

If Auto Optimize Off is selected, the time domain data is not optimized in any parameter for 
viewing and the start time and the stop time is set to show the full time range of the 
measurement. Often, no usable information is displayed over much of the time.

If Auto Optimize On is selected, the time domain data is optimized in all parameters for 
viewing and the start time and stop time are changed to show the time domain time range 
such that there is not a lot of unusable information displayed. 

Changing the Start Time and Stop Time Manually

When Manual is selected, you can change as many parameters that you like to the start and 
stop time values that you choose. When Manual is selected, all differential and single-ended 
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time domain parameters are placed in the list at the left, the Available Parameter List. 
Move the parameters that have a start or stop time that you would like to change to the right 
list at the right, the Selected Parameter List. Move the parameters using the eight Move 
Parameters Buttons located between the two lists. A description of each of these buttons is 
located below.

Figure 8-17 Time Domain Start and Stop Time Dialog Box in Manual Mode

Button 
Label

Description

> Moves the highlighted parameters in the available parameters list to the 
right into the selected parameters list

< Moves the highlighted parameters in the selected parameters list to the left 
into the available parameters list

>> Moves all parameters in the available parameters list to the right into the 
selected parameters list

<< Moves all parameters in the selected parameters list to the left into the 
available parameters list

Diff TDR > Moves all differential TDR parameters in the available parameters list to the 
right into the selected parameters list. The different TDR parameters are: 
TCC11, TCC22, TCD11, TCD22, TDC11, TDC22, TDD11, and TDD22.

SE TDR > Moves all single ended TDR parameters in the available parameters list to 
the right into the selected parameters list. The single ended TDR parameters 
are: T11, T22, T33, and T44.
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For example, to change the start and stop time of the single ended TDR parameter plots, you 
must move the parameters to the Selected Parameter List. See Figure 8-18.

Figure 8-18 Moving the Single Ended TDR Parameters

Once the parameters are listed in the Selected Parameter List, change the Start Time and 
the Stop Time using the Start Time and the Stop Time text entry boxes. See Figure 8-19.

Figure 8-19 Changing the Start Time and Stop Time

Diff TDT > Moves all differential TDT parameters in the available parameters list to the 
right into the selected parameters list. The different TDT parameters are: 
TCC12, TCC21, TCD12, TCD21, TDC12, TDC21, TDD12, and TDD21.

SE TDT > Moves all single ended TDT parameters in the available parameters list to 
the right into the selected parameters list. The single ended TDT parameters 
are: T12, T13, T14, T21, T23, T24, T31, T32, T34, T41, T42, and T43.

Button 
Label

Description
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The times can be changed two ways:

1. By typing in a new value for one or both of the times and then clicking the Apply button.

2. By dragging over the value to change with the mouse, and clicking the spinner to the new 
value. This method changes the value with clicking the Apply button.

NOTE The spinners in the method are unique. They increment or decrement only the 
most significant digit that was highlighted with the mouse. For example, the 
Stop Time in Figure 8-19 is 5.34 ns. If you highlight the entire “5.34” value or 
just the “5”, clicking the up spinner increments the “5”. However, if you 
highlight the “34” or only the “3”, clicking the up spinner increments the “3”.
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Selecting Time Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 8-20 Format Menu and Format Bar for Time Domain

Time Domain Format Bar

Stimulus - Type of the input to the DUT
Impulse inputs an impulse waveform as the stimulus. 

Step inputs a step waveform as the stimulus. This is the default 
format.

Vertical Format - Units used on the vertical axis
Volts selects volts as the vertical unit of measure. This is the default 

format.
Real displays only the real (resistive) portion of the measured 

complex data. Real can show both positive and negative values. 
This is the default format.

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. 
Typical measurements are return loss and gain. 

Impedance selects ohms as the vertical unit of measure. This choice is active 
only for reflection plots with a Step stimulus. 
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Horizontal Format - Units used on the horizontal axis
ns selects time units (in nanoseconds) for the horizontal format. 

This is the default format.
cm selects distance units (in centimeters) for the horizontal format.

Time Domain Format Bar
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 8-21 Time Domain Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 8-22.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 8-22.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 8-22. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 8-22 Entering a Scale Value

The horizontal scale is changed by changing the start and stop frequencies in megahertz 
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(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. 

The horizontal scale units are either nanoseconds (ns) or centimeters (cm) depending on the 
Format Bar or Format menu selection. 

NOTE When the horizontal units per division is changed, the Delay value is reset to 
zero.

The vertical scale is either volts, units, ohms, or decibels depending on the Format Bar or 
Format menu selection. The vertical scale selections are:

Quick Scale Features

PLTS has three features that make scaling changes quickly and easily. The three features are:

• Autoscale

• Reset Scale

• Copy Plot Format used with Paste Plot Format (see “Copying and Pasting Plot 
Formats” on page 394)

Autoscale

Autoscale changes the vertical scale of the active plot to allow the trace to occupy 
approximately 80% of the vertical axis of the display. It places the display such that the 
graticule values are numbers that are easy to work with.

To autoscale a plot, select the plot, then right click on the plot to display the quick menu. See 
Figure 8-23. Click Autoscale to change the vertical scale of the plot. The figure shows a time 
domain plot that has Autoscale applied to it.

Volts selects volts as the vertical unit of measure.
Real displays only the real (resistive) portion of the measured complex data. Real 

can show both positive and negative values. This is the default format.
Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. Typical 

measurements are return loss and gain. 
Impedance selects ohms as the vertical unit of measure. This choice is active only for 

reflection plots with a Step stimulus.
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Figure 8-23 Autoscale

Reset Scale

Reset Scale resets the vertical and horizontal scale of the active plot to the default settings. 
This is useful when you are adjusting the scale and the trace is moved off screen and can no 
longer be seen.

To reset the scale of a plot, select the plot, then right click on the plot to display the quick 
menu displayed in Figure 8-24. Click Reset Scale to reset the plot to the default settings.

Figure 8-24 Reset Scale
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Gating
Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot that 
you define, replacing it with an ideal transmission line having the same electrical delay as the 
removed section. By observing the original frequency domain response and the transformed 
frequency domain response, the effect of the gating operation on the S-parameter data can be 
seen. For detailed information on gating, refer to “Gating” on page 352.
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Analyzing Data using Eye Diagrams
The physical layer test system software constructs measurement-based eye diagrams (or 
patterns) by convolving the calculated time domain impulse response (generated from 
frequency domain measurement data) with a simulated pattern of bit sequences. Refer to 
Figure 9-1 for a simplified block diagram of the eye diagram creation process.

Figure 9-1 Eye Diagram Process Simplified Block Diagram

With eye diagrams you can see signal quality with one display, you can diagnose problems, 
such as attenuation, noise, jitter, and dispersion that arise or characterize specific parts of the 
system. You can then view the measurement in the Time Domain mode to help isolate the 
source of the problem.

The software allows you to specify a simulated bit pattern (sequence) of between 8 and 32 bits 
that is convolved with the calculated time domain data to generate the eye diagram. You may 
select from three simulated bit patterns types: 1) a pre-defined bit pattern, 2) a bit pattern 
that you have defined, or 3) an arbitrary bit stream (a random-like bit pattern).
Chapter 9280



Analyzing Data using Eye Diagrams
The Eye Diagram
The Eye Diagram
The eye diagram shown in Figure 9-2 identifies key eye diagram definitions. These definitions 
are listed below this illustration. The eye diagram of the TCC21 parameter shown in Figure 
9-2 was created using the BTL.dut file located in the PLTS data folder. An Arbitrary 
Bitstream bit pattern with the following settings was also used: 

Figure 9-2 The Eye Diagram

Rise/Fall Time = 0 ps Data Rate = 2.5 Gb/s
Pattern Length = 32 bits Number of Patterns = 12

1 Zero Level Zero Level is a measure of the mean value of the logical 0 of an 
eye diagram. 

2 One Level One Level is a measure of the mean value of the logical 1 of an 
eye diagram. 
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Time Domain Windowing

The PLTS software has a feature called Time Domain Windowing that enhances the displayed 
Time Domain plots. The need for windowing is due to the abrupt transitions in the Frequency 
Domain measurement at the start and stop frequencies. This band limiting of the frequency 
domain response causes overshoot and ringing in the Time Domain response. It causes the 
un-Windowed Impulse stimulus to have a sin (kt)/kt shape (k=π/frequency span), which has 
two effects that limit the usefulness of the Time Domain measurement:

• Finite Impulse Width limits the ability to resolve between two closely-spaced responses. 
The effects of the finite impulse width cannot be improved with increasing the frequency 
span of the measurement.

• Impulse Sidelobes limit the dynamic range of the Time Domain measurement by hiding 
low level response within the sidelobes of the higher level responses. The effects of 

3 Rise Time Rise time is a measure of the transition time of the data from 
the 10% level to the 90% level on the upward slope of an eye 
diagram. 

4 Fall Time Fall time is a measure of the transition time of the data from 
the 90% level to the 10% level on the downward slope of an eye 
diagram. 

5 Eye Height Eye height is a measure of the vertical opening of an eye 
diagram. An ideal eye opening would be measured from the 
one level to the zero level. However, noise on the eye will cause 
the eye to close. The eye height measurement determines eye 
closure due to noise.

6 Eye Width Eye width is a measure of the horizontal opening of an eye 
diagram. Ideally, the eye width would be measured between 
the crossing points of the eye. However, jitter may appear on 
the waveform and influence the eye opening. 

7 Deterministic 
Jitter

Deterministic jitter is the deviation of a transition from its 
ideal time caused by reflections relative to other transitions.

8 Eye Amplitude Eye amplitude is the difference between the logic 1 level and 
the logic 0 level histogram mean values of an eye diagram. 

9 Bit Rate Bit rate (data rate) is the inverse of bit period (1 / bit period). 
The bit period is a measure of the horizontal opening of an eye 
diagram at the crossing points of the eye. 
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sidelobes can be improved by windowing.

Windowing improves the dynamic range of the Time Domain measurement by modifying 
(filtering) the Frequency Domain data prior to conversion to the Time Domain to produce an 
impulse stimulus with lower sidelobes. This greatly enhances the effectiveness in viewing 
Time Domain responses that are very different in magnitude. The sidelobe reduction is 
achieved, however, as the tradeoff with increased impulse width. The effect of Windowing on 
the STEP stimulus is a reduction of overshoot and ringing a the tradeoff with increased rise 
time.

Three windows are available: Maximum, Normal, and Minimum. The sidelobe levels of the 
Time Domain stimulus depend only on the Window that is selected. Figure 9-3 shows the 
same eye diagram that was displayed in Figure 9-2 with each of the three window settings.

Figure 9-3 The Effect of the Time Domain Windowing Selection
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The purpose of windowing is to make the Time Domain response more useful in isolating and 
identifying individual responses. The window does not affect the displayed Frequency Domain 
response. It is turned on only when the Time Domain response is viewed.

The following formula can be used to determine the equivalent 10 percent to 90 percent 
system rise time for the step function transformation and the eye diagram simulation:

Table 9-1 shows the equivalent rise times for a maximum frequency of 20 GHz for each 
window setting.

By increasing or decreasing the filter value above or below the default, a trade-off can be 
made between rise time and side-lobe level (dynamic range). 

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed allowing a choice of the three Time Domain Window settings. 

Figure 9-4 Time Domain Window Dialog Box

 Tr = (1000 / Fmax) × MF

Where, Tr = Rise time of the step response form 10% to 90% (in picoseconds)

 1000 = Factor to convert frequency to picoseconds
 Fmax = Maximum stop frequency used in the measurement (in GHz)

 FM = Multiplication factor constant for the filter coefficient
As an example: System rise time = 27 ps = (1000/ 20 GHz) × 0.54 (see Table 9-1)

Table 9-1 Equivalent Rise Times for a Maximum Frequency of 20 GHz

Window Setting Maximum Frequency  Filter Coefficient Equivalent Rise Time

Minimum 20 GHz 0.54 27 ps

Normal 20 GHz 0.71 35.5 ps

Maximum 20 GHz 0.91 45.5 ps
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• Maximum gives the minimum sidelobes and this provides the greatest dynamic range. 
The filter coefficient value is 0.91. This is the default setting.

• Normal gives reduced sidelobes and is normally the most useful. The filter coefficient 
value is 0.71. 

• Minimum is essentially no window and therefore give the highest sidelobes. The filter 
coefficient value is 0.54. 

NOTE When you open measurement data in time domain format, the previously 
selected windowing is used. To change the windowing selection, select Time 
Domain Window… from the Tool menu which displays the Time Domain 
Window dialog box. Make your windowing selection from the dialog box and 
click OK. Then delete the current plot window and reopen a new plot window 
using the same data. The new windowing choice is then applied to the data.
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Designing a Bit Pattern for Eye Diagrams
The Bit Pattern feature in the Tools menu allows you to design a digital bit pattern and to 
apply a bit pattern that has been saved to eye diagram plots. Only the industry standard 
K 28.5 bit pattern has been created and included in the software. However, the PLTS software 
allows you to create bit patterns, from 8 to 32 bits very easily.

Figure 9-5 Tools Menu with Bit Pattern Expanded

1. Select Bit Pattern then Design… from the Tools menu to open the Digital Pattern 
Generator dialog box shown in Figure 9-6.

Figure 9-6 Digital Pattern Generator

2. Click on the “0” key as shown in Figure 9-7.
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Figure 9-7 Selecting the “0” Piano Key

3. Select the remaining even-numbered piano keys so that you have a series of alternating 
bits as shown in Figure 9-8.

Figure 9-8 Digital Pattern Generator with a 32-Bit Pattern

Note the alternating bits going high (turning on) and the alternating 1’s and 0’s in the 
Numeric Representation area.

1. Selecting the “0” key (piano key) in the Bit Representation area:

A. Causes Bit 0 to go high (turn on)

B. Generates a “1” in the first digit of the binary numeric representation
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4. Enter values in the Rise/Fall Time and the Data Rate boxes. Rise/Fall Time is entered 
in picoseconds (ps) and Data Rate is entered in Gigabits per second (Gb/s). See Figure 9-9 
and Figure 9-10.

Figure 9-9 Rise/Fall Time and Data Rate

5. Check the value in the Pattern Length (bits) box. The default value is 32. The allowable 
range is between 8 and 32 bits. You may change this if your pattern contains fewer bits. If 
this value is changed to a value less than 32, any remaining bits are ignored. For example 
if you enter 10 as the pattern length value, then bits 0 through 9 are used and bits 10 
through 31 are ignored.

6. Enter a name for the digital pattern in the Save Pattern box. In this example, 
Alternating Bits is entered. Click the OK button to save the pattern to be used later. 
See Figure 9-10.

Figure 9-10 Save the Digital Pattern
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Viewing Data using Eye Diagrams
This section guides you with opening measured data in the eye diagram plot mode and 
viewing the data in the way that best suits your requirements. There are 8 output plots for 
balanced mode and 12 output plots for single-ended mode. Only transmission paths are 
displayed; no reflection paths are displayed.

Opening a Eye Diagram Plot Window

The eye diagram may be viewed in either balanced or single-ended mode. You may open the 
eye diagram plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 9-11

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 9-11

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 9-11

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Eye Diagram choices - see (B) of Figure 9-11

Figure 9-11 Opening the Eye Diagram Plot Window
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NOTE When using the Browser method to open a window, first select the bit pattern 
to use with the data (described in the rest of this section), then select the 
parameters that you want to view from the Parameter Bar or the Data menu 
once the blank plot window is displayed.

The Choose a Digital Pattern for Eye Generation dialog box is then displayed (see Figure 9-12). 
You may select a digital pattern to apply from the list of digital patterns. The software is 
shipped with the K 28.5 selection (an industry standard) and the Arbitrary Bitstream 
selection (a random-like bit stream). Any bit patterns that you have created and saved using 
the process described in Designing a Bit Pattern for Eye Diagrams beginning on page  286 are 
also displayed in the Choose a Digital Pattern for Eye Generation dialog box. 

Figure 9-12 Choose a Digital Pattern Dialog Box

NOTE If the bit pattern has already been selected for the data, the Choose a Digital 
Pattern for Eye Generation dialog box is not displayed and the data will is 
displayed using that bit pattern information. To change the bit pattern, select 
Bit Pattern then Apply… from the Tools menu to display the dialog box 
shown in Figure 9-12. Then, select the desired bit pattern from the list on the 
left, enter the desired information (Rise/Fall Time, Data Rate, Pattern Length, 
and Number of Patterns) as described below, and click OK. Then, delete the 
current plot window and reopen a new plot window using the same data. The 
new bit pattern is then applied.
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After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.

• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
(10% to 90%) condition (or the time that it takes a signal to transition from a high to a low 
(90% to 10%) condition).

• Data Rate (Gb/S) is the speed that data is transferred over a circuit or a communications 
line. 

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. The value of 
the Pattern Length allowed is between 8 and 32. Where B is the pattern length entered, 
the number of unique bit patterns is: 2B − 2. If B = 32 (the maximum number of allowable 
bits), then 4.29×109 unique bit patterns are generated.

• Number of Patterns (active only when Arbitrary Bitstream is selected) is used to set 
the number of unique bit patterns used in creating the eye diagram. This value must be 
equal or less than the number of unique bit patterns determined by the Pattern Length 
entry.

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

IMPORTANT Arbitrary Bitstream

Though Arbitrary Bitstream (ABS) is a random-like bit stream used to 
generate eye diagrams, it is different than the Pseudo-Random Binary 
Sequence (PRBS) standard. The ABS pattern was defined to provide a large 
random pattern of bits that would quickly converge the eye diagram to show 
worst case tolerances. 

ABS develops a random sequence of bits for the virtual pattern generator using 
the Pattern Length and the Number of Patterns entries. First, Pattern 
Length is entered (from 8 to 32 bits) defining the number of bits within a 
specific pattern. Second, Number of Patterns is defined and randomly 
selected which will have a maximum value of 2Pattern Length − 2. This is easiest 
to understand with an example:

If the Pattern Length = 8 bits, there are 256 unique patterns available if you 
count in binary from 0 to 255.

00000000
00000001
00000010
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.

.

.
11111101
11111110
11111111

ABS then removes patterns 00000000 and 11111111 as invalid patterns so that 
you now have a total of 2Pattern Length − 2 = 28 − 2 = 254 unique patterns to 
choose from. Then ABS uses a random number generator to choose the first 
pattern to put into the virtual pattern generator and continues to pick new 
random patterns up to the number of patterns that you have defined within the 
interface (maximum is 254).

Using both of these values, a random number generator selects unique bit 
patterns until the appropriate number of patterns are identified. Each of these 
unique bit patterns are then used to create the eye diagram, one bit pattern at 
a time. 

As the eye diagram is created, the Arbitrary Bitstream Eye Status box is 
displayed. This box shows the status of the eye diagrams as they are being 
generated. When a parameter is complete, it is grayed. When all parameters 
are complete, this box is removed and the plots are complete. You can cancel a 
parameter by selecting the Cancel button for that plot. Selecting all Cancel 
buttons that have not been grayed ends the generation of the eye diagram

Using this procedure, the arbitrary bit stream is reproduced when the Pattern 
Length entry and the Number of Patterns entry are the same values. As the 
Number of Patterns value becomes larger, the time to complete this process 
also increases. 
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eye diagram 
parameter plots are displayed. There are four parameter plots for differential measurements 
and 12 parameter plots for single-ended measurements. Each of the plots are labeled. The bit 
map information used to create the eye diagram is displayed above the plot as shown in the 
inset of Figure 9-13.

As noted above, when you open the plot window from the Browser, an empty plot window is 
displayed. View all plots by selecting All from the Parameter Bar or from the Data menu.

Figure 9-13 Balanced Eye Diagram Plots with Information Bar
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Viewing a Single Eye Diagram

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
plots (or with multiple plots if you have a custom plot window displayed), double-click on the 
plot that you would like to view. See Figure 9-14. 

Figure 9-14 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Creating a Custom Eye Diagram Plots Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the two TDDxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Eye Diagram (Differential). A blank plots 
window is displayed. From the Parameter Bar (or the Data menu), click the desired 
parameters (TDD12 and TDD21 in this example). As each parameter is selected, a new plot is 
added to the plots window. See Figure 9-15.

Figure 9-15 Custom Eye Diagram Plots Window with Two Plots
Chapter 9 295



Analyzing Data using Eye Diagrams
Viewing Data using Eye Diagrams
Chapter 9296



10 Analyzing Transmission Line 
Parameters
297



Analyzing Transmission Line Parameters
There are four formats in which RLCG parameters may be displayed in PLTS: 

• W-Element

• Differential

• Common

• Self/Mutual

Only the W-Element format may be exported for use by HSPICE or ADS. The W-Element 
format uses the 4-port S-parameters of the symmetrical, coupled transmission line to compute 
the R (resistance), L (inductance), C (capacitance), and G (conductance) parameters. Each is 
displayed in a 2-by-2 matrix. There is an R-value for each line and coupling values for R. The 
same is true for L, C, and G. These parameters can then be used in HSPICE or ADS as a 
model of the measured transmission line.

There are two formats, Differential and Common, of the RLCG parameters that treat the 
coupled line as a 2-port device instead of a 4-port device. These formats simply use the four 
pure differential-mode parameters or four pure common-mode parameters as a 2-port 
S-parameter device. This is saying we have a line driven differentially (or in common) and 
what are the RLCG parameters, impedance, and propagation constant for this line. In this 
case, the RLCG parameters are a single value, not a 2-by-2 array. There is no self or coupling 
since it is treated as a single line. Neither of these formats is directly usable in HSPICE or 
ADS but these formats can give insight to an experienced user.

The fourth format is the Self/Mutual format. It is a slight deviation from the W-Element 
format. The only difference in this format is the way that the coupling between parameters is 
defined. The conversion is described in “CPTL RLCG Extraction Procedure” on page 306.

An important issue that is not clearly understood is that the measurements must be for only 
the line to be modeled. Connectors and single ended launches to connect to the actual coupled 
line must be removed using de-embedding or calibration standards in the medial. The 
simplest way to measure coupled lines is by probing the lines. When the lines are probed, no 
connectors or launches need be removed. 
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Transmission Line Parameters
Transmission lines are distributed devices. However, SPICE type simulators work with 
lumped elements, not distributed elements. To approximate the distributed behavior of a 
transmission line, RLCG type models are commonly used. The single transmission line shown 
in Figure 10-1 can be modeled by a network consisting of a series resistance and inductance 
with parallel capacitance and conductance.

Figure 10-1 RLCG Model for Single Transmission Line

The different terms included in the model describe the following physical phenomena:

R − Resistive loss of the conductor (transmission line trace). Determined by the 
conductance of the metal, width, height, and length of the conductor.

L − Inductive part of the circuit resulting from the layout of the conductors. Determined 
by the dimensions of the conductor, permeability of the metal, and layout.

C − Capacitive part of the circuit resulting from the layout of the conductors. Determined 
by the permittivity and thickness of the board material and the area of the conductor.

G − Shunt loss of the dielectric. Determined by the layout of the conductors, permittivity, 
loss tangent and thickness of the board material.
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RLCG modes are frequency-based models. See Figure 10-2.

Figure 10-2 Copper Loss (R) and Dielectric Loss (G)

Equation Set 1 describes the most adopted frequency dependencies of RLCG parameters.

NOTE These parameters are called fitted parameters.

The values for RLCG are typically specified in per unit length, where the unit of length is in 
meters. Therefore for a given length of line the value for each of the parameters is easily 
determined. To best approximate the distributed behavior of the transmission line multiple 
sections of RLCG circuits are used. The value of the parameters, R for example, is determined 
by dividing the R value for the given length of line by the number of sections. Since R (and) L 
values add in series and C and G values add in parallel, a multi-section model for simulation 
can easily be constructed. For example:

If the value of R for a given line is 2.4 ohms per meter,
and the length of line needed is 100 cm,
then the total resistance needed for the 100 cm line is 0.24 ohms
If 12 sections are used to model the line, then each R is 0.02 ohms.

The same calculation can be made for each of the parameters.

Equation 
Set 1

R RDC RSKIN f+=

L constant=

G GDC GAC f⋅+=

C constant=
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Extracting Fitted RLCG Parameters from S-Parameters
Telegrapher’s equations are used to solve for the RLCG values. The Telegrapher’s equations 
described in “Coupled-Transmission Line Models” on page 303 for the 2-coupled line model. 
Telegrapher’s equations deal with the voltage and current as shown in Figure 10-1. However, 
we measure S-parameters, which are ratios of power reflected from and transmitted thru to 
the incident power. For a single transmission line, the impedance (Z) and propagation 
constant (γ) can be derived from the measured 2-port S-parameters of the line. Equation Set 2 
defines the S-parameters in terms of Z, Z0 (characteristic impedance of the measurement 
system), γ, and l (the length of the line).

where

Ds = 2 × Z × Z0 cosh γl + (Z2 + Z0
2) sinh γl

Using Equation Set 2 and transforming to [ABCD} parameter, we can solve for γ and Z as 
functions of S-parameters as shown in Equation Set 3 and Equation Set 4:

where

Equation 
Set 2

Equation 
Set 3

Equation 
Set 4
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Once γ and Z are known, from the standard transmission line relationships, values for R, L, C, 
and G can be determined as shown in Equation Set 5 through Equation Set 10 below:

Then,

In the case of a pair of coupled transmission lines, each RLCG parameter is actually a 2-by-2 
matrix. For symmetrical uniform coupled transmission lines, the matrices are real and 
symmetrical. The latter is described in more detail in the following section.

Equation 
Set 5

Equation 
Set 6

Equation 
Set 7

Equation 
Set 8

Equation 
Set 9

Equation 
Set 10

γ R jωL+( ) G jωC+( ) α jB+= =

Z
R jωL+( )
G jωC+( )--------------------------=

R Re γZ{ }=

L Im γZ{ } ω⁄=

G Re γ Z⁄{ }=

C Im γ Z⁄{ } ω⁄=
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Coupled-Transmission Line Models
Start with an ideal lossless symmetrical coupled-transmission line (CPTL):

Figure 10-3 Lossless Coupled Line Model

The Telegraphers set of equations are described in Equation Set 11 and Equation Set 12:

Equation 
Set 11

Equation 
Set 12

∂V1

∂x
---------– L

∂I1

∂t
------- Lm

∂I2

∂t
-------+=

∂V2

∂x
---------– Lm

∂I1

∂t
------- L

∂I2

∂t
-------+=

∂I1

∂x
-------– C

∂V1

∂t
--------- Cm

∂ V1 V2–( )
∂t

--------------------------+=

∂I2

∂x
-------– Cm

∂ V2 V– 1( )
∂t

-------------------------- C
∂V2

∂t
---------+=
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These equations represent the closest form to the physical behavior of CPTL, since they 
describe each line by its own self parameters (L and C) and the different mutual couplings 
(Lm and Cm). Obviously, these equations can be extented for the lossy case, where the 
conductor and dielectric losses would be taken into account.

NOTE These parameters are called self-parameters.

By rearranging Equation Set 11 and Equation Set 12, a second set of parameters can be 
defined as shown in Equation Set 13 and Equation Set 14:

In the general case, RLCG parameters are grouped in 2-by-2 real matrices, each term being 
frequency-dependent. In the case of symmetrical coupled-lines, these matrices are 
symmetrical. See Equation Set 15.

NOTE These parameters are called spice-parameters.

Most Spice-type simulators use this type of model description with different variations in the 
implementation. This aspect is described in more details in Chapter 11, “Importing and 
Exporting Data.”.

Equation 
Set 13

Equation 
Set 14

Equation 
Set 15
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The third model representation that will be introduced with PLTS is called 
Differential-Common Modes Equivalent Model. We created this model mainly for the 
following reason:

The current RLCG extraction algorithm deals only with single-ended transmission lines 
(SETL). See the “Extracting fitted RLCG parameters from S- parameters” section above. 
So, we treat each quadrant from the mixed-mode S-parameters, in particular the 
Diff-Diff and Com-Com, as two separate SETL, with predefined normalized impedance.

The new set of RLCG parameters extracted for the differential and common modes, can be 
represented in a frequency-dependent matrix format, as shown in Equation Set 16.

NOTE These parameters are called Diff/Com parameters.

Equation 
Set 16
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CPTL RLCG Extraction Procedure
As previously described, we start by extracting the RLCG parameters for each of these two 
modes: Diff-Diff and Com-Com. In the case of a symmetrical CPTL, mode-conversion should 
be negligible. Then we offer the following options to visualize. See Figure 10-4.

Figure 10-4 RLCG Extraction Block Diagram

This section describes the formulas for the different transformations.

Equation Set 17 and Equation Set 18 relate the Odd and Even modes to the Differential and 
Common modes of propagation:

Equation 
Set 17

Equation 
Set 18
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Using the propagation constant and the characteristic impedance for the Odd/Even modes, 
the Spice parameters are derived in Equation Set 19 and Equation Set 20.

Finally, Self parameters can be derived as shown in Equation Set 21 and Equation Set 22.

Equation 
Set 19

Equation 
Set 20

Equation 
Set 21

Equation 
Set 22
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RLCG Output Plots
Figure 10-5 illustrates the difference between the extracted parameters and the fitted curve.

Figure 10-5 Extracted and Fitted Parameters

This plot format should be applied to either Diff/Com, Spice or Self parameters. 
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Figure 10-6 illustrates the propagation constant and Figure 10-7 illustrates the characteristic 
impedance in real-imaginary format. Since these two parameters are complex numbers, you 
have the choice of plotting these parameters in other formats, like Magnitude/Phase, 
dB/Phase versus linear or log of the frequency. Version 1.0 displays the familiar real and 
imaginary part of the impedance and the alpha and beta of the propagation constant.

Figure 10-6 Propagation Constant versus Frequency

Figure 10-7 Impedance versus Frequency
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Export data section is intended to link PLTS to the main EDA tools used by R&D engineers in 
the field of Signal Integrity. These EDA simulators are:

• Agilent ADS

• Avanti HSPICE

• IBM PowerSpice (not supported in Release 1)

For Agilent ADS, there are two main export formats defined so far. The first format exports 
fitted parameters in an ASCII file to be used with the ML2CTL_C model found in the 
Multilayer TL Library. The syntax is described in the following example:

BEGIN DSCR(RLGC)

! C[i][j]/eps0 l[i][j]/mu0 Rdc[i][j] Rhf[i][j]/sqrt(f_GHz) 
G[i][j]/omega*eps0
% C(real) L(real) Rdc(real) Rhf(real) G(real)
8.911534 0.326182 1.345030 13.7199 0.133030
-1.013052 0.067352 -0.000279 0.838288 -0.005866
8.911534 0.326182 1.345030 13.7199 0.133030

END

NOTE The ADS format has the capacitance values divided by epsilon zero, the 
inductance values divided by mu zero, and the high frequency resistance (Rs) 
divided by the square root of frequency in GHz.

To use this file in ADS, insert the ML2CTL_C component (found in the Tlines-Multilayer 
Pallet) and have the “RLCG_File” parameter point to the exported file. You will also need to 
set the “ReuseRLCG” parameter to “yes” and set the “Length” parameter to the length of the 
line you wish to simulate. Figure 10-8 is an ADS schematic using the RLCG parameters to 
simulate the S-parameters of the modeled line.
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Figure 10-8 ADS Schematic Using the ML2CTL_C Component
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The second format exports extracted parameters versus frequency in an ASCII file. Two files 
are created, one with the self parameters (i.e. R11, C11, etc.) and one with the mutual 
parameters (i.e. R12, C12, etc.). The file format is shown in Figure 10-9 and Figure 10-10.

Figure 10-9 Exported Extracted Parameter File Format for Self Parameters

Figure 10-10 Exported Extracted Parameter File Format for Mutual 
Parameters
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For Avanti HSPICE, the following format exports fitted parameters in an ASCII file to be 
used with the W element TL model. The syntax is described in the following example:

* RLCG parameters for a 2-conductor lossy
* frequency-dependent line

* N (number of signal conductors)
*****************************************
2

* Lo
4.098919e-007
8.463660e-008  4.098919e-007

* Co
7.890361e-011
-8.969661e-012  7.890361e-011

* Ro
1.34503
-0.000278525  1.34503

* Go
9.842513e-012
-5.905520e-012  9.842513e-012

* Rs
0.000419683
2.65087e-005  0.000419683

* Gd
7.399602e-012
-3.256807e-013  7.399602e-012 

To use this file in HSPICE use the W element and have the “RLCGfile” parameter point to the 
file exported from PLTS. A simple netlist using the W element and the exported parameters to 
do an S-parameter simulation of the modeled line is shown in the following example:

Single Ended TDR simulation of TL
.OPTIONS LIST NODE POST
.OP
.tran 0.01ns 5ns
.NET V(OUT) VIN ROUT=50 RIN=50
* .PLOT AC S11(DB) S22(DB) S21(DB)
VIN 3 0 DC=0 AC=1 pulse(0v 0.4v 0ns 100ps)
W1 In 1 0 OUT 2 0 N=2 L=0.127 RLGCfile=probednew.rlgc
R1 1 0 50
R2 2 0 50
R3 3 IN 50
R4 OUT 0 50
.END
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Considerations When Extracting RLCG Parameters
When extracting the RLCG parameters for a symmetrical coupled line, the measurement 
must include only the two-coupled line. It should not include any connectors, or single-ended 
launches in the measurement. If any of these are included, the parameters will not accurately 
model the transmission line. Figure 10-11 shows the connector and launches that need to be 
removed.

Figure 10-11 Typical Connectorized Device to be Tested

The effects to the left of the dotted line need to be removed. These can be removed one of two 
ways. The first is to characterize the launch structure (to the left of the dotted line) and then 
de-embed it from the measurement. This is not easily done. The other way is to create 
calibration standards on the board that include the connector and launch and use them to 
calibrate with. However the parasitics of the standards need to be characterized and entered 
into the calibration kit definition.

The easiest way to characterize the transmission line is to do a probed measurement. By 
performing a probe calibration there are no connectors or launches to remove. Figure 10-12 
shows a typical probed measurement.
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Figure 10-12 Typical Probed Measurement of a Transmission Line
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The Parameters for Each RLCG Format
The data (parameters) available for each of the four RLCG formats varies due to the model 
assumptions. The individual parameter selections are based on the specific RLCG data 
analysis type. The following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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This section guides you with opening measured data and viewing the data using transmission 
line (RLCG) parameter extraction. There are eight transmission line parameters for each 
transmission line format. You may elect to view any number of these parameters.

Opening a Transmission Line Plot Window

The transmission line parameters may be viewed in any of four formats (differential, common, 
W-Element, and self/mutual). 

You may open the transmission line plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 10-13

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 10-13

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 10-13

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the RLCG choices - see (B) of Figure 10-13

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the RLCG 
menu once the blank plot window is displayed after the T-Line parameters are 
defined in the next step.
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Figure 10-13 Opening the Transmission Line Plot Window

The T-Line Characteristics dialog box (Figure 10-14) is then displayed. Enter the length of the 
transmission line (in meters) and the highest measured frequency (in megahertz) and then 
click OK. 

Figure 10-14 T-Line Characteristics Dialog Box

Length (M) can be used to scale extracted values in units/meter.

Highest Extracted Frequency (MHz) defaults to the stop frequency. However, this can be 
set at a lower frequency to better fit your parameters.

The highest extracted frequency is 90% of the maximum measured frequency. For example, 
45 GHz for a 50 GHz measurement or in the case shown in Figure 10-14, 8100 MHz for a 
9 GHz measurement. This allows for some guard band of the data, extra bandwidth for use in 
time to frequency conversions, and to allow some extra frequency range to get food data and 
allow for time domain roll off.
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The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eight of the RLCG 
parameter plots are displayed. Each of the plots are labeled. See Figure 10-15.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all eight plots by selecting All from the Parameter Bar or from 
the RLCG menu with New Plot selected.

Figure 10-15 All 8 RLCG Plots
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Viewing a Single RLCG Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
eight plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 10-16. 

Figure 10-16 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Creating a Custom RLCG Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four RLCG plots of RLCG (Differential). To create this 
custom window, open the measured data file in any analysis type. Then, in the Browser, 
select the data type that you want to display the plots. In this example, select RLCG 
(Differential). A blank plots window is displayed. With New Plot selected in the 
Parameter Bar (or the RLCG menu), click the desired parameters (R, L, C, and G in this 
example). As each parameter is selected, a new plot is added to the plots window. See Figure 
10-17.

Figure 10-17 Custom Plots Window with Four Plots
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The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 10-18 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 10-19.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 10-19.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 10-19. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 10-19 Entering a Scale Value

The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
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frequencies used in the measurement. 

The vertical scale units are changed using the same method as used for the horizontal units. 
The units vary to be appropriate for each plot. For example, when the plot is inductance, the 
units are in Henrys while when a resistive plots is displayed, the units are ohms. 
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Exporting Transmission Line Data
The PLTS can export the transmission line data to the main electronic design automation 
(EDA) software tools used by R&D engineers in the field of signal integrity. These EDA 
simulators are:

• HSPICE
• ADS (Advanced Design System - Integrated Design Software and Test Instrumentation 

solution from Agilent Technologies)

Refer to “Export Data Formats” on page 310 for detailed information on the file formats for 
exported data.

Selecting the Export in the File menu to access the three RLCG export menu selections. A 
brief description and the syntax of each selection is listed in this section. 

Figure 10-20 RLCG Export Menu
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Importing and Exporting Data
In addition to making measurements and reviewing the data files within the software, PLTS 
has both import and export capabilities. While PLTS makes quick and accurate 
measurements and provides an excellent platform to view measured data, you will want to 
import data from other sources that you can view and compare and you will want to export 
data for use with modeling and simulation tools. PLTS can be used with a variety of modeling 
and simulation tools and can import and export in multiple formats. Figure 11-1 shows how 
the data file import and data file export capabilities blend with the whole PLTS software 
product.

Figure 11-1 PLTS Data File Import and Export Block Diagram
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File Formats
This section describes the S4P (Touchstone) and the CITIfile file formats. The Touchstone file 
format begins on page 334.

CITIfile

CITIfile is a standardized data format, used for exchanging data between different computers 
and instruments. CITIfile is an abbreviation for “Common Instrumentation Transfer and 
Interchange file”. 

This standard has been a group effort between instrument designers and designers of 
computer-aided design programs. As much as possible, CITIfile meets current needs for data 
transfer, and it was designed to be expandable so it can meet future needs.

CITIfile defines how the data inside an ASCII package is formatted. Since it is not tied to any 
particular disk or transfer format, it can be used with any operating system (BASIC, DOS, 
UNIX, etc.), with any disk format (LIF, DOS, HFS, etc.), or with any transfer mechanism 
(disk, LAN, GPIB, etc.). 

By careful implementation of the standard, instruments and software packages using CITIfile 
are able to load and work with data created on another instrument or computer. It is possible, 
for example, for a network analyzer to directly load and display data measured on a scalar 
analyzer, or for a software package running on a computer to read data measured on the 
network analyzer. 

NOTE For many data processing applications, the S4P file may provide a more 
convenient format.

Data Formats

There are two main types of data formats: binary and ASCII. CITIfile uses the ASCII text 
format. While this format does take up more bytes of space than a binary format, ASCII data 
is a transportable, standard type of format which is supported by all operating systems. In 
addition, the ASCII format is accepted by most text editors. This allows files to be created, 
examined, and edited easily, making CITIfile easier to test and debug.

File and Operating System Formats

CITIfile was designed to be independent of the data storage mechanism, and therefore may be 
implemented for any file system. However transfer between file systems may sometimes be 
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necessary. Any commercially available software that has the ability to transfer ASCII files 
between systems may be used to transfer CITIfile data.

Definition of CITIfile Terms

This section will define the following terms: package, header, data array, keyword

Package  A typical package is divided into two parts: The first part, the header, is made up of 
keywords and setup information. The second part, the data, usually consists of one or more 
arrays of data. Example 1 shows the basic structure of a CITIfile package:

Example 1, A CITIfile Package

The “header” part  CITIFILE A.01.00
NAME MEMORY
VAR FREQ MAG 3
DATA S RI

The “data” part  BEGIN
-3.54545E-2, -1.38601E-3
0.23491E-3, -1.39883QE-3
2.00382E-3, -1.40022E-3
END

When stored in a disk file there may be more than one CITIfile package.

The CITIfile Header  The header section contains information about the data that will 
follow. It may also include information about the setup of the instrument that measured the 
data. For example, the header may include information such as:

• CITIfile version number
• Network analyzer model number
• Firmware revision currently installed in the analyzer
• Type of Data
• Data Format
• Measurement parameters
• Start and stop frequencies
• Number of sample points

The CITIfile header shown in Example 1 has just the bare minimum of information 
necessary; no instrument setup information was included.

An Array of Data  An array is numeric data that is arranged with one data element per line. 
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In the Smith chart and polar formats, the data is in real and imaginary pairs. In all other 
formats, the data is still in pairs, but the second term of the pair is 0E0. All information is 
true formatted data in the same format as on the analyzer display (dB, SWR, etc.).

A CITIfile package may contain more than one array of data. Arrays of data start after the 
BEGIN keyword, and the END keyword will follow the last data element in an array. A 
CITIfile package does not necessarily need to include data arrays; for instance, CITIfile could 
be used to store the current state of an instrument. In that case the keywords VAR, DATA, 
BEGIN, and END would not be required.

CITIfile Keywords  

Table 11-1 CITIfile Keywords

Keyword Explanation and Examples

CITIFILE CITIFILE A.01.01 identifies the file as a CITIfile, and indicates the 
revision level of the file. The CITIfile keyword and revision code must 
precede any other keywords. The CITIfile keyword at the beginning of the 
package assures the device reading the file that the data that follows is in 
the CITIfile format. The revision number allows for future extensions of the 
CITIfile standard. The revision code shown here following the CITIfile 
keyword indicates that the machine writing this file is using the A.01.01 
version of CITIfile as defined here. Any future extensions of CITIfile will 
increment the revision code. 

NAME NAME CAL_SET allows the current CITIfile “package” to be named. The 
name of the package should be a single word with no embedded spaces. A 
list of standard package names follows: 

Label Definition.

RAW_DATA Uncorrected data.

DATA Data that has been error corrected.When only a single data array exists, it 
should be named DATA.

FORMATTED Corrected and formatted data.

MEMORY Data trace stored for comparison purposes.

CAL_SET Coefficients used for error correction.

CAL_KIT Description of the standards used.

DELAY_TABLE Delay coefficients for calibration.
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VAR VAR FREQ MAG 201 defines the name of the independent variable 
(FREQ), the format of values in a VAR_LIST_BEGIN table (MAG, if used), 
and the number of data points (201).Typical names for the independent 
variable are FREQ (in Hz), TIME (in seconds), and POWER (in dBm). For 
the VAR_LIST_BEGIN table, only the “MAG” format is supported at this 
point. # #NA POWER1 1.0E1 allows variables specific to a particular type 
of device to be defined. The pound sign (#) tells the device reading the file 
that the following variable is for a particular device. The “NA” shown here 
indicates that the information is for a Network Analyzer. This convention 
allows new devices to be defined without fear of conflict with keywords for 
previously defined devices. The device identifier (i.e. NA) may be any 
number of characters. 

SEG_LIST_BEGIN SEG_LIST_BEGIN indicates that a list of segments for the independent 
variable follow. Format for the segments is: [segment type] [start] [stop] 
[number of points]. The current implementation only supports a single 
segment. If there is more than one segment, the VAR_LIST_BEGIN 
construct is used. CITIfile revision A.01.00 supports only the SEG (linear 
segment) segment type. 

SEG_LIST_END SEG_LIST_END defines the end of a list of independent variable segments. 

VAR_LIST_BEGIN VAR_LIST_BEGIN indicates that a list of the values for the independent 
variable (declared in the VAR statement) follow. Only the MAG format is 
supported in revision A.01.00. 

VAR_LIST_END VAR_LIST_END defines the end of a list of values for the independent 
variable. 

DATA DATA S[1,1] RI defines the name of an array of data that will be read later 
in the current CITIfile package, and the format that the data will be in. 
Multiple arrays of data are supported by using standard array indexing. 
Versions A.01.00 and A.01.01 of CITIfile only support the RI (real and 
imaginary) format, and a maximum of two array indexes. Commonly used 
array names include the following: “S” for “S parameter” Example: S[2,1] 
“E” for “Error term” Example: E[1] “USER” for “User parameter” Example: 
USER[1] “VOLTAGE” Example: VOLTAGE[1] “VOLTAGE_RATIO” for a 
ratio of Example: VOLTAGE_RATIO[1,0] two voltages (A/R). 

Table 11-1 CITIfile Keywords

Keyword Explanation and Examples
Chapter 11332



Importing and Exporting Data
File Formats
• The COMMENT statement is not absolutely required, but is highly recommended to aid 
readability. 

• The year should always be the full four digits (“1999” is correct, but “99” is not). This is to 
avoid problems with the year 2000, when the shortened version of the year will be “00.”

• The hour value should be in 24-hour “military” time. 

• When writing a CITIfile and the fractional seconds value is zero, then the “seconds” value 
may be printed either with or without a decimal point: either “47.0” or “47” would be 
acceptable. When reading a CITIfile, the seconds value should always be read as if it were 
a floating point number. 

CONSTANT CONSTANT [name] [value] allows for the recording of values which don’t 
change when the independent variable changes. 

CONSTANTs are part of the main CITIfile definition. Users must not 
define their own CONSTANTs. Use the #KEYWORD device specification to 
create your own KEYWORD instead. The #NA device specification is an 
example of this. No constants were defined for revision A.01.00 of CITIfile. 
CITIfile revision A.01.01 defined the following constant:

CONSTANTs are part of the main CITIfile definition. Users must not 
define their own CONSTANTs. Use the #KEYWORD device specification to 
create your own KEYWORD instead. The #NA device specification is an 
example of this. No constants were defined for revision A.01.00 of CITIfile. 
CITIfile revision A.01.01 defined the following constant: 

CONSTANT TIME [year] [month] [day] [hour] [min] [secs] 
Example: 
CONSTANT TIME 1999 02 26 17 33 53.25

Table 11-1 CITIfile Keywords

Keyword Explanation and Examples
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S4P (Touchstone)

These files contain S-parameters described by frequency-dependent linear network 
parameters for 4-port components. The S4P data file format is the type of file format that also 
known as Touchstone format. 

An .s4p file can be used with an S4P component to model the behavior of a linear model using 
S-parameters. The file contains the S-parameters, the component is placed within the 
schematic.

This section describes:

• An overview of the S4P file
• The basic S4P format
• The basic S4P format applied to S-parameters, plus example 

S4P data files are ASCII text files in which data appears line by line, one line per data point, 
in increasing order of frequency. Each line of data consists of a frequency value and one or 
more pairs of values for the magnitude and phase of each S-Parameter at that frequency. 
Values are separated by one or more spaces, tabs or commands. Comments are preceded by an 
exclamation mark (!). Comments can appear on separate lines, or after the data on any line or 
lines. Extra spaces are ignored. PLTS uses the following format for 4-port touchstone file 
identification: filename.s4p

Basic S4P File Format

The following example shows the general format for component data files. It consists of:

• An option line
• Data lines
• Comments 

The Option Line

The option line, specifying the frequency units and the normalizing impedance, precedes the 
data lines.

where, 

# = The delimiter that tells the program you are specifying these parameters

option line − # <frequency unit> <parameter> <format> <R n> 
<data line> 
…
<data line> 
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frequency units  = The set of units desired (GHz, MHz, KHz, Hz)

parameter = The parameter desired (“S” for S4P components)

format = The format desired (DB for dB-angle, MA for magnitude-angle, and RI for 
real-imaginary)

R n = The reference resistance in ohms, where n is a positive number of ohms of 
the real impedance to which the parameters are normalized)

In summary, the option line should read: # [HZ/KHZ/MHZ/GHZ] [S] [MA/DB/RI] [R n]

Where square brackets [...] indicate optional information; .../.../.../ indicates that you select one 
of the choices; and, n is replaced by a positive number. 

The default option line for component data files is: 

# GHZ S MA R 50 

An example of an Option Line for a files with Frequency in GHz, S-parameters in 
real-imaginary format, normalized 100 ohms: 

# GHz S RI R 100 

Data Line

Data lines contain the data of interest. For 4-port data files, the network parameters appear 
in the file in a matrix form, each row starting on a separate line. A maximum of four network 
parameters (with 2 real numbers for each) appear on any line. The remaining network 
parameters are continued on as many additional lines as are needed. 

Data Line Formats  When you type the data below the option line, the columns need not 
line up precisely like those shown. The syntax for data is as follows:

4-Port Components  Magnitude-Angle format: 

Freq Mag Ang Mag Ang Mag Ang Mag Ang

f S11 S11 S12 S12 S13 S13 S14 S14

S21 S21 S22 S22 S23 S23 S24 S24

S31 S31 S32 S32 S33 S33 S34 S34

S41 S41 S42 S42 S43 S43 S44 S44

where f = Frequency,
Mag = Magnitude of S-parameter, and 
Ang = Angle of S-parameter
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Comments

You can document your data files by preceding a comment with the exclamation mark (!) on 
any line. A comment can be the only entry on a line or can follow the data on any line. 

S4P Format Examples

Here are formatting reference examples for S-parameter files.

S4P files can have MA, RI, or DB formats. The following examples show the format of each 
format style.

The MA file format is:

The RI file format is:

 # frequency_unit S MA R impedance ! 1st row

freq magS11 angS11 magS12 angS12 magS13 angS13 magS14 angS14

magS21 angS21 magS22 angS22 magS23 angS23 magS24 angS24

magS31 angS31 magS32 angS32 magS33 angS33 magS34 angS34

magS41 angS41 magS42 angS42 mag43 angS43 magS44 angS44

where freq = Frequency,
mag = Magnitude of S-parameter, and 
ang = Angle of S-parameter

 # frequency_unit S RI R impedance ! 1st row

freq realS11 imagS11 realS12 imagS12 realS13 imagS13 realS14 imagS14

realS21 imagS21 realS22 imagS22 realS23 imagS23 realS24 imagS24

realS31 imagS31 realS32 imagS32 realS33 imagS33 realS34 imagS34

realS41 imagS41 realS42 imagS42 real43 imagS43 realS44 imagS44

where freq = Frequency,
real = Real portion of S-parameter value, and 
imag = Imaginary portion of S-parameter value
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The DB file format is:

4-Port S4P (Touchstone) File Example

The following example shows an S4P file in Magnitude format with the frequencies displayed 
in GHz, and having a 50-ohm reference resistance. This examples shows actual data at three 
frequency points.

 # frequency_unit S DB R impedance ! 1st row

freq dBS11 angS11 dBS12 angS12 dBS13 angS13 dBS14 angS14

dBS21 angS21 dBS22 angS22 dBS23 angS23 dBS24 angS24

dBS31 angS31 dBS32 angS32 dBS33 angS33 dBS34 angS34

dBS41 angS41 dBS42 angS42 db43 angS43 dBS44 angS44

where freq = Frequency,
dB = dB value of S-parameter, and 
Ang = Angle of S-parameter

 #  GHZ S MA R 50

5.00000 0.60262 161.240 0.40611 -42.2029 0.42918 -66.5876 0.53640 -79.3473

0.40611 -42.2029 0.60262 161.240 0.53640 -79.3473 0.42918 -66.5876

0.42918 -66.5876 0.53640 -79.3473 0.60262 161.240 0.40611 -42.2029

0.53640 -79.3473 0.42918 -66.5876 0.40611 -42.2029 0.60262 161.240

6.00000 0.57701 150.379 0.40942 -44.3428 0.41011 -81.2449 0.57554 -95.7731

0.40942 -44.3428 0.57701 150.379 0.57554 -95.7731 0.41011 -81.2449

0.41011 -81.2449 0.57554 -95.7731 0.57701 150.379 0.40942 -44.3428

0.57554 -95.7731 0.41011 -81.2449 0.40942 -44.3428 0.57701 150.379

7.00000 0.50641 136.693 0.45378 -46.4151 0.37845 -99.0918 0.62802 -114.196

0.45378 -46.4151 0.50641 136.693 0.62802 -114.196 0.37845 -99.0918

0.37845 -99.0918 0.62802 -114.196 0.50641 136.693 0.45378 -46.4151

0.62802 -114.196 0.37845 -99.0918 0.45378 -46.4151 0.50641 136.693
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Select Import from the File menu to import a single-ended measurement data file. Then 
select either CITIFile to import a file in CITIfile format or Touchstone (S4P) to import a file 
in Touchstone format. Then select from one of the port selections (either Port Configuration 
= 1 & 3 -> 2 & 4 or Port Configuration = 1 & 2 -> 3 & 4) based on the calibration type used 
with the original measurement.

Figure 11-2 File Menu with Import and CITIFile Expanded

Figure 11-3 Balanced Transform Port Configuration Diagram
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CITIFile

CITIFile imports data previously saved in CITIfile (*.cit) format. Files imported in this 
fashion can be used for comparison with other data sets using trace memory and math 
functions. Refer to Figure 11-3 and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the TRL calibration.

Touchstone

Touchstone imports data previously saved in Touchstone (*.S4P) format. Refer to Figure 11-3 
and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the TRL calibration.
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Exporting Data Files
Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.

Figure 11-4 File Menu with Export Expanded

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.

Plots to Clipboard

Plot(s) to Clipboard exports the active plots window to the Windows clipboard. It does not 
copy or export data.

From the File menu, select Export, then Plot(s) to Clipboard to export the plot images to 
Windows clipboard. The contents of the clipboard can then be pasted into other Windows 
programs.

This feature is the same as the Copy icon on the Toolbar.
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Plots to Image File

Plot(s) to Image File exports the contents of the active plot window to an image file. 

The Select Bitmap Size dialog box is displayed giving you the choice of bitmap sizes. Choose 
from 640 x 460, 800 x 600, 1024 x 768, or 1280 x 1024 pixels. See Figure 11-5.

Figure 11-5 Select Bitmap Size Dialog Box

When you export it, you may choose from Windows Bitmap (*.BMP), JPEG Bitmap (*.JPG), or 
Targa Bitmap (*.TGA) formats. Select OK to export the image.

This feature is the same as the Export Bitmap icon (the camera icon) in the Toolbar.

Frequency Domain

Frequency Domain exports the data of a single S-parameter (either single-ended or 
balanced) or the data of all 32 single-ended and balanced using one of four frequency domain 
formats: Real/Imaginary, Log Magnitude, Linear Magnitude, or Phase. 

1. From the File menu, select Export, Frequency Domain to display the Frequency 
Domain Export dialog box.

Figure 11-6 Frequency Domain Export Dialog Box
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2. In the 1. Select the frequency domain parameter list, select any one of the 16 single 
ended parameters or any one of the 16 balanced parameters to export. You can also export 
all 32 of the parameters by selecting All at the bottom of the list.

3. In the 2. Select the format area, select one of the four formats to save the data as: 
Real/Imaginary, Log Magnitude, Linear Magnitude, or Phase

4. Select the OK button to open the Save As dialog box.

Figure 11-7 Save As Dialog Box

5.  In the Save As dialog box, select the directory that you want to save the data in.

6. In the File name: text box, enter a file name for the data to be saved.

7. In the Save as type: list, select the file to save the data to.

You may select either CSV (comma-separated variable with .csv extension) or Text (tab 
delimited with .txt extension).

8. Click the Save button to save the data.

When a single parameter is selected, the parameters data is saved to the file that you 
named with the extension that you selected. When all parameters are selected, each 
parameter is saved to a separate file; thus 32 files are created. Each file is saved with the 
name you entered. However, each file name has a parameter labeled appended to the 
name. For example, you entered device4 as the file name, the S11 parameter file is 
named: device4_S11

CITIFile

CITIFile exports the current data in CITIfile format (*.cit).
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Touchstone

Touchstone exports the current data in the S4P format which also has the following data 
format choices in which the data may be saved: 

• Magnitude, angle 

• dB, angle (power, angle)

• Real, imaginary

Figure 11-8 File Menu with Export and Touchstone Expanded

Time Domain

Time Domain exports the data of a single time domain parameter (either single-ended or 
differential) or the data of all 32 single-ended and differential using either the Step or 
Impulse response type.

1. From the File menu, select Export, Time Domain to display the Export Time Domain 
dialog box.
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Figure 11-9 Export Time Domain Dialog Box

2. In the 1. Select the time domain parameter list, select any one of the 16 single ended 
parameters or any one of the 16 differential parameters to export. You can also export all 
32 of the parameters by selecting All at the bottom of the list.

3. In the 2. Select response type area, select either: Step or Impulse

4. Select the OK button to open the Save As dialog box.

Figure 11-10 Save As Dialog Box

5.  In the Save As dialog box, select the directory that you want to save the data in.

6. In the File name: text box, enter a file name for the data to be saved.

7. In the Save as type: list, select the file to save the data to.

You may select either CSV (comma-separated variable with .csv extension) or Text (tab 
delimited with .txt extension).

8. Click the Save button to save the data.

When a single parameter is selected, the parameters data is saved to the file that you 
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named with the extension that you selected. When all parameters are selected, each 
parameter is saved to a separate file; thus 32 files are created. Each file is saved with the 
name you entered. However, each file name has a parameter labeled appended to the 
name. For example, you entered device4 as the file name, the T11 parameter file is 
named: device4_T11 
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TDA MeasureXtractor

TDA MeasureXtractor directly export 4-port S-parameters in Touchstone format for import 
into TDA Systems’ MeasureXtractor. This is a powerful capability that allows you to describe 
the exact frequency dependent behavior of your passive device using an S-parameter block 
inside of MeasureXtractor. MeasureXtractor also allows you to create a SPICE compatible 
model for further circuit simulation. You can access the PLTS TDA MeasureXtractor export 
feature by selecting Export then TDA MeasureXtractor from the File menu.

File Format and Port Conventions

The format of the 4-port S-parameter Touchstone file is magnitude (in dB) and phase (in 
degrees) information at each frequency point. Port designations in the resultant Touchstone 
file are as they appear in the DUT file.

• If you are only using a single S-parameter defined data block in your MeasureXtractor 
schematic, your results are specific to what you attach to each of the ports.

• If you are using cascaded S-parameter data blocks in your schematic they must have ports 
1 and 3 as the input ports and ports 2 and 4 as the output ports (see Figure 11-11). Since 
TDR measurements typically have ports 1 and 2 as the input ports and 3 and 4 as outputs, 
a port swap between port 2 and port 3 will need to be performed. You can also read TDR 
waveforms directly into IConnect MeasureXtractor for data driven models.

Figure 11-11 Requirement when S-Parameter Blocks are Cascaded

Recommendations for a Good MeasureXtractor-compatible File

• For TDR-based measurements set the number of points to 2000 or above and make all 16 
single-ended measurements (differential measurements are not required). A complete 
4-port measurement set is required to export directly to MeasureXtractor. Alternately, you 
can export selected S-parameters directly from PLTS into a Touchstone file from the File 
menu by selecting Export, Touchstone, and Magnitude, angle.

• When using a VNA, perform your measurement starting at as low a frequency as possible. 
Since Start and Step frequency settings are coupled, this will ensure several things 
including getting about 1000 points of data (so as to avoid undersampling) and an 
adequate extrapolation down to dc. Not following these precautions can lead to difficulty 
with successfully extracting a circuit in MeasureXtractor.
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• Maintain good fixturing, calibration practices, and a low IF bandwidth when using a VNA 
will ensure good reciprocity and prevent your passive device from turning active at any 
frequency point. The MeasureXtractor software requires good reciprocity (e.g. S12 = S21, 
S34 = S43 to better than about 2%) for its algorithms to function and utilizes an input 
checker that will reject files with poor reciprocity. You can visually check for reciprocity or 
perform math functions within PLTS before exporting to MeasureXtractor as an earlier 
indicator.

• Use only short-to-medium length devices. Using devices that are less than 20 wavelengths, 
or no more than 100 rise times long, will keep extraction time and simulation time of the 
resultant S-parameter block in MeasureXtractor reasonable.

• Obtain dc response information on your device if possible. This will enhance the accuracy 
of the model created inside of MeasureXtractor.

Recommendations for Using the Exported File in MeasureXtractor

In TDA Systems’ software:

• Change the Max Frequency field under Tools > Options > Waveform Viewer to match 
the maximum frequency of your Touchstone file.

• Follow the guidelines listed in the TDA Systems’ documentation for rise time, truncating, 
and dc values.
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RLCG

RLCG exports the current data in one of two RLCG formats: 

• HSPICE exports the RLCG data in a format compatible with HSPICE (a Simulation 
Program with Integrated Circuit Emphasis) software. Refer to “Exporting Transmission 
Line Data” on page 325.

• ADS exports the RLCG data in a format compatible with the Agilent Advanced Design 
System (ADS) software format which also has the two following data format choices in 
which the data may be saved:

❏ Actual Measured Parameters exports extracted parameters versus frequency in an 
ASCII file for ADS. Refer to “Exporting Transmission Line Data” on page 325. 

❏ ML2CTL exports fitted parameters in an ASCII file to be used with the ADS 
MultiLayer 2 Coupled Transmission Lines (ML2CTL) model. Refer to “Exporting 
Transmission Line Data” on page 325.

Figure 11-12 File Menu with Export, RLCG, and ADS Expanded
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Removing Unwanted Effects from the Measurement
To reduce your measurement, analysis, and redesign cycles, the physical layer test system 
offers three techniques to help you define/redefine your device under test (DUT).

CAUTION If you have not yet saved your measured data, save it before removing any of 
these unwanted effects by selecting Save from the File menu. 

Figure 12-1 Ease Versus Accuracy of Removing Unwanted Effects

• Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot 
that you define, replacing it with an ideal transmission line having the same electrical 
delay as the removed section. By observing the original frequency domain response and 
the transformed frequency domain response, the effect of the gating operation on the 
S-parameter data can be seen.

• Port Reference Plane Adjustment (or port reference plane rotation) mathematically 
extends the measurement plane to the DUT, but assumes the fixture looks like a perfect 
transmission line: a flat magnitude response, a linear phase response, and constant 
impedance. Port reference plane adjustments are usually done after a coaxial calibration 
has been performed at the end of the test cables. If the fixture is very well designed, this 
technique may be sufficient.

• De-embedding affords a very accurate technique that removes the effect of added loss, 
phase shift, and mismatch due to adding adapters, probes, and fixtures to your DUT. It 
combines the errors determined from a coaxial calibration with the errors in the fixture to 
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obtain a single error coefficient array that corrects for everything up to the measurement 
plane of the DUT. Deembedding uses an accurate linear model of the fixture, or measured 
S-parameter data of the fixture. This modeled or measured data is then mathematically 
removed from the DUT measurement data in post-processing.
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Gating
The controls for gating the time domain response provide the ability to remove the effect of a 
particular circuit element mathematically. You define the start- and stop-points of the gate. 
An 'Ideal' gate replaces the gated section with an ideal transmission line having the same 
electrical delay as the section that it replaced. 

Up to 10 gates can be added. The gates are numbered sequentially from the left edge of the 
plot to the right edge. For example, the first gate (Gate 1) was added. Then a second gate is 
added to the left of the Gate 1. The gates are then renumbered such that the gate on the left 
(the second gate that was added) becomes Gate 1, and the original gate is changed to Gate 2. 
Either deleting or moving a gate can cause the gates to be renumbered.

By observing the original frequency domain response and the transformed frequency domain 
response, the effect of the gating operation on the S-parameter data can be seen. 

To Add a Gate

1. Click Gating from the Utilities menu. Then click either Gating (Single Ended) or 
Gating (Balanced) depending on whether your Time Domain plot is single-ended or 
differential.

Figure 12-2 Utilities Menu with Gating Expanded

The Gating Bar (shown in Figure 12-3) and an empty plot window are displayed when 
gating is selected from the Utilities menu.
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Figure 12-3 Gating Bar

2. From the Parameter Bar (or from the Data menu), select the parameter that will have 
gates added to it. 

When you select the parameter, two plots are displayed in the plots window. The left plot is 
the parameter you selected displayed in Time Domain mode. The right plot is that same 
parameter displayed in Frequency Domain Mode. See Figure 12-4. When adding a gate to 
the time domain trace, you will also be able to see how adding the gate affects the 
parameter in the Frequency Domain by watching the right plot.

Figure 12-4 Gating Display: Time Domain Plot and Frequency Domain Plot
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3. Click the Start button. 

4. While watching the gate start marker, a solid blue vertical line on your time domain plot, 
move the slide control to the right to set the start position of the gate. As the slide control 
is positioned, the time (or distance) of the start gating marker is displayed in the Start 
box. See Figure 12-5.

Figure 12-5 Setting the Gating Start Position

5. Click Stop button.

6. While watching the gate stop marker, a broken blue vertical line on your time domain plot, 
move the slide control to the right to set the stop position of the gate. See Figure 12-6.
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Figure 12-6 Setting the Gating Stop Position

7. Click the Add button to add the gate. 

When Add is selected:

• A gate identifier is added to the Gate box to identify the number of the gate that was 
just added. See Figure 12-7.

• In the Time Domain plot, a straight blue line is added between the start and stop 
points to reflect that the measured data is being replaced mathematically with an ideal 
transmission line.

• In the Frequency Domain plot, the red trace shows how the original S-parameter looks. 
The black trace shows how the S-parameter looks when the effects of the gate are taken 
into account.
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Figure 12-7 The Effects of Adding a Gate

8. Repeat Steps 3 through 7 to add additional gates.

The maximum number of gates that can be added is 10.

To Move a Gate

A gate can be moved by selecting the gate from the Gate list and clicking the Move button, 
and moving the slide control left or right to the desired location. Then select the Apply button 
to have the move take affect. The range between the start and stop values of the gate remains 
the same, just the start and stop values are changed. 

To Delete a Gate

A gate can be deleted by selecting the gate from the Gate list and clicking the Delete button. 
The gate numbers are moved down in number when a gate is deleted. For example, when Gate 
4 is deleted, Gate 5 becomes Gate 4, and Gate 6 becomes Gate 5, and so on. 
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Port Reference Plane Adjustment
Adding adapters, fixtures, and probes introduces additional loss, phase shift, and mismatch 
that can add error to the measurement of your DUT. The port reference plane adjustment 
feature allows you to move the calibrated reference plane from the end of the test cable 
toward the DUT in an attempt to eliminate the effects of phase shift introduced by the 
addition of adapters, fixtures, and probes. Port reference plane adjustment does not correct for 
additional loss and mismatch introduced by these items.

Port reference plane adjustment can be adjusted using either of the two methods described in 
this section. Refer to To Adjust Port Reference Plane located below or “To Rotate the 
Reference Plane Using the De-Embedding Dialog Box” on page 358. 

To Adjust Port Reference Plane

The easiest way to adjust the port reference plane is by using the following method:

1. Select Adjust Port Reference Plane from the Utilities menu to open the Adjust Port 
Reference Plane dialog box where you can change the reference plane rotation settings and 
recalculate the displayed data.

Figure 12-8 Adjust Port Reference Plane Dialog Box

2. Enter the new reference plane values for the desired ports by using the arrows or entering 
the values in the port box directly. 

A positive value rotates the phase towards the DUT (effectively removing a length of 50Ω 
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line) and a negative number rotates the phase away from the DUT (effectively adding a 
length of 50Ω line).

3. Click Apply Rotation to recalculate the data and display the new plots. 

Note that when reference plane rotation is applied, the De-Embedding indicator color 
changes to a bright color. See Figure 12-10 on page 359.

Reset returns the values to zero, recalculates the data, and displays original plots.

To Rotate the Reference Plane Using the De-Embedding Dialog Box

1. Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. 

Use the De-Embedding dialog box to configure DUT reference planes by de-embedding 
probes, fixtures, or adapters from the measured data.

Figure 12-9 De-Embedding Dialog Box

2.  In the Reference Plane area, click Rotate Reference Plane.

3. Enter a reference plane rotation value (in centimeters-in-air). 

You can use the spinner or click in the cm box and enter a value directly. 

A positive value rotates the phase towards the DUT (effectively removing a length of 50Ω 
line) and a negative number rotates the phase away from the DUT (effectively adding a 
length of 50Ω line).
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4. Select the port to assign the rotation value to a port by selecting from the port numbers.

As you select a port, that rotation value is shown below in the information area for that 
port.

5. Repeat steps 3 and 4 until you have assigned rotation values to all appropriate ports.

6. Turn the port reference plane adjustment on by clicking the ON/OFF button (shown in 
Figure 12-9) until the label reads: De-embedding is currently ON for this file

7. Click OK to accept the configuration and exit the dialog box.

 Cancel ignores any changes and exits the dialog box.

The De-Embedding indicator on status bar means that De-embedding is being applied. See 
Figure 12-10.

Figure 12-10 De-Embedding Indicator on the Status Bar
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De-Embedding
Adapters, test fixtures, or other non-DUT structures introduce unwanted effects and error 
into measurement results. These unwanted effects typically include additional loss, phase 
shift, mismatch, discontinuities, and time delay. De-embedding is the process of 
mathematically removing previously characterized performance of the non-DUT structure 
from the measurement in post-processing.

NOTE De-embedding is a powerful utility, but requires advanced S-parameter 
characterization of the non-DUT structure through measurement or modeling. 
While measuring the structure can provide the most accurate characterization, 
it may be difficult or impossible to perform the measurement due to 
connectivity issues. In these cases, S-parameter models may offer the best 
alternative.

After an S-parameter file of the non-DUT structure is created in CitiFile format, it is 
user-modified and saved as an adapter characterization file (with a “.txs” filename extension). 
See “Converting a CitiFile to a PLTS Adapter File” on page 600. At that point, it is ready to be 
used by following the instructions below.

1. Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. 

Figure 12-11 De-Embedding Dialog Box
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2. Click Select Device to De-Embed.

3. Select a de-embedding file (.txs) that you want to use from the de-embedding file list.

4. Select the check box associated with the port to which the file applies. 

5. Click the associated << button to add the file to the port. (Clicking the ✕ button will 
remove the file from the port.)

6. Repeat steps 3 through 5 until you have assigned de-embedding files to all appropriate 
ports.

7. Select all ports that use reverse adapter orientation.

Reverse orientation is noted by check marks for each port specified in the Use Reverse 
Orientation check boxes. Reverse orientation refers to when port 1 of the adapter is 
connected to the DUT. Refer to “Characterizing Adapters” on page 176 for further 
information and instructions on performing adapter characterization.

8. Turn the de-embedding on by clicking the ON/OFF button (shown in Figure 12-11) until 
the label reads: De-embedding is currently ON for this file

9. Click OK to accept the configuration and exit the dialog box.

 Cancel ignores any changes and exits the dialog box.

The De-Embedding indicator on status bar means that de-embedding is being applied. See 
Figure 12-12.

Figure 12-12 De-Embedding Indicator on the Status Bar
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Using Analysis Tools and Utilities
This chapter describes several tools that are very useful in performing your analysis. This 
chapter includes:

• Markers

• Click and Drag Zooming

• Math

• Data Sharing

• Characterization Report Generator

• Copying and Pasting Plot Formats

• Renaming Plots

• Printing

• File Converter
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Markers
PLTS uses two different types of markers. The marker type used is dependent on the analysis 
type. For time domain, frequency domain, and RLCG analysis, refer to Time-Domain, 
Frequency-Domain, and RLCG Markers. For eye diagram analysis, refer to “Eye Diagram 
Markers” on page 373. 

Time-Domain, Frequency-Domain, and RLCG Markers

Time domain, frequency domain, and RLCG analysis, use markers that are displayed 
vertically on a plot. As the vertical marker intersects a trace on the plot, the values of the 
horizontal and vertical position at the intersection are displayed. Up to two markers may be 
set on each plot.

To use the markers:

1. With a plot displayed, click the Marker 1 button.

Figure 13-1 Single Marker for Time Domain, Frequency Domain, and RLCG
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2. Click and drag the Marker 1 Slide Control to the right.

As the Slide Control is moved to the right, a solid blue vertical line (the marker) is 
displayed with an M1 label at the top of the line.

TIP Once the vertical marker line is displayed, you may adjust the marker by 
clicking and dragging the marker line itself instead of the Slide Control.

3. Release the Slide Control at the desired position of the plot.

4. Note that the values of the X and Y position for the point that the marker intersects the 
trace are displayed near the upper right corner of the plot.

TIP Moving the Marker One Measurement Point at a Time

The marker may be moved one measurement point at a time by pressing the 
keyboards arrows (← & →). Each keyboard press, changes the X and Y values.

5. To display the second marker, click the Marker 2 button.

Figure 13-2 Time-domain, Frequency-domain, and RLCG Dual Markers
Chapter 13366



Using Analysis Tools and Utilities
Markers
6. Click and drag the Marker 2 Slide Control to the right, releasing it at the desired 
position of the plot.

As the Slide Control is moved, the marker is displayed. Marker 2 is a broken blue 
vertical line with the label M2 at the top.

7. Note that the X and Y position values for Marker 2 are displayed near the upper right 
corner of the plot. When both markers as used, the difference (delta) between the position 
of Marker 1 and Marker 2 are also displayed immediately below the Marker 2 information.

8. Note that markers may be used with multiple plots. As your needs arise, you may have up 
to two markers in each plot. The marker information is displayed at the upper right corner 
of each plot.

Figure 13-3 Markers with Multiple Plots
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9. Also note that markers may be used with multiple traces. You may use either one or two 
markers in a plot that displays as many as four traces. The marker information is for each 
trace is displayed along the right edge of the plot.

Figure 13-4 Markers with Multiple Traces

Quick Markers

By clicking the right mouse button with the cursor over the plot, you can access the markers 
(either Marker 1 or Marker 2) quickly. See Figure 13-5. Both Marker 1 and Marker 2 have 
four choices available: On, Set At…, Find Min, and Find Max.

Figure 13-5 Marker Menu Opened with a Right Button Mouse Click
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On  Turns the associated marker on or off. When the marker is turned on, a check mark is 
displayed to the left side of the On selection. The marker, the vertical blue line is displayed 
with a label at the top of the plot.

• Marker 1 is a solid blue line with the M1 label at the top of the plot.
• Marker 2 is a broken blue line with the M2 label at the top of the plot.

Adjust the marker by clicking and dragging the marker line to the left or to the right.

Set At…  Places the associated marker at a specified time (with a time domain plot) or at a 
specified frequency (with a frequency domain or RLCG plot). The Set Marker dialog box allows 
you to enter the time or frequency to set the marker. See Figure 13-6.

Figure 13-6 Set Marker Dialog Boxes

Find Min  Places the associated marker at the point of the minimum displayed value. If 
multiple traces are displayed, this selection finds the lowest value of all of the traces.

Find Max  Places the associated marker at the point of the maximum displayed value. If 
multiple traces are displayed, this selection finds the highest value of all of the traces.
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Frequency Domain Polar and Smith Chart Markers

Frequency domain plots that are displayed in either Polar or Smith Chart formats use 
markers that are displayed differently than the markers shown in “Frequency Domain Polar 
and Smith Chart Markers” on page 370. When a marker is used in a Smith or Polar Chart 
format, it is essentially a point that follows the displayed trace around the chart. Up to two 
markers may be set on each plot.

To use the markers:

1. With the plot displayed on the Polar or Smith Chart, select the display style on the Marker 
Bar. You may select either Mag + Phase or Inductance. See Figure 13-7.

Figure 13-7 Single Marker for Frequency Domain Polar and Smith Charts
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The Mag + Phase style displays the magnitude and the phase at the marker frequency. 
Inductance displays the magnitude and inductance at the marker frequency.

2. Click the Marker 1 button.

3. Click and drag the Marker 1 Slide Control to the right.

As the Slide Control is moved to the right, a marker is moved along the trace. 

4. Release the Slide Control at the desired position of the plot.

5. Note that the values for the markers position are displayed near the upper right corner of 
the plot.

6. To display the second marker, click the Marker 2 button. See Figure 13-8.

Figure 13-8 Polar and Smith Chart Dual Markers

7. Click and drag the Marker 2 Slide Control to the right, releasing it at the desired 
position of the plot.

As the Slide Control is moved, the marker is displayed. See Figure 13-8 and note the 
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difference between the two marker symbols.

8. Note that the values for Marker 2 are displayed near the upper right corner of the plot. 
When both markers as used, the frequency difference (delta) between Marker 1 and 
Marker 2 is also displayed immediately below the Marker 2 information.

9. Note that markers may be used with multiple plots. As your needs arise, you may have up 
to two markers in each plot. The marker information is displayed at the upper right corner 
of each plot. See Figure 13-9.

Figure 13-9 Markers with Multiple Polar and Smith Chart Plots
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Eye Diagram Markers

Eye diagram analysis uses markers that are displayed both vertically and horizontally on a 
plot. As the vertical marker intersects the eye, the value of the horizontal (X) position is 
displayed. As the horizontal marker intersects the eye, the value of the vertical (Y) position is 
displayed. Up to two vertical and two horizontal markers may be set on each plot.

To use the markers:

1. With a plot displayed, click the Marker 1 button.

Figure 13-10 Eye Diagram Markers: Horizontal (X) Position

2. Click and drag the Marker 1 X Slide Control to the right.

As the X Slide Control is moved to the right, a broken blue vertical line (the marker) is 
displayed.

3. Release the X Slide Control at the desired position of the plot.

4. Note that the value of the X position of the marker is displayed near the upper right corner 
of the plot.
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5. To display the second marker, click the Marker 2 button and repeat steps 2 through 4 for 
the second marker.

Marker 2, a solid blue vertical line, is displayed.

6. Also note that with the two markers displayed, the difference (delta) between the two 
markers is displayed.

7. To display the vertical (Y) position, click the Marker 1 button and drag the Marker 1 Y 
Slide Control to the right, releasing the slide control at the desired position on the plot. 
See Figure 13-11.

As the Y Slide Control is moved to the right, a broken blue horizontal line (the marker) is 
displayed.

Figure 13-11 Eye Diagram Markers: Vertical (Y) Position

8. Repeat step 7 for Marker 2.

Marker 2 is a solid horizontal line.

9. Note that with two markers displayed, the difference (delta) between the two markers is 
displayed.
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Quick Markers

By clicking the right mouse button with the cursor over the eye diagram plot, you can access 
the marker choices: Marker 1 and Marker 2. See Figure 13-12. These selections turn both 
the Horizontal and Vertical markers on or off.

Figure 13-12 Eye Diagram Marker Menu Opened with a Right Button Mouse 
Click

Marker 1  This selection turns both the horizontal and vertical markers of Marker 1 on or off. 
When the marker is turned on, a check mark is displayed to the left of Marker 1.

Marker 2  This selection turns both the horizontal and vertical markers of Marker 2 on or off. 
When the marker is turned on, a check mark is displayed to the left of Marker 2.
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Click and Drag Zoom
While you are looking at a plot and you want to zoom in on a particular area of interest, you 
can zoom using by clicking and dragging across the area of interest within the plot. 

NOTE The zoom feature is not available for eye diagram plots.

To zoom in on an area:

1. With a plot displayed, click within the plot and drag the mouse, creating a rectangle as the 
mouse is moved. See Figure 13-13.

Figure 13-13 Defining Zoom Area

The rectangle is created by dashed lines from the point of the mouse click to the position 
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that the mouse has been dragged. 

2. Once the rectangle encloses the area of the plot that you want to zoom in to, release the 
mouse button.

Figure 13-14 New Plot after Zoom

The rectangular area of the plot that you have defined with the mouse is now displayed, 
replacing the original plot. Note the new X-axis start and stop frequencies and the new 
Y-axis scale.

3. If the new plot does not center the traces in the Y-axis, clicking the right mouse button 
with the cursor over the plot and selecting Autoscale sets the Y-axis scale so that the data 
is better displayed. 
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Figure 13-15 Autoscale Selection

4. When you are have finished examining the new plot, you can click the right mouse button 
with the cursor over the plot and select Reset Scale to return the plot to the default 
horizontal and vertical settings.

Figure 13-16 Auto Zoom Selection
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Math may be performed on traces that are displayed within a plot. For example, you may 
divide the data of one trace by the data of a second trace for a comparison of gain or 
attenuation between the two traces. Another commonly-used math function is subtracting the 
data of one trace from the data of a second tract for a measure of directivity.

Math may be performed on a trace using two methods. You may create a formula and apply 
the formula to a displayed trace (see “Creating a Math Formula” on page 379) or you may 
perform a quick math function on a displayed trace (see “Using Quick Math” on page 385). 

Creating a Math Formula

Math formulas may be created, saved, and applied to opened traces at a later time. Formulas 
are created using the Create Formulas dialog box. Figure 13-17 shows the Create Formulas 
dialog box that is used to create and save math formulas. This dialog box is divided into 
several areas.

Figure 13-17 Create Formulas Dialog Box

DUT Files Used to identify the desired Data area selection to apply the math 
operation. It allows you to select the file of the data used in the math 
operation from a list of open files. Data from multiple files may be used in a 
formula.

Domain Used to identify the desired Data area selection to apply the math 
operation. It allows you to select between Frequency Domain and Time 
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Domain. When in frequency domain, you must select between Single Ended 
and Balanced data. When in time domain, you must select between Single 
Ended and Differential data.

Formula displays the math formula that you are creating.

Data Used to build the formula. It allows you to select parameters based on the 
selections in the Domain area.

Key Pad Used to build the formula. It allows you to enter numeric entries and 
operators.

Functions Used to build the formula. It allows you to enter math symbols and 
delimiters as well as some frequency domain formats.

Formula Name allows you to enter a name to save the formula and recall it for future use.

To create a math formula:

1. Select Math, Design… from the Tools menu to open the Create Formulas dialog box as 
shown in Figure 13-18.

Figure 13-18 Opening the Create Formulas Dialog Box

2. In the DUT File list, select the file that the first Data area parameter belongs.

Figure 13-19 DUT File Selection List
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3. In the Domain area, select the domain and the mode of the first Data area parameter.

The Domain area allows you to select between Frequency Domain (Freq) and Time 
Domain (Time).

• In frequency domain, select between Single Ended (SE) data and Balanced (Bal) data.

• In time domain, select between Single Ended (SE) data and Differential (Diff) data.

Each Domain area combination displays a different set of Data area parameters. Refer to 
Figure 13-20 for the Data area selections for each of the four combinations.

Figure 13-20 Data Area Parameters for Each Domain Area Combination

4. Start building your formula using the appropriate Data area parameters shown in Figure 
13-20 and the Key Pad and Functions area buttons shown in Figure 13-21.

Figure 13-21 Key Pad and Functions Areas

The Key Pad area buttons are just the ten numerals(0 through 9) and several basic math 
symbols/operators: decimal (.), equals (=), add (+), subtract (-), multiply (*), and divide (/).
Chapter 13 381



Using Analysis Tools and Utilities
Math
The Functions area buttons are:

5. As you make selections from the Data, the Key Pad, and the Functions areas, these are 
displayed in the Formula area. 

Just as an example, if you to divide TDD21 by π, 
you would select these buttons: TDD21, /, PI 
and the Formula area box would display: 

Use the < BkSp button to back step the cursor one position at a time. 
Use the Clear button to remove the entire entry from the Formula area box.

6. Repeat steps 2 through 5 until your formula is complete.

7. Once your formula is complete, enter a name for the formula in the Formula Name box 
and click the Save button. See Figure 13-22.

Table 13-1 Functions Area Buttons

Sqrt ( Use the square root of the 
following term.

Delta ( Use the difference (∆) of the 
following terms.

Real ( Use the real portion of the 
following complex term. This 
choice is not available when 
Time is selected in the Domain 
area.

Imag ( Use the imaginary portion of the 
following complex term. This 
choice is not available when 
Time is selected in the Domain 
area.

Abs ( Use the absolute value of the 
following term. This choice is 
not available when Time is 
selected in the Domain area.

Conj ( Use the standard conjugate 
function for complex numbers. 
This choice is not available 
when Time is selected in the 
Domain area.

Arg ( Use the standard argument 
function for complex numbers. 
This choice is not available 
when Time is selected in the 
Domain area.

( and ) The “open parenthesis” and the 
“closed parenthesis” delimiters

PI pi (π) - the constant of 3.14159… _Z1 
through 
_Z4

The impedance vectors for Port 
1, Port 2, Port 3, and Port 4
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If you want to save the formula with the same name as a previously saved formula, select 
the formula name from the drop down list and click the Save button to delete the 
previously saved formula and save the new formula.

Figure 13-22 Save the Formula

8. When you have finished saving your math formula, click Close to close the Create 
Formulas dialog box. Continue to Applying a Math Formula to use the formula with 
opened data files.

Applying a Math Formula

Once math formulas have been created and saved, they may be applied to opened data files. 

To create a math formula:

1. Select Math, Apply… from the Tools menu to open the Choose Variable Traces to Display 
dialog box as shown in Figure 13-23.

Figure 13-23 Opening the Apply Formulas Dialog Box
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2. With the Choose Variable Traces to Display dialog box opened, select a formula from the 
list of formulas. See Figure 13-24.

Figure 13-24 Choose Variable Traces to Display Dialog Box

Note that (TD) was appended to the right of the formula name. This informs you that this 
is a time domain formula. Had this been a frequency domain formula, (FD) would have 
been appended to the formula name. 

3. Click the Apply button to apply the formula to the opened data files.

A plot is displayed showing the data file plot after the formula has been applied. 

4. When you have finished reviewing the plot, click the Remove button to remove the data 
file plot after the formula has been applied. 

5. If you want to delete a formula from the list of formulas, select the formula and click the 
Delete button.

The formula is deleted and is no longer available.

6. Click Exit to return to the main PLTS window.
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Using Quick Math

You can use Quick Math to perform simple math operations on two traces in the same plot. A 
plot allows up to four traces to be displayed. As quick math is performed, the resultant plots 
are displayed on the plot. Since two data traces are required on the plot, you may perform one 
or two quick math functions on these data traces so that either three or four traces are 
displayed on the plot. If three traces are displayed on the plot, only one quick math function 
may be performed.

To perform a quick math function:

1. With two (or three) data traces displayed on the active plot, click the right mouse button 
with the cursor over the plot. Then click Quick Math and Operand 1. Click the label 
identifying the first trace of the math operation. Refer to Figure 13-25.

Figure 13-25 Four Steps for Quick Math

2. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Operator. Click the desired math operation.

3. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Operand 2. Click the label identifying the second trace of the math function.
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4. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Result (=) to display the result of the math operation.

A new trace is displayed showing the results of the math operation. The trace label is 
displayed along the right side of the plot.

Figure 13-26 Two Traces with Quick Math Result Displayed (SDD21/SCC21)

Remove all Quick Math result traces by clicking the right mouse button with the cursor over 
the plot, then click Quick Math and Remove Math.
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Data Sharing
Data sharing allows you to place multiple traces from different files on the same plot. You 
may place traces from a maximum of three files on a single plot. This is very helpful when 
comparing a parameter from the current measurement with the same parameter from a 
previous measurement that you made.

The data sharing feature is only available for Time Domain and Frequency Domain 
parameters only. You may only use data sharing between file of the same type. For example, if 
you have a “Differential Time Domain” parameter, you may only share with other files in the 
“Differential Time Domain” format.

The measurement parameters of the shared files do not need be the same. For example, in 
Frequency domain, the start and stop frequencies of the two files do not need to be same.

To use the data sharing feature, with the two files opened:

1. Display the parameter that you are interested in comparing against a parameter of 
another file so that it displayed individually for best viewing by double-clicking the plot if 
it is in a view with multiple plots.

2. From Utilities menu, select Data Sharing to open the data sharing bar.

Figure 13-27 Opening the Data Sharing Bar

3. From the DUT File list shown in Figure 13-28, select the data file what you want to share 
with the plot used in step 1.
Chapter 13 387



Using Analysis Tools and Utilities
Data Sharing
Figure 13-28 Data Sharing Bar

4. From the Parameter list, select the parameter to share with the original plot in step 1.

5. Click the Show button to display the selected parameter with the original plot in step 1.

As files are shared with the original plot, a label noting the parameter of the original plot 
is displayed to the right of the plot. The parameters of shared files are also have labels 
displayed to the right of the plot, however, these parameter labels have the shared file 
appended to the label. 

6. Repeat steps 3 through 5 if you want to data share another plot.

7. When you have finished with the data sharing plot, click the Remove button to remove all 
of the shared traces from the original trace.
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Characterization Report Generator
The Characterization Report is a standard report that can be generated to show:

• Device, Test Equipment, Measurement, and Calibration information

• In the time domain, plots and information for:

— Differential Impedance (TDD11)
— Common Mode Impedance (TCC11)
— Eye Diagram

• In the frequency domain, plots and information for:

— Differential Loss (SDD21)
— Differential Match (SDD11)
— Common to Differential (SCD21)

To generate the characterization report:

1. Select Characterization Report… from the File menu to open the Characterization 
Report dialog box. See Figure 13-29.

Figure 13-29 Open Characterization Report
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The blank Characterization Report dialog box is then displayed as shown in Figure 13-30.

Figure 13-30 Blank Characterization Report Dialog Box

2. Complete the Characterization Report dialog box entries. The dialog box has three areas: 
Measurement Information, Eye Diagram Information, and Data Source. Each area 
is described below. When the Characterization Report dialog box is complete, select the 
Generate Report button to continue.

Figure 13-31 Completed Characterization Report Dialog Box
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• The Measurement Information area allows you to input the following information: 
Device Name (a descriptive name for the DUT), Cable Information (any information 
about the cables used during the test), Probe Information (information about any 
probes used during the test), and Calibration Kit Serial Number (affixed to the 
calibration kit box).

• The Eye Diagram Information area allows you input the Data Rate (Gb/s), Rise 
Time (ps), and the Bit Pattern. This information is used to generate the eye diagram 
for the characterization report.

• The Data Source area allows you select the source of the data used to create your 
characterization report. Use Loaded DUT allows you to select any data file that is 
currently opened by selecting the file from the list. Use Saved DUT allows you to 
select any data file that is saved by clicking the Browse… button to locate and select 
the file.

3. In the Export dialog box (see Figure 13-32), select the format in which to save the 
characterization report from the list. Then click the OK button.

Figure 13-32 Select the Report Format in the Export Dialog Box

4. In the Export Options dialog box (see Figure 13-33), select the page range choice. All saves 
all of the characterization report pages. Page Range allows you to enter the range of 
pages to save. Then click the OK button. 

Figure 13-33 Select the Page Range in the Export Options Dialog Box
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5. In the Choose export file dialog box (see Figure 13-34), choose the directory to save the 
characterization report. You may also change the file name or format from the inputs that 
were previously entered. Then click the Save button to save the characterization report.

Figure 13-34 Choose Export File Dialog Box

6. Go to the directory to which you saved your characterization report and open the file to 
review. This is a four-page report as shown in Figure 13-35.

The following information is available on the Device Characterization Report:

Page 1 Device Name and Report Time Stamp
Test Equipment Configuration
Calibration Information
Calibration Setup and Measurement Setup Information

Page 2 Differential Impedance (TDD11) Plot and Information
Common Mode Impedance (TCC11) Plot and Information

Page 3 Eye Diagram Plot and Information
Differential Loss (SDD21) Plot and Information

Page 4 Differential Match (SDD11) Plot and Information
Common to Differential (SCD21) Plot and Information
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Figure 13-35 Device Characterization Report
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Copying and Pasting Plot Formats
The plots aren’t always displayed in the format or scale that you would like to see them. Now, 
you can change the plots quickly using the quick format function. This is very useful when you 
are displaying several plots within the plot window. 

To perform a quick plot format function:

1. With your data plots displayed, select the first plot to change. Make any changes in the 
format or scale that enables you to display the plot as you would like it displayed. See 
Figure 13-36. In this example, the format was changed from step to impulse and the 
vertical scale was changed.

Figure 13-36 Change and Copy the Plot Format and Scale
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2. Click the right mouse button with the cursor over the plot. Then click Copy Plot Format.

3. Select the next plot to be displayed with these settings by clicking the plot. See 
Figure 13-37.

4. Click the right mouse button with the cursor over the plot. Then click Paste Plot Format.

The plot is now displayed with the new format and scale settings.

Figure 13-37 Select a Plot and Paste the Format

5. Repeat steps 3 and 4 to change as many plots to the new format and scale that you like.
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Renaming Plots
Plots are labeled with the parameter that they display. These labels can be changed to text of 
your choice. Labels are limited to 22 characters. To rename a plot:

1. Right click on the plot to display the quick menu as shown in Figure 13-38. From the quick 
menu, select Rename Plot… to open the Rename Plot… dialog box.

Figure 13-38 Open the Rename Plot Dialog box

2. Highlight the original label and type in the new label. See Figure 13-39.

Figure 13-39 Enter the New Label
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3. When you have finished entering the new label, click the OK button. The new label is 
displayed above the plot. See Figure 13-40.

Figure 13-40 Saving the Label
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Printing
The Print feature in the File menu has three options. Refer to Figure 13-41. Each of the print 
options is described in this section.

• For Print Setup…, refer to page 399.

• For Print Preview…, refer to page 403.

• For Print…, refer to page 405.

Figure 13-41 Three Print Options from File Menu
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Print Setup…

The Print Setup dialog box allows you to set your printer settings to print the displayed PLTS 
information in the way you choose. 

To set the settings for the printer:

1. Select Print Setup… from the File menu to open the Print Setup dialog box. See Figure 
13-42.

Figure 13-42 Opening the Print Setup Dialog Box
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2. Confirm the settings in the Print Setup dialog box. See Figure 13-43. Change any incorrect 
settings for your printer.

The Print Setup dialog box allows you to change the following basic printer functions:

• The printer: Select a new printer from the Name list in the Printer area.

• The paper size: Select the paper size from the Size list in the Paper area.

• The paper source: Select the paper source from the Source list in the Paper area.

• The paper orientation: Select the orientation, either Portrait or Landscape in the 
Orientation area.

Figure 13-43 Print Setup Dialog Box

More advanced settings are available by selecting the Properties… button or the 
Network… button.

The OK button saves the changes that were made, exits the Print Setup dialog box, and 
returns to the PLTS window.

The Cancel button cancels any changes that were made, exits the Print Setup dialog box, 
and returns to the PLTS window.
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3. If you select the Properties… button, the Document Properties dialog box is displayed. 
See Figure 13-44. Each printer has its own unique Document Properties dialog box. Refer 
to your printer documentation for the specific information available for your printer 
selections.

Figure 13-44 Example Document Properties Dialog Box (Layout Tab)
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4. If you select the Network… button, the Connect to Printer dialog box is displayed. See 
Figure 13-45. 

Figure 13-45 Connect to Printer Dialog Box
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Print Preview…

The Print Preview… option allows you to preview your active plot screen before printing the 
display. To preview your active plot screen before printing:

1. Select Print Preview… from the File menu to open the preview screen of the active plot. 
See Figure 13-46.

Figure 13-46 Opening the Print Preview Dialog Box

2. Examine the displayed active plot as needed prior to printing. See Figure 13-47.

The screen showing the active plot that will be printed is displayed for your review. 
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Figure 13-47 Preview Screen of the Active Plot

In addition to the area to be printed, the screen displays the following seven buttons across 
the top of the screen.

Print: Prints the active plot in the preview screen to the printer.
Next Page: Active when One Page is selected. Moves the display to the next page 

of the display.
Prev Page: Active when One Page is selected. Moves the display to the previous 

page of the display.
One Page or 
Two Page:

Toggles between the two selections. When only one page of the display 
is shown, Two Page is displayed. When both of the pages of the 
display are shown, One Page is displayed.

Zoom In: Allows you to zoom in on the displayed active plot.
Zoom Out: Allows you to zoom out from the displayed active plot.
Close: Closes the preview screen without printing.
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Print…

The active plot may be printed to the printer defined in the Print Setup dialog box. To print 
the active plot:

1. Select Print… from the File menu to open the Print dialog box. See Figure 13-46.

Figure 13-48 Opening the Print Dialog Box
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2. Make the Print dialog box selections that meet your requirements. See Figure 13-49.

Figure 13-49 Print…

In the Printer area:

• Select another printer from the Name list if the displayed printer is not 
appropriate.

• Select the Properties… button to display the Document Properties dialog box 
unique to the selected printer. This dialog box allows you to make several advanced 
choices. See Figure 13-44 on page 401. Refer to your printer documentation for 
specific information available for your printer selection.

• Select the Print to file check box, to save the active plot as a print (.prn) file rather 
than printing to a printer.

In the Print range area:

• Select All to print all pages.
• Select Pages to print specific pages. Then enter the first page to print in the from: 

entry box and enter the last page to print in the to: entry box.
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In the Copies area:

• Enter the Number of copies to change the number of copies that you want to 
print. You may enter a number in the entry box or you may click the spinners (the 
up arrow and the down arrow at the right edge of the entry box) to change the 
number of copies.

• If the Number of copies entry is greater than “1”, you can toggle Collate check 
box on and off. If the check box has a check, the print copies will be collated.

3. When the Print dialog box entries are correct, click the OK button to print the active plot 
screen. 

The Cancel button exits the dialog box without printing and returns to the main PLTS 
window.

NOTE The display may also be printed by:

• Selecting the printer button on the Toolbar. See page 432.

• Selecting the Print button in the print preview display. See page 403.
Chapter 13 407



Using Analysis Tools and Utilities
File Converter
File Converter
The File Converter was installed with PLTS, it is a separate utility. The File Converter 
converts files in .dut, .cit, and .s2p formats to files in .txs format. These .txs files can be used 
during the calibration as files for thru adapters. 

It is easiest to copy a Thru adapter file into the Adapters directory of PLTS. If you used the 
default directory on your C drive, the path is: C:/Program Files/Agilent/PLTS/Adapters

To begin the file conversion:

1. From the PLTS directory mentioned above, double-click the FileConverter.exe file icon to 
open the File Converter. 

Figure 13-50 FileConverter.exe Executable File
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2. Enter the connector type of the connector in the text boxes and then click the Add File… 
button to open the Open dialog box.

Figure 13-51 File Converter Dialog Box

3. In the Open dialog box, change to the directory where you copied the files to be converted. 
In this case: C:/Program Files/Agilent/PLTS/Adapters

Select the type of file (.dut, .cit, or .s2p file) to be converted in the File of type: box. Select 
the file that you want to convert. When you have selected your file, click the Open button.

Repeat if you want to convert multiple files.

Figure 13-52 Selecting the File to Convert
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4. With the files in the left list of the Files conversion area, click the Convert -> button.

Figure 13-53 Convert the Files

5. The converted files are listed in the right list of the Files conversion area. Click the OK 
button to save the files into the directory where they were found. 
In this case: C:/Program Files/Agilent/PLTS/Adapters 

Figure 13-54 Save the Converted Files

Then close the FileConverter dialog box.
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6. Open the Adapters directory to find the newly converted files. In this case, two files were 
converted. 

Figure 13-55 Adapter Directory with Newly Converted Files

The new .txs files can now be used to define a calibration kit.
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Part IV provides reference information related to operating the physical layer test system.

Chapter 14, “Menu Reference”

Provides you with descriptions of each menu bar selection in the test system 
software.

Chapter 15, “Specifications and Characteristics”

Provides you with the specifications and characteristics of the physical layer test 
system.

Chapter 16, “Test Set Front Panel and Rear Panel”

Provides you with specific information regarding each test set front panel and 
rear panel connector, switch, fuse, and LED indicator.

Chapter 17, “Troubleshooting and Maintenance”

Provides you with information about troubleshooting the test system, contacting 
Agilent for assistance, care of test cables and coaxial connectors, and 
electrostatic discharge.

Chapter 18, “Safety and Regulatory Information”

Provides you with information that will allow you to operate the test system 
safely. This chapter also lists the appropriate information required by regulatory 
agencies.
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Menu Reference
The following menus and each of their selections are described in detail in this chapter. Many 
of these menus are displayed only under specific measurement conditions. Refer to each 
specific menu on the pages listed for selections and conditions.

• File menu on page 417

• Measure menu on page 430

• View menu on page 432

• Utilities menu on page 438

• Tools menu on page 447

• Data menu on page 457

• Format menu on page 460

• RLCG menu on page 462

• Options menu on page 464

• Window menu on page 466

• Help menu on page 468
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File Menu
The File menu provides access to many standard software functions such as creating, 
opening, and saving data, importing and exporting files, creating a characterization report, 
printing, and exiting the software.

Figure 14-1 File Menu
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New

Select New from the File menu to start a new measurement process and open the Startup 
Wizard window. 

Figure 14-2 Startup Wizard Window

Open

Select Open from the File menu to load a previously saved file.

Figure 14-3 Open Dialog Box
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Save

Select Save from the File menu to save the current measurement or calibration data. New 
data or imported data may be saved.

Until measurement data is saved, the plot window title bar is labeled PLTS along with the 
analysis type of the plot window and the sequential plow window number. Once the data is 
saved, the PLTS label is replaced with the name of the saved file. Figure 14-4 shows the plot 
window title bar before the data was saved and how it changes to match the file name 
(BTL_50M_6G_120PT.dut) after it is saved.

Figure 14-4 Plot Window Title Bar Changes After Data is Saved

Only one unsaved plot window may be open at a time. If you have one unsaved plot window, 
you must either save the data or delete the window before you can open another plot window 
with unsaved data.

Save As…

Select Save As… from the File menu to save new measurement or calibration data or 
existing data as a new file. 

Figure 14-5 Save As Dialog Box
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Import

Select Import from the File menu to import a single-ended measurement data file. Then 
select either CITIFile to import a file in CITIfile format or Touchstone to import a file in 
Touchstone format. Then select from one of the port selections (either Port Configuration = 
1 & 3 -> 2 & 4 or Port Configuration = 1 & 2 -> 3 & 4) based on the calibration type used 
with the original measurement.

Figure 14-6 File Menu with Import and CITIFile Expanded

Figure 14-7 Balanced Transform Port Configuration Diagram

CITIFile

CITIFile imports data previously saved in CITIfile (*.cit) format. CITIfiles imported in this 
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fashion can be used for comparison with other data sets using trace memory and math 
functions. Refer to Figure 14-7 and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the TRL calibration.

Touchstone

Touchstone imports data previously saved in Touchstone (*.S4P) format. Refer to Figure 14-7 
and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data that 
has taken with the system calibrated using the TRL calibration.

Export

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CitiFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.

Figure 14-8 File Menu with Export Expanded
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Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.

Plots to Clipboard exports the contents of the current plot window to the Windows 
clipboard.

Plots to Image File exports the contents of the current plot window as an image file. When 
you export it, you may choose from Windows Bitmap (*.BMP), JPEG Bitmap (*.JPG), or Targa 
Bitmap (*.TGA) formats.

Frequency Domain exports the data of a single S-parameter (either single-ended or 
balanced) in one of four frequency domain formats: Real/Imaginary, Log Magnitude, Linear 
Magnitude, or Phase. All four formats are exported in tabular format as a text file, each with 
a header. The measured data is bounded by a BEGIN and an END message. The 
Real/Imaginary data of each measured point is exported as comma-separated values. 

Use the Frequency Domain Export dialog box shown in to select the S-parameter (all 
single-ended and balanced S-parameters are listed). Then click OK to export the data.

Figure 14-9 Frequency Domain Export Dialog Box

CITIFile exports the current data in CITIfile format (*.cit).

Touchstone exports the current data in the S4P format which also has the following data 
format choices in which the data may be saved: 

• Magnitude, angle 

• dB, angle (power, angle)

• Real, imaginary
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Figure 14-10 File Menu with Export and Touchstone Expanded

Time Domain exports the current time domain data in text format (*.txt). It saves a name, 
the parameter and format information in a header. In the body, each X and Y measurement 
coordinate is displayed separated by a comma. These coordinates are bounded by a BEGIN 
and END message.

TDA MeasureXtractor exports measured data into the TDA MeasureXtractor format. Refer 
to “TDA MeasureXtractor” on page 346.

RLCG exports the current data in one of two RLCG formats: 

• HSPICE exports the RLCG data in a format compatible with HSPICE (a Simulation 
Program with Integrated Circuit Emphasis) software. Refer to “Exporting Transmission 
Line Data” on page 325.

• ADS exports the RLCG data in a format compatible with the Agilent Advanced Design 
System (ADS) software format which also has the two following data format choices in 
which the data may be saved:

❏ Actual Measured Parameters exports extracted parameters versus frequency in an 
ASCII file for ADS. Refer to “Exporting Transmission Line Data” on page 325. 

❏ ML2CTL exports fitted parameters in an ASCII file to be used with the ADS 
MultiLayer 2 Coupled Transmission Lines (ML2CTL) model. Refer to “Exporting 
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Transmission Line Data” on page 325.

Figure 14-11 File Menu with Export, RLCG, and ADS Expanded
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Characterization Report…

Click the File menu and then click Characterization Report… to start creating the 
characterization report. The Characterization Report dialog box is displayed. 

Figure 14-12 Characterization Report Dialog Box

Refer to “Characterization Report Generator” on page 389 for more information.
Chapter 14 425



Menu Reference
File Menu
Print Setup…

Click the File menu and then click Print Setup… to review the printer settings. The Print 
Setup dialog box is displayed. The Print Setup dialog box allows you to select the destination 
printer and its properties, the paper size and printer paper source, additional network 
printers, and choose the orientation of the paper when printed.

Figure 14-13 Print Setup Dialog Box

If you are connected to other networks, click Network… to find additional printers.

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
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Print Preview…

Click the File menu and then click Print Preview… to review the active plot window prior 
to printing. The data is displayed in the preview window. The preview window allows you to 
move between multiple pages of data, zooming in and zooming out on displayed data, printing 
the data, and closing the window.

Figure 14-14 Displayed Data when Print Preview… is Selected
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Print…

Click Print… from the File menu to print the selected plots and display the Print dialog box. 
The Print dialog box allows you to select the destination printer and its properties, the range 
of pages to be printed, and the number of copies you wish to print.

Figure 14-15 Print Dialog Box

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
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Recent Files 

Open any of the four most recently accessed files by clicking the name of the file from this list. 
Only the four most recently accessed files are displayed. 

Figure 14-16 Opening Recently Accessed Files

Exit

Click Exit from the File menu to quit this program.
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Measure Menu
The Measure menu allows you to start a measurement, start and stop a continuous sweep 
measurement, and change the stimulus. 

Figure 14-17 Measure Menu

Continuous Sweep

Continuous Sweep sets the system to make measurements as the selected frequency span is 
swept continuously. After each measurement, the displayed data is updated.

To perform a continuous sweep measurement, select Continuous Sweep so that it has a 
check mark on its left side on the Measure menu. With Continuous Sweep active, the Start 
and Stop menu selections control continuous sweep. Select Start to begin a continuous 
measurement and select Stop to stop the measurement.

The Continuous sweep indicator on status bar means that system is currently in the 
continuous sweep mode. See Figure 14-18.

Figure 14-18 Continuous Sweep Indicator on the Status Bar

Start

Start begins a measurement when it is selected. When Continuous Sweep has a check 
mark, Start begins a continuous sweep measurement; otherwise it begins a single sweep 
measurement.

Stop

Stop stops a continuous sweep measurement.
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Stimulus…

Stimulus… opens the Modify Time and Frequency Parameters dialog box so that you can 
change the parameters. Refer to the stimulus information on “Setting Up the Calibration and 
Measurement Parameters” on page 111 for detailed information regarding changing the 
stimulus parameters.
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View Menu
The View menu opens and closes the various tool bars. 

Figure 14-19 View Menu

Toolbar

The Toolbar provides quick access to several File menu features as well as two others. The 
features that are available on the Toolbar are New, Open, Save, Copy, Export Bitmap, 
Remove Plot, Print, and About.

Figure 14-20 Toolbar
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Status Bar

The Status Bar provides a graphic display of when several features are active. Each feature 
has a label on the left and an indicator just to the right side of the label. When a feature is 
active, the indicator is changed to a bright color. When the feature in not active, the indicator 
is gray. The impedance of each test system channel is displayed at the right side of this bar.

Figure 14-21 Status Bar

Browser

The Browser allows selection of data analysis type and the selection of plots to view. 
Selecting a data analysis type (a bold selection) opens a blank plot window for that analysis 
type. Selecting an existing plot (a non-bold selection) makes that plot active and displays it in 
the front of the plot window. 

Data analysis types that have a plot opened have either a “+” or a “−” to the left of the label. 
Select the “+” to display all plots of that type or the “−” to collapse and hide all plots.

Figure 14-22 Browser

Measurement is bright when a measurement is being performed
Continuous sweep is bright when a continuous sweep measurement is being performed
De-Embedding is bright when de-embedding is applied to the data
Ref-Z is bright when port reference impedance is applied to the data
Hardware is bright when the software recognizes the GPIB-connected hardware
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Marker Bar

The Marker Bar allows you to add up to 2 markers to a plot. Simply select the plot, select the 
marker button, and click and drag the horizontal scroll bar in the window to move the marker 
in the plot. The marker X and Y values are displayed to the right of the plot. The frequency 
domain Smith Chart and Polar Chart formats allow you to choose between magnitude/phase 
and impedance styles. This is not available when time-domain gating is enabled.

Figure 14-23 Marker Bar

Refer to “Markers” on page 365 for Marker information.

Parameter Bar

The Parameter Bar displays each individual parameter for each specific data analysis type 
as well as the capability to display all of the parameters. See Figure 14-24 on page 435.

The time domain, frequency domain, and RLCG data analysis types also have the option to 
allow you to display multiple plots on the same plot or separate plots. For Time Domain, 
Frequency Domain, and Eye Diagram, refer to “Data Menu” on page 457 for detailed 
information. For RLCG, refer to “RLCG Menu” on page 462 for detailed information. 
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Figure 14-24 Parameter Bars for Each Data Analysis Type
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Gating Bar

The Gating Bar allows you to add up to 10 gates to a time domain plot. Select Gating from 
the Utilities menu to display this bar. After the time domain plot is displayed, slide the 
horizontal control to set the gate’s stop and start position and then press Add to add the gate 
to the plot. Gates may also be deleted and moved from this window. See “Gating” on page 352. 
This is only available when time domain Gating is enabled.

Figure 14-25 Gating Bar

Format Bar

The Format Bar displays the plot using the format selected from the bar. Format Bar is 
only available for Time Domain and Frequency Domain plots. As shown below, the Time 
Domain Format Bar differs from the Frequency Domain Format Bar. Refer to “Format Menu” 
on page 460 for a detailed description of each format item.

Time Domain Format Bar Frequency Domain Format Bar

For detailed information about each of the 
selections, refer to “Selecting Time Domain 
Display Formats” on page 272.

For detailed information about each of the 
selections, refer to “Selecting Frequency 
Domain Display Formats” on page 233.

Impulse Log Mag

Step Linear Mag

Volts Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart

ns (nanoseconds) Real

cm (centimeters) Imaginary
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Scaling Bar

Scaling Bar allows you to change the scale of the active plot. There are two different scaling 
bars available. The analysis type determines the scaling bar that is displayed. Eye diagrams 
do not have an associated scaling bar.

Figure 14-26 Scaling Bar

Full Screen

Full Screen enlarges the Plot area to full screen by:

• Removing the Browser. The Browser may be turned on and off by selecting the View 
menu.

• Making the Parameter Bar, Scaling Bar, Format Bar, and Marker Bar free floating over the 
PLTS window. These tool bars may be turned on and off through the View menu.

Clinking the Full Screen selection again, turns of the Full Screen feature, returning the Plot 
area, Browser, and the tool bars back to normal.
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Utilities Menu
The Utilities menu provides access to calibration resources and several enhancement tools 
that you can use to provide a realistic analysis result.

Figure 14-27 Utilities Menu

Calibration

The Calibration selection allows you to start a calibration, characterize an adapter used for 
calibration, or edit the definition of mechanical calibration kits. 

Figure 14-28 Utilities Menu with Calibration Expanded
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Calibrate

Selecting Calibrate opens the wizard so that you may begin your calibration. Refer to 
Chapter 5, “Performing Error Correction on the VNA-Based PLTS,” for detailed calibration 
information.

Figure 14-29 Calibration Wizard
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Characterize Adapter

Adapters used in measurements and calibration must be characterized to ensure accurate 
results. The Physical Layer Test System software has a wizard that steps you through this 
adapter characterization process. Select Characterize Adapter from the Utilities menu to 
start the Custom Adapter Characterization Wizard.

Figure 14-30 Custom Adapter Characterization Wizard

A short/open/load calibration is performed directly at the network analyzer front panel test 
port with out any cables. Then the calibration is repeated with the adapter inserted. The 
resulting adapter S-parameters are saved in CITIfile format, which can later be de-embedded 
from the device measurement. 

To allow for best interpolation of adapters used in broadband measurements, characterize the 
adapter over the entire frequency range of the system with as many points as possible.

Your adapters must have an orientation, forward and reverse directions. Mark the connectors 
on the adapter as ports 1 and 2. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Refer to “Characterizing Adapters” on page 176 for detailed instructions on performing 
adapter characterization.
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Edit Cal Kit

The Edit Cal Kit feature gives you flexibility to make changes to your calibration kit 
definition or to add new calibration kits. First, select the calibration type from the Select 
Calibration Type list. Then, from the Cal Kit column, select your calibration kit model 
number to edit an existing kit or select USER_DEF to define a new calibration kit.

Figure 14-31 Select Cal Kit Dialog Box

An Edit Calibration Kit dialog box is displayed allowing you to change the calibration kit 
parameters. The USER_DEF selection provides a blank dialog box that you can enter new 
parameter values. Refer to the list below for an illustration showing each of the Edit 
Calibration Kit dialog boxes and the location of detailed instructions for completing the 
calibration kit definitions.

Calibration Type To define the calibration kit, refer to the following section for 
detailed instructions: 

SOLT “Defining a SOLT Calibration Kit” on page 132

TRL “Defining a TRL Calibration Kit” on page 150

LRM “Defining an LRM Calibration Kit” on page 165
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De-Embedding

Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. Use 
the De-Embedding dialog box to configure DUT reference planes by de-embedding probes, 
fixtures, or adapters from the measured data.

Figure 14-32 De-Embedding Dialog Box

Select the reference plane rotation using one of the following methods: 

• Reference Plane

You can use the Adjust Port Reference Plane selection in the Utilities menu (see 
“Adjust Port Reference Plane” on page 444) or you can use this method of adjusting the 
reference plane.

1. Click Rotate Reference Plane.

2. Enter a reference plane rotation value (in centimeters-in-air). 

A positive value rotates the phase towards the DUT (effectively removing a length of 
50Ω line) and a negative number rotates the phase away from the DUT (effectively 
adding a length of 50Ω line).

3. Select the port to assign the rotation value.
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4. Repeat steps 2 and 3 until you have assigned rotation values to all appropriate ports.

5. Make sure that De-embedding is on. If the OFF button is displayed, click it to turn 
de-embedding on.

• Remove Device or Component Effects

1. Click Select Device to De-Embed.

2. Select a de-embedding file (.txs) that you want to use from the drop-down box.

3. Select the check box associated with the port to which the file applies. 

4. Click the associated << button to add the file to the port. (Clicking the ✕ button will 
remove the file from the port.)

5. Repeat steps 2 through 4 until you have assigned de-embedding files to all appropriate 
ports.

6. Select all ports that use reverse orientation.

Reverse orientation is noted by check marks for each port specified in the Use Reverse 
Orientation check boxes.

7. Make sure that de-embedding is on. If the OFF button is displayed, click it to turn 
de-embedding on.

Click OK to accept the configuration and exit the dialog box or Cancel to ignore any changes 
and exit the dialog box.

De-embedding files hold information about the ports on the fixture that you are 
de-embedding, and match the connectors during de-embed setup. If you try to specify a fixture 
connection that cannot be made, the software warns you.

NOTE Port connectors are defined by the cal kits assigned to them in the Calibration 
Kit Selection dialog box.

The De-Embedding indicator on status bar means that is being applied. See Figure 14-33.

Figure 14-33 De-Embedding Indicator on the Status Bar
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Adjust Port Reference Plane

Select Adjust Port Reference Plane from the Utilities menu to open the Adjust Port 
Reference Plane dialog box where you can change the reference plane rotation settings and 
recalculate the displayed data.

Enter the new reference plane rotation values for the desired ports by using the arrows or 
entering the values in the port box directly. A positive value rotates the phase towards the 
DUT (effectively removing a length of 50Ω line) and a negative number rotates the phase 
away from the DUT (effectively adding a length of 50Ω line).

Click Apply Rotation to recalculate the data and display the new plots. Reset returns the 
values to zero, recalculates the data, and displays original plots.

Figure 14-34 Adjust Port Reference Plane Dialog Box

Note that when reference plane is applied, the De-Embedding indicator color changes to a 
bright color. See Figure 14-33.
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Port Reference Impedance

Select Port Reference Impedance from the Utilities menu to open the Port Reference 
Impedance dialog box. By default, all four ports are set to a resistive 50Ω impedance. Enter 
new reference impedances in the port boxes as desired. 

Figure 14-35 Port Reference Impedance Dialog Box

This feature does not affect the impedance presented to the DUT by the system hardware. 
Rather, it mathematically transforms the measured data to show how the performance of a 
linear device would change in a non-50Ω measurement system. Impedance transforms can be 
specified either before or after measurement. Only the current data set is affected.

The reference impedance can only be specified as a resistive circuit.

Differential reference impedances are additive. For example, specifying a reference 
impedance of 125Ω on port 1 and 125Ω on port 3 corresponds to a differential-mode reference 
impedance of 250Ω on balanced port one. Likewise, the common-mode reference impedances 
are the parallel equivalent impedance.

Click Set All Ports to 50 ohms (Resistive) to return to the default configuration.

Click OK to accept the configuration and exit the dialog box or Cancel to ignore any changes 
and exit the dialog box.

The Ref-Z indicator on status bar means that the current data has been modified for a 
non-50Ω reference impedance for at least one port. See Figure 14-36.

Figure 14-36 Port Reference Impedance (Ref-Z) Indicator on the Status Bar
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Gating

Gating the time domain response provides the ability to mathematically remove the effect of a 
particular circuit element. By observing the original frequency domain response and the 
transformed frequency domain response, the effect of the gating operation on the S-parameter 
data can be seen. Refer to “Gating” on page 352 for additional information.

Click Gating from the Utilities menu. Then click either Gating (Single Ended) or Gating 
(Differential) depending on whether your Time Domain plot is single-ended or differential.

Figure 14-37 Utilities Menu with Gating Expanded

Gating (Single Ended)

Select Gating (Single Ended) when you are planning to gate a single-ended Time Domain 
plot.

Gating (Differential)

Select Gating (Differential) when you are planning to gate a differential Time Domain plot.

Data Sharing

Data Sharing is used to overlay the plot of one measurement over the plot of another so that 
differences and similarities between the two plots can easily be viewed.

Refer to “Data Sharing” on page 387 for additional information.
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Tools Menu
The Tools menu allows access to the Math, Bit Pattern, and T-Line Characteristics features. 
It also allows you to launch the startup wizard, set the velocity factor, change the time domain 
windowing, set the time domain start and stop times, and scan or select new data acquisition 
hardware.

Figure 14-38 Tools Menu

Math

The Math feature allows you to design and save a mathematical formula and to apply that 
formula to compare measured parameters. For example, you could use the math feature to 
determine noise immunity on a balanced line by calculating the common mode rejection ratio 
(CMRR) using the following equation:

You could also characterize the loss of a single-ended frequency domain measurement using 
the following equation:

CMRR SDD21( ) SCC21( )⁄=

Loss
1

2
------- S21 jS31+( )=
Chapter 14 447



Menu Reference
Tools Menu
Figure 14-39 Tools Menu with Math Expanded

Design

To create a formula for use with the measured data, select Design from the Math choice of 
the Tools menu. Select the domain, either Freq or Time and either SE (single-ended), Diff 
(differential for time domain) or Bal (balanced for frequency domain) in the Domain area. 
Click the Formula box and begin entering the equation using the buttons in the Data, Key 
Pad, and Functions areas. Enter your equation from left to right. When you have finished, 
enter a name in the Formula Name box and click the Save Formula button. When you have 
finished inputting equations, click the Close button. For more details, refer to “Creating a 
Math Formula” on page 379.

Figure 14-40 Create Formulas Dialog Box
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Apply

To apply a formula to the active data, display the Choose Variable Traces to Display dialog box 
by selecting Apply from the Math choice of the Tools menu. Then select the formula name 
from those displayed in the list. Click the Apply button to apply the formula to the active 
data and display a trace showing the data with the formula applied. 

Remove removes the selected formula from the active data and removes the trace shown 
when Apply was clicked. Delete removes the selected variable from the list in the dialog box. 
Exit closes the dialog box. 

Figure 14-41 Choose Variable Traces to Display Dialog Box

Bit Pattern

The Bit Pattern feature allows you to design a digital pattern and save the pattern. Then you 
can apply the digital pattern to eye diagram plots.

Figure 14-42 Tools Menu with Bit Pattern Expanded
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Design

Select Design from the Bit Pattern choice in the Tools menu to design a digital pattern 
using the Digital Pattern Generator. The Digital Pattern Generator allows you to create a 
pattern of between 8 and 32 bits. You may create the pattern in one of two ways, either 
clicking the numbered keys (0 to 31) or by typing the numeric value in either Binary (base 2), 
Octal (base 8), or Hexadecimal (base 16) formats. As you enter the pattern inputs, the pattern 
is displayed in the upper portion of the Bit Representation area.

Figure 14-43 Digital Pattern Generator

After the pattern has been created and is displayed correctly, save the pattern by entering a 
pattern name in the Save Pattern box and values in the Rise/Fall Time (pS), Data Rate 
(Gb/s), and Pattern Length boxes. Then select OK to save the digital pattern.

Apply

Apply a digital pattern to an eye diagram using the Choose a Digital Pattern for Eye 
Generation dialog box. This dialog box also allows you to change the values for the rise/fall 
time, data rate, pattern length, and number of patterns (arbitrary bitstream only). A digital 
pattern must be applied to view data using the eye diagram data analysis type.
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Figure 14-44 Choose a Digital Pattern for Eye Generation Dialog Box

After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.

• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
condition (or the time that it takes a signal to transition from a high to a low condition). 
Refer to Figure 9-9 on page 288 for additional information regarding transition time.

• Data Rate (Gb/s) is the speed that data is transferred over a circuit or a communications 
line. Refer to Figure 9-9 on page 288 for additional information regarding data rate.

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. The number 
of bits allowed between 8 and 32. Where B is the number of bits entered, the number of 
unique bit patterns is: 2B − 2. If B = 32 (the maximum number of allowable bits), the then 
4.29×109 unique bit patterns are generated.

• Number of Patterns (active only when Arbitrary Bitstream is selected) is used to 
indicate the number of unique bit patterns to use in creating the eye diagram. This value 
must be equal or less than the number of unique bit patterns determined by the pattern 
length entry.

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

For additional information regarding Arbitrary Bitstream, refer to “Arbitrary Bitstream” on 
page 291.
Chapter 14 451



Menu Reference
Tools Menu
NOTE You may change the digital pattern using the dialog box shown in Figure 14-44 
by selecting Bit Pattern then Apply… from the Tools menu.

T-Line Characteristics

T-Line Characteristics displays the RLCG data analysis T-Line Characteristics dialog box. 
This is the same dialog box that is displayed when any RLCG analysis is selected. Enter the 
length of the transmission line (in meters) and the highest frequency (in megahertz) in this 
dialog box to change the existing transmission line characteristics.

Figure 14-45 T-Line Characteristics

Launch Startup Wizard

When Launch Startup Wizard is selected, this menu choice starts the Physical Layer 
Test System Startup Wizard. See Figure 14-46.
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Figure 14-46 Startup Wizard

Set Velocity Factor

When Set Velocity Factor is selected from the Tools menu, the dialog box shown in Figure 
14-47 is displayed. Enter the new velocity factor in the Current Velocity Factor box and 
click OK. The maximum allowable value is 1.000000.

Figure 14-47 Set Velocity Factor Dialog Box

Time Domain Window…

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed (see Figure 14-48). This dialog box allows you to set the Time Domain 
Window setting to one of three levels, Maximum (the default value), Normal, and 
Minimum. See “Time Domain Windowing” on page 251 for additional information.
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Figure 14-48 Time Domain Window Dialog Box

• Maximum gives the minimum sidelobes and this provides the greatest dynamic range. 
This is the default setting.

• Normal gives reduced sidelobes and is normally the most useful.

• Minimum is essentially no window and therefore give the highest sidelobes.

OK closes the dialog box. Cancel closes the dialog box without making changes.

Time Domain Start and Stop Time…

When Time Domain Start and Stop Time… is selected, you can change the start and stop 
time values for your time domain plots that were converted from frequency domain 
parameters (S-parameters). The Time Domain Start and Stop Time dialog box is opened. See 
Figure 14-49. You can have these plots displayed in their full time range, automatically 
optimized, or you may change the start and stop time values manually. Refer to “Optimizing 
the Time Domain Time Scale for Viewing” on page 267 for additional information.
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Figure 14-49 Time Domain Start and Stop Time Dialog Box

Acquisition Hardware

Acquisition Hardware allows you to select Choose Data Acquisition Device… or Scan 
for New Hardware.

Figure 14-50 Tools Menu with Acquisition Hardware Expanded

Choose Data Acquisition Device…

The Choose Data Acquisition Device… selection displays all of the hardware that is 
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detected in the Select Measurement System dialog box. See Figure 14-51. For example, the left 
dialog box shown in shows both an 86100A TDR-based PLTS, as well as an 8753ES 
VNA-based PLTS. When no hardware is detected, the software displays virtual PLTS 
hardware systems (two VNA-based and two TDR-based systems). A virtual PLTS hardware 
system allows you to use the software just like you would while using actual PLTS hardware 
with the exception of making a measurement. 

Figure 14-51 Select Measurement System Dialog Box

Select your hardware and click the OK button to change your hardware.

Scan for New Hardware

The Scan for New Hardware selection causes the PLTS software to check the GPIB bus for 
connected hardware. After the bus has been scanned, the Select Measurement System dialog 
box that is shown in Figure 14-51 is displayed.
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The Data menu displays each individual parameter for each specific data analysis type as 
well as the capability to display all of the parameters. The time domain and frequency domain 
data analysis types also have the option to allow you to display multiple plots on the same plot 
or separate plots. Figure 14-52 shows each of the data menus and their selections. See also 
“Parameter Bar” on page 434.

Figure 14-52 Data Menu

Individual Parameter Selections

The individual parameter selections are based on the specific data analysis type. The 
following lists each data analysis type and its associated parameters:

• Time Domain (Differential)

TDD11, TDD12, TDD21, TDD22, TDC11, TDC12, TDC21, TDC22, 
TCD11, TCD12, TCD21, TCD22, TCC11, TCC12, TCC21, TCC22 
Chapter 14 457
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• Time Domain (Single Ended)

T11, T12, T13, T14, T21, T22, T23, T24, T31, T32, T33, T34, T41, T42, T43, T44

• Frequency Domain (Balanced)

SDD11, SDD12, SDD21, SDD22, SDC11, SDC12, SDC21, SDC22, 
SCD11, SCD12, SCD21, SCD22, SCC11, SCC12, SCC21, SCC22 

• Frequency Domain (Single Ended)

S11, S12, S13, S14, S21, S22, S23, S24, S31, S32, S33, S34, S41, S42, S43, S44

• Eye Diagram (Differential)

TDD12, TDD21, TDC12, TDC21, TCD12, TCD21, TCC12, TCC21

• Eye Diagram (Single Ended)

T12, T13, T14, T21, T23, T24, T31, T32, T34, T41, T42, T43

All

Selecting All displays: 

• All 16 of the time domain parameters if the active plot window is a time domain window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• All 16 of the frequency domain parameters if the active plot window is a frequency domain 
window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• 4 of the eye diagram parameters if the active plot window is a differential eye diagram 
window.

• All 12 of the eye diagram parameters if the active plot window is a single-ended eye 
diagram window.
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New Plot

When New Plot is chosen, selecting any of the time or frequency domain parameters will 
display a new plot with that parameter within the active plots window. If New Plot is chosen, 
selecting All displays all 16 of the time or frequency domain parameters on individual plots in 
one window. 

New Trace

When New Trace is chosen, selecting any of the time or frequency domain parameters will 
display a new trace within the active plot. If New Trace is chosen, selecting All displays all 
16 of the time or frequency domain parameters on a single plot.
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There are two versions of the Format menu, one for active displays in the time domain and 
another for active displays in the frequency mode. The Format menu is not displayed for 
displays in other modes. See also “Format Bar” on page 436.

Time Domain Format Menu

Figure 14-53 Format Menu for Time Domain Measurements

Refer to “Selecting Time Domain Display Formats” on page 272 for more information.

Impulse Sets the active time domain plot to show the response with an impulse 
stimulus.

Step Sets the active time domain plot to show the response with a step-voltage 
stimulus. This is the default setting.

Volts Sets the active time domain plot’s vertical axis to Volts mode. This is the 
default setting. 

Real Sets the active time domain plot’s vertical axis to Real mode.

Log Mag Sets the active time domain plot’s vertical axis to Log Mag mode.

Impedance Sets the active time domain plot’s vertical axis to impedance mode. Active 
only for reflection plots with a step stimulus.

ns Sets the active time domain plot’s horizontal axis to nanoseconds (ns). 
This is the default setting.

cm Sets the active time domain plot’s horizontal axis to centimeters (cm).
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Frequency Domain Format Menu

Figure 14-54 Format Menu for Frequency Domain Measurements

Refer to “Selecting Frequency Domain Display Formats” on page 233 for more information.

Log Mag Displays the active frequency domain plot in Log Magnitude format. This 
is the default setting.

Linear Mag Displays the active frequency domain plot in Linear Magnitude format.

Phase Displays the active frequency domain plot in Phase format.

Group Delay Displays the active frequency domain plot in Group Delay format.

Smith Chart Displays the active frequency domain plot in Smith Chart format.

Polar Chart Displays the active frequency domain plot in Polar Chart format.

Real Displays the active frequency domain plot in Real format.

Imaginary Displays the active frequency domain plot in Imaginary format.
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RLCG Menu
When any of the RLCG data analysis types are selected, the RLCG menu is displayed. Each 
of the four RLCG data analysis types has its own menu. Refer to Figure 14-55.

Figure 14-55 RLCG Menus

Individual Parameter Selections

The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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All

If New Plot is chosen, selecting All displays all eight parameters on individual plots in one 
window. If New Trace is chosen, selecting All displays all eight parameters on a single plot.

New Plot

When New Plot is chosen, selecting any of the RLCG parameters will display a new plot with 
that parameter within the active plots window. If New Plot is chosen, selecting All displays 
all eight parameters on individual plots in one window. 
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The Options menu provides access to the User Preferences dialog box

Figure 14-56 Options Menu

User Preferences

The User Preferences dialog box allows you to customize your Physical Layer Test System 
software. This dialog box has the following three tabs to choose from: General, 
Measurement, and Load/Save.

Figure 14-57 User Preferences Dialog Box

General

The General tab (see Figure 14-57) has the following choices:

• Perform Setup - when selected, the PLTS software, when it is next started, will operate 
as if it has just been installed and go through a complete setup routine. At the conclusion 
of this routine, the Perform Setup option is automatically turned off.

• Display feedback during operations - controls the display of informational and 
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progress windows for various operations, such as the file conversion summary window and 
the measurement post-processing progress window. When selected, these windows are 
displayed; otherwise, these windows are hidden. This option’s default setting is ON. 

Measurement

The Measurement tab (see Figure 14-57) has the following choices:

• Beep when measurement is complete - when checked, the PC emits a beep to indicate 
that the measurement is complete.

• Show warning before uncalibrated measurements - when checked, a message is 
displayed confirming that you are making an uncalibrated measurement.

• Always optimize the Start and Stop Times when calculating the time domain 
data from frequency domain data - when checked, the time domain start and stop 
times are optimized for best viewing. This selection affects the Time Domain Start and 
Stop Time dialog box default optimize selection. See “Automated Start and Stop Settings 
In Time Domain” on page 257.

Load/Save

The Load/Save tab (see Figure 14-57) has the following choices:

• Save data in BMS Format - when checked, data is saved in Balanced Measurement 
System format.
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Window Menu
The Window menu provides an efficient method of working with analysis windows. It gives 
you the ability to add new analysis windows, arrange open analysis windows for optimum 
viewing, arrange the minimized analysis window icons, and select/display individual analysis 
windows.

Figure 14-58 Window Menu

New Window

New Window adds a new analysis window to the display area. The new window will display 
the analysis type that is currently selected.

Cascade

Cascade arranges all of the open plot windows to optimum and equal size with the active 
window arranged on top so that is fully displayed. Any window may be accessed by a single 
click.

Tile

Tile displays all open plot windows completely in the plot window area. Each plot window is 
reduced in size to accommodate new plot windows.

List of Open Analysis Windows

The Window menu also lists the open analysis windows below the standard Window menu 
selections. Each open analysis window is listed in the order they were opened with the most 
recent window listed at the bottom. The active analysis window is shown with a check mark 
displayed at its left side. Selecting a window from the list displays the window in the display 
area.
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Figure 14-59 List of Open Data Analysis Windows
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Help Menu
The Help menu provides access to information about the software.

Figure 14-60 Help Menu

Help…

The Help… selection displays the user’s guide (this manual) in pdf format.

About PLTS…

The About PLTS… window displays the software version information.

Figure 14-61 About PLTS… Window
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Specifications and Characteristics
Definitions
Definitions
All specifications and characteristics apply over a 25 °C ±5 °C range (unless otherwise stated) 
and 90 minutes after the instrument has been turned on.

Specification (spec.) Warranted performance. Specifications include guard bands to 
account for the expected statistical performance distribution, 
measurement uncertainties, and changes in performance due to 
environmental conditions.

Characteristic (char.) A performance parameter that the product is expected to meet 
before it leaves the factory, but that is not verified in the field 
and is not covered by the product warranty. A characteristic 
includes the same guard bands as a specification.

Typical (typ.) Expected performance of an average unit which does not 
include guard bands. It is not covered by the product warranty.

Nominal (nom.) A general, descriptive term that does not imply a level of 
performance. It is not covered by the product warranty.

Calibration The process of measuring known standards to characterize the 
system's systematic (repeatable) errors.

Corrected (residual) Indicates performance after error correction (calibration). It is 
determined by the quality of calibration standards and how 
well “known” they are, plus system repeatability, stability, and 
noise.

Uncorrected (raw) Indicates instrument performance without error correction. The 
uncorrected performance affects the stability of a calibration.
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N1947A and N1948A Electrical Specifications and Characteristics
N1947A and N1948A Electrical Specifications and 
Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +10 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent E8803A Option 014 (N1947A System)

Agilent E8358A Option 015 (N1948A System)

Test Set: Agilent N4417A Option 103 (N1947A System)

Agilent N4417A Option 104 (N1948A System)

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4417A Option B20

Calibration Technique: Four-Port SOLT

Table 15-1 System Dynamic Range

Frequency Range Specification

300 kHz to 1.3 GHz 120 dBa

a. May be limited to 100 dB at particular frequencies below 750 MHz due to spurious 
receiver residuals.

1.3 GHz to 3.0 GHz 120 dB

3.0 GHz to 6.0 GHz 108 dB

6.0 GHz to 9.0 GHz 103 dB
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Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 15-2 Measurement Port Characteristics

Description Characteristic

300 kHz
to

1.3 GHz

1.3 GHz
to

3.0 GHz

3.0 GHz
to

6.0 GHz

6.0 GHz
to

9.0 GHz

Directivity 50 dB 47 dB 42 dB 40 dB

Source Match 42 dB 42 dB 38 dB 35 dB

Load Match 50 dB 47 dB 42 dB 40 dB

Reflection Tracking ± 0.006 dB ± 0.007 dB ± 0.009 dB ± 0.015 dB

Transmission Tracking ± 0.012 dB ± 0.015 dB ± 0.040 dB ± 0.060 dB
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N1947A and N1948A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1947A and N1948A systems.

Figure 15-1 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 15-2 3.5 mm Reflection Magnitude and Phase Uncertainty
Chapter 15 473



Specifications and Characteristics
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Test Set Performance

Power Supply

The power supply requirements for the test sets are listed below. 

Table 15-3 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 300 kHz to 9.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler In 4.5 dB maximum

Port 2 to A In and Port 4 to B In 8.5 dB maximum

A In to A Out and B In to B Out 8.0 dB maximum

Isolation (port to port and A to B) ≥ 105 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

Test Port Connectors 50 Ohms (nom.) 
Type-N Connectors

Table 15-4 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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N1951A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +5 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent 8720ES Option H32

Test Set: Agilent N4418A

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4418A Option B20

Calibration Technique: Four-Port SOLT

Table 15-5 System Dynamic Range

Frequency Range Specification

50 MHz to 840 MHz 77 dB

840 MHz to 20.0 GHz 90 dB
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Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 15-6 Measurement Port Characteristics

Description Characteristic

50 MHz
to

2.0 GHz

2.0 GHz
to

8.0 GHz

8.0 GHz
to

20.0 GHz

Directivity 48 dB 48 dB 43 dB

Source Match 41 dB 41 dB 38 dB

Load Match 48 dB 48 dB 43 dB

Reflection Tracking ± 0.005 dB ± 0.005 dB ± 0.008 dB

Transmission Tracking ± 0.014 dB ± 0.014 dB ± 0.035 dB
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Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1951A system.

Figure 15-3 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 15-4 3.5 mm Reflection Magnitude and Phase Uncertainty
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Test Set Performance

Power Supply

The power supply requirements for the test sets are listed below. 

Table 15-7 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 50 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss 8 to 10 dB

Isolation (port to port) ≥ 85 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

DC Bias Range 
(Option UNK only)

40 VDC, 500 mA

Test Port Connectors 50 Ohms (nom.) 
3.5 mm (m) Connectors

Table 15-8 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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N1953A/B Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −5 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

System: N1953A N1953B

Network Analyzer: Agilent E8362A 
Options 014 and UNL

Agilent E8362B 
Options 014 and UNL

Test Set: Agilent N4419A Agilent N4419B

Calibration Kit: Agilent 85052D 3.5 mm Agilent 85052D 3.5 mm

Test Port Cables: Agilent N4419A Option B20 Agilent N4419B Option B20

Calibration 
Technique:

Four-Port SOLT Four-Port SOLT

Table 15-9 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHza

a. This frequency range is not applicable to the N1957A.

60 dB (char.)

45 MHz to 500 MHz 70 dB

500 MHz to 2.0 GHz 100 dB

2.0 GHz to 10.0 GHz 100 dB

10.0 GHz to 20.0 GHz 85 dB
Chapter 15 479



Specifications and Characteristics
N1953A/B Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 15-10 Measurement Port Characteristics

Description Characteristic

45 MHz
to

2.0 GHz

2.0 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

Directivity 56 dB 42 dB 40 dB

Source Match 42 dB 36 dB 33 dB

Load Match 56 dB 42 dB 40 dB

Reflection Tracking ± 0.0025 dB ± 0.009 dB ± 0.013 dB

Transmission Tracking ± 0.020 dB ± 0.032 dB ± 0.050 dB
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Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 15-5 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 15-6 3.5 mm Reflection Magnitude and Phase Uncertainty
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Table 15-11 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 20.0 GHz a

10 MHz to 20.0 GHzb 

a. N1957A only.
b. N1957B only.

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 5.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 20.0 GHz 18 to 25 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

8.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 20 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
3.5 mm Connectors
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Power Supply

The power supply requirements for the test sets are listed below. 

Table 15-12 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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N1955B Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8363B Options 014 and UNL

Test Set: Agilent N4420B

Calibration Kit: Agilent 85056A 2.4 mm

Test Cables: Agilent N4420B Option B20

Calibration Technique: Four-Port SOLT

Table 15-13 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHz 55 dB (char.)

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 40.0 GHz 55 dB
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Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 15-14 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

40.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 15-7 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure 15-8 2.4 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Test Set Performance
Table 15-15 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 10 MHz to 40.0 GHz 

Transition Time 
(10 to 90%, TR=.72/BW)

18 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 40.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 40 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
2.4 mm (m) Connectors
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 15-16 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics

The following specifications are applicable for the systems in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

System: N1957A N1957B

Network Analyzer: Agilent E8364A 
Options 014 and UNL

Agilent E8364B 
Options 014 and UNL

Test Set: Agilent N4421A Agilent N4421B

Calibration Kit: Agilent 85056A 2.4 mm Agilent 85056A 2.4 mm

Test Cables: Agilent N4421A Option B20 Agilent N4421B Option B20

Calibration 
Technique:

Four-Port SOLT Four-Port SOLT

Table 15-17 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHza

a. This frequency range is not applicable to the N1957A.

55 dB (char.)

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 50.0 GHz 55 dB
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Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 15-18 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

50.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
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Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 15-9 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure 15-10 2.4 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics
Test Set Performance
Table 15-19 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 50.0 GHza 

10 MHz to 50.0 GHzb 

a. N1957A only.
b. N1957B only.

Transition Time 
(10 to 90%, TR=.72/BW)

14 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 50.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 50 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
2.4 mm (m) Connectors
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Specifications and Characteristics
N1957A/B Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 15-20 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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General Characteristics
General Characteristics
The test set environmental operating conditions and physical characteristics are displayed on 
the following pages.

Environmental Operating Conditions

The environmental operating conditions for the test set are listed below.

This product is designed for use in INSTALLATION CATEGORY II and POLLUTION 
DEGREE 2, per IED 61010-1 and 664, respectively.

Table 15-21 Test Set Environmental Operating Conditions

Description Conditions

Operating Environment Indoor use

Altitude

Operating: 0 to 2.0 km (6,560 ft)

Storage: 0 to 15.24 km (50,000 ft)

Temperature 0 °C to 40 °C

Maximum Relative Humidity 80% for temperatures up to 31 °C decreasing 
linearly to 50% for a temperature of 40 °C
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General Characteristics
Physical Characteristics

The weight and dimensions for the test sets are listed below.

Weight and Dimensions

Table 15-22 Test Set Weight and Dimensions

 Model Number Weight Dimensions

Height (A) Width (B) Depth (C)

N4415A, N4416A, 
N4417A, N4418A,
and N4419A/B

9.0 kilograms
(19.9 pounds)

3.0 in
(7.62 cm)

16.75 in
(42.55 cm)

19.25 in
(48.90 cm)

N4420B, and 
N4421A/B

9.0 kilograms
(19.9 pounds)

5.5 in
(13.97 cm)

16.75 in
(42.55 cm)

16.75 in
(42.55 cm)
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Test Set Front Panel and Rear Panel
This chapter provides a graphical overview of the test sets used as part of the physical layer 
test system. This chapter also illustrates the front and rear panels of the S-parameter test 
sets separately. The features of each front and rear panel (such as connectors, switches, LEDs, 
and fuses) are identified and briefly described.

The individual network analyzer features are described in the network analyzer 
documentation. They are not be described in this document!

The front and rear panel of each S-parameter test set model is illustrated and described. Refer 
to the page number listed below for your test set model number.

For Model Number: Refer to:

N4415A page 500

N4416A page 504

N4417A page 508

N4418A page 512

N4419A/B page 516

N4420B page 520

N4421A /B page 524
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Test Set Front Panel and Rear Panel
N4415A
N4415A

N4415A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 COUPLER connector using a semirigid cable.

3 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)
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Test Set Front Panel and Rear Panel
N4415A
6 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 COUPLER connector using a semirigid cable.

7 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

8 R IN SMA (f) connector that is connected to the network analyzer 
R Channel IN connector using a semirigid cable.

9 R OUT SMA (f) connector that is connected to the network analyzer 
R Channel OUT connector using a semirigid cable.

10 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

15 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4415A
N4415A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT Not Used

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor. 

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN Not Used
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Test Set Front Panel and Rear Panel
N4415A
10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4416A
N4416A

N4416A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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Test Set Front Panel and Rear Panel
N4416A
6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4416A
N4416A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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Test Set Front Panel and Rear Panel
N4416A
10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4417A
N4417A

N4417A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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Test Set Front Panel and Rear Panel
N4417A
6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4417A
N4417A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal
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Test Set Front Panel and Rear Panel
N4417A
9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

ID 
Number

Rear Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4418A
N4418A

N4418A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 BIAS TEE connector using a semirigid cable.

3 PORT 2 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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Test Set Front Panel and Rear Panel
N4418A
5 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

6 PORT 4 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

7 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 BIAS TEE connector using a semirigid cable.

8 R OUT SMA (f) connector that is connected to the network analyzer 
R CHANNEL OUT connector using a semirigid cable.

9 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

10 IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

11 R IN SMA (f) connector that is connected to the network analyzer 
R CHANNEL IN connector using a semirigid cable.

12 OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

15 IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4418A
N4418A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT SMA (f) connector, used as an output reference signal

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN SMA (f) connector, used as an input reference signal.
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Test Set Front Panel and Rear Panel
N4418A
10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4419A/B
N4419A/B 

N4419A/B Front Panels

ID 
Number

Front Panel 
Feature

Feature Description 

1 REFERENCE 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 SOURCE OUT connector using a semirigid cable.

2 REFERENCE 1 
RCVR R1 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 RCVR R1 IN connector using a semirigid cable.

3 PORT 2 PORT 2 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB STATUS Three LEDs (R, T, and L) that display the GPIB status of the test set 
when it is communicating with the network analyzer. R = Remote 
Operation, T = Talk mode, L = Listen mode.

5 POWER ON/OFF switch that disconnects the mains circuits from the mains 
supply before other parts of the test set. The front panel POWER 
switch disconnects the mains circuits from the mains supply after 
the EMC filters and before other parts of the instrument.

6 PORT 4 PORT 4 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)
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Test Set Front Panel and Rear Panel
N4419A/B
7 REFERENCE 2 
RCVR R2 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 RCVR R2 IN connector using a semirigid cable.

8 REFERENCE 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 SOURCE OUT connector using a semirigid cable.

9 PORT 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 2 
SOURCE OUT connector using a semirigid cable.

10 PORT 2 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR ARM connector using a semirigid cable.

11 PORT 2 RCVR 
B IN

SMA (f) connector that is connected to the network analyzer PORT 2 
RCVR B IN connector using a semirigid cable.

12 PORT 2 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR THRU connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the Agilent 
N4430A/B ECal module to provide ECal capability.

14 PORT 1 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR THRU connector using a semirigid cable.

15 PORT 1 RCVR 
A IN

SMA (f) connector that is connected to the network analyzer PORT 1 
RCVR A IN connector using a semirigid cable.

16 PORT 1 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR ARM connector using a semirigid cable.

17 PORT 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 1 
SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description 
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Test Set Front Panel and Rear Panel
N4419A/B
N4419A/B Rear Panel

ID 
Number 

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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Test Set Front Panel and Rear Panel
N4419A/B
10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number 

Rear Panel 
Feature

Feature Description
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N4420B
N4420B

N4420B Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)
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6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.

7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4420B
N4420B Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  2.4 mm (f) connector, used as an output reference signal

2 REF 2 R IN  2.4 mm (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

4 REF 1 R IN 2.4 mm (f) connector, used as an input reference signal

5 REF 1 R OUT 2.4 mm (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250 Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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N4420B
9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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N4421A/B

N4421A/B Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)
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6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.

7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4421A/B
N4421A/B Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  2.4 mm (f) connector, used as an output reference signal

2 REF 2 R IN  2.4 mm (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 39 for further information.

4 REF 1 R IN 2.4 mm (f) connector, used as an input reference signal

5 REF 1 R OUT 2.4 mm (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250 Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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Test Set Front Panel and Rear Panel
N4421A/B
9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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N4421A/B
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Troubleshooting and Maintenance
Electrostatic Discharge
Electrostatic Discharge
Although protected internally, test systems are sensitive to electrostatic discharge (ESD). 
Static discharges too small to feel can damage or degrade the test equipment or your devices.

Use standard precautions to protect against ESD before using the test system for calibration 
or measurement.

Use the following illustration and list of equipment to set up a static-safe workstation.

Figure 17-1 Static-Safe Workstation

• static-control table mat and earth ground wire: part number 9300-0797

• wrist-strap cord: part number 9300-0980

• wrist-strap: part number 9300-1367

• heel-straps: part number 9300-1308

• floor mat: not available through Agilent Technologies
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Troubleshooting
Troubleshooting 
Use the following table to help troubleshoot your test system.

Table 17-1 Troubleshooting the Test System

Symptom Cause Cure

One or more biases not 
applied.

Bias fuse blown. Check bias fuses. Replace 
blow fuse with fuse of the 
same type and rating. Refer to 
the test set rear-panel 
information in Chapter 16.

Control computer can't 
communicate with the test 
set.

Accidental change to GPIB 
switch settings.

Set the GPIB address as 
needed. Restart the test 
system. See “Step 7. Set Up 
the General Purpose Interface 
Bus (GPIB)” on page 39.

The test set does not come 
on the first time you use it.

Line fuse not installed, or 
incorrect line fuse installed.

Install the line fuse. Refer to 
“Replacing the Test Set Line 
Fuse” on page 534.

Excessive ripple in data. Load termination damaged 
by excessive RF power.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 552 for more 
information.

Loose connections between 
VNA and test set and/or 
between test set and DUT.

Check and torque the 
connectors.

Poor test cable repeatability. Replace test cables as needed. 
You can replace a single cable, 
without replacing the entire 
set.

High loss on one path with 
poor raw data match (as 
seen during analyzer 
sweep) or inability to make 
a good calibration.

Possible signal channel 
damage.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 552 for more 
information.
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Additional Troubleshooting Assistance

Situation 

During installation, the PLTS software does not recognize the Agilent GPIB card. The GPIB 
card default address is “gpib0” (though it could be any address “gpib1” thru “gpib7” as well).

Background:   The software first looks for the presence of a National Instruments GPIB card 
by looking in the National Instruments library for addresses “gpib0” through “gpib7”. Because 
the software does not find the card because it is an Agilent GPIB card that is not supported by 
National Instruments. Then the software looks for the presence of a Hewlett-Packard HP-IB 
or Agilent Technologies GPIB card in the SICL library. The program looks for the following six 
addresses in this file: “hpib”, “hpib7”, “HPIB”, “HPIB7”, “Hpib”, and “Hpib7”. However, the 
Agilent GPIB address is not found.

Solution:   In Windows, select Start, Programs, Agilent IO Libraries, then IO Config. 
Click “gpib0” in the Configured Interfaces list, then click Edit. Change the SICL 
Interface Name to “hpib7” and click OK. Then click OK to confirm the change. Restarting 
the software should allow the software to recognize the Agilent GPIB card.
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Maintenance
This section provides basic maintenance information such as cleaning, fuse replacement, 
cable care, and connector care.

Cleaning

Clean the cabinet, using a dry or damp cloth only.

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A/B, N4420B, and N4421A/B) 
S-parameter test set from mains before cleaning. Use a dry cloth or one 
slightly dampened with water to clean the external case parts. Do not 
attempt to clean internally.
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Replacing the Test Set Line Fuse

To replace the line fuse, disconnect the power cord from the rear of the test set, use a small 
screwdriver to pry open the line fuse holder and slide it open until it reaches its stop. Replace 
the fuse in use with the spare fuse and slide the fuse holder back into the instrument. 

WARNING For continued protection against fire hazard replace the test set line 
fuse only with same type and rating (115V and 230V operation: T2.5A 
250V). The use of other fuses or material is prohibited.

Figure 17-2 Line Fuse Replacement
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Care of Test Cable Assemblies

Proper use and care of your test cable assemblies will yield positive results including:

• longer life

• higher performance

• better repeatability

Performing the routine inspection and cleaning of the test cable assemblies, especially the 
connectors, is very important to making the best possible measurements.

Connector Mating

Alignment of the center lines of the connectors of the test cables with the test set and DUT 
connectors before mating is important. It is possible to start the threads on the connector nuts 
without good alignment, but this will result in bent pins and damaged inserts. Resistance 
encountered while turning the connector nut may be due to one of the following:

• The pins are not aligned.

• The coupling nut is cross-threaded.

• The connector (or its mate) has been damaged by excessive torque.

Stop and determine the reason. To proceed without doing so risks the destruction of the 
assembly and the mating connector.

Holding a connector nut stationary while screwing the socket into the connector will wear 
away the connector plating and score the connector parts. If the pins lock up, serious damage 
can be caused.

Connector Torque

Make sure to grasp the body of the connector before applying final torque. If the connector 
body is allowed to rotate with the nut, the connector plating, outer interface rim, or pin 
assembly may be damaged. Excess torque applied to the connector will be transferred to the 
cable assembly. Refer to “Care of RF and Microwave Coaxial Connectors” on page 537 for more 
information. 
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Depending on the connector, over-torque can cause damage to connectors in a variety of ways: 

• mushroomed outer interface shells

• mushroomed pin shoulders

• recessed or protruding pins

• recessed or protruding dielectrics

• bent pins

• chipped plating

• coupling nut retaining ring damage

• damage to coupling threads

Cable Handling

The test cables have a 1 inch minimum bend radius. Exceeding this radius can result in poor 
measurements and poor repeatability. Be alert to tight bends where they are not necessarily 
obvious — like at the end of connector strain relief tubing.

Swept 90° adapters may be used (typically, at the test set front panel) to minimize cable 
bending. However, if the adapters are used, they must be in place during the calibration.

Cables are often stored in a coiled configuration. Coiled cable “set” (the tendency to stay 
coiled) can occur if the cables are left coiled. Use large coil diameters (one or two feet) to 
minimize cable set. Unroll coiled cables prior to use – never just pull out the loops.

Avoid pinching, crushing, or dropping objects on cable assemblies. Dragging a cable over a 
sharp edge will tend to flatten one side, and it is highly likely that the minimum bend radius 
will be exceeded.
Chapter 17536



Troubleshooting and Maintenance
Maintenance
Care of RF and Microwave Coaxial Connectors

Proper connector care is critical for accurate and repeatable measurements. The following 
information will help you preserve the precision and extend the life of your connectors - saving 
both time and money. Prior to making connections to your test system, review the connector 
care information within this section.

This section is made up of three main subjects:

• Connector Care Reference
which contains information about:
❏ Safety Reminders
❏ Connector Cleaning Supplies
❏ Connector Care Quick Reference

• Connector Care Concepts
which contains information about:
❏ Connector Service Life
❏ Connector Grades and Performance
❏ Adapters as Connector Savers
❏ Connector Mating Plane Surfaces
❏ Gaging Fundamentals
❏ Handling and Storing Connectors

• Connector Care Procedures
which contains information about:
❏ Inspecting Connectors
❏ Cleaning Connectors
❏ Making Connections
❏ Separating Connections
❏ Gaging Connectors
❏ Using a Torque Wrench
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Connector Care Reference

This section includes the following information:

• Safety Reminders

• Connector Cleaning Supplies

• Connector Care Quick Reference

Safety Reminders  When cleaning connectors:

• Always use protective eyewear when using compressed air or nitrogen.

• Keep isopropyl alcohol away from heat, sparks and flame. Use with adequate ventilation. 
Avoid contact with eyes, skin and clothing. 

• Avoid electrostatic discharge (ESD). Wear a grounded wrist strap (having a 1 MΩ series 
resistor) when cleaning device, cable or test port connectors. 

Connector Cleaning Supplies  Products commonly used to clean connectors are listed 
below. To order these and other connector care products, contact Agilent Technologies.

Table 17-2 Connector Cleaning Supplies

Cleaning Supplies Description Agilent Part Number

Lint-Free Swabs, small 100 ct. 9301-1243

IPA 99.5% alcohol, 30 ml bottle 8500-5344

Compressed Air, 235 ml can 8500-6659
Chapter 17538



Troubleshooting and Maintenance
Maintenance
Connector Care Quick Reference  Use the following table as a quick guide for connector 
care:

Table 17-3 Connector Care Quick Reference

Handling and Storage

Do Keep connectors clean Do Not Touch mating-plane surfaces

Extend sleeve or connector nut Set connectors contact-end down

Use plastic end-caps during storage

Visual Inspection

Do Inspect all connectors carefully Do Not Use a damaged connector - ever

Look for metal particles, scratches, 
and dents

Connector Cleaning

Do Try compressed air first Do Not Use any abrasives

Use isopropyl alcohol Get liquid into plastic support 
beads

Clean connector threads

Gaging Connectors

Do Clean and zero the gage before use Do Not Use an out-of-spec connector

Use the correct gage type

Use correct end of calibration block

Gage all connectors before first use

Making Connections

Do Align connectors carefully Do Not Apply bending force to connection

Make preliminary connection lightly Over tighten preliminary 
connection

Turn only the connector nut Twist or screw any connection

Use a torque wrench for final 
connect

Tighten past torque wrench 
“break” point
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Connector Care Concepts

This section includes the following concepts:

• Connector Service Life

• Connector Grades and Performance

• Adapters as Connector Savers

• Connector Mating Plane Surfaces

• Gaging Fundamentals

• Handling and Storing Connectors

Connector Service Life  Even though calibration standards, cables, and test set connectors 
are designed and manufactured to the highest standards, all connectors have a limited service 
life. This means that connectors can become defective due to wear during normal use. For best 
results, all connectors should be inspected and maintained to maximize their service life.

Visual Inspection should be performed each time a connection is made. Metal particles from 
connector threads often find their way onto the mating surface when a connection is made or 
disconnected. See Inspection procedure.

Cleaning the dirt and contamination from the connector mating plane surfaces and threads 
can extend the service life of the connector and improve the quality of your calibration and 
measurements. See Cleaning procedure.

Gaging connectors not only provides assurance of proper mechanical tolerances, and thus 
connector performance, but also indicate situations where the potential for damage to another 
connector may exist. See “Gaging Fundamentals” on page 543.

Proper connector care and connection techniques yield:

• Longer Service Life

• Higher Performance

• Better Repeatability
Chapter 17540



Troubleshooting and Maintenance
Maintenance
Connector Grades and Performance  The three connector grades (levels of quality) for the 
popular connector families are listed below. Some specialized types may not have all three 
grades.

• Production grade connectors are the lowest grade and the least expensive. It is the 
connector grade most commonly used on the typical device under test (DUT). It has the 
lowest performance of all connectors due to its loose tolerances. This means that 
production grade connectors should always be carefully inspected before making a 
connection to the analyzer. Some production grade connectors are not intended to mate 
with metrology grade connectors. 

• Instrument grade is the middle grade of connectors. It is mainly used in and with test 
instruments, most cables and adapters, and some calibration standards. It provides long 
life with good performance and tighter tolerances. It may have a dielectric supported 
interface and therefore may not exhibit the excellent match of a metrology grade 
connector. 

• Metrology grade connectors have the highest performance and the highest cost of all 
connector grades. This grade is used on calibration standards, verification standards, and 
precision adapters. Because it is a high precision connector, it can withstand many 
connections and disconnections and, thus, has the longest life of all connector grades. This 
connector grade has the closest material and geometric specifications. Pin diameter and 
pin depth are very closely specified. Metrology grade uses an air dielectric interface and a 
slotless female contact which provide the highest performance and traceability.

NOTE In general, Metrology grade connectors should not be mated with Production 
grade connectors.

Adapters as Connector Savers  Make sure to use a high quality (Instrument grade or 
better) adapter when adapting a different connector type to the analyzer test ports. It is a 
good idea to use an adapter even when the device under test is the same connector type as the 
analyzer test ports. In both cases, it will help extend service life, and protect the test ports 
from damage and costly repair. 

The adapter must be fully inspected before connecting it to the analyzer test port and 
inspected and cleaned frequently thereafter. Because calibration standards are connected to 
the adapter, the adapter should be the highest quality to provide acceptable RF performance 
and minimize the effects of mismatch. 
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Connector Mating Plane Surfaces  An important concept in RF and microwave 
measurements is the reference plane. For a network analyzer, this is the surface or point that 
measurements are referenced to at calibration. In connectors, the reference plane is defined 
as the plane where the mating plane surfaces meet. Good connections require perfectly flat 
contact between connectors at all points on the mating plane surfaces (see Figure 17-3).

Figure 17-3 Connector Mating Surfaces (Reference Plane)
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Gaging Fundamentals  Connector gages are important tools used to measure center 
conductor pin depth in connectors. See Figure 17-4. Connector pin depth is generally the 
distance between the mating plane of the outer conductor and the end of the center conductor, 
or the shoulder of the center conductor for a stepped male pin. 

Figure 17-4 Typical Connector Gage
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Recession and Protrusion  Pin depth is negative (recession) if the center conductor is 
recessed below the outer conductor mating plane, usually referred to as the “reference plane”. 
Pin depth is positive (protrusion) if the center conductor projects forward from the connector 
reference plane. See Figure 17-5.

Figure 17-5 Connector Pin Depth

1. Recession of female contact

2. Recession of male pin shoulder

Some connectors, like Type-N connectors, have the mating plane of the center conductors 
offset from the connector reference plane. In this case the zero setting “gage masters” 
generally offset the nominal distance between the center conductor mating plane and the 
connector reference plane.

When to Gage Connectors  Connectors should be gaged at each of the following events:

• Before using a connector or adapter the first time.

• When visual inspection or electrical performance suggests the connector interface may be 
out of range.

• After every 100 connections, depending on use. 
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Connector Gage Accuracy  Connector gages (those included with calibration and 
verification kits), are capable of performing coarse measurements only. This is due to the 
repeatability uncertainties associated with the measurement. It is important to recognize 
that test port connectors and calibration standards have mechanical specifications that are 
extremely precise. Only special gaging processes and electrical testing (performed in a 
calibration lab) can accurately verify the mechanical characteristics of these devices. The pin 
depth specifications in the Agilent calibration kit manuals provide a compromise between the 
pin depth accuracy required, and the accuracy of the gages. The gages shipped with 
calibration and verification kits allow you to measure connector pin depth and avoid damage 
from out-of-specification connectors. 

NOTE Before gaging any connector, the mechanical specifications provided with that 
connector or device should be checked.

Handling and Storing Connectors   Use the following precautions when handling or 
storing connectors.

• Install protective end caps when connectors are not in use.

• Never store connectors, airlines, or calibration standards loose in a box. This is a common 
cause of connector damage.

• Keep connector temperature the same as analyzer. Holding the connector in your hand or 
cleaning connector with compressed air can significantly change the temperature. Wait for 
connector temperature to stabilize before using in calibration or measurements.

• Do not touch mating plane surfaces. Natural skin oils and microscopic particles of dirt are 
difficult to remove from these surfaces.

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).
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Connector Care Procedures

This section includes the following procedures:

• Inspecting Connectors

• Cleaning Connectors

• Making Connections

• Separating Connections

• Gaging Connectors

• Using a Torque Wrench

Inspecting Connectors  Use the following procedures when inspecting connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use a magnifying glass (>10×) and inspect the connector for the following conditions:

• Badly worn plating or deep scratches

• Deformed threads

• Metal particles on threads and mating plane surfaces 

• Bent, broken, or mis-aligned center conductors

• Poor connector nut rotation

CAUTION A damaged or out-of-specification device can destroy a good connector attached 
to it even on the first connection. Any connector with an obvious defect should 
be marked for disposal or sent out for repair. 
Chapter 17546



Troubleshooting and Maintenance
Maintenance
Cleaning Connectors  Use the following procedures when cleaning connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use clean, low-pressure air to remove loose particles from mating plane surfaces and 
threads (see Figure 17-6). Inspect connector thoroughly. If additional cleaning is required, 
continue with the following steps.

Figure 17-6 Removing Loose Particles using Clean, Low Pressure Air

3. Moisten-do not saturate-a lint-free swab with isopropyl alcohol. See Cleaning Supplies for 
recommended type.

4. Clean contamination and debris from mating plane surfaces and threads. When cleaning 
interior surfaces, avoid exerting pressure on center conductor and keep swab fibers from 
getting trapped in the female center conductor. See Figure 17-7.

Figure 17-7 Cleaning Surfaces using a Lint-Free Swab

5. Let alcohol evaporate-then use compressed air to blow surfaces clean.

6. Inspect connector. Make sure no particles or residue remains.

7. If defects are still visible after cleaning, the connector itself may be damaged and should 
not be used. Determine the cause of damage before making further connections. 
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Gaging Connectors  Use the following procedures when gaging connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Select proper gage for device under test (DUT).

3. Inspect and clean gage, gage master, and DUT.

4. Zero the connector gage.

a. While holding gage by the barrel, carefully connect gage master to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection. If needed, use additional wrench to 
prevent gage master (body) from turning.

c. The gage pointer should line up exactly with the zero mark on gage. If not, adjust “zero 
set” knob until gage pointer reads zero. On gages having a dial lock screw and a 
movable dial, loosen the dial lock screw and move the dial until the gage pointer reads 
zero. Gages should be zeroed before each set of measurements to make sure zero setting 
has not changed.

d. Remove gage master.

5. Gage the DUT.

a. While holding gage by the barrel, carefully connect DUT to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection and, if needed, use additional 
wrench to prevent DUT (body) from turning.

c. Read gage indicator dial for recession or protrusion and compare reading with device 
specifications. 

CAUTION If the gage indicates excessive protrusion or recession, the connector should be 
marked for disposal or sent out for repair.

6. For maximum accuracy, measure the device a minimum of three times and take an 
average of the readings. After each measurement, rotate the gage a quarter-turn to reduce 
measurement variations.

7. If there is doubt about measurement accuracy, be sure the temperatures of the parts have 
stabilized. Then perform the cleaning, zeroing, and measuring procedure again.
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Making Connections  Use the following procedures when making connections.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Inspect, clean, and gage connectors. All connectors must be undamaged, clean, and within 
mechanical specification.

3. Carefully align center axis of both devices. The center conductor pin-from the male 
connector-must slip concentrically into the contact finger of the female connector. See 
Figure 17-8.

Figure 17-8 Aligning the Center Axis of Both Connectors

4. Carefully push the connectors straight together so they can engage smoothly. Rotate the 
connector nut (not the device itself) until finger-tight, being careful not to cross the 
threads. See Figure 17-9.

Figure 17-9 Pushing the Connectors Together and Rotating the Nut
Chapter 17 549



Troubleshooting and Maintenance
Maintenance
5. Use a torque wrench to make final connection. Tighten until the “break” point of the 
torque wrench is reached. Do not push beyond initial break point. Use additional wrench, 
if needed, to prevent device body from turning. See Figure 17-10.

Figure 17-10 Using a Torque Wrench to Make the Final Connection

Separating Connections  Use the following procedures when separating connections.

1. Support the devices to avoid any twisting, rocking or bending force on either connector.

2. Use an open-end wrench to prevent the device body from turning.

3. Use another open-end wrench to loosen the connector nut.

4. Complete the disconnection by hand, turning only the connector nut.

5. Pull the connectors straight apart.
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Using a Torque Wrench  Use the following procedures when using a torque wrench.

1. Make sure torque wrench is set to the correct torque setting. 

2. Position torque wrench and a second wrench (to hold device or cable) within 90° of each 
other before applying force. Make sure to support the devices to avoid putting stress on the 
connectors. See Figure 17-11.

Figure 17-11 Positioning the Wrenches

3. Hold torque wrench lightly at the end of handle-then apply force perpendicular to the 
torque wrench handle. Tighten until the “break” point of the torque wrench is reached. Do 
not push beyond initial break point. See Figure 17-12.

Figure 17-12 Torquing with the Torque Wrench
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Contacting Agilent

You may use the following table to contact Agilent Technologies for assistance with any 
Agilent product.

Table 17-4 Contacting Agilent

Online assistance: www.agilent.com/find/assist

United States
(tel) 1 800 452 4844

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

New Zealand
(tel) 0 800 738 378
(fax) (+64) 4 495 8950

Japan
(tel) (+81) 426 56 7832
(fax) (+81) 426 56 7840

Malaysia
(tel) 1 800 828 848
(fax) 1 800 801 664

India
(tel) 1-600-11-2929
(fax) 000-800-650-1101

Taiwan
(tel) 0800-047-866
(fax) (886) 2 25456723

Hong Kong
(tel) 800 930 871
(fax) (852) 2506 9233

Canada
(tel) 1 877 894 4414
(fax) (905) 282-6495

Europe
(tel) (+31) 20 547 2323
(fax) (+31) 20 547 2390

Australia
(tel) 1 800 629 485
(fax) (+61) 3 9210 5947

Singapore
(tel) 1 800 375 8100
(fax) (65) 836 0252

Thailand
(tel) outside Bangkok: (088) 226 008
(tel) within Bangkok: (662) 661 3999
(fax) (66) 1 661 3714

People’s Republic of China
(tel) (preferred): 800-810-0189
(tel) (alternate): 10800-650-0021
(fax) 10800-650-0121

Philippines
(tel) (632) 8426802
(tel) (PLDT subscriber only): 1 800 16510170

(fax) (632) 8426809
(fax) (PLDT subscriber only): 1 800 16510288 
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Make sure have the following information readily available when you call:

• the serial number of the test set

• a list of any options or accessories installed in or in use with the test set

• the type of GPIB board in your computer

• any information you can supply about the DUT

• the nature of the problem

• the version number of software

Shipment for Service 

If you are sending the instrument to Agilent Technologies for service, ship the test set to the 
nearest service center for repair, including a description of any failed test and any error 
message. Ship the instrument using the original or comparable antistatic packaging 
materials.

Refer to “Contacting Agilent” on page 552 for additional information.
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Safety Information
Safety Information
Review to the safety information in this section before operating your physical layer test 
system. 

Safety Symbols 

The following safety symbols are used throughout this manual. Familiarize yourself with each 
of the symbols and its meaning before operating the physical layer test system.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not correctly 
performed or adhered to, would result in damage to or destruction of the 
instrument. Do not proceed beyond a caution note until the indicated conditions 
are fully understood and met.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if 
not correctly performed or adhered to, could result in injury or loss of 
life. Do not proceed beyond a warning note until the indicated 
conditions are fully understood and met.
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Instrument Markings

Familiarize yourself with each of the markings and its meaning before operating the physical 
layer test system.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The AC symbol. The AC symbol is used to indicate the required nature 
of the line module input power.

The instruction documentation symbol. The product is marked with 
this symbol when it is necessary for the user to refer to the instructions 
in the documentation.

The CE mark is a registered trademark of the European Community. 
(If accompanied by a year, it is when the design was proven.)

The CSA mark is a registered trademark of the Canadian Standards 
Association.

This is a symbol of an Industrial Scientific and Medical Group 1 Class 
A product.

ICES / NMB-001 This is a marking to indicate product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

The C-Tick mark is a registered trademark of the Australian Spectrum 
Management Agency.
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Safety Considerations 

Familiarize yourself with each of the safety considerations before operating the physical layer 
test system.

NOTE Positioning the Test System for Use

When setting up the physical layer test system for use, position the equipment 
so that the front panel power switch is easy to reach.

NOTE This instrument has been designed and tested in accordance with the 
standards listed on the Manufacturer’s Declaration of Conformity and has been 
supplied in a safe condition. This instruction documentation contains 
information and warnings which must be followed by the user to ensure safe 
operation and to maintain the instrument in a safe condition.

Safety Earth Ground 

WARNING This is a Safety Class 1 product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor, inside or outside the 
instrument, is likely to make the instrument dangerous. Intentional 
interruption is prohibited.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause product 
damage.
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Before Applying Power 

CAUTION Install the instrument so that the ON/OFF switch is readily identifiable and is 
easily reached by the operator. The ON/OFF switch or the detachable power 
cord is the instrument disconnecting device. It disconnects the mains circuits 
from the mains supply before other parts of the instrument. Alternately, an 
externally installed switch or circuit breaker (which is readily identifiable and 
is easily reached by the operator) may be used as a disconnecting device.

CAUTION Before switching on this instrument, make sure that the correct fuse is 
installed and the supply voltage is in the specified range.

Servicing 

WARNING No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock, do not remove covers.

WARNING These servicing instructions are for use by qualified personnel only. To 
avoid electrical shock, do not perform any servicing unless you are 
qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose dangerous 
voltages. Disconnect the instrument from all voltage sources while it is 
being opened.

WARNING The power cord is connected to internal capacitors that may remain 
live for 5 seconds after disconnecting the plug from its power supply. 

WARNING For continued protection against fire hazard replace line fuse only 
with same type and rating (115V and 230V operation: T2.5A 250V). The 
use of other fuses or material is prohibited.
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General 

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A/B, N4420B, and N4421A/B) 
S-parameter test set from mains before cleaning. Use a dry cloth or one 
slightly dampened with water to clean the external case parts. Do not 
attempt to clean internally.

WARNING If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

CAUTION This product is designed for use in Installation Category II and Pollution 
Degree 2 per IEC 1010 and 664 respectively.

CAUTION VENTILATION REQUIREMENTS: When installing the product in a cabinet, 
the convection into and out of the product must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4° C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater that 800 watts, 
then forced convection must be used.
Chapter 18560



Safety and Regulatory Information
Regulatory Information
Regulatory Information
The Agilent Technologies S-Parameter test system complies with the regulatory requirements 
listed in this section.

Compliance with Canadian EMC Requirements 

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB du Canada.

Compliance with German Noise Requirements 

This is to declare that this instrument is in conformance with the German Regulation on 
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordung −3. GSGV 
Deutschland).

Acoustic Noise Emission/Geraeuschemission 

LpA <70 dB LpA <70 dB

Operator position am Arbeitsplatz

Normal position normaler Betrieb

per ISO 7779 nach DIN 45635 t. 19
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Appendices is a collection of supplementary information that you may find useful.

Appendix A, “Glossary”

Defines terms that you may encounter while performing measurements using 
the physical layer test system.

Appendix B, “Procedures”

Provides procedures that may be needed but are not commonly used while using 
the physical layer test system.
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Glossary
− Symbols −

.SnP .SnP data format creates component data files that describe frequency 
dependent linear network parameters for n port components. This 
format is used to import/export S-parameter data. Also see 
“Touchstone” on page 592.

γ (Gamma) Gamma is the complex propagation constant. γ = α + jβ where α is the 
attenuation per length and β is related to the wave velocity.

Γ (Gamma) In network analysis, Γ (Gamma) is the ratio of the reflected voltage 
signal level to the incident signal voltage level 
(Γ = Vreflected/Vincident). It is the complex reflection coefficient that 
consists of magnitude (ρ) and phase (Φ) components.

δ (delta) Skin depth. A measure of the depth of current penetration towards the 
center of a conductor from the perimeter at a particular frequency.

Tan δ Loss tangent of a material. This is mostly a measure of the ease at 
which electric fields penetrate (or propagate through) a material. 
Typical values in electronic materials are in the 0.001 – 0.025 range.

εr  εr is the relative permittivity of a material (also referred to as 
dielectric constant), which is mostly a measure of a material’s density. 
Most insulators used in electronics are in the range of 3 to 10. εo is the 

permittivity of air, which is 8.85e−12.

µ (mu) µ (mu) is the relative permeability of a material. A measure of how 
easily a material is magnetized. Most all non-magnetic materials have 
a value of 1. µo is the permeability of a vacuum, which is 4πe−7.

µW 1. Microwave. See “Microwave” on page 580. 

2. Microwatts (one-millionth of a watt)

ρ (rho) 1. (Material properties) Bulk resistivity of a material (e.g. 
Cu = 1.7e−8 ohm-meters). A measure of a materials resistance to 
current flow.

2. (Network analysis) Magnitude portion of the complex reflection 
coefficient (Γ). The magnitude of the ratio between the reflected 
and the incident voltages.
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σ (sigma) 1. (Material properties) Bulk conductivity of a material (the inverse of 
resistivity).

2. (Statistics) Standard deviation, which is the measure of the 
dispersion or spread of the statistical average of all results for a 
particular measurement. See “Standard Deviation” on page 589.

τ (tau) In network analysis, τ (tau) is the magnitude portion of the complex 
transmission coefficient (T). The magnitude of the ratio between the 
transmitted and the incident voltages.

T (Tau) T (Tau) is the ratio of the transmitted voltage signal level to the 
incident signal voltage level (T = Vtransmitted/Vincident). It is the 
complex transmission coefficient that consists of magnitude (τ) and 
phase (ø) components.

ø (phi) In network analysis, ø (phi) is the phase angle portion of the complex 
transmission coefficient (the ratio between the transmitted and the 
incident voltages).

Φ (Phi) In network analysis, Φ (Phi) is the phase angle portion of the complex 
reflection coefficient (the ratio between the reflected and the incident 
voltages).

− Numeric −

2-Level (PAM2) A 2-level data signal generates 1 bit per symbol.

4-Level (PAM4) A 4-level data signal generates 2 bits per symbol consuming half the 
bandwidth of a 2-level signal.

− A −

Active Device An active device is a device that requires a source of energy to add gain 
to a signal or control a circuit. Examples of active device are LEDs, 
transistors, and integrated circuits.

American Wire 
Gauge (AWG)

AWG is the standard for determining wire size. The gauge number 
varies inversely with the diameter of the wire. 

Analog Analog is a method of transmitting information. Analog is 
characterized by adding data of continuously varying frequency or 
amplitude to carrier waves. Digital transmissions depend on the 
varying between two discrete levels. An analog signal responds to 
changes in light, sound, heat and pressure.
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Arbitrary 
Bitstream (ABS)

Arbitrary Bitstream is a random-like bit stream used to generate eye 
diagrams. The "number of bits" and the "number of patterns" user 
inputs is used to create the ABS. The "number of bits" entry identifies 
the number of unique bit patterns that are available. The "number of 
patterns" identifies the number of these unique bit patterns that are 
used to create the eye diagram. Using both of these values, a random 
number generator selects unique bit patterns until the appropriate 
number of bit patterns is identified. Each of these unique bit patterns 
are then used to create the eye diagram, one bit pattern at a time.

Attenuation Attenuation is a reduction in signal amplitude. The difference between 
transmitted and received power due to loss through equipment, lines, 
or other transmission devices; usually expressed in decibels.

Averaging Averaging is a waveform acquisition mode in which the instrument 
acquires waveforms from multiple data acquisitions and then averages 
the waveforms together, point by point. Averaging significantly 
reduces noise and improves resolution of the displayed waveform. The 
noise sources can average to zero over time while the underlying 
waveform is preserved. The effective resolution of the displayed 
waveform increases as more acquisitions are averaged together. This 
improves the stability of both the display and waveform 
measurements. 

− B −

Backplane A backplane is a circuit board that has sockets and circuitry and 
serves as an interconnection between other cards (circuit boards) that 
are plugged into the sockets. Typically refers to a special, heavy-duty 
printed or discrete wired circuit board. In terms of PCs, this circuit 
board is synonymous with the motherboard. Typically the backplane is 
designed for a longer life than the daughter cards and has improved 
signal integrity. It is often manufactured out of more expensive PCB 
materials.

Backplanes are either active (also called intelligent) or passive. Active 
backplanes also contain a microprocessor or circuitry that performs 
computing functions. Passive backplanes have no computing circuitry.

Balanced Device A balanced device is composed of two nominally identical halves. 
Practically speaking, the signals on each side of the device can have 
any relative amplitude and phase relationship, but they can be 
decomposed into a differential-mode (anti-phase) component, and a 
common-mode (in-phase) component. 
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Balanced 
Measurement 
System (BMS)

The BMS is the predecessor to the Physical Layer Test System. The 
BMS acquires 2-, 3-, or 4-port frequency domain test data using a 
network analyzer and multiport test set and displays the data in 
either frequency or time domain. ATN Microwave originally developed 
this product before being acquired by Agilent Technologies.

Balun A balun (balanced-unbalanced) is an impedance matching device used 
to connect a balanced line or device with an unbalanced coaxial line or 
device. 

Bandwidth In analog terms, bandwidth is the difference between the maximum 
and minimum frequency. It is measured in hertz (Hz). 

In digital terms, bandwidth is the data transmission capacity of an 
electronic circuit or system. It is measured in bits (or bytes) per 
second.

Baud Baud refers to the number of level transitions through a device in a 
one second period. One baud is one state-transition or level-transition 
per second. In the past, baud was the accepted units for data 
transmission rate. However, bits per second (bps) is replacing baud as 
a more accepted unit of measure. 

Bit Bit is an abbreviation of the term "Binary Digit". A bit is the smallest 
unit of computer data. It is a single digit number, either a one or a 
zero. A collection of bits makes up a group called a "byte" or a "word" 
which is equivalent to one alphanumeric character.

Bit Pattern A bit pattern is a series of bits that are convolved with a time domain 
impulse response of a system to create an eye diagram.

Bits Per Second 
(bps)

Bits per second (bps) is the unit of measure for the rate or speed of 
data transfer. Refer to “Data Transfer Rate” on page 572.

Bit Rate Bit rate is the number of bits that are sent through a circuit per 
second, calculated as inverse of the bit period (1/bit period). The bit 
period is a measure of the horizontal opening of an eye diagram at the 
crossing points of the eye.

Broadband Broadband is high-speed transmission. Although not a standard, it 
commonly refers to computer data and telecommunication rates in 
excess of 1.544 Mbps, the rate of T1 lines. Broadband often refers to 
Internet access using cable modems and DSL. A broadband network 
can carry voice, video and data all at the same time.
Appendix A 569



Glossary
Bus A collection of wires in a cable (or copper traces on a circuit board) that 
serve as a common data path between multiple devices. The bus is 
used to transmit signals (data, status, and control) between the 
devices that share the bus. Bus typically refers to a parallel data 
transmission structure (1 clock, multiple data channels). As designs 
transition from parallel to serial with data rates in excess of 1 Gbps 
barrier, the terms "Channel" or "Lane" may become more commonly 
used than "Bus". 

Byte A byte is a unit of data that is eight bits in length. A byte represents a 
single character, such as a letter, number, or symbol. "Byte" may be 
preceded with Kilo (Kilobyte) for 1 thousand bytes, Mega (Megabyte) 
for 1 million bytes, or Giga (Gigabyte) for 1 billion bytes.

− C −

C (capacitance) Capacitance (farads) is a measure of stored electric charge.

Calibration In network analyzer systems, calibration is the process of removing 
systematic errors from measurements (also known as accuracy 
enhancement or error correction). See “SOLT Calibration” on page 588 
and “Thru Reflect Line (TRL) Calibration” on page 591.

Calibration Kit A calibration kit contains hardware and software required to perform 
error correction on a network analyzer for a specific measurement 
and/or test set.

Characteristic 
Impedance (Zo)

Characteristic impedance is the impedance looking into the end of an 
infinitely long lossless transmission line.

Coaxial Cable 
(Coax)

Coaxial cable is a cable with the inner solid or stranded wire acting as 
the primary conductor wire that is surrounded by a solid or braided 
metallic shield serving as the ground with an insulating medium 
between the two. 
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Common 
Instrumentation 
Transfer and 
Interchange File 
(CITIfile)

CITIfile is an ASCII data format that is useful when exchanging data 
between different computers and instruments. CITIfile is a data 
storage convention designed to be independent of the operating 
system, and therefore may be implemented by any file system that has 
the ability to transfer ASCII files. 

A typical CITIfile package is divided into two sections, the header and 
the data. The header section contains information about the data that 
will follow. It may also include information about the setup of the 
instrument that measured the data. The Data is a numeric array of 
data that is arranged with one data element per line. The data section 
may contain more than one array of data. Arrays of data start after the 
BEGIN keyword, and the END keyword follows the last data element 
in an array. 

Common Mode Common mode is the in-phase mode of a balanced measurement.

Continuous 
Sweep Mode

Continuous sweep mode is the vector network analyzer condition 
where traces are automatically updated each time trigger conditions 
are met.

Crossing 
Percentage (Eye)

Crossing percentage (eye) is a measure of the amplitude of an eye 
diagram crossing points relative to the one level and zero level.

Crossing percentage = 100 (Vcross − Vzero level) / (Vone level − Vzero level))

Crossing Point 
(Eye)

Crossing point (eye) is the point in time, in an eye diagram, where the 
rising edge of a waveform intersects with the falling edge.

Crossstalk Crosstalk is the occurrence of a signal at one port of a device being 
affected by a signal in any other path. Isolation is a description of each 
signal path (or channel's or lane's) immunity from noise from other 
channels or outside sources.

− D −

Data Sharing Data Sharing is a Physical Layer Test System utility that is used to 
overlay the plot of one measurement parameter over the plot of the 
same measured parameter from a different data set so that differences 
and similarities can be readily seen.
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Data Transfer 
Rate

The number of bits that are sent during a one second period. This is 
generally associated with high-speed serial data transfer systems. The 
base unit of measure is bits per second (bps). "bps" may be preceded 
with K (Kbps) for 1000 bits per second, M (Mbps) for 1,000,000 bits per 
second, or G (Gbps) for 1,000,000,000 bits per second.

De-embedding De-embedding eliminates the effects (loss, phase shift, mismatch) of 
the test fixture, connectors, cables and other equipment. 
De-embedding combines these effects with the errors determined 
during a coaxial calibration to account for errors of all of the 
equipment required to measure the DUT. This characterized data is 
mathematically removed from the measured data, thus ensuring that 
only the effects of the DUT are displayed. This technique is very useful 
for measuring DUTs that require fixtures, such as wafers and 
packages.

Deterministic 
Jitter

Deterministic jitter is the deviation of a transition from its ideal time 
caused by reflections relative to other transitions or events happening 
on neighboring lines. It is pattern dependent, occurring in a 
predictable, systematic manner due to the varying data patterns. It 
adds linearly and is measured in peak-to-peak means. 

Differential Mode Differential mode is the anti-phase mode of a balanced measurement.

Direct Current 
(DC)

Direct Current is electron flow at zero hertz. 

DUT DUT is an acronym commonly used for the device under test.

Dynamic Range Dynamic range specifies the amplitude (size) of a signal that can be 
input into the instrument at a particular vertical scale without 
overdriving the front end, resulting in an inaccurate acquisition of 
data. 

− E −

Electromagnetic 
Interference 
(EMI)

Any electromagnetic energy created by an outside source that 
interrupts, degrades, or limits the performance of electronics 
equipment or systems. It can result from unintentional sources, such 
as spurious emissions and responses, or it can be induced 
intentionally, as a form of electronic warfare.
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Electronic 
Calibration 
(ECal)

Electronic calibration performs a SOLT (Short-Open-Load-Thru) 
calibration on the Physical Layer Test System using an ECal module 
controlled by the N1930A software. The ECal module is a 
state-of-the-art, solid-state device with programmable and highly 
repeatable impedance states that provide consistent calibrations and 
eliminate operator errors while bringing convenience and simplicity to 
your calibration routine. The PLTS uses the N4430A and N4430B 
ECal modules to calibrate to maximum frequencies of 6 GHz and 9 
GHz, respectively.

Ethernet Ethernet is a network that adheres to the IEEE 802.3 Local Area 
Network standard.

Extinction Ratio Extinction ratio is the ratio of the one level and the zero level of an eye 
diagram. This measurement is made in a section of the eye referred to 
as the eye window. 

Eye Amplitude Eye amplitude is the difference between the logic 1 level and the logic 
0 level histogram mean values of an eye diagram.

Eye Diagram or 
Pattern

An eye diagram is a waveform display that has a specific number of 
bits sliced and folded on top of one another to produce an overlaid 
display. In PLTS, the eye diagram is produced by convolving the time 
domain impulse response of SDD21 with a repetitive bit pattern, 
which is wrapped.

Eye Height Eye height is a measure of the vertical opening of an eye diagram. 

Eye Opening 
Factor 

Eye Opening Factor is a measure of the vertical opening of an eye 
diagram.

Eye Width Eye width is a measure of the horizontal opening of an eye diagram. 

Eye Window The eye window provides the time boundaries within which signal 
parameters for eye diagrams are measured. 

− F −

Fall Time Fall time is the transition time for the falling edge of a pulse to 
decrease from 90% of its peak value to 10% of its peak value. 

Fast Fourier 
Transform (FFT)

The Fast Fourier Transform is an algorithm for transforming data 
from the time domain to the frequency domain.
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Fixturing Fixturing is the process of using a test fixture as an interface between 
your test equipment and your device under test (DUT). See “Test 
Fixture” on page 591.

Forward 
Orientation

Forward orientation is the direction an adapter is inserted into the 
Physical Layer Test System equipment setup. An adapter is "forward 
oriented" when the end labeled "1" at the PLTS test cable and the end 
labeled "2" will be connected to the DUT. See “Orientation” on page 
582.

FR-4 FR-4 is a common epoxy resin glass laminate that is used as substrate 
for PC boards. 

Frequency Frequency is the number of periodic oscillations, vibrations, or waves 
per unit of time, usually expressed in cycles per second, or Hertz (Hz).

Frequency 
Accuracy

Frequency accuracy is the uncertainty with which the frequency of a 
signal or spectral component is indicated, either in an absolute sense 
or relative to another signal or spectral component. Absolute and 
relative frequency accuracies are specified independently.

Frequency Band Frequency band is a term that identifies a range of frequencies in the 
electromagnetic spectrum.

Frequency Range Frequency range is the range of frequencies over which a device or 
instrument performance is specified.

Frequency 
Response

In frequency mode, frequency response is the peak-to-peak variation 
in the displayed amplitude response over a specified center frequency 
range. Frequency response is typically specified in terms of dB, 
relative to the value midway between the extremes.

Frequency Span Frequency span is represented by the horizontal axis of the display. 
Generally, frequency span is given as the total span across the full 
display. Sometimes frequency span (scan width) is represented as a 
per-division value.

Functions (Math) Functions (Math) are mathematical operations (such as Add, Subtract, 
Multiply, Integrate, Versus for XY plots) that can be performed on 
input waveforms, stored waveform memories, or even other functions. 

− G −

G (conductance) Conductance is the resistive component in shunt impedance from a 
signal to ground or across transmission lines.
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Gating Gating enables a network analyzer to remove displayed data between 
specific intervals. This function is used in the time domain mode to 
separate device connector and coupling effects.

General Purpose 
Interface Bus 
(GPIB)

The GPIB bus provides an easy and reliable interface between GPIB 
instruments and a computer GPIB interface card using GPIB cables. 
These cables are available in various lengths. Multiple cables can be 
daisy-chained together to simplify the system interconnection.

Gigabits per 
Second (Gbps)

Gigabits per second or one billion bits per second. Refer to “Data 
Transfer Rate” on page 572.

Gigabyte Gigabyte is generally defined as either 1,000 or 1,024 megabytes. See 
“Byte” on page 570.

Gigahertz (GHz) One billion cycles per second. Refer to “Frequency” on page 574.

Golden Device A device under test that is measured and its test results are saved for 
comparison against future measurements as a metric of calibration 
quality and repeatability.

Graticule Graticules are the horizontal and vertical grid lines making up the 
plot area. Graticules allow for easier, more accurate viewing of the 
waveform data and markers. 

Group Delay A measure of the transit time of a signal through a DUT versus 
frequency. Group delay can be calculated by differentiating the DUT's 
insertion-phase response versus frequency.

−∆ Phase / (∆f) (360)

where, ∆ Phase is the phase difference between two adjacent 
frequencies, ∆f.

− H −

Hertz (Hz) One cycle per second. Refer to “Frequency” on page 574.

Horizontal Scale Horizontal scale is an instrument control that controls the x-axis (time 
or frequency per division) of displayed waveforms. Horizontal scale is 
often referred to as sweep speed in some instruments. 

HSPICE HSPICE is a circuit simulation tool based on SPICE (Simulation 
Program for Integrated Circuits Emphasis). Physical Layer Test 
System data can be exported in an HSPICE format. HSPICE is a 
product of Synopsys, Inc.
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Hub A hub is a central connection point for devices in a network. It receives 
a signal from one device and retransmits the signal to one or more 
devices. Passive hubs are data conduits that just connect devices, 
adding nothing to the data passing through them. Active hubs 
regenerate the data bits in order to maintain a strong signal. 
Intelligent hubs have additional features that monitor traffic. 
Switching hubs read the destination address of each packet of 
information and then forward the information to the proper 
destination.

− I −

IEEE 802 IEEE 802 is a series of documents that define the standards for Local 
and Metropolitan Area Networks. The Institute of Electrical and 
Electronics Engineers, Inc. (IEEE) publish these standards. The 
following is a list of subjects that the standards define:

IEEE Std 802: Overview and Architecture
IEEE Std 802.1: Bridging and Management
IEEE Std 802.2: Logical Link Control
IEEE Std 802.3: CSMA/CD Access Method
IEEE Std 802.5: Token Ring Access Method
IEEE Std 802.6: DQDB Access Method
IEEE Std 802.7: Broadband LAN
IEEE Std 802.10: Security
IEEE Std 802.11: Wireless LANs
IEEE Std 802.12: Demand Priority Access Method
IEEE Std 802.15: Wireless Personal Area Networks
IEEE Std 802.16: Broadband Wireless Metropolitan Area 
Networks

Imaginary Imaginary is a format that displays the reactive portion of the 
measured data on a Cartesian format. This is the corollary to the Real 
format where the resistive portion is displayed.

Impedance Impedance is the ratio of voltage to current at a port of a circuit, 
expressed in ohms.

Insertion Loss Insertion loss is the difference between the power measured before 
and after the insertion of a device or the attenuation between the 
input and output of a device.
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Inverse Fast 
Fourier 
Transform

The Inverse Fast Fourier Transform is an algorithm for transforming 
data from the frequency domain to the time domain.

Isolation Isolation is the specification or measure of the immunity that one 
signal has to being affected by another adjacent signal. Low isolation 
in digital systems manifests itself as crosstalk or noise on the victim 
channel.

− J −

Jitter Jitter is the measure of the time variances of the rising and falling 
edges of an eye diagram as these edges affect the crossing points of the 
eye. 

− K −

K28.5 K28.5 is an industry standard, finite length, specific bit sequence than 
includes a comma character and 8B/10B encoding. 

Kilobits per 
Second (Kbps)

Kilobits per second or one thousand bits per second. Refer to “Data 
Transfer Rate” on page 572.

Kilobyte Kilobyte is generally defined as either 1,000 or 1,024 bytes. See “Byte” 
on page 570.

Kilohertz (kHz) One thousand cycles per second. Refer to “Frequency” on page 574.

− L −

L (inductance) Inductance (henries) is stored magnetic charge.

Line Reflect 
Match (LRM) 
Calibration

LRM calibration is a calibration type that utilizes three simpler, more 
convenient standards to define the error terms to be removed from the 
measurement. The measured parameters of the Line, Reflect, and 
Match standards in a LRM calibration kit provides the same 
information as a SOLT calibration via a different algorithm.

A calibration at the coaxial ports of the test system removes the effects 
of the system and any cables or adapters before the fixture; however, 
the effects of the fixture itself are not accounted for. An in-fixture 
calibration is preferable, but SOLT standards may not be readily 
available to allow a conventional full 4-port calibration at the desired 
measurement port of the device. 
Appendix A 577



Glossary
Line Reflect 
Match (LRM) 
Calibration 
(continued)

LRM calibration is convenient because calibration standards can be 
fabricated for the specific measurement environment. The 
characteristic impedance of these fabricated transmission lines can be 
determined from the physical dimensions and substrate's dielectric 
constant. The LRM calibration relies on the characteristic impedance 
of simple transmission lines.

Linear Device A linear device is a device that only modifies phase or magnitude of 
frequency components present on the input signal. 

Linear Mag Linear Mag is the display mode in which the vertical deflection is 
presented in linear function (vertical divisions are uniformly space). 
This format is used for unit-less measurements, such as reflection 
coefficient magnitude and for linear measurement units. It is used to 
display conversion parameters and time domain transform data.

Load 1) A load is a one-port microwave device used to terminate a path in its 
characteristic impedance.

2) A load is a calibration standard that is an actual line that 
terminates a path with the path's characteristic impedance. See 
“SOLT Calibration” on page 588. 

Load Match Load match is a measure of how close the device's terminating load 
impedance is to the ideal transmission line impedance. Match is 
usually measured as return loss or standing wave ratio (SWR) of the 
load.

Log Display Log display (logarithmic display) is the display mode in which vertical 
deflection is a logarithmic function of the input signal amplitude. The 
display calibration is set by selecting the value of the reference level 
position and scale factor in dB per division. 

Log Mag Log Mag is the display mode in which vertical deflection is a 
logarithmic function of the input signal amplitude. Log Mag is also 
called logarithmic display.
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Low Voltage 
Differential 
Signals (LVDS)

LVDS is a high-speed (gigabits per second), low-noise, low-power, low 
voltage method of transmitting digital information. The differential 
signals are transmitted over two traces or over balanced cable using a 
very low voltage swing between high (binary 1) and low (binary 0). The 
low swing voltage means that data can switched very quickly which 
provides the higher data transfer rate. LVDS uses the two traces 
(cables) for two signals, which are 180 degrees out of phase from each 
other. Thus, the noise travels at the same level making filtering very 
effective. This mode of transmission is often used with SCSI hardware.

− M −

Magnitude Magnitude is the amplitude of a signal measured in its characteristic 
impedance without regard to phase.

Markers Marker lines are used to determine the position or amplitude of the 
selected point on the display graticule. Marker lines can be positioned 
on either: 

• A selected waveform source (input channel, waveform memory, or 
waveform function)

• Independently, anywhere on the display graticule

Mask A mask is a template consisting of numbered, shaded regions on the 
instrument display screen. The input waveform must remain within 
these regions in order to comply with industry standards. The 
waveforms that intrude these regions are mask violations. 

Masking Time domain responses are most accurate closest to the location of the 
source. A discontinuity in the DUT will reflect some power back to the 
source, meaning less power is transmitted to the rest of the DUT. This 
loss of power going away from the source is referred to as masking, and 
allows the true impedance of the next discontinuity to be 
misrepresented.

Mask Test A mask test is a test process used to verify that waveforms generated 
by a test device conform to industry standards. 
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Measurement 
Uncertainty

Measurement uncertainty is the quantified amount of error in a 
measurement situation. Calibrations are intended to reduce the 
amount of uncertainty. The following are sources of measurement 
errors that lead to uncertainty: 

• Systematic errors (imperfections in calibration standards, 
connectors, cables, and instrumentation) 

• Random errors (noise, connector repeatability)
• Drift (source and instrumentation) 

Megabits per 
Second (Mbps)

Megabits per second or one million bits per second. Refer to “Data 
Transfer Rate” on page 572.

Megabyte Megabyte is generally defined as either 1,000 or 1,024 kilobytes. See 
“Byte” on page 570.

Megahertz (MHz) One million cycles per second. Refer to “Frequency” on page 574.

Microprocessor 
Unit (MPU)

A microprocessor is a computer (central processing unit, CPU) on a 
single digital semiconductor chip. It performs math and logic 
operations and executes instructions from memory. A microprocessor 
requires a power supply, clock and memory to function as a computer.

Microstrip Microstrip is a planar transmission line that consists of a thin 
conductive trace (or traces) printed or etched on the top side of an 
insulating substrate with a parallel ground plane on the other side of 
the substrate. Microstrips are also used for antennas and antenna 
arrays.

Microwave Microwave is the frequency band where radio waves are very short. 
This band ranges from approximately 1 GHz to 40 GHz, within the 
UHF, SHF, and EHF frequency bands. 

Mixed Mode 
S-parameters

Mixed-mode S-parameters describe the performance of a device when 
measuring a balanced device. Each balanced port will support both a 
common-mode and a differential-mode signal. 
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Mode Conversion Mode conversion is a measure of isolation when making balanced 
S-parameter measurements where there is a:

• Differential-mode stimulus with a common-mode response 
(SCDXX). Mode conversion in this configuration can result in 
device asymmetry and generation of electromagnetic interference 
(EMI).

• Common-mode stimulus with a differential-mode response 
(SDCXX). Mode conversion in this configuration can result in 
device asymmetry and susceptibility to EMI.

− N −

Near End 
Crosstalk (NEXT)

Signal distortion as a result of signal coupling from one wire pair to 
another wire pair at various frequencies. When measuring the NEXT, 
it is usually the resultant voltage excursion expressed as a percentage 
of the incident voltage swing of the culprit line. 

Network Analysis Network analysis is the characterization of a device, circuit, or system 
derived by comparing a signal input going into the device to a signal or 
signals coming out from the device. 

Noise Noise is an unwanted disturbance (voltage or current) superimposed 
on a useful waveform.

Non-insertable 
Calibration

A non-insertable calibration is one in which the test port connectors 
are of the same gender (male-to-male or female-to-female).

Non-linear Device A non-linear device is a device in which frequency components are 
added or deleted (not just modified) from the original signal.

Non-Return to 
Zero (NRZ) 
Signaling

NRZ signaling is used in differential signaling to describe that swing 
about some offset voltage do no return to 0 volts.

Normalize To normalize is to subtract one trace from another to eliminate 
calibration data errors or to obtain relative information.

− O −

Offset Offset is used to move or set off a determined amount. Used in 
instruments for offsetting frequencies, limits, delay, loss, impedance, 
etc.
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One Level One level is a measure of the mean value of the logical 1 of an eye 
diagram. 

Open An Open is a calibration standard that is an actual line that 
terminates a path with an electrical open. See “SOLT Calibration” on 
page 588. 

Orientation Orientation is the direction that an adapter is inserted between the 
Physical Layer Test System port's coaxial test cable and the DUT. 
Each end of the adapter should be labeled: either "1" or "2". Identifying 
the adapter orientation is important when calibrating the test system. 
An adapter is "forward oriented" when the end labeled "1" at the test 
cable and the end labeled "2" will be connected to the DUT. An adapter 
is "reverse oriented" when the end labeled "2" at the test cable and the 
end labeled "1" will be connected to the DUT.

− P −

Passive Device A passive device is a device that requires only a signal to perform its 
function. It does not require a source of power for its operation and it 
provides no gain to a circuit. Examples of passive devices are resistors, 
inductors, capacitors, cables, and filters.

Pattern Length Pattern length is the number of bits that are used to create a bit 
pattern used to create an eye diagram in the Physical Layer Test 
System. Bit patterns may be between 8 and 32 bits long.

Phase The fractional part of a cycle through which an oscillation has 
advanced, measured from an arbitrary starting point; usually 
measured in radians or degrees. In network analysis, the phase 
response of the device under test is the change in phase as a function 
of frequency between the input stimulus and the measured response. 
In network analysis, the phase response of the device under test is the 
change in phase as a function of frequency between the input stimulus 
and the measured response.

Phase Rotation See “Phase Skew” on page 583.

Phase Shift Phase shift is the change in phase of a signal between two points of 
time. Phase shift is expressed in degrees of lead or lag.
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Phase Skew Phase skew is a technique to remove the time delay caused by a 
fixture. Since the SOLT calibration only calibrates to the end of the 
test cables, the effects added by the test fixture can be removed 
mathematically. Phase skew moves the reference plane from the end of 
the test cables to the connection between the fixture and the DUT by 
accounting for the electrical length of each fixture path. Other terms 
for phase skew are phase rotation, port extension, port rotation, and 
reference plane rotation.

Physical Layer The physical layer is layer 1, the lowest layer, of the seven-layer Open 
System Interconnection model. In broad terms, the physical layer is 
responsible for activating and using physical connections for transfer 
of electronic bits (zeros and ones) between a device and its 
transmission medium. The physical layer defines the electrical, 
mechanical, and handshaking protocols that govern transmission 
media and signals over the interface connecting a device to the 
transmission medium. In doing so, the physical layer insulates the 
data link layer (layer 2) from the physical characteristics of the 
transmission medium, such as baseband, broadband, or fiber-optic 
transmission. The physical layer is subdivided into the physical 
medium-dependent sublayer and the transmission convergence 
sublayer. Physical layer has three basic mediums: electrical (where 
SIO is focused), wireless/over air, and optical. All three are used in 
today's communications systems.

Polar Chart The Polar chart is a format where each point corresponds to a 
particular value of both magnitude and phase. Quantities are read 
vectorally: the magnitude at any point is determined by its 
displacement from the center (which has zero value), and the phase by 
the angle counterclockwise from the positive x-axis. Magnitude is 
scaled in a linear fashion, with the value of the outer circle set to a 
ratio value of 1. Since there is no frequency axis, frequency 
information is read from the markers. The default marker readout for 
the polar format is in linear magnitude and phase.

Port Port is a network-analysis term for the path that sends/received data 
to/from the DUT. In logic analysis and oscilloscope terminology a port 
is more like a channel. A channel in a logic analyzer or an oscilloscope 
is usually unidirectional (acquisition only) where as a port in a 
network analyzer is bi-directional. A port is also equivalent to the 
"pin" of an IC or board tester, which is usually bi-directional as well. So 
a port is similar to a pin on a package or connector.
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Port Extension See “Phase Skew” on page 583.

Port Rotation See “Phase Skew” on page 583.

Power Level Power level (dBm) is the stimulus level at the test port required for the 
measurement of the device under test.

Probe A probe is the test device is connected to the Physical Layer Test 
System (or some other electronic device) that is used to make contact 
with a DUT to deliver or detect a signal for the purpose of on-circuit 
measurements. It is often a stylus-like device having multiple 
conductors for signal and ground paths. The tip is also often spring 
loaded to apply a constant pressure to the DUT.

Probing In the frequency domain, probing is the process of using a probe to 
perform on-circuit measurements.

In the time domain, probing typically refers to the technique of either 
browsing (single probe) or attaching (multiple probes, as in a logic 
analyzer) to the DUT and attempting to be non-intrusive with respect 
to the signal. Oscilloscope or logic analyzer-based measurements 
probing is designed to be as non-intrusive to the active electrical signal 
as possible while retaining the high bandwidth required to make 
accurate measurements.

Pseudo-Random 
Binary Sequence 
(PRBS)

Pseudo-Random Binary Sequence is a fixed length, somewhat random, 
digital signal pattern. 

Pulse Width Pulse width is the difference in time between the rising and falling 
edges of a signal that is transitioning, away from and then back to, its 
steady state. 

− R −

R (resistance) Resistance (ohms) is the opposition to the flow of current in a 
conductor.

Rack Units A rack unit (U) is the vertical distance (height) between screw holes in 
an equipment rack. One rack unit (1U) equals 1.75 inches (44.45 mm) 
of rack space for equipment. 2U provides 3.5 inches of rack space for 
equipment, and so forth.
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Radio Frequency 
(RF) 

RF is the frequency band where radio waves are below the microwave 
band. The RF band ranges from approximately 50 kHz to 3 GHz, 
within the LF, MF, HF, VHF, and UHF frequency bands. 

Range Resolution Range resolution is defined as the ability to locate a single response in 
the time domain. If only one response is present, range resolution is a 
measure of how closely you can pinpoint the peak of that response. The 
range resolution is equal to the digital resolution of the display, which 
is the time domain span divided by the number of points on the 
display. The range resolution is always much finer than the response 
resolution.

Real Real is a format that displays the resistive portion of the measured 
data on a Cartesian format. This is the corollary to the Imaginary 
format where the reactive portion is displayed.

Record Length In frequency domain, record length refers to number of frequency 
points measured by the network analyzer. A longer record length 
(number of points) in a VNA implies either more resolution (closer 
points in the frequency domain) or a wider bandwidth measurement.

In time domain, record length refers to the number of time points or 
instances acquired by the scope or logic analyzer. A longer record 
length (also occasionally called "points") means greater resolution for 
any given time duration.

Reference Level Reference level is an instrument function that allows the user to set 
the amplitude value at the reference position. On network analyzers, 
the reference position is also selectable. 

Reference Plane A reference plane is the electrical location at which a network analyzer 
assumes the system connectors and fixturing ends and the device 
under test (DUT) begins. The reference plane is set by using 
calibration standards with known electrical lengths. The closer the 
reference plane is to the DUT, the better the characterization of the 
device because of the elimination of test system uncertainties.

Reference Plane 
Rotation

See “Phase Skew” on page 583.

Reflection Reflection is the phenomenon in which a traveling wave strikes a 
discontinuity and returns to the original medium.
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Reflection 
Coefficient

The reflection coefficient is the ratio of the reflected voltage to the 
incident voltage into a transmission line or circuit. If a transmission 
line is terminated in its characteristic impedance, the reflection 
coefficient is zero. If the line is shorted or open, the coefficient is 1. 

Reflection 
Measurements

Reflection measurements characterize the input and output behavior 
of the device under test. Measured as the ratio of the reflected signal 
to the incident signal as a function of frequency. Parameters are called 
return loss, reflection coefficient, impedance match, and standing 
wave ratio (SWR), all as a function of frequency.

Response The Physical Layer Test System applies reference signals that are 
transmitted through the DUT or are reflected from the DUT's input. 
The transmitted or reflected signal is then detected and compared 
against the reference signal. A detected signal is called the "response". 
A reference signal is called the stimulus.

Response 
Resolution

Response resolution is defined as the ability to resolve two closely 
spaced responses, or a measure of how close two responses can be to 
each other and still be distinguished from each other in the time 
domain.

Reverse 
Orientation

Reverse orientation is the direction an adapter is inserted into the 
Physical Layer Test System equipment setup. An adapter is "reverse 
oriented" when the end labeled "2" at the PLTS test cable and the end 
labeled "1" will be connected to the DUT. See “Orientation” on page 
582.

Rise Time Rise time is the transition time for the leading edge of a pulse to rise 
from 10% of its peak value to 90% of its peak value.

RMS RMS is the root-mean-square (rms) of the voltage values of a 
waveform. Typically, the rms is taken over the first period of the 
displayed waveform. 
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Router 
(Networking)

A router is an electronic device that links local and wide area networks 
(LANs and WANs), allowing them to talk to one another even though 
the networks may be based on different standards. Using routing 
tables and protocols, routers read the network address in each 
transmitted frame and decide how to send it based on the most 
expedient route. Gateway is a generic term for a router.

Most routers are specialized computers that are optimized for 
communications; however, router functions can also be implemented 
by adding routing software to a file server.

− S −

S-parameters 
(Scattering 
Parameters)

A convention used to characterize the way a device modifies signal 
flow. A four-port device has sixteen S-parameters: four forward 
transmission parameters, four reverse transmission parameters, four 
forward reflection parameters, and four reverse reflection parameters.

Scale (horizontal) Horizontal scale is an instrument control that controls the x-axis or 
time per division of displayed waveforms. Horizontal scale is often 
referred to as sweep speed in some instruments.

Scale (vertical) Vertical scale is an instrument control that controls the y-axis or volts 
per division for the selected channel. This control allows you to adjust 
the sensitivity of the instrument.

Serializer-Deseria
lizer (SERDES)

SERDES is a term applied to the serialization (conversion from 
parallel to serial) and deserialization (conversion from serial to 
parallel) of data. The serialization portion usually merges clock and 
data and performs encoding while the deserialization typically 
performs decoding and clock/data recovery. SERDES are commonly 
used in high-speed serial links.

Short A Short is a calibration standard that is an actual line that terminates 
a path with a precision electrical short. See “SOLT Calibration” on 
page 588. 

Signal-to-Noise 
Ratio

Signal-to-noise is the ratio of the amplitude of a signal relative to the 
amplitude of the noise on the signal.

Signal Integrity 
Engineering

Signal Integrity Engineering is using digital design and analog circuit 
theory along with accurate models and simulation to design circuits 
correctly the first time to save time and cost. When problems do occur 
signal integrity engineering quickly finds the root cause of signal 
distortions and fixes them. 
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Single-ended A singled-ended or unbalanced device, having all of its signals 
referenced to a common ground potential.

Single-ended 
Device

A single-ended device has all of its signals referenced to a common 
ground potential.

Single-Ended 
Mode (SEM)

Single-ended mode is a method of sending SCSI signals along a cable. 
Single-ended mode uses one wire for the signal, which is compared to a 
common ground. The signal is the voltage difference between the two 
wires. Cable lengths for single-ended mode are restricted to between 6 
and 1.5 meters (20 to 5 ft.) with the length decreasing as the data 
speed increases.

Skew Skew changes the horizontal position of a waveform on the display 
independent of any other waveforms on the display. Skew is typically 
used for overlaying waveforms, or eliminating timing difference 
caused by different cable and probe lengths. The time base position 
control moves all of the waveforms on the display at the same time, 
whereas skew moves individual waveforms.

Skin Effect Skin effect is the tendency of high-frequency currents to flow close to 
the surface of the conductor restricting the flow to a small part of the 
conductor's cross-sectional area. As frequency increases, so does the 
resistance and thus the loss also increases due to skin effect.

Small Computer 
System Interface 
(SCSI)

SCSI (pronounced "skuzzy") is a standardized hardware interface for a 
computer that acts as an I/O bus that can be used to connect the 
computer to several peripheral devices, such as printers, disk drives, 
CD-ROM, CD-R, Zip drives, and scanners.

SOLT Calibration SOLT is a calibration using four known standards: 
Short-Open-Load-Thru. 
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Smith Chart The Smith chart is the most common way to display complex 
impedance. The Smith chart is a circular chart with a bisecting 
horizontal line. The amount of reflection that occurs when 
characterizing a device depends on the impedance the incident signal 
sees. Since any impedance can be represented as a real and imaginary 
part (R+jX or G+jB), these quantities can be plotted on a rectilinear 
grid (known as the complex impedance plane). 

All values of reactance and all positive values of resistance from 0 to 
infinity fall within the outer circle of the Smith chart. Impedances on 
the chart are always normalized to the characteristic impedance of the 
test system. A perfect termination (Zo) appears in the center of the 
chart. A pure open appears at the left end of the bisecting horizontal 
line (infinity on the x-axis), while a pure short appears at the right end 
of the same line (zero on the x-axis). Loci of constant resistance now 
appear as circles, and loci of constant reactance appear as arcs. 
Inductance (positive reactance) is displayed in the upper half of the 
Smith chart, while capacitance (negative reactance) is displayed in the 
lower half.

Source The source (input channel, function, waveform memory, or constant) 
used when performing tasks, such as measurements, math, or mask 
tests.

Standard 
Deviation

Standard deviation, represented by the Greek letter sigma (σ), is the 
measure of the dispersion or spread of the statistical average of all 
results for a particular measurement. In a Gaussian distribution, two 
sigma, or within ±1σ of the mean is where 68.3 percent of the data 
points reside. Six sigma, or within ±3σ of the mean is where 99.7 
percent of the data points reside. 

Start Frequency Start frequency is the start point of the frequency domain 
measurement range, or the lowest frequency measured. Together with 
the stop frequency, they determine the span of the measurement 
range.

Stimulus The Physical Layer Test System applies reference signals that are 
transmitted through the DUT or are reflected from the DUT's input. 
The transmitted or reflected signal is then detected and compared 
against the reference signal. A reference signal is called the 
"stimulus". A detected signal is called the response.
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Stop Frequency Stop frequency is the stop point of the frequency domain measurement 
range, or the highest frequency measured. Together with the start 
frequency, they determine the span of the measurement range.

Stripline A stripline is a planar transmission line structure that consists of a 
thin conductive trace (or traces) printed or etched within an insulating 
substrate with parallel ground planes on both sides of the substrate. 

Sweep A sweep is the ability of the source to provide a specified signal level 
over a specified frequency range in a specified time period. 

Sweep Cycle Time Sweep cycle time is the time required for making a complete sweep 
and preparing for the next sweep. It can be measured as the time from 
the start of one sweep to the start of the next sweep. 

Sweep Mode Sweep mode is the way in which a sweep is initiated or selected.

Sweep Type Sweep type is the method of sweeping the source, e.g., linear, log, or 
frequency step. 

− T −

T-carrier T-carrier is a full-duplex digital transmission type that uses four wire 
cables. One pair is used to transmit; the other pair is used to receive. 
The cable types were originally twisted pairs, but now include coaxial 
cable, digital microwave, optical fiber, and other media. Other 
T-carrier characteristics are:

• Symmetry: the same amount of bandwidth is provided in each 
direction.

• Time Division Multiplexing: multiple transmissions can be 
supported over multiple channels by interleaving the signals over a 
given carrier frequency. 

• Unbiasing: all applications and data types are treated the same. 
Every bit of each transmission is treated the same, regardless of 
whether it's a voice bit, a data bit, or a video bit. 

T1 T1 lines are a standard for broadband digital transmission over 
telephone lines. T3 lines consist of 24 channels at 1.544 Mbps. These 
lines are generally used by Internet Service Providers. See “T-carrier” 
on page 590.
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T3 T3 lines consist of 672 channels at 44.736 Mbps. These lines are 
generally used by Internet Service Providers and are also referred to 
as DS3 lines. See “T-carrier” on page 590.

Termination A termination is a load connected to a transmission line or other 
device.

Test Fixture A test fixture is a fixture used to hold the DUT, route signals to and 
from the DUT, and to apply bias voltages and ground paths to the 
DUT.

Test Set A test set is the arrangement of hardware (switches, couplers, 
connectors and cables) that connect a test device input and output to 
the network analyzer's source and receiver to make S-parameter 
measurements.

Thru A Thru (through) is a calibration standard that is an actual through 
line. See “SOLT Calibration” on page 588. 

Thru Reflect Line 
(TRL) Calibration

TRL calibration is a calibration type that utilizes three simpler, more 
convenient standards to define the error terms to be removed from the 
measurement. The measured parameters of the Thru, Reflect, and 
Line standards in a TRL calibration kit provides the same information 
as a SOLT calibration via a different algorithm.

A calibration at the coaxial ports of the test system removes the effects 
of the system and any cables or adapters before the fixture; however, 
the effects of the fixture itself are not accounted for. An in-fixture 
calibration is preferable, but SOLT standards may not be readily 
available to allow a conventional full 4-port calibration at the desired 
measurement port of the device. 

TRL calibration is convenient because calibration standards can be 
fabricated for the specific measurement environment. The 
characteristic impedance of these fabricated transmission lines can be 
determined from the physical dimensions and substrate's dielectric 
constant. The TRL calibration relies on the characteristic impedance 
of simple transmission lines.

Time Domain 
Network Analysis 
(TDNA)

TDNA includes both time domain reflectometry (TDR) and time 
domain transmission (TDT) measurements to characterize a network. 
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Time Domain 
Reflectometry 
(TDR)

TDR gives an intuitive measurement of any discontinuities in a 
circuit. It measures the location, electrical length, nature of the circuit 
(resistive, capacitive, inductive), and amount of reflection from 
discontinuities.

Time Domain 
Transmission 
(TDT)

TDT is a measurement technique that measures both attenuation and 
propagation delay of your device under test. 

Topology Topology is the way that circuits are connected to link the network 
nodes together. Several network topologies are listed: 

• Bus topology: A topology in which all nodes, i.e., stations, are 
connected together by a single bus.

• Fully connected topology: A topology in which every node has a 
direct path to every other node.

• Hybrid topology: A combination of any two or more other 
topologies.

• Mesh topology: A topology in which there is a minimum of two 
nodes with each having a minimum of two (often more) paths.

• Ring topology: A topology in which every node has exactly two 
branches connected to it forming a ring when all connections are 
made.

• Star topology: A topology in which peripheral nodes are connected 
to a central node. The central node rebroadcasts all transmissions 
received from any peripheral node to all peripheral nodes on the 
network.

• Tree topology: A topology in which multiple star topologies are 
connected together when their central nodes are connected to a 
higher level central node. In turn, this central node may be 
connected to other higher-level central nodes.

Touchstone Touchstone data files, also known as .Snp files, are ASCII text files 
used to import and export S-parameter data. This file format displays 
the data line-by-line, one line per data point, in increasing order of 
frequency. Each line of data consists of a frequency value and one or 
more pairs of values for the magnitude and phase of each S-parameter 
at that frequency. Values are separated by one or more spaces. 
Comments are preceded by an exclamation mark (!). Comments can 
appear on separate lines, or after the data on any line or lines. 
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Trace A series of data points containing frequency/time and amplitude 
information on a plot. In the Physical Layer Test System, a plot may 
have only one trace or it may be defined to have multiple traces. 

Transition Time Transition time is the time duration that a pulse takes to rise from the 
10% level to the 90% level when turning on (the rise time) or the time 
duration that a pulse takes to fall from the 90% level to the 10% level 
when turning off (the fall time).

Transmission 
Measurements

The characterization of the transfer function of a device, that is, the 
ratio of the output signal to the incident signal. Most common 
measurements include gain, insertion loss, transmission coefficient, 
insertion phase, and group delay, all measured over frequency.

Twisted Pair A twisted pair is a cable that is made up of one or more separately 
insulated twisted-wire pairs which reduces susceptibility to RF noise.

− U −

Uncorrected 
Measurements

Uncorrected measurements are measurements made without 
performing calibration (error correction).

uW See “Microwave” on page 580. 

− V −

Velocity Factor Velocity factor is a numerical value related to the speed of energy 
through transmission lines with different dielectrics (.66 for 
polyethylene). In making time domain measurements, a velocity factor 
of 1 = speed of light = 299.7925 x 106 m/s.

Vertical 
Resolution

Vertical resolution is the degree to which an instrument can 
differentiate amplitude between two signals. 

Via A via is a hole filled or lined with a conducting material which is used 
to link two or more conducting layers of a PC board. There are blind 
vias (a via that connects two or more layers including the top or bottom 
layer), buried vias (a via that connects two or more layers that does not 
include the top or bottom layer), and through-hole vias (a via that 
connects all layers). 

− W −

Waveform A waveform is a representation of a signal plotting amplitude versus 
time. 
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Wavelength Wavelength is the physical distance that an electromagnetic wave 
travels during the time it completes one cycle. The distance between 
points of corresponding phase of two consecutive cycles of a wave. The 
wavelength (l) is related to the propagation velocity (v) and the 
frequency (f) by l = v / f. 

Windowing Windowing is a time domain feature that smooths (filters) overshoot 
and ringing displayed in time domain plots. Overshoot and ringing are 
caused by the abrupt transitions of start and stop frequencies used in 
frequency domain measurements. 

− Z −

Zero Level Zero level is a measure of the mean value of the logical 0 of an eye 
diagram.

Zo Zo is the characteristic impedance of a transmission line.
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Procedures
The procedures in this appendix may be required while using the physical layer test system; 
however, they are not used commonly. The following is a list of the procedures.

• Setting Up the General Purpose Interface Bus Manually is used when you want to set up 
your GPIB in a manual mode.

• Using the Network Analyzer to Make 2-Port Measurements is used when you want to 
make 2-port measurements using only the network analyzer.

• Converting a CitiFile to a PLTS Adapter File is used when you want to convert a citifile 
(“.cit”) containing measured data to an adapter file (“.txs”) for de-embedding.

• IF Gain Adjustment is used to set up the N8362A, N8363A, or N8364A PNA network 
analyzer, with firmware revision less than 3.0, to be used in the PLTS system.
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Setting Up the General Purpose Interface Bus Manually
The Physical Layer Test System software will locate and identify your test system equipment 
automatically. However, there may be the occasion that you need to set up the GPIB address 
for equipment manually. 

The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. Each test system device must have a unique GPIB address. There are 32 GPIB 
addresses, numbered 0 to 31. GPIB addresses for test equipment are set either using switches 
on the rear panel (as in the case of the test sets for the VNA-based systems and some network 
analyzers (8720ES and 8753ES)) or using the equipment firmware (as in the case of the PNA 
network analyzers and Agilent TDR system).

In the case of GPIB addresses that are set using the rear-panel switches, the GPIB addresses 
are five-bit binary numbers that are set with the switches labeled “16” through “1” (“1” is the 
least significant digit). The five address switches allow for 32 GPIB addresses, numbered from 
0 to 31. The test set has a default address of “18” that is set at the factory. While this address 
is a unique address in most cases, the address may be changed (if required) to avoid conflicts 
with other equipment on the same bus.

There are three other switches labeled “T”, “L”, and “S” which correspond to Talk, Listen, and 
Status. The factory default for these switches is off.

CAUTION If your PC is using an Agilent 82357A USB/GPIB Interface for Windows or any 
Agilent GPIB card, you must perform the following task to allow the software to 
recognize the Agilent GPIB device:

In Windows, select Start, Programs, Agilent IO Libraries, then IO Config. 
Click “gpib0” in the Configured Interfaces list, then click Edit. Change the 
SICL Interface Name to “hpib7” and click OK. Then click OK to confirm the 
change. Restarting the software should allow the software to recognize the 
Agilent GPIB card.
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1. Make sure the GPIB address switch on the rear panel of the test set is set to the correct 
address. The illustration below shows the factory default setting of “18”, which is set by 
turning on switches “16” and “2”. Make sure the “T”, “L”, and “S” switches are set as shown 
(off).

2. Make sure that the network analyzer GPIB address is set to a unique address. The factory 
default address of the network analyzer is “16”. Refer to the network analyzer 
documentation for information about how to check and set the GPIB address of the 
analyzer.

3. If your equipment does not have a switch on the rear panel to change the GPIB address, 
refer to the equipment documentation to changed the address. 

4. Make sure that the GPIB cables are connected from the PC to the test equipment. Refer to 
the hardware installation chapter for your PLTS system (either Chapter 1 or Chapter 2).

NOTE After changing any GPIB address setting, cycle the ac power on all system 
equipment, including the PC, to establish the new GPIB address.
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Using the Network Analyzer to Make 2-Port Measurements
You can make two port measurements using the front panel control of the network analyzer 
without having to disconnect the network analyzer from the test set using the following 
procedure.

1. Turn off the PLTS software.

2. Toggle the power on the test set to reset the switches.

3. Leave the power of the test set in the ON position.

4. Use the network analyzer from the front panel.
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Converting a CitiFile to a PLTS Adapter File
The Physical Layer Test System uses adapter files to de-embed measurement data. PLTS 
adapter files (“.txs” files) can be created by adding a two-line comment near the top of an 
S-parameter citifile (“.cit” file) as shown below. You can use an MS Windows-based ASCII text 
editor such as Notepad to perform this procedure. The following shows a citifile for a thru 
device with 3.5mm connector at each end. (The measurement data within this example file 
has been replaced with a vertical ellipsis only as a space savings for this example.)

CITIFILE A.01.00
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END

Using the two comment lines shown below, identified with “#TXS”, the type of device and the 
connector type of its ports are identified.

#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM

These two comment lines are inserted be the first and second line of the citifile as shown 
below. This is then saved as a “.txs” file in the PLTS deembedding directory.

CITIFILE A.01.00
#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
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SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END
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IF Gain Adjustment
This procedure is for N8362A, N8363A, and N8364A PNA network analyzers that have 
firmware revisions less than Revision 3.0.

It is recommended that the Service IF Gain Adjustment test be run before using the test set. 
This routine adjusts the R Channel receivers ALC gain to ensure phase lock over the entire 
frequency range of the PNA Series Network Analyzer. Connect the test set to the analyzer 
before adjusting the IF gain. 

NOTE When the analyzer is removed from the test set for service, or for other 
applications that do not require the test set, the IF gain adjustment must be 
run again to return the R Channel receiver ALC gain back to normal.

Adjustment Test

1. Close the PNA Series Network Analyzer window.

2. Open “My Computer”, located on the desk top, double click on “Hard Disk (c:).”
(You may also use Explorer). Refer to Figure B-1.

3. Open the following folder path: Programs Files/Agilent/Network Analyzer/Service
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Figure B-1 File Path on PNA Network Analyzer Window

4. Double click “ifgainadjust.exe.”

5. Minimize the PNA Network Analyzer window when it appears. You should see the IF Gain 
Adjust window.

Figure B-2 IF Gain Adjustment Window

6. Select the test set in the “Select Specials, if any” pull down menu and click on “Begin Adj.” 
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Symbols
.cal file extension, 143, 161, 175
.cit file extension, 600
.cit file extension, converting, 408
.dut file extension, converting, 408
.ecl file extension, 146
.NET Framework, 55
.s2p file extension, converting, 408
.s4p file format description, 334–337
.txs file extension, 600
.txs file extension, converting to, 408

Numerics
2-port measurements, making, 599
4 box thru configuration, 138, 140
4 cross thru configuration, 138, 140
4-channel LRM calibration procedure, 168
4-channel SOLT calibration, 126, 127, 129
4-channel TRL calibration, 127
4-channel TRL calibration procedure, 154
50 ohm cable option, 9
6 cross thru configuration, 138, 140

A
A IN connector, 501, 504, 508
A OUT connector, 501, 505, 509
About PLTS menu selection, 468
ac power, 41, 50

cord, 8
frequency range, 41

AC symbol, 557
accessories, 8, 54
acoustic noise emission, 561
Acquisition Hardware menu selection, 455
Actual Measured Parameters menu 

selection, 348, 423
adapter

all others characterization category, 177
characterization, 176–182
characterization file, 147
check box, 147
in-series, same-sex characterization 

category, 177
marking, 176, 440
orientation, 176, 440
reverse orientation, 361

adapter file, 600
Adapter Installation window, 178
address switch, 39, 49, 502, 506, 510, 514, 518, 

597
address, GPIB, 39, 49, 597

Adjust Port Reference Plane menu selection, 
444

adjusting the port reference plane, 357
adjustment, IF gain, 42, 602
ADS, 325
ADS menu selection, 348, 423
Advanced button, 126
Agilent T&M Programmer’s Toolkit, 57
Agilent Technologies offices, 552, 553
All menu selection, 458, 463
all others adapter characterization category, 

177
altitude, 41, 494
amplitude, eye, 282
analysis type, 119, 217
analysis type, selecting the, 115, 213
analyzer model number, 109
analyzer setup, 10
analyzing measurement data, 119, 217
Apply menu selection, 449, 450
applying math formulas, 383
arbitrary bitstream, 290, 291
assistance, 552
Australian Spectrum Management Agency, 

557
auto optimize start and stop time, 268
automated start and stop settings, 257
automatic de-deskewing, 206
autoscale, 238, 275, 378
AUXILIARY connector, 501, 505, 509, 513, 

517
averaging, 111, 190

B
B IN connector, 501, 505, 509
B OUT connector, 501, 505, 509
Balanced 1234, 339, 421
Balanced 1324, 339, 421
balanced line, 128
balanced S-parameters, 226–227
balanced transmission line pc board, 8
balanced transmission line, connecting a, 212
bandwidth, sampler, 190
bandwidth, setting the IF, 111
bar

cursor, 99
format, 97
menu, 93
parameter, 96
scaling, 98
scaling for frequency domain, 237
scaling for RLCG, 323
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scaling for time domain, 274
status, 99
title, 92
tool, 94

before applying power safety considerations, 
559

bench top installation, 16
bending, cable, 536
bent connector center pin, 535
best throughput and flatness, 190
bias fuse, 531
bias range, 478
bit pattern

choosing a, 290
creating a, 286
menu selection, 286, 449
saving, 288

bit rate, 282
bit representation area, 287
bitstream, arbitrary, 290, 291
browser, 95
Browser menu selection, 433
BUS ADDRESS switch, 502, 506, 510, 514, 

518
bus connector, 502, 506, 511, 514, 518

C
cable

bends, 536
care, 535
center pins, 535
GPIB, 39
handling, 536
option, 9

cables, 21
connecting ECal, 145
semirigid interconnect, 8
TDR, 184

calculations, time domain, 261
Calibrate menu selection, 439
calibrate, reason to, 122
calibrating hardware, 111, 113, 190
calibration, 470

changing parameters, 126
checking the data, 125
comparing thru path, 139
electronic, 144–147
icon color changes, 141, 142
interface, mechanical, 137
kit, 9
kit frequency range, 130

kit minimum rise time, 130
kit, defining a, 132, 150, 165
kit, selecting a, 126, 127, 129, 130, 149, 150, 

163, 164
loading existing data, 110, 189
LRM, 162–175
mechanical, 137–143
parameters window, 126
performing, 113
performing a new, 110, 189
performing TDR, 195–211
procedure, 126–182
prompt, 142
saving data, 143, 161, 175
short/open/load, 141
SOL, 141
thru, 138, 139
thru icon, 140
TRL, 148–161
type, selecting, 127, 129, 149, 163
type, selecting a, 126
without prompts, 141

calibration file name, TDR, 196
calibration kit

defining a TDR, 199
calibration kit selection, TDR, 196
Calibration menu selection, 438
calibration procedure, LRM, 168
calibration procedure, TRL, 154
calibration standards, TDR, 184
calibration times, approximate TDR, 193
calibration type differences, 128
calibration type, choosing a TDR, 202
calibration, performing a module, 203
calibration, performing a TDR standards, 

205–211
Canadian

EMC requirements, 561
Interference-Causing Equipment Standard 

symbol, 557
Standards Association symbol, 557

care of connectors, 537
Cascade menu selection, 466
cautions

before applying power, 559
definition, 556
general, 560
safety earth ground, 558
servicing, 559

CD-ROM, 5, 46, 53, 54
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CE symbol, 557
changing parameters, 126
changing spatial, 111
characteristic T-Line, 318
characteristics, 469–495
characterization file

adapter, 147
ECal module, 146, 147

characterization report generator, 389–393
Characterization Report menu selection, 425
Characterize Adapter menu selection, 176, 

440
characterize adapters, 176–182
check box, adapter, 147
check box, reverse orientation, 147
checking the calibration, 125
chirp-z transform, 242
Choose Data Acquisition Device menu 

selection, 455
CITIfile file format description, 329–333
CITIfile keywords, 331
CITIFile menu selection, 421, 422
Citifile menu selection, 339, 342
CITIfile terms

array of data, 330
header, 330
package, 330

CitiFile, converting a, 600
CITIfile, importing files, 339
cleaning connectors, 539
cleaning the test set, 533
cm, 273
cm menu selection, 460
colors

calibration icon changes, 141, 142
of icons, 140, 141

communication bus connector, 502, 506, 511, 
514, 518

comparing thru path calibrations, 139
compatible network analyzer options, 10
compliance with

Canadian EMC requirements, 561
German noise requirements, 561

computer requirements, 5, 46, 53
configure a system, 90
conformity, declaration of, 562
connecting the device under test, 212
connection manager, 64, 75
connector

care, 537
mating, 535
torque, 535

Continuous sweep indicator, 99
Continuous Sweep menu selection, 430
copying plot formats, 394–395
cord, ac power, 8
corrected, 470
coupled transmission line, 303
coupled transmission line extraction, 306
COUPLER connector, 500, 501, 512, 513, 516, 

517
COUPLER IN connector, 504, 505, 508, 509
create a measurement system, 88
creating math formulas, 379
CSA symbol, 557
C-Tick mark, 557
cursor bar, 99
Custom Adapter Characterization Wizard, 

177–181

D
damage from shipment, 6, 47, 54
damage level, 474, 478, 482, 487, 492
Data menu, 457
data sharing, 387–388
Data Sharing menu selection, 446
dB, angle menu selection, 343, 422
DC bias range, 478
declaration of conformity, 562
de-embedding, 358–361

file, 600
indicator, 99, 361
menu selection, 360, 442

depth, 495
Design menu selection, 448, 450
de-skewing, automatic, 206
detecting hardware, 109, 187
deterministic jitter, 282
device under test

connecting a, 212
sample, 8

device, golden, 125
dielectric constant, 190

changing, 111
differential TDR parameters, 192
digital pattern

choosing a, 290
creating a, 286
generator, 286

dimensions, 495
directivity, 472, 476, 480, 485, 490
drift errors, 122
dynamic range, 471, 475, 479, 484, 489
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E
earth ground wire, 530
ECal, 144–147

connecting the cables, 145
kit option, 9
module, 144
module characterization file, 146, 147
module connections, 144
module connector, 501, 505, 509, 513, 517
using adapters, 147
window, 144

Edit Cal Kit menu selection, 441
effective dielectric constant, 190
electronic calibration, 144
electronic calibration. See also ECal
electrostatic discharge. See ESD
EMC requirements, Canadian, 561
environment operating conditions, 494
environment, operating, 41
equipment installation

TDR-based, 43–50
VNA-based, 3–42

equipment rack installation, 17
errors, 122
ESD

precautions, 530
supplies, 530

European Community symbol, 557
existing calibration data, loading, 110, 189
Exit menu selection, 429
Export menu selection, 340, 421
exporting data files, 340–348
exporting data in CITIfile format, 342
exporting data in Touchstone format, 343
exporting data to TDA MeasureXtractor, 346
exporting frequency domain data, 341
exporting plots to an image file, 341
exporting plots to clipboard, 340
exporting RLCG, 310
exporting RLCG data, 325, 348
exporting time domain data, 343
exporting transmission line data, 325
extension, port, 357, 358
extracting fitted parameters, 301
eye amplitude, 282
eye diagram, 281, 282

bit rate, 282
choosing a digital pattern, 290
creating a digital pattern, 286
deterministic jitter, 282
eye amplitude, 282

eye width, 282
fall time, 282
one level, 281
opening plots, 289
rise time, 282
viewing all plots, 293
viewing custom plots, 295
viewing plots, 289–295
viewing single plots, 294
zero level, 281

eye height, 282
eye width, 282

F
factor, changing velocity, 111
fall time, 282
file converter utility, 408–411
File menu, 417
filtering, 251, 282
fitted parameters, 300
fitted parameters, extracting, 301
flange kit, 17
flatness, best, 190
floor mat, static-control, 530
format bar, 97

frequency domain, 233
menu selection, 436
time domain, 272

format menu, 460
frequency domain, 233
time domain, 272

formats
selecting frequency domain, 233–235
selecting time domain, 272

forward orientation of adapters, 179, 180
frequency

range, 7, 130, 474, 478, 482, 487, 492
range of power supply, 474, 478, 483, 488, 

493
setting start and stop, 111
step, setting, 111

frequency domain
changing parameters, 126
changing scale, 237
format bar, 97, 233
format menu, 233
menu selection, 341, 422
modifying measurement parameters, 111
opening plots, 228
scale units, 238
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selecting formats, 233–235
view parameters window, 214
viewing all plots, 229
viewing custom plots, 232
viewing plots, 228–232
viewing single plots, 230

frequency domain markers, 365
front panel

N4415A, 500
N4416A, 504
N4417A, 508
N4418A, 512
N4419A, 516
N4419B, 516
N4420B, 520
N4421A, 524
N4421B, 524

Full Screen menu selection, 437
fuse, bias, 502, 506, 510, 514, 518
fuse, power, 503, 507, 511, 515, 519

G
gaging connectors, 539
gain, IF, 42, 602
gating, 277, 352–356

adding a gate, 352
deleting a gate, 356
menu selection, 352, 446
moving a gate, 356

Gating Bar menu selection, 436
general safety considerations, 560
generator, digital pattern, 286
Geraeuschemission, 561
German noise requirements, 561
glossary, 566
golden device, 125
GPIB, 5, 46, 53

address, 39, 49, 531, 597
address switch, 39, 49, 502, 506, 510, 514, 

518, 597
address, viewing the, 109, 188
card, 5, 46
connecting the able, 39
connector, 502, 506, 511, 514, 518
STATUS LEDs, 500, 504, 508, 512, 516

ground wire, 530
Group Delay format, 233

H
handle kit, 17

handles, 8, 9
handling cables, 536
handling connectors, 539
hardware, 87

auto-detection, 109, 187
calibration values, 111, 190
indicator, 99
rescan, 110, 188

hardware, virtual, 88
heel straps, ESD, 530
height, 495
help, 552
Help menu, 468
Help menu selection, 468
HSPICE

menu selection, 423
hSpice, 325

menu selection, 348
humidity, 41, 494

I
ICES-001, 561
icon color, 140, 141
icon, software, 85
identifying, 87
identifying hardware, 87
IEEE-488 connector, 502, 506, 511, 514, 518
IF bandwidth

setting, 111
IF gain, 42, 602
Imaginary format, 234
impedance, 474, 478, 482, 487, 492

format selection, 272
indicator, 99
port, 445
port reference, 445

Impedance menu selection, 460
Import menu selection, 338, 420
importing CITIfile files, 339
importing data files, 338–339
importing Touchstone files, 339
Impulse, 272
impulse

reflection, 245
transmission, 245

Impulse menu selection, 460
IN connector, 513, 517
incompatible network analyzer options, 10
Industrial Scientific and Medical Group 1 

Class A product, 557
initial software setup, 108–112
initial TDR setup, 187–194
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input voltage, 41
input voltage range of power supply, 474, 

478, 483, 488, 493
in-series, same-sex adapter characterization 

category, 177
insertion loss, 474, 478, 482, 487, 492
inspecting connectors, 539
installation

bench top, 16
equipment rack, 17
software, 51–90
TDR-based, 43–50
VNA-based, 3–42

instrument documentation symbol, 557
instrument markings, 557
interconnect cables, 8
interconnections, 21–38
inverse Fourier transform, 242
IO Libraries, 55
ISM1-A symbol, 557
isolation, 474, 478, 482, 487, 492

J
jitter, deterministic, 282

K
key, piano, 287
kit, defining a calibration, 132, 150, 165
kit, selecting a calibration, 126, 127, 129, 130, 

149, 150, 163, 164

L
Launch Startup Wizard menu selection, 452
LEDs, GPIB STATUS, 500, 504, 508, 512, 516
level

damage, 474, 478, 482, 487, 492
operating, 474, 478, 482, 487, 492

license
network-server floating, 77, 79–84
node-locked, 77, 77–79
specify type, 85

licensing, iii
line fuse, 531
Linear Mag, 233
list of open measurement windows, 466
LM-120, 54
load

icon, 141
match, 472, 476, 480, 485, 490
measurement button, 107, 186

termination, 531
loading existing calibration data, 110, 189
Log Mag, 272
Log Mag format, 233
Log Mag menu selection, 460, 461
logical measurement system, 88
loss

insertion, 474, 478, 482, 487, 492
LRM calibration, 162–175
LRM calibration procedure, 168

M
mag, angle menu selection, 343, 422
magnitude, reflection, 473, 477, 481, 486, 491
magnitude, transmission, 473, 477, 481, 486, 

491
main memory, 5, 46, 53
main window, 91
maintenance, 533
making a measurement, 114–118, 212–216
making connections, 539
manual, 54
manually configure a system, 90
Marker Bar menu selection, 434
markers, 99, 365–375
markings, 557
masking, 250
mat, floor, static-control, 530
mat, table, static-control, 530
match

load, 472, 476, 480, 485, 490
source, 472, 476, 480, 485, 490

math, 379–386
math fromulas, applying, 383
math fromulas, creating, 379
Math menu selection, 447
math, quick, 385
maximum time base, 111, 113, 190
Measure button, 179
Measure menu, 430
measurement

indicator, 99
Load Measurement button, 107, 186
making a, 114–118, 212–216
New Measurement button, 107, 186
parameters, resetting, 111, 113
port, 472, 476, 480, 485, 490
uncertainty, 473, 477, 481, 486, 491
viewing and analyzing results, 119, 217
window, 114
window list, 466
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measurement parameters, modifying the, 
215

measurement stimulus, modifying the, 214
measurement system, create a, 88
measurement, running the TDR, 216
measurements, making 2-port, 599
mechanical calibration, 137–143

interface, 137
memory, main, 5, 46, 53
memory, virtual, 5, 46, 53
menu

bar, 93
Data, 457
File, 417
Format, 460
Help, 468
Measure, 430
Options, 464
RLCG, 462
Tools, 447
Utilities, 438
View, 432
Window, 466

menu selection, 458
About PLTS, 468
Acquisition Hardware, 455
Actual Measured Parameters, 348, 423
Adjust Port Reference Plane, 444
ADS, 348, 423
All, 458, 463
Apply, 449, 450
Bit Pattern, 286, 449
Browser, 433
Calibrate, 439
Calibration, 438
Cascade, 466
Characterization Report, 425
Characterize Adapter, 440
Choose Data Acquisition Device, 455
CITIFile, 421, 422
Citifile, 339, 342
cm, 460
Continuous Sweep, 430
Data Sharing, 446
dB, angle, 343, 422
De-embedding, 360, 442
Design, 448, 450
Edit Cal Kit, 441
Exit, 429
Export, 340, 421

Format Bar, 436
Frequency Domain, 341, 422
Full Screen, 437
Gating, 352, 446
Gating Bar, 436
Help, 468
HSPICE, 423
hSpice, 348
Impedance, 460
Import, 338, 420
Impulse, 460
Launch Startup Wizard, 452
Log Mag, 460, 461
mag, angle, 343, 422
Marker Bar, 434
Math, 447
ML2CTL, 348, 424
New, 418
New Plot, 459, 463
New Trace, 459
New Window, 466
ns, 460
Open, 418
open measurement window list, 466
Parameter Bar, 434
Plots to Clipboard, 340, 422
Plots to Image, 341
Plots to Image File, 422
Port Reference Impedance, 445
Print, 428
Print Preview, 427
Print Setup, 426
Real, 460
real, imaginary, 343, 422
Recent Files, 429
RLCG, 348, 423
S11 through S44, 457, 458, 462
Save, 419
Save As, 419
Scaling Bar, 437
Scan for New Hardware, 456
SCC11 through SDC22, 458
SCD11 through SCD22, 458
SDC11 through SDC22, 458
SDD11 through SDD22, 458
Set Velocity Factor, 453
Start, 430
Status Bar, 433
Step, 460
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Stimulus, 431
Stop, 430
TCC11 through TDC22, 457
TCD11 through TCD22, 457
TDA MeasureXtractor, 346, 423
TDC11 through TDC22, 457
TDD11 through TDD22, 457
Tile, 466
Time Domain, 343, 423
Time Domain Window, 251, 282, 453
T-Line Characteristics, 452
Toolbar, 432
Touchstone, 339, 343, 421, 422
User Preferences, 464
Volts, 460

microwave connector care, 537
minimum rise time, 111, 113, 190
mixed-mode S-parameters, 226–227
ML2CTL menu selection, 348, 424
model number

module, 188
network analyzer, 7, 109
TDR, 188
test set, 7, 109

modify measurement stimulus, 116
modify time and frequency parameters, 111, 

126
module calibration, 202
module calibration, performing a, 203
module characterization file, 146
module connections, 144
module model number, 188

N
N1947A interconnections, 33
N1948A interconnections, 31
N1951A interconnections, 29
N1953A interconnections, 27
N1953B interconnections, 27
N1955B interconnections, 25
N1957A interconnections, 23
N1957B interconnections, 23
N4443A interconnections, 37
N4444A interconnections, 35
N4446A interconnections, 29
network analyzer

model number, 109
options, 7
setup, 10

network-server floating license, 77, 79–84
new calibration, performing a, 110, 189

new measurement button, 107, 186
New menu selection, 418
New Plot, 96
New Plot menu selection, 459, 463
New Trace, 96
New Trace menu selection, 459
New Window menu selection, 466
node-locked license, 77, 77–79
noise emission, acoustic, 561
noise requirements, German, 561
nominal, 470
normalization and reference plane 

calibration, 202
ns, 273
ns menu selection, 460
number of points

changing, 111

O
off symbol, 557
offices of Agilent Technologies, 552, 553
on symbol, 557
ON/OFF switch, 501, 505, 509, 513, 516
one level, 281
online assistance, 552
open icon, 141
open measurement window list, 466
Open menu selection, 418
opening plots

choosing a digital pattern for eye 
generation, 290

eye diagram, 289
frequency domain, 228
RLCG, 317
time domain, 262

opening the startup wizard, 126
operating environment, 41, 494
operating level, 474, 478, 482, 487, 492
option

060, 9
1CP, 9
B20, 9
UNK, 478

options, 9
network analyzer, 7, 10

Options menu, 464
orientation of adapters, 176, 440

forward, 179, 180
reverse, 181, 361

OUT connector, 513, 517
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P
packing materials, 553
parameter bar, 96
Parameter Bar menu selection, 434
parameters

changing, 126
mixed-mode (balanced) S, 226–227
recalculating, 126
S, 223–227
single-ended (unbalanced) S, 224–225
view window, 214
window, 126

parameters, modifying the measurement, 
215

pasting plot formats, 394–395
pattern, bit, 286, 290
pc board

sample balanced transmission line, 8
PC requirements, 5, 46, 53
Pentium, 5, 46, 53
Phase format, 233
phase skew, 357
phase uncertainty, 473, 477, 481, 486, 491
physical characteristics, 495
piano key, 287
plane, adjust reference, 444
plane, rotating the port reference, 357
plane, rotating the reference, 358
plot formats, copying and pasting, 394–395
plots

opening eye diagram, 289
opening frequency domain, 228
opening RLCG, 317
opening time domain, 262
viewing all eye diagram, 293
viewing all frequency domain, 229
viewing all RLCG, 320
viewing all time domain, 263
viewing custom eye diagram, 295
viewing custom frequency domain, 232
viewing custom RLCG, 322
viewing custom time domain, 266
viewing eye diagram, 289–295
viewing frequency domain, 228–232
viewing RLCG, 317–322
viewing single eye diagram, 294
viewing single frequency domain, 230
viewing single RLCG, 321
viewing single time domain, 264
viewing time domain, 262–266

Plots to Clipboard menu selection, 340, 422
Plots to Image File menu selection, 422
Plots to Image menu selection, 341
plots window, 100
plots, renaming, 396–397
PLTS connection manager, 64, 75
points per waveform, 190
points, changing the number of, 111
Polar Chart format, 234
PORT 2 BIAS connector, 502, 506, 510, 514, 

518
PORT 2 connector, 500, 504, 508, 512, 516
PORT 2 FUSE, 502, 506, 510, 514, 518
PORT 4 BIAS connector, 506, 510, 514, 518
PORT 4 connector, 500, 505, 509, 513, 516
PORT 4 FUSE, 502, 506, 510, 514, 518
port extension, 357, 358
port impedance, 445
Port Reference Impedance menu selection, 

445
port reference plane adjustment, 357–359
port reference plane, adjusting the, 357
port usage, 128
power

setting, 111
power cord, 8
power cord connector, 503, 507, 511, 515, 519
power source requirements, 41
power supply requirements, 474, 478, 483, 

488, 493
POWER switch, 501, 505, 509, 513, 516
preview before printing, 403–404
Print menu selection, 428
print preview, 403–404
Print Preview menu selection, 427
print setup, 399–402
Print Setup menu selection, 426
printint, 405–407
procedures, 595–603
Programmer’s Toolkit, 55, 57
prompt, calibration, 142

Q
quick markers, 368
quick math, 385

R
R IN connector, 501, 513, 517
R OUT connector, 501, 513, 517
R1 IN connector, 504, 508
R1 OUT connector, 505, 509
R2 IN connector, 505, 509
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R2 OUT connector, 505, 509
rack mount option, 9
rail set, 17
RAM, 5, 46, 53
random errors, 122
range

DC bias, 478
frequency, 474, 478, 482, 487, 492
resolution, 254
system dynamic, 471, 475, 479, 484, 489

Real, 272
Real format, 234
Real menu selection, 460
real, imaginary menu selection, 343, 422
rear panel

N4415A, 502
N4416A, 506
N4417A, 510
N4418A, 514
N4419A, 518
N4419B, 518
N4420B, 522
N4421A, 526
N4421B, 526

recalculate parameters, 111
Recalculate Parameters button, 126, 178
Recent Files menu selection, 429
record length, 111, 113, 190
REF 1 R IN connector, 503, 506, 510, 515, 518
REF 1 R OUT connector, 502, 506, 510, 514, 

518
REF 2 R IN connector, 506, 510, 514, 518
REF 2 R OUT connector, 507, 511, 514, 519
reference plane, 444
reference plane adjustment, 357–359
reference plane calibration only, 202
reference plane, rotating the, 358
reflection magnitude, 473, 477, 481, 486, 491
reflection tracking, 472, 476, 480, 485, 490
reflection, impulse, 245
reflection, step, 245
Ref-Z indicator, 99
relative velocity factor, 190
renaming plots, 396–397
repairs, 553
report generator, 389–393
requirements, computer, 5, 46, 53
rescanning for hardware, 110, 188
reset scale, 239, 276, 378
resetting parameter values, 111, 113
resolution, 111

range, 254

response, 253
screen, 5, 46, 53
spatial, 254

response resolution, 253
reverse adapter orientation, 181, 361

check box, 147
RF connector care, 537
RF power, 531
ripple, 531
rise time, 282

minimum, 111, 113, 130, 190
setting, 111

RLCG
changing scale, 323
export data formats, 310
exporting data, 325
menu, 462
menu selection, 348, 423
opening plots, 317
parameters, 297–325
scale units, 324
viewing all plots, 320
viewing custom plots, 322
viewing plots, 317–322
viewing single plots, 321

RLCG markers, 365
RLCG parameters

extracting, 314
rotating the reference plane, 358
run the software, 85

S
S11 through S44 menu selection, 457, 458, 

462
s4p file format description, 334–337
safety considerations, 558–560

before applying power, 559
general, 560
safety earth ground, 558
servicing, 559

safety earth ground safety considerations, 
558

safety symbols, 556
sample device under test, 8
sample pc board, 8
sampler bandwidth, 190
Save As menu selection, 419
Save menu selection, 419
saving

a bit pattern, 288
calibration data, 143, 161, 175
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scale
changing frequency domain, 237
changing RLCG, 323
changing time domain, 274
frequency domain horizontal, 238
frequency domain units, 238
frequency domain vertical, 238
RLCG horizontal, 324
RLCG units, 324
RLCG vertical, 324
time domain horizontal, 275
time domain units, 275
time domain vertical, 275

scale, reset, 239, 276, 378
scaling bar, 98

frequency domain, 237
RLCG, 323
time domain, 274

Scaling Bar menu selection, 437
Scan for New Hardware menu selection, 456
scanning, 87
scanning for hardware, 110, 188
SCC11 through SDC22 menu selection, 458
SCD11 through SCD22 menu selection, 458
screen resolution, 5, 46, 53
screen, main, 91
SDC11 through SDC22 menu selection, 458
SDD11 through SDD22 menu selection, 458
Select Adapter Files, 147
selecting the analysis type, 115, 213
semirigid interconnect, 21
semirigid interconnect cables, 8, 21
servicing safety considerations, 559
Set Velocity Factor menu selection, 453
setting up for printing, 399–402
Setup Stimulus button, 178
setup, software, 108–112
setup, TDR, 187–194
shipment damage, 6, 47, 54
shipment for service, 553
shipping materials, 553
short icon, 141
short/open/load calibration, 141
SICL name, 62, 73
signatures, time domain, 245
single ended TDR parameters, 192
single-ended S-parameters, 224–225
skew, 357
Smith Chart format, 234
software

CD-ROM, 54, 55
icon, 85

initial setup, 108–112
licence, 77
window, 91

software installation, 51–90
SOL calibration, 141
SOLT calibration, 127, 129

interface, 137
source match, 472, 476, 480, 485, 490
SOURCE OUT connector, 505, 509
S-parameters, 223–227

mixed-mode (balanced), 226–227
single-ended (unbalanced), 224–225

spatial
resolution, 254
resolution, setting, 111

specifications, 469–495
start frequency, setting the, 111
Start menu selection, 430
start settings, automated, 257
start the software, 85
start time, 267
startup wizard, 107, 186

opening, 126
static-safe workstation, 530
Status bar, 99, 361
Status Bar menu selection, 433
Step, 272
step

reflection, 245
setting frequency, 111
transmission, 245

Step menu selection, 460
stepped measurement, selecting, 111
Stimulus menu selection, 431
Stimulus Parameters window, 178
stimulus, modify the, 116
stimulus, modifying the measurement, 214
stimulus, view window, 214
stop frequency, setting the, 111
Stop menu selection, 430
stop settings, automated, 257
stop time, 267
storage altitude, 494
storing connectors, 539
sweep, continuous indicator, 99
switch

BUS ADDRESS, 502, 506, 510, 514, 518
GPIB address, 39, 49, 597
POWER, 501, 505, 509, 513, 516

SWITCH connector, 500, 501, 512, 513, 516, 
517

symbols, 557
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system
configurations, 7
dynamic range, 471, 475, 479, 484, 489
interconnections, 21–38
warmup time, 137, 144, 154, 168
weight, 6, 47

system, create a, 88
systematic errors, 122

T
T&M Programmer’s Toolkit, 57
T11 through T44 menu selection, 458
table mat, static-control, 530
TCC11 through TDC22 menu selection, 457
TCD11 through TCD22 menu selection, 457
TDA MeasureXtractor

menu selection, 346, 423
TDC11 through TDC22 menu selection, 457
TDD11 through TDD22 menu selection, 457
TDR

setup, 47
TDR cables, 184
TDR calibration

performing, 195–211
TDR calibration file name, 196
TDR calibration files, 198
TDR calibration kit

defining a, 199
TDR calibration kit selection, 196
TDR calibration parameters, 192
TDR calibration standards, 184
TDR calibration type, choosing a, 202
TDR firmware, 54
TDR measurement parameters, 192
TDR measurement, running the, 216
TDR model number, 188
TDR parameters, selecting, 192
TDR setup, 47, 187–194
TDR standards calibration,performing a, 

205–211
TDR-based installation, 43–50
telephone numbers, Agilent, 552
temperature, 494
temperature requirements, 41
test

cable, care of, 535
port connector type, 474, 478, 482, 487, 492
set model number, 109
set performance, 474, 478, 482, 487, 492
set ports, 176, 440

throughput, best, 190
thru

calibration, 138, 139
configuration, 139
configuration options, 138
configuration patterns, 140
icon, 140
path calibrations, comparing, 139
paths, 138

Tile menu selection, 466
time base

maximum, 111, 113, 190
setting, 111

time domain
calculation, 261
changing parameters, 126
changing scale, 274
comparison to frequency domain, 242
filtering, 251, 282
format bar, 97, 272
format menu, 272
gating, 277, 352–356
horizontal axis, 273
masking, 250
measurement, 242
menu selection, 343, 423
modifying measurement parameters, 111
opening plots, 262
range resolution, 254
response resolution, 253
scale units, 275
selecting formats, 272
signatures, 245
spatial resolution, 254
stimulus, 272
vertical axis, 272
view parameters window, 214
viewing all plots, 263
viewing custom plots, 266
viewing plots, 262–266
viewing single plots, 264
windowing, 251, 282, 453

time domain markers, 365
time domain time scale, optimizing, 267
Time Domain Window menu selection, 251, 

282, 453
time, start and stop, 267
time, warmup, 137, 144, 154, 168
title bar, 92
T-Line characteristic, 318
T-Line Characteristics menu selection, 452
toolbar, 94
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Toolbar menu selection, 432
Tools menu, 447
torque, connector, 535
torque, interconnect cable, 21
Touchstone file format description, 334–337
Touchstone menu selection, 339, 343, 421, 422
Touchstone, importing files, 339
tracking

reflection, 472, 476, 480, 485, 490
transmission, 472, 476, 480, 485, 490

transmission
impulse, 245
magnitude, 473, 477, 481, 486, 491
step, 245
tracking, 472, 476, 480, 485, 490

transmission line
exporting data, 325
model, 299
models, 303
parameters, 297–325

transmission line. See also RLCG
triggers to calibrate, 124
TRL calibration, 127, 148–161
TRL calibration procedure, 154
typical, 470

U
unbalanced S-parameters, 224–225
uncertainty, 473, 477, 481, 486, 491

phase, 473, 477, 481, 486, 491
uncorrected, 470
unpacking the system, 6, 47
user preferences, 268
User Preferences menu selection, 464
user’s guide, 54
Utilities menu, 438
utility, file converter, 408–411

V
validity of a time domain calculation, 261
velocity factor, 190

changing, 111
ventilation requirements, 15, 560
View menu, 432
view, stimulus window, 214
Viewing, 229
viewing measurement data, 119, 217
viewing plots

all eye diagram, 293
all frequency domain, 229
all RLCG, 320

all time domain, 263
custom eye diagram, 295
custom frequency domain, 232
custom RLCG, 322
custom time domain, 266
eye diagram, 289–295
frequency domain, 228–232
RLCG, 317–322
single eye diagram, 294
single frequency domain, 230
single RLCG, 321
single time domain, 264
time domain, 262–266

virtual instrument, 88
virtual memory, 5, 46, 53
VISA name, 62, 73
VNA-based

equipment installation, 3–42
VNA-based PLTS interconnections, 23–38
voltage requirements, 41
Volts, 272
Volts menu selection, 460

W
warmup time, 137, 144, 154, 168
warnings

before applying power, 559
definition, 556
general, 560
safety earth ground, 558
servicing, 559

waveform points, 190
weight, 6, 47, 495
welcome screen, 107, 186
when to calibrate, 124
width, 495
window

Adapter Installation, 178
ECal, 144
main, 91
plots, 100
Stimulus Parameters, 178

Window menu, 466
windowing, time domain, 251, 282, 453
Windows, 5, 46, 53
wizard

custom adapter characterization, 177–181
startup, 107, 186

workstation, static-safe, 530
wrist strap, ESD, 530
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Z
zero level, 281
zooming in and out, 376–378
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